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1. Introduction to MCUXpresso IDE

1.1

MCUXpresso IDE User Guide -

MCUXpresso IDE version 11.6.0 is an easy-to-use Eclipse-based development environment for
NXP MCUs based on Arm Cortex-M cores. It provides an end-to-end solution enabling engineers
to develop embedded applications from initial evaluation to final production. The MCUXpresso
IDE offers advanced editing, compiling, and debugging features with the addition of MCU-specific
debugging views, code trace and profiling, multicore debugging, and integrated configuration
tools.

The MCUXpresso platform ecosystem includes:

. - a software development environment for creating applications for
NXP’s ARM Cortex-M based MCUs including “LPC”, “Kinetis” and iMX RT" ranges.

. , comprising of Pins, Clocks and Peripherals Tools that are
designed to work with SDK projects and are fully integrated and installed by default.

. , each offering a package of device support and example software
extending the capability and part knowledge of MCUXpresso IDE.

e The range of LPCXpresso development boards, each of which includes a built-in “LPC-
Link”, “LPC-Link2", or CMSIS-DAP compatible debug probe. These boards are developed in
collaboration with Embedded Artists.

« The range of Tower and Freedom development boards, most of which include an OpenSDA
debug circuit supporting a range of firmware options.

e Therange of IMX RT Series EVK development board which include an OpenSDA debug circuit
supporting a range of firmware options, or high performance FreeLink (LPC-Link2 compatible)
debug probe.

¢ The range of EVK development boards which include an MCU-Link debug circuit
¢ The standalone “LPC-Link2” debug probe.
¢ The standalone “MCU-Link” and “MCU-Link Pro” debug probes.

This guide is intended as an introduction to using MCUXpresso IDE. It assumes that you have
some knowledge of MCUs and software development for embedded systems.

Note: MCUXpresso IDE incorporates technology and design from LPCXpresso IDE. This means
that users familiar with LPCXpresso IDE will find MCUXpresso IDE looks relatively familiar.

MCUXpresso IDE Overview of Features

MCUXpresso IDE is a fully featured software development environment for NXP's ARM-
based MCUs, and includes all the tools necessary to develop high-quality embedded software
applications in a timely and cost effective fashion.

MCUXpresso IDE is based on the Eclipse IDE and includes the industry standard ARM GNU
toolchain. It brings developers an easy-to-use and unlimited code size development environment
for NXP MCUs based on Cortex-M cores (LPC, Kinetis and iMX RT). The IDE combines the
best of the widely popular LPCXpresso and Kinetis Design Studio IDE’s, providing a common
platform for all NXP Cortex-M microcontrollers.

MCUXpresso IDE is a free toolchain providing developers with no restrictions on code or
debug sizes. It provides an intuitive and powerful interface with profiling, power measurement
on supported boards, GNU tool integration and library, multicore capable debugger, trace
functionality and more. MCUXpresso IDE debug connections support Freedom, Tower, EVK,
LPCXpresso and custom development boards with industry leading open-source and commercial
debug probes including MCU-Link, MCU-Link Pro, LPC-Link2, PEmicro and SEGGER.
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The fully featured debugger supports both SWD and JTAG debugging, and features direct
download to on-chip and external flash memory.

For the latest details on new features and functionality, please visit:

https://www.nxp.com/mcuxpresso/ide

Summary of Features

Complete C/C++ integrated development environment

» Eclipse-based IDE with many ease-of-use enhancements
* Built on Eclipse 2021.12 (Eclipse Platform 4.22.0 / CDT 10.5.0)
¢ The IDE installs with various Eclipse plugins including:
 Git, and support for PEmicro debug probes
« The IDE can be further enhanced with many other Eclipse plugins
« Command line tools are included for integration into build, test, and manufacturing systems

Industry standard GNU toolchain 10.3-2021.10 including:

¢ C and C++ compilers, assembler, and linker
« Converters for SREC, HEX, and binary

Advanced project wizards

¢ Simple creation of pre-configured applications for
» Extendable with
« Device-specific support for NXP’'s ARM-based MCUs (including LPC, Kinetis and iMX RT)

. of linker scripts for correct placement of code and data into Flash
and RAM

» Extended support for flexible placement of
Automatic generation of MCU-specific startup and device initialization code
* Note: No assembler required with Cortex-M MCUs

Advanced multicore support

* Provision for for each core in multicore MCUs

¢ Debugging of within a single IDE instance, with the ability to link
various debug views to specific cores

Fully featured native debugger supporting SWD and JTAG connection via LinkServer

¢ Built-in optimized for internal and external QSPI and Hyper Flash
¢ High-level and instruction-level

. and

* Views of CPU and on-chip

¢ Support for multiple devices on the JTAG scan-chain

Full install and integration of 3rd party debug solutions from:

Library support

¢ Redlib: a small-footprint embedded C library
* RedLib-nf: a smaller footprint library offering reduced fprintf support
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1.1.2
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* RedLib-mb: a library variant offering enhanced semihosting performance
¢ Newlib: a complete C and C++ library
* NewlibNano: a new small-footprint C and C++ library, based on Newlib
¢ LPCOpen MCU software libraries
« Cortex Microcontroller Software Interface Standard (CMSIS) libraries and source code
« Extendible support per device via MCUXpresso SDKs

Trace functionality
« Instruction trace via Embedded Trace Buffer (ETB) on certain Cortex-M3/M4/M7/M33 based
MCUs or via Micro Trace Buffer (MTB) on Cortex-M0O+ based MCUs

« Providing a snapshot of application execution with linkage back to source, disassembly and
profile

¢ SWO Trace on Cortex-M0+/M3/M4/M7/M33 based MCUs when debugging via MCU-Link,
MCU-Link Pro and LPC-Link2, providing functionality including:

 Profile tracing

« Interrupt tracing
« Datawatch tracing
* Printf over ITM

* Note: Now extended to work with PEmicro and SEGGER J-Link, in addition to native
LinkServer

LinkServer Energy Measurement
¢ On LPCXpresso boards, sample power usage at adjustable rates of up to 100 ksps; average
power and energy usage display option

¢ MCU-Link Pro or built-in implementations provide additional features, like simultaneous target
supply and current measurement, dynamic range switching for increased accuracy, analog
signal input, trigger-based measurements.

» Power Profile view providing correlated energy and trace measurements.
e Explore detailed plots of collected data in the IDE
« Export and import data for offline analysis

RTOS Debug Awareness

* GDB thread awareness for various RTOS providers: FreeRTOS, Azure ThreadX, Zephyr and
MQX

* Views for different RTOS elements: Thread list, Message queues, Semaphores, Mutexes,
Event flags, Timers, Memory block pools, Memory byte pools, etc

MCUXpresso Configuration Tools

. , designed to work with SDK projects are fully integrated
and installed by default

Supported Debug Probes

MCUXpresso IDE installs with built in support for 3 debug solutions. This support includes the
installation of all necessary drivers and supporting software.

Note: Certain mbed boards require a serial port driver to be recognized and this one exception
must be installed separately for each board. The driver is linked from Help -> Additional
Resources -> MBED Serial Port Driver Website

In normal use MCUXpresso IDE presents a similar interface and array of features for each of
the solutions listed below:
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Native LinkServer (including CMSIS-DAP) as also used in LPCXpresso IDE

« this supports a variety of debug probes including OpenSDA programmed with CMSIS-DAP
firmware, LPC-Link2, MCU-Link etc.

¢ https://community.nxp.com/message/630896

PEmicro

« this supports a variety of debug probes including OpenSDA programmed with PEmicro
compatible firmware and MultiLink and Cyclone probes

¢ https://lwww.pemicro.com/

SEGGER J-Link

e this supports a variety of debug probes including OpenSDA programmed with J-Link
compatible firmware and J-Link debug probes

¢ https://lwww.segger.com/

Please see for more details.

Note: Kinetis Freedom and Tower boards typically provide an on-board OpenSDA debug circuit.
This can be programmed with a range of debug firmware including:

* mBed CMSIS-DAP — supported by LinkServer connections

¢ DAP-Link — supported by LinkServer connections (DAP-Link is preferred to mBed CMSIS-DAP
when available)

e J-Link — supported by SEGGER J-Link connections
¢ PEmicro — supported by PEmicro connections

The default firmware can be changed if required, for details of the procedure and range of
supported firmware options please information visit: https://www.nxp.com/opensda

Tip

@ Under Windows 10, OpenSDA Bootloaders might experience problems and the
OpenSDA LED will blink an error code. The following article discusses the problem
and how it can be fixed: https://mcuoneclipse.com/2018/04/10/recovering-opensda-
boards-with-windows-10

1.1.3 Development Boards
NXP have a large range of development boards that work seamlessly with MCUXpresso IDE
including:
LPCXpresso Boards for LPC
These boards provide practical and easy-to-use development hardware to use as a starting point
for your LPC Cortex-M MCU based projects.
MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.
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Figure 1.2. LPCXpresso Development Board (LPCXpresso54608)

For more information, visit: https://www.nxp.com/Ipcxpresso-boards
Freedom and Tower Boards for Kinetis

Similarly, for Kinetis MCUs there are many development boards available including the popular
Freedom and Tower ranges of boards.
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Figure 1.3. Tower (TWR-KV58F220M)

For more information, visit: https://www.nxp.com/pages/:TOWER_HOME

Figure 1.4, Freedom (FRDM-K64F)

For more information, visit: https://www.nxp.com/pages/:FREDEVPLA
iMX RT Crossover Processor Boards

iMX RT based boards bring the convergence of low power applications processors with high-
performance microcontrollers.
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Figure 1.5. i.MX RTxxxx Series (MIMXRT1050-EVK)

For more information, visit: https://www.nxp.com/pages/:IMX-RT-SERIES

Figure 1.6. i.MX RTxxx Series (MIMXRT600-EVK)

For more information, visit: https://www.nxp.com/pages/:IMX-RT-SERIES
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2. New Features in MCUXpresso IDE version 11.6.0

2.1

MCUXpresso IDE User Guide -

The new MCUXpresso IDE product comes with a set of improvements and bug fixes including:

Product

» Eclipse version to 2022.12 (Eclipse Platform 4.22.0 / CDT 10.5.0).

« MCUXpresso IDE integrated with OpenJDK11 (HotSpot engine, build 11.0.11+9)
¢ GNU ARM Embedded Toolchain to version 10.3-2021.10.

¢ Upgraded SEGGER J-Link software (v7.66e, 64bit).

« Upgraded PEmicro plugin (v5.2.6).

* Upgraded MCUXpresso Config Tools (v12).

e Upgraded for Ubuntu 22.04 LTS support.

¢ Upgraded xPack Windows Build Tools (v4.3.0-1).

¢ Synchronization with SDK v2.12.x and manifest schema version 3.10.

¢ Added IMXRT1040-EVK support.

IDE

« Added Power Profile feature aiming to correlate energy/power measurement with SWO trace.
The view displays the SWO based trace information (similar with SWO Profile view), plus
each function showing various energy consumption information. The feature is available from
Eclipse Menu -> Analysis -> Power Profile.

* Added analog data traffic statistics information for energy/power based views.

SDK

e Support to allow sub-manifest under same SDK.
« Adapted SDK Creator for creating split manifests.

e Updated “Contribute project to SDK Git repository” feature to work with the new sub-
manifests.

Debug

¢ Added Zephyr RTOS Awareness:
» Added GDB thread awareness for LinkServer debug connection.
* Added Threads view.

LinkServer Flash Programming

Please also see the supplied ReadMe document for further information and details of bug fixes
and improvements. This document is located within the MCUXpresso IDE installation folder.

Feature Highlights from previous releases of MCUXpresso IDE

Product

¢ GNU make 4.2.1 is now integrated on IDE on all OS-es.

¢ The IDE does not internally use WMI command line utility anymore (deprecated as of Windows
10, version 21H1). PowerShell will be used instead.

¢ New , designed to provide a dramatically improved out-of-box
experience for new users

¢ Improved capability simplifying the update procedure for all supported
hosts

« Scripts to create a command line environment now supplied in DOS and Bash versions
« Use of these scripts is described within the Installation Guide

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.
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SDK installation options improved, see

Windows version now uses Busybox (from the GNU MCU Eclipse Windows Build Tools project)
to provide Unix-like layer for GCC tools

All previous Pro Edition features have been incorporated into the standard Free edition and
the Pro edition has been discontinued

IDE

Added FreeRTOS Task Notifications view to display task notification list for each task, including

status and value properties. This included synchronization with FreeRTOS v10.4.3. For more

information please refer to MCUXpresso_IDE_FreeRTOS_Debug_Guide.pdf documentation.

Azure RTOS ThreadX debug awareness:

« Ability to export trace that can be further used within TraceX Microsoft tool;

* GDB thread awareness;

* Views, similar to the FreeRTOS, for: Thread list, Message queues, Semaphores, Mutexes,
Event flags, Timers, Memory block pools, Memory byte pools.

Added offline peripheral view (“Offline Peripherals”). With this view, the peripheral registers

can be inspected outside of a debug session. Reset value can be inspected as well together

with the rest of the register elements.

Peripherals+ view design was changed to support register group expansion directly into the

Peripherals+ view, with no extra Memory View usage. Consequently, all elements shown

before in Memory View are now available directly in the Peripherals+ view: values, bitfields,

details.

Added Energy Measurement view for energy consumption measurement.

< Various measurement channels: voltage, current, power, etc, at various sampling speeds,
up to 100ksps.

< Import/Export measurement.

* Zooming, panning and annotation capabilities on graph.

* Unlimited sampling time, depending on the available space on disk.

« Data gathering enabled / disabled by trigger signal MCU-Link Pro and on-board probes
with energy measurement circuitry can use a GPIO signal as a trigger/enable (input) for the
energy measurement data gathering such that data capture will commence and stop based
on trigger signal transitions. The Energy Measurement view includes a trigger configuration
section to make use of this probe capability. The supported modes of operation include level-
based and pulse-based transitions of the trigger signal, with additional configuration of start
and stop conditions. Note. This feature requires firmware version MCU-LINK CMSIS-DAP
v2.249 (or greater).

Community forum accessible now from the main toolbar too (together with the older link from

Help -> MCUXpresso IDE support forum).

Expressions added in Global Variables are now persistent between debug sessions.

Added new control to manage the maximum number of child expressions that are evaluated

in advance by the Live Variables service. This improves the Global Variables window

responsiveness for instance when large structures are displayed. New control available on

Eclipse Preferences -> MCUXpresso IDE -> Debug Options -> “Number of subexpressions

proactively evaluated by Live Variables service”. Default is 2 set as depth.

Added option to help reporting an issue by gathering MCU IDE
environment information.

New mechanism that provides a simpler flow for selection and installation
of MCUXpresso IDE SDKs

New provides a low-light interface that displays mostly dark surfaces that
may be more relaxing on the eye

Improved

Improved

Improved

« the code size of debug builds of SDK projects has been reduced by decreasing the overhead
of the assert() function, which is commonly called by SDK functions.
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Added support for handling more complex specification of dependencies between SDK
components.

for all debug solutions

« shows usage against allocated RAM allocation for bare metal
projects

 Live Heap updates and stack when paused
extends and replaces the Symbol Browser

« incorporating detailed memory usage plus hyperlinked Memory Content and Static Call
Graph display

Revamped
Editor for linker scripts, linker templates and debug map files
 providing linked navigation of file contents
Redesigned
e Quick Start panel -> now displays the current settings for Library
* links for for all supported Debug Solutions

automatically displayed (for LinkServer) should a CPU fault occur
Improved with enhanced display and grouping options

are now only automatically generated for the selected build

configuration
Project can now be edited in place for settings and wizards

Project Explorer view enhanced to display current project build configuration for the selected
project (also displayed in Quickstart view)
Support for new MCUs based on the ARM Cortex M33

Projects

A specific SVD file can be assigned to a project that can be used afterwards within
or views.

Imported or new will now expand to show the source file containing the main
function and also opens this file within the editor

Improved display of Components in
Quick Start panel -> now displays the current settings

Project association with an SDK (MCU) can now be flexibly managed, maintaining existing
memory configuration if desired see

Many enhancements for improved including:
» Drag and Drop of projects for import and export
« Options for project local inclusion of: SDK part support, flash drivers, and LinkServer connect
and reset scripts

introduced to enable easy visibility and editing of project

configurations
for all debug solutions delivered via project launch

configurations

Debug

The target configuration for SWO trace is now optional. The default setting is to have the IDE
perform the necessary configuration for SWO trace. However, the user can choose to disable
this functionality and rely on target configuration performed by the application. The behavior
is controlled by the “SWO configured by IDE” (depending on the debug probe) checkbox in
“SWO Trace Config” view -> “Change” button -> “Clock speed configuration” dialog. For more
information please refer to MCUXpresso_IDE_SWO_Trace.pdf documentation.

A new console named displays all configuration and register
settings performed while configuring SWO.

[J-Link] Added possibility to connect to a remote gdb server. In launch configuration -> J-Link
Debugger tab -> GDB Server Settings, use Server execution option to set a remote server.
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UART console is the default debug console when importing a project.

The IDE displays inside Probes Discovered dialog the nickname assigned to a PEmicro or J-
Link debug probe. Each solution offers a specific procedure for assigning a nickname, thus
the appropriate documentation must be followed.

Auto-debug secondary project(s) for multicore projects option becomes default option for

multicore debug purpose for LinkServer debug connection. That means, in the case of

multicore projects on which primary project refers one or several secondary projects, debug
sessions will be automatically started for secondary projects after initiating debug with the
primary project.

e Option is set by default on: Window -> Preferences -> MCUXpresso IDE -> Debug
Options -> LinkServer Options -> Miscellaneous -> Enable auto-debug secondary
project(s) for multicore projects.

« If you don’'t want to have this feature enabled (so if you want to start debug sessions for
each core independently), uncheck this option.

Similar, auto-debug secondary project(s) for multicore projects option becomes default option
for multicore debug purpose for PEmicro too. Option is enabled by default on: Window ->
Preferences -> MCUXpresso IDE -> Debug Options -> PEMicro Options -> Enable auto-
debug secondary project(s) for multicore projects and also for J-Link debug session, set
by default on: Window -> Preferences -> MCUXpresso IDE -> Debug Options -> J-Link
Options -> Enable Auto-debug secondary project(s) for multicore projects.

Most LinkServer now implements a Verify Same operation for any
flash sector that are unchanged from previous debug operations

LinkServer MultiCore debug operations can now be started via a single click

Reworked graphing offering improvements to variable selection
and display

Reworked SWO Interrupt trace

LinkServer LPC-Link2 firmware now softloaded as v5.361 which offers improved debug control
through target reset

Redesigned LinkServer dialogue offering improved functionality
and ease of use

« this is reflected in a new LinkServer Launch configuration icon

New launch configuration tab for all debug solutions to allow the loading of
from additional images

Improved performance for Single Stepping LinkServer debug connections
Implemented support for SWO Trace on Cortex-M33 based MCUs

are now available for SEGGER JLINK and PEmicro debug
probes in addition to LinkServer LPC-Link2

LinkServer internal flash drivers prioritised over supplied SDK drivers

now Multicore aware ensuring secondary project attach
settings are observed

Improved now displays Fault Address when available

SWO trace features are now available for SEGGER JLINK and PEmicro debug probes in
addition to LinkServer LPC-Link2 and MCU-Link

LinkServer debug probes now support selection via their serial number (for command line use)
Increased integration of our supported debug solutions including:

. is re-architected to provide support for LinkServer, PEmicro and
SEGGER debug solutions

« offering binary flash programming and erase capability for all supported debug solutions

» with a feature set integrated into the Quickstart panel, project Launch Configurations and
from the IDE as before

« Instruction trace is seamlessly supported by LinkServer, PEmicro and SEGGER debug
solutions

including printf are further optimised to deliver
approximately double the performance of the previous release
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via new library variant Redlib MB and
LinkServer which can deliver both a further increase in performance and no disruption to code
executing with time critical interrupts
LinkServer
« Live global variable values can now be traced both in graphical and tabular forms
to simplify complex peripheral views

LinkServer Flash Programming

External flash drivers for RT116x, RT117x, RT500 and RT600 available as examples in
<install_dir>/ide/Examples/Flashdrivers/NXP/IMXRT.
extended to support iMX RT MCUs
Programming of data flash regions on certain Kinetis parts is now supported
Improved flash programming performance and reliability
LinkServer via self configuring flash
drivers
« using JEDEC SFDP (Serial Flash Discovery Protocol) available for LPC18/43, LPC546xx,
LPC540xx, iMX RTxxX, iIMX RTXXxX

SDK

MCUXpresso IDE User Guide -

A GitHub SDK repository can be imported and managed within IDE, integrating existing IDE’s
SDK management functionality and git capability.

e Support to an already cloned repository;
e Support to a remote repository (using west init and west update);
« Ability to a project back to SDK GitHub repository;

Improved SDK installation and refresh time

Redesigned New and Import SDK example wizard

* incorporating Error Decorators

SDK part support is now generated within the current workspace eliminating issues that could

arise if multiple IDEs were launched

 part support is intelligently regenerated when required avoiding unnecessary delays
can now be set via a workspace preference

Installed SDK view improved to display version information and enhanced tooltips

SDK Manifest Analyser to provide visibility of SDK XML description

Easy access to

Extension of SDK Component Management to allow

e improved SDK Component Management

General Improvements in SDK Handling including:

» SDK version string now present and reported in SDK view

 user selection of versioned internal XML descriptions (enabled via preference)

 better automatic support for SDKs with overlapping capabilities
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3. IDE Overview

The following chapter provides a high level overview of the features offered by MCUXpresso IDE
(often referred to as the IDE).

3.1 Workspaces

When you first launch MCUXpresso IDE, you will be asked to select a Workspace, as shown
in Figure 3.1.

® MCUXpresso IDE Launcher
Select a directory as workspace

MCUXpresso IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | sters,’nxprocuments,fMCUXpressoIDEJ‘I.1,0_alpha.iworkspace|ﬁ Browse...

» Recent Workspaces

~ Copy Settings
Workbench Layout
Working Sets

Preferences

(?) Cancel

Figure 3.1. Workspace selection

A Workspace is simply a filing system directory used to store projects and data, and the
recommended default location should typically be accepted for new installations. If you tick the
Use this as the default and do not ask again option, then MCUXpresso IDE will always start
up with the chosen Workspace opened; otherwise, you will always be prompted to choose a
Workspace.

MCUXpresso IDE can only access a single Workspace at a time but many Workspaces may
be used. You may change the Workspace that MCUXpresso IDE uses, via the File -> Switch
Workspace option.

Tip
@ It is possible to run multiple instances of the IDE in parallel with each instance
accessing a different Workspace.

Note: when changing workspaces, you may choose to copy settings (preferences) from an
existing workspace to the new workspace using the various Copy Settings tick box options.

3.2 Welcome View

MCUXpresso IDE version 11.1.0 launches with a new Welcome View. This View is intended to
help reduce the learning curve for new users by offering links and help for common tasks and
IDE operations.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.
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= | (01 Welcome 53

i ®

Welcome to MCUXpresso IDE

MCUXpresso IDE provides an easy-to- "‘" L Download and Install SDKs

use Eclipse-based development
environment for NXP MCUs based on

Emionentt <je g o Clickto start the IDE
(_I1DE J

crossover processors. It offers advanced
editing, compiling, and debugging
features with the addition of MCU-

specific debugging views, code trace % o

and profiling, multicore debugging, and i?

integrated configuration tools. Import SDK Examp'es
(_IDE_J

AV 4
‘r k

MCUXpresso = Always show Welcome at start up

Figure 3.2. Welcome View

ﬁ >/ \ P @ @?3 A e

Home Overview What's New First Steps Web Resources Documentation IDE

3.3

MCUXpresso IDE User Guide -

1. Click to select, download and install a
2. Click to be guided through
3. Click to be guided through

Since support for most NXP MCUs is added to the IDE via the installation of an SDK, the first
option is to guide the user to a new installation view. From this view, an SDK
for a required MCU or (development board) can be selected, downloaded and installed with just
a few clicks. Also from this screen are guided workflows for creating New Projects and Installing
SDK Examples.

Across the top of this View are links to Features and Resources including a jump to IDE
link (highlighted above) which takes the user directly to the IDE’s main development view
(Perspective).

Note: This Welcome View is provided by Eclipse functionality and so incorporates standard icons
to maximise, minimise and restore etc. like all Eclipse views. Since this view is intended to be
used full screen, minimising or restoring may lead to a poor screen layout. The recommended
way to switch back to the main IDE Develop view is via the IDE link or by closing this Welcome
Screen. The Welcome View can be restored at any time by clicking the Home Icon within the
main Eclipse Icon view.

The Welcome view can be disabled from appearing at startup by unchecking the box at the lower
right of the view.

Documentation and Help

In addition to the help features offered from the Welcome View are a comprehensive suite of
Guides.
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MCUXpresso IDE is based on the Eclipse IDE framework, and many of the core features are
described well in generic Eclipse documentation and in the help files to be found on MCUXpresso
IDE’s Help -> Help Contents menu. It also provides access to the MCUXpresso IDE User Guide
(this document), as well as the documentation for the compiler, linker, and other underlying tools.

MCUXpresso IDE documentation comprises a suite of documents including:

* MCUXpresso IDE Installation Guide

« MCUXpresso IDE User Guide (this document)

¢ MCUXpresso IDE SWO Trace Guide

e MCUXpresso IDE Instruction Trace Guide

¢« MCUXpresso IDE LinkServer Energy Measurement Guide
« MCUXpresso IDE FreeRTOS Debug Guide

¢ MCUXpresso IDE Azure RTOS ThreadX Debug Guide

*« MCUXpresso IDE Zephyr RTOS Debug Guide

*« MCUXpresso IDE MQX RTOS Debug Guide

¢ MCUXpresso (IDE) Config Tools User’'s Guide
These Guides are also supplied in PDF format within the MCUXpresso IDE’s installation folder.
To obtain assistance on using MCUXpresso IDE, visit: https://www.nxp.com/mcuxpresso/ide

Related web links can be found at Help -> Additional resources as shown below:

Figure 3.3. Additional Resources

Help
i Welcome
@ Help Contents
' MCUXpresso IDE User Guide
% Search
Show Contextual Help

Show Active Keybindings... Ctrl+Shift+L
\ Tips and Tricks...
Cheat Sheets...
@ Edipse User Storage >
% Check for Updates
4 Install New Software...
© Eclipse Marketplace...
B MCUXpresso IDE product web page

* Additional resources

MCUXpresso IDE installation details MCUXpresso SDK product web page

MCUXpresso IDE Save Info for Support B MCUXpresso Config Tools product web page

® MCUXpresso IDE support forum B MCUXpresso Secure Provisioning Tool product web page
GboutMEUxoressollDE MCUXpresso SDK Builder

“ LPCOpen Resources
* Code Bundles for LPC800 Family devices
* OpenSDA probe firmware
* LPCScrypt - LPC-Link2 probe firmware
* LPC11U35 CMSIS-DAP probe firmware
B SEGGER J-Link website
[ PEMicro website
B MBED Serial Port Driver website

@ 'MCU on Eclipse' blogs

3.4

MCUXpresso IDE User Guide -

Perspectives and Views

The overall layout of the main MCUXpresso IDE window is known as a Perspective. Within
each Perspective are many sub-windows, called Views. A View displays a set of data in the IDE
environment. For example, this data might be source code, hex dumps, disassembly, or memory
contents. Views can be opened, moved (dragged), docked, and closed, and the layout of the
currently displayed Views can be saved and restored.

Typically, MCUXpresso IDE operates using the single Develop Perspective, under which both
code development and debug sessions operate as shown in Figure 3.6. This single perspective
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simplifies the Eclipse environment, but at the cost of slightly reducing the amount of information
displayed on screen.

Alternatively, MCUXpresso IDE can operate in a “dual Perspective” mode such that the C/
C++ Perspective is used for developing and navigating around your code and the Debug
Perspective is used when debugging your application.

Note: when within the debug perspective, the concept of a selected project remains. The Blue
Debug button tool tip will display this selected project. Also, if a debug operation is started within
the Debug perspective and a switch is made to the Develop perspective, the IDE will automatically
open a debug stack view to display the active debug connection.

You can manually switch between Perspectives using the Perspective icons in the top right of
the MCUXpresso IDE window, as shown in Figure 3.4.

B (X G

Figure 3.4. Perspective selection

New perspectives can be selected by clicking the view+ icon. Once a view has been selected,
its icon will appear within the horizontal section as highlighted above.

All Views in a Perspective can also be rearranged to match your specific requirements by
dragging and dropping. If a View is accidentally closed, it can be restored by selecting it from the
Window -> Show View dialog. The default layout for a perspective can be restored at any time
via Window -> Perspective -> Reset Perspective.

Commonly used Views for Analysis (Trace) and RTOS debugging have been made more readily
available via top level drop down menus as shown below:

Analysis Window Help RTOS Analysis Window Help

2| SWO Trace Config Azure RTOS ThreadX
& SWO Profile i Threads
¢4 SWO Data % Message Queues
& SWO Interrupts i Semaphores
A SWO Counters % Mutexes
E SWO ITM Console % EventFlags
€ Instruction Trace % Timers
B Instruction Trace Config % Memory Block Pools
&  Memory Byte Pools
‘& Power Profile
- FreeRTOS
[i* Energy Measurement B Task List
il Task Notifications
' Queue List
i1 Timer List
i Heap Usage
Zephyr RTOS

Threads

Figure 3.5. Additional Views

MCUXpresso IDE User Guide -

One selected, these additional views will appear alongside the Console view but can be relocated
as desired.

Note: The rest of this guide assumes the default Develop Perspective is used.
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3.5 Major Components of the Develop Perspective
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Figure 3.6. Develop Perspective (whilst debugging)

1. Project Explorer / Peripherals / Registers / Faults
e The Project Explorer view (shown) gives you a view of all the projects within your current

* Many editing and configuration features are available from this view including new
options and

« When debugging, the Peripherals view allows you to display a list of the MCU
and project memory regions. Note: depending on your MCUs

configuration, some peripherals may not be powered/clocked and hence their content will
not display.

¢ When debugging, the improved Registers view allows you to view the
and their content within the CPU of your MCU.
« Pseudo registers are also displayed here such as ‘cycle delta’ which shows the calculated

number of cycles since the last pause

¢ Also displayed here is the Faults view, which will appear automatically if a CPU
(such as hard fault) occurs. This view decodes CPU registers to provide detailed information
indicating the reason for the fault occurring.

2. Quickstart / Variables / Breakpoints

On the lower left of the window, the Quickstart Panel View (shown) has fast links to
commonly used features. From here you can launch various wizards including New Project,
Import projects from SDK and also from the File System plus options such as Build, Debug,
Export etc.. The large icon in each section will perform the first option in the group i.e.
New project, Build, Debug. Also, the Debug group contains debug solution specific

« Note: This Panel is essential to the operation of MCUXpresso IDE and so cannot be
removed from the perspective.

« Sitting in parallel to the Quickstart Panel, the Variables View allows you to see and edit
the values of local variables.
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3.

7.

8.

e Sitting in parallel to the Quickstart Panel, the Breakpoints View allows you to see and
modify currently set and

Debug
¢ The Debug View appears when you are your projects. This view shows
you the debug stack, in the “stopped/paused” state you can click within the stack and inspect
items in scope such as local variables.
. Editor

¢ Centrally located is the Editor, which allows creation and editing of source code and other
text files. When debugging, this is where you can see the code you are executing and can
step from line to line. By pressing the ' i->' icon at the top of the Debug view, you can switch
to stepping from source to assembly instructions. Clicking in the left margin will set and
delete
. provides structure, keyword and linkage for debug Map files,
Linker Script and Linker Template files.

. Console / Installed SDKs / Problems / Trace Views / Power Measurement

¢ On the mid lower of the window are Console, Installed SDK and Problems Views etc. The
Console View displays status information on compilation and debug operations, as well as
displaying semihosted program output.

e The view (shown) enables the management of installed SDKs.
New SDKs can be added as Plugins via Drag and Drop or Copy and Paste. Other SDK
management features are also provided from this view including unzip, explore and delete.
Details of any selected SDK can be viewed in Outline view.

» SDK Documentation can be browsed and extracted

¢ The Problems View shows all compiler errors and warnings and will allow easy navigation
to the error location in the Editor View.

e The Image Information View
e This view provides detailed information on an image (or object)

static memory footprint (usage and content).

. Quick Access/Perspective Selection

* Enables quick access to features such as views, perspectives etc. for example enter ‘Error’
to view and open the IDE’s Error Log, or ‘Trace’ to view and open the various LinkServer
Trace views.

* Perspective Selection allows you to switch between the various defined perspectives.

Outline / Global Variables

¢ The Outline View allows you to quickly locate symbols, declarations, functions within the
editor view. This view can also display details of any SDK selected in the Installed SDK view.

« Sitting in parallel is the Global Variables View (shown) which allows you to see and edit
the values of Global variables.

» Variables can be monitored while the target is running using the
and features.

Memory / Heap and Stack / Trace

« The Memory View provides a range of options for viewing target memory

e The Heap and Stack View enables easy monitoring of values for
bare metal projects.

* Warnings are given when preset limits are approached or exceeded

e Trace Views

¢ Trace Views including SWO Trace (Profiling shown), Instruction Trace, and Power are not
shown on this screenshot, however these views may be selected when required from the
Analysis Menu. For more information on Trace functionality, please see the MCUXpresso
IDE SWO Trace Guide and/or the MCUXpresso IDE Instruction Trace Guide and/or the
MCUXpresso IDE LinkServer Power Measurement Guide.

* The SWO Trace Views allow you to gather and display runtime information using the
SWO/SWYV technology that is part of Cortex-M0+/M3/M4/M7/M33 based parts.

e The Instruction Trace view on certain MCUs, you can capture and view instruction trace
data downloaded from the MCU’s Embedded Trace Buffer (ETB) or Micro Trace Buffer
(MTB).
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* The Power Measurement View, this view is capable of displaying real-time target power
usage. For more information please see the MCUXpresso IDE Power Measurement
Guide.

9. Status Bar Shortcuts

¢ Various useful shortcuts, for example to open a project’'s workspace or to open a terminal
at the project’s location with the IDE’s environment. Hover here and tooltips will explain the
various options.

3.5.1 Dark Theme

MCUXpresso IDE contains support for a Dark Theme. Dark Theme is a Workspace preference
that can be selected from Window -> Preferences -> Appearance -> Theme followed by a
selection from the drop down menu.

Wi =5 (E=n
type filter text Appearance - - -
4 General - o
[ Enable theming (requires restart]
olors and Fonts Theme: [iMCngﬂﬁ&D Dark V_]]
Label Decorations :L
Capabilities Color and Font theme: -
Compare/Patch Dark [Linux]
Content Types Dark [Mac 05 X]
Editors D_ark[Mac 05X]
F Light
Globalization |= Light [Linux]
Keys Light [Mac 05 X]
Link Handlers Description: MCUXpresso Dark
MNetwork Connection:| MCUXpresse Dark 10.13 [Mac 05 X]
Perspectives MCUXpresso Dark [Linux]
g MCUXpresso Dark [Mac 05 X]
Project Natures MCUXpresseo Light
Search MCUXpresso Light [Linux]
Security L MCUXpresso Light [Mac OS X]
Srtip.and Shutrnws [ Enable animations Windows Classic

IR M i :
e i [¥| Use mixed fonts and colors for labels
User Storage Service
Web Browser
Visible tabs on overflow:

Workspace
» CfCe+ [V Show most recently used tabs
Sl hé [Restore Defaults] [ Apply |
” e - estore Defaults pply
'\? g |.__‘ {Apply and Gasel [ Cancel ]

Figure 3.7. Appearance Preference

When selected, a Dark theme with be used to render the perspective and will appear similar to
the image below:
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8008 +, workspace.nxp - frdmi6af_bubble/source/bubble.c - MCUXpresso IDE

P we
T T & T Outline Global Variables x

¥ i Bw-2 W -

Heeeenees

& Quickstart ...

MC!

@insta. x M Prope.. B Probl. = Console [ Termi.. [ Imag. P Debu. s

W installed SOKs

Figure 3.8. Develop Perspective Dark

Note: An IDE restart File -> Restart is required for the perspective to display correctly.

3.6 The Quickstart Panel

A key feature of MCUXpresso IDE is the Quickstart Panel — which is frequently referenced
with this document. The Quickstart panel is designed to bring together many of the common IDE
features and operations including links to Project Creation, Project Building, Project Debug and

Miscellaneous common Project operations.

It is strongly recommended that this panel is used to perform the supported MCUXpresso
IDE operations described below since many underlying Eclipse features are enhanced when

accessed in this way to improve and simplify the user experience.

Features of the Panel are highlighted and described below:
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) Quickstart Panel &3 Variables Breakpoints =i

. MCUXpresso IDE - Quickstart Panel
|_IpE ) [Project: MKB4FN1MOxxx12_Project [Debug]b

~ Create or import a project

. New project...
b . ]
/ . Import SDK example(s)...
® Import project(s) from file system...

~ Build your project

%, Build
& Clean .
~ Debug your project ' ﬂ" ﬂ'

“t% Debug O

- Miscellaneous

[ 8 Edit project settings
. MCUXpresso Config Tools>>
& Quick Settings>>

IE
r
12

i

| [ Build all projects [Debug]

Figure 3.9. The Quickstart Panel

Tip
@ The Large Icon performs the action of the first button in the group

Where:

1. Shows the Project currently selected within the Project Explorer view. Build, Debug and
Miscellaneous operations will be performed to this Project

2. Links to , and Import from the
3. (or Clean) the currently selected Project

¢ See progress and results within the view
4. Debug the currently selected Project

¢ Clicking will by default Build the project (if necessary), perform a Debug Probe
Discovery, create a default (if necessary) and if successful,
begin the debug session.

« Terminate, Build and Debug, Terminates the existing Debug session for the selected project,
and them performs another debug operation. It is intended to be used for iterative source
code fix and debug retry operations

5. offer arange of debug operations for specific vendor Debug Solutions
6. The Miscellaneous section offers a range of option and shortcuts
« Edit project settings is a shortcut equivalent to a right click on a project and then selecting

Properties
. Tools offers shortcuts to launch one of the Config tools for the
selected project
. offers a range of options for the currently selected project
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« Export the selected Project (and References) to the file system. See also additional
information on

« this feature requires that the project is selected at the top level within Project Explorer
< Build the Active Build Configuration of all projects within the current Workspace.

Tip
@ If the Quickstart panel has become hidden, then in the menu bar at the top of the IDE,
select Window -> Show View -> MCUXpresso IDE and double-click on Quickstart

The Quickstart panel is directly linked to active selection from Project Explorer, which controls
the enablement state of various actions within the view. However, when the Quickstart panel is
visible it also controls automatic selection of the debugged project when various debug launch
events are encountered. Behavior can be adapted by accessing the appropriate preference page:
Window -> Preferences -> MCUXpresso IDE -> Quickstart Panel. The project associated with
the active debug session can be auto-selected in Project Explorer when adding, terminating or
removing a launch from Debug view. If a child resource of the project is already selected when
a launch event occurs, selection will not be changed.

Figure 3.10. Quickstart panel Preferences

3 preferences O X
type filter text Quick t Panel [eR 4 ~ 8

Maven ~
MCUXpresso Config Tools
~ MCUXpresso IDE

Debug Options
Default Tool settings [] Activate Project Explorer when a launch is added, removed or terminated in Debug view

[] Ask to browse web when importing examples
Enable Wizard template support

Project Explorer activation and auto-selection of a project

Editor Awareness [ Auto-select project when a launch is added in Debug view
Energy Measurement []Auto-select project when a launch is removed from Debug view
General [“] Auto-select project when a launch is terminated in Debug view
MCU settings
Paths and Directories
Quickstart Panel
RTOS TAD
SDK Handling
SWO Trace
User Interface Enablement
Utilities

Run/Debug

SWTChart Extensions

Terminal v Restore Defaults Apply
@ i e Apply and Close Cancel

3.7
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Project Explorer and New Projects
The version of Eclipse underlying MCUXpresso IDE incorporates some new Project Explorer

functionality that is seen only when there are no projects within the chosen
- as shown below:
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{5 Project Explorer 2 2. Peripherals+ iiif Registers Ay Faults — O

=

o

There are no projects in your workspace.
To add a project:

Bl Create a new MCUXpresso IDE C/C++ project.
Import examples from SDK.

[ Create a project... ]

£ Import projects...

Figure 3.11. Project Explorer Empty

The first two options here are directly equivalent to the first two operations offered via the
Quickstart panel. It is recommended that the Quickstart is used in preference to the remaining
options since this ensures that MCUXpresso IDE wizards and functionality is used.

Note: Due to this Eclipse feature, Drag and Drop functionality to the Project Explorer view is
unavailable until the first project is created or imported.

New or Imported Projects will appear in the Project Explorer view. A newly created project will
automatically expand to show the source file containing the main function. This source file will
also be opened into the editor for convenience as shown below.
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£ Project 22 Periph Regist FsFaults = O
B |- -
1[5
v 15 frdmk64f_bubble <Debug>
» @ Project Settings

[€ bubble.c 52

int main(void)

i tmwmmmmm!
217 = {e};

» gillincludes 2 fxos_data_t sensorData = {0}
» (2 CMSIS 2 fxos_config_t config = {|.5}_
- uint8_t sensorRange =0;
b 48 accel uints_t dataScale -0
» (B board int16_t xData =0;
» (2 component intl6_t yData =
» (2 device uint8_t i =
o A uint8_t array_addr_size = @;
» (D drivers status_t result = kStatus_Fail;

v (“ source
» <] bubble.c

> |c] semihost_hardfault.c

/* Board pin, clock, debug console init */
BOARD_InitPins();
BOARD_BootClockRUN() ;

» @Bsrc BOARD_I2C_ReleaseBus();

» (“startup 13 BOARD_I2C_ConfigurePins();
» B utilities 233 BOARD_InitDebugConsole();
» (= doc 2 /* T2C initialize x/

BOARD_Accel_I2C_Init();

238 /% Configure the I2C function */
config.I2C_SendFunc = BOARD_Accel_I2C_Send;
config.I2C_ReceiveFunc = BOARD_Accel_I2C_Receive;

array_addr_size = sizeof(g_accel_address) / sizeof(g_accel_address[0]);
{or (i=0; i < array_addr_size; i++)

config.slaveAddress = g_accel_address[i];

/% Initialize accelerometer sensor */

result = FXOS_Init{&fxosHandle, &config);

if (result == kStatus_Success)

{

break;

Figure 3.12. New or Imported Project

3.8 Updating MCUXpresso IDE

MCUXpresso IDE incorporates the facility to update an installation to add new features, updates
and/or to roll out bug fixes etc. To facilitate this mechanism, MCUXpresso IDE version internals
locate key components with Eclipse style plugins.

Tip

Locating low level components can be difficult due to both the complex directory
structure but also because component locations may change after an update is
performed. Therefore, to simplify the experience a number of softlinks are available
within the install_dir/ide as discussed in section below “Locating IDE Components”

By default, when an update is released by NXP, a notification of the availability will appear at
the bottom of the screen.

Updates Available X

Updates are available for your software.
Click to review and install updates.

You will be reminded in 4 Hours.
Set reminder preferences

Figure 3.13. Update Notification

Alternatively you can check for updates via Help -> Check for Updates. If updates are available
you will be presented with a dialogue similar to that below:

MCUXpresso IDE User Guide -
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Figure 3.14. Updating MCUXpresso IDE Components

@ [ ] Available Updates
Available Updates

Check the updates that you wish to install. I~
Name Version Id
gk GNU ARM PEMicro Interface Debugging Support 3.7.8.201810122006 com.pemicro.debug.gdbjtag.pne.feature fe...
@ lgkMCUXpresso IDE base functionality 10.3.0.201810111056 com.crt.|pcxpresso.feature.feature.group
kg MCUXpresso IDE Configuration Tools Integration 1.1.0.201810111248 com.nxp.swtools.mcuxpressoide.feature.fe...
gk MCUXpresso IDE LinkServer and Pre-installed part support 10.3.0.201810151121 com.nxp.mcuxpresso.tools.core feature.fea...
gk MCUXpresso IDE SDK handling 10.3.0.201810111544 com.nxp.mcuxpresso.core.datamodels.feat...
@ [§-MCUXpresso IDE Trace and Power 10.3.0.201810111148 com.nxp.mcuxpresso.trace.feature.feature....

Select All Deselect All
Details
(@) < Back [ Next> ] Cance!

3.8.1

MCUXpresso IDE User Guide -

Simply, ensure the required updates are checked and click Next. At this point the components will
be downloaded and installed into MCUXpresso IDE. After installation, a restart will be required
before new features are available.

Note: In addition to updates for MCUXpresso IDE, updates to the MCUXpresso Config tools and
PEMicro debug solution are also delivered using this mechanism.

Major product releases will only be delivered as full product installations since these are
typically based on newer versions of Eclipse

Locating IDE Components

MCUXpresso IDE consists of many components, some of which may be used independently
from the IDE. Also included are documents, examples, scripts, drivers etc. that may need to be
referenced from within the IDE.

Due to the structural changes introduced in MCUXpresso IDE version 10.3.0, the paths for certain
items may be both different from previous releases and may change after a product update (and
also be quite long). For example, the IDE bin folder will now be at a location of the form:

<install _dir>/ide//plugins/com nxp. ncuxpresso.tools.bin. nmacosx_11.1.0.201911211415/ bi nari es

Therefore, to simplify the location of certain folders, shortcuts (or symbolic links) are installed
into the ide directory within the product’s installation directory. These links can be used directly
to locate components or items, or within script paths.

Shortcuts are available for the following directories:

¢ bin -> install_dir/ide/bin

e Examples -> install_dir/ide/Examples
e Wizards -> install_dir/ide/Wizards

* tools -> install_dir/ide/tools

In practice, these links will allow paths to be used unchanged from earlier version of MCUXpresso
IDE, yet will always reference the latest plugin components.

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022 25



NXP Semiconductors MCUXpresso IDE User Guide

4. Part Support Overview (Preinstalled and via SDKSs)

To support a particular MCU (or family of MCUs) and any associated development boards, a
number of elements are required. These break down into:

e Startup code

» This code will handle specific features required by the MCU
e Memory Map knowledge

e The addresses and sizes and types of all memory regions
< Peripheral knowledge

 Detailed information allowing the MCUs peripherals registers to be viewed and edited
¢ Flash Drivers

» Routines to program the MCU’s on and off chip Flash devices as efficiently as possible
* Debug capabilities

« Knowledge of the MCU debug interfaces and features (e.g. SWO, ETB)
« Example Code (this is not strictly required or a part support element)

« Code to demonstrate the features of the particular MCU and supporting drivers

Collectively, this data is known as Part Support, MCUXpresso IDE uses these data elements for
populating its wizards and for built in intelligence features, such as the automatic generation of
linker scripts etc.

MCUXpresso IDE installs with a base set of part support primarily for older LPC Devices
(Preinstalled). Knowledge of later devices such as the LPC5xxxx, Kinetis, IMXRTxxx etc. must
be provided to the IDE via the

4.1 Preinstalled Part Support
The IDE installs with an enhanced version of the part support as provided with the older NXP
IDE LPCXpresso IDE v8.2.2. This provides support for the majority of LPC Cortex-M based parts
‘out of the box'. This is known as preinstalled part support. In general, SDKs are not available for
these older parts however, the LPC5410x and LPC5411x part families can be used with either
Preinstalled Part Support or SDK Part support.
Example code for these preinstalled parts is provided by sophisticated LPCOpen packages (and
Code Bundles). Each of these contains code libraries to support the MCU features, LPCXpresso
boards (and some other popular ones), plus a large number of code examples and drivers.
Version of these are installed by default at:
<install dir>/ide/ Exanpl es/ LPCOpen
<install dir>/ide/ Exanpl es/ CodeBundl es
Further information can be found at:
https://lwww.nxp.com/Ipcopen
https://www.nxp.com/LPC800-Code-Bundles
4.1.1 Differences in Preinstalled and SDK Part Handling
Since SDKs combine part (MCU) and board support into a single package, MCUXpresso IDE
is able to provide linkage between SDK installed MCUs and their related boards when creating
or importing projects.
For preinstalled parts, the board support libraries are provided within LPCOpen packages and
Code Bundles. It is the responsibility of the user to match an MCU with its related LPCOpen
board and chip library when creating or importing projects.
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4.1.2

Creating and importing project using Preinstalled and SDK part support is described in the
following chapters.

Note: When exporting or sharing projects with created with Preinstalled part support, no special

actions are required, since other installations of MCUXpresso IDE will also contain the required
part support. For sharing projects created from SDKs, please see

Viewing Preinstalled Part Support

When MCUXpresso IDE is installed, it will contain preinstalled part support for most LPC based
MCUs.

To explore the range of preinstalled MCUs simply click ‘New project’ in the Quickstart panel.
This will open a page similar to the image below:

SDK Wizard
@ Creating project for device: LPC 1549 with no board. ‘:;/‘.,'i f 2
. Board and/or Device selection page
~ SDKMCUs Available boards %1% &
MCUs frgm installed SDKs. Please select an available board for your project.
Please visit mcuxpresso.nxp.com to
obtain additional SDKs.
Target
LPCXpresso1549 LPCXpresso1347 LPCXpresso1343 LPCXpresso1227

NXP LPC1549
LPC1517
LPC1518
LPC1519
LPC1547
LPC1548
LPC1549

»LPC1700

#LPC177x_8x

»LPC18xx

»1PCANTY Ay

Target Core:
Description:

Figure 4.1. New

(’Fre‘tnstatled MCUs \ ! A
MCUs from preinstalled LPC and 1

generic Cortex-M part support

Selected Device: LPC1549 with no board. SDKs for selactd MCU

LPCXpresso1115

LPCXpresso11U14

cm0

Cortex-M3 based microcontroller, with USB and up to 256KB Flash
and 36K RAM

Name SDK Version Manifest Versio Location

Project Wizard

MCUXpresso IDE User Guide -

The list of preinstalled parts is presented on the bottom left of this window.

You will also see a range of related development boards indicating whether a matching LPCOpen
Library or Code Bundle is available.

For creating project with preinstalled part support please see:

If you intend to work on an MCU that is not available from the range of preinstalled parts, for

example a Kinetis MCU, then you must first extend the part support of MCUXpresso IDE by
installing the appropriate MCU SDK.
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4.2 SDK Part Support

The IDE’s Part Support can be extended using freely available MCUXpresso SDK v2.x packages.
SDK 2.x packages are used to add support for all Kinetis, iMX RT and newer LPC MCUs etc.

Starting with MCUXpresso IDE version 11.1.0 there is a streamlined approach to the supply
and installation of SDKs — these SDKs are known as Plugin SDKs. Plugin SDKs are pre-built
SDKs hosted on NXP’s servers that can be browsed, downloaded and installed directly from
within the IDE when required. See

Each SDK will install as an Eclipse plugin and so benefit from the standard Eclipse management
and update mechanisms. MCUXpresso IDE Plugin SDKs are available for a wide range of
NXP’s MCUs. Like all Eclipse plugins, once Plugin SDKs are installed, they become part of
the product itself. Management of a Plugin SDK can be performed using the

The previous Classic method of SDK installation and handling is still available. See

Once an SDK has been installed, the included part support becomes available through the
New Project Wizard and also the SDK example import Wizard, and for use by

4.2.1 Obtaining and Installing a Plugin SDK

SDKs are installed and managed via the Installed SDKs view, which is located by default as
the first tab within the Consoles view. See item 3 for more information.
Plugin SDK installation can also be started via the New Welcome system and via the Install New
MCUXpresso SDK icon on the main IDE icon bar.

Once launched a dialogue similar to that below will be displayed:

] ] ‘workspace_rios_part_4 - hitp:/fmcuxpresso nxp.oom - MCUXpresso IDE
o~ b resso s to install from https://mcuxpressonxp.com /eclipse/ sdk ‘
R o e Refresh
.

N )

Fater

Fide instalied () Show latest | Hide board images

_ W Flash DB): g

e * MaxFlash (KBY: | a006
SOK 2 FROM-KE.. 2.7.0 MEISZZBEVLLY 256 32
Mo RAV (K)o

“ MaxRAM (K8): | 4608

External Flash

o
Multicore

O ax cores. Cortex-MO+  Cortex-M33
Cortex-M4  Cartex-M7

W TERIR misedTLS
Micro CANopen Plus Microsoft Azure.

‘Motor Control Mator Control (ACIM)
Motor Control (BLDC) Matar Control (DC Brush)
Motor Contral (PMSM) Mator Control (Stepper)
wart e

SDK 2 FRDMAKL. 220 M2s2128VIKS 128 18 NTAG 12€ plus Over the Alr (OTA} Updates

SDK_2.x FROM-KE.

MKE1GZG4VLFA 64

SDK_Zx FROM-KL. 2.3.1 MKLOIZIZVFKS 32 2

SDK_Zx FRDM-KL_ 2.20 MKL26Z128VLKS 128 "
LEARN MORE >

NXe

PawerQuad Programmable Logic Uit (PLU)
PTPRIEEE-1588 PP for 2D Acceleration
SDK_2x FROM-KL.. 220 MKLISZ128VIKL 128 18 RPbivg Lite SCTimer

SDCand with FatFS 5010

Tamper Datect TensorFiow Lite
frdmki25z_p3115 SDK_2x FROM-KL_ 2.20 MKL267128VIKe 128 " 2
Trustod Firmware Example | TrustZone

usa USB Audic

'WiFi (Cypress) WiF| [QCA)
frmki26z SDK_2. FRDM-KL. 2.2.0 MKL26Z128VLHA 128 15 J WOHESL WolfSSL
| ER—— — e

T ssam ) O werkspace iz part &

Figure 4.2. Plugin SDK Installation

1. From this section the SDK for the desired Board (or Processor) can be selected for installation.
Column sorting is supported to help location and options for filtering the list are discussed
below
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« By default, SDKs that are already installed are hidden from this view
« If the Hide Installed is unchecked, installed SDKs will also be shown along with Status
indication for the SDKs already installed (shown as red circle)
2. A range of filtering options may be selected to reduce the list of displayed SDKs. These filters
allow the user to explore the capabilities of the MCUs and Boards.
3. Once an SDK has been selected it can be installed (with options)
 Install and Create Project will Download, Install and launch the New Project Wizard with
the chosen board selected
 Install and Import Example will Download, Install and launch the Import SDK Example
Wizard with the chosen board selected
« Install will Download and Install

Note: On rare occasions, it may be necessary to manually force a refresh of the cached contents
of the remote repository — and this can be performed via the button highlighted above.

Once an SDK (or SDKs) is selected and an install operation begun, you will be presented with
an option to accept the SDK license condition as below:

Figure 4.3. Plugin SDK Installation License

[ ] [ ] Install
Review Licenses I
Licenses must be reviewed and accepted before the software can be installed. S
—/

License text (for SDK_2.x_FROM-KB2F 2.6.0.201911251448):

LA_OPT_NXP_Software_License v9 August 2019

IMPORTANT. Read the following NXP Software License Agreement ("Agreement”) completely. By selecting the "I Accept” button at the end
of this page, or by downloading, installing, or using the Licensed Software, you indicate that you accept the terms of the Agreement and you
acknowledge that you have the authority, for yourself or on behalf of your company, to bind your company to these terms. You may then
download or install the file. In the event of a conflict between the terms of this Agreement and any license terms and conditions for NXP's
proprietary software embedded anywhere in the Licensed Software file, the terms of this Agreement shall control. If a separate license
agreement for the Licensed Software has been signed by you and NXP, then that agreement shall gavern your use of the Licensed Software
and shall supersede this Agreement.

NXP SOFTWARE LICENSE AGREEMENT

This is a legal agreement between your employer, of which you are an authorized representative, or, if you have no employer, you as an
individual ("you" or "Licensee"}, and NXP BV. ("NXP"). It concerns your rights to use the software provided to you in binary or source code
form and any accompanying written materials (the “Licensed Software"). The Licensed Software may include any updates or error
corrections or documentation relating to the Licensed Software provided to you by NXP under this Agreement. In consideration for NXP
allowing you to access the Licensed Software, you are agreeing to be bound by the terms of this Agreement. If you do not agree to all of the
terms of this Agreement, do not download or install the Licensed Software. if you change your mind later, stop using the Licensed Software

© 1 accept the terms of the license agreement
I do not accept the terms of the license agreement

@ Cancel ) LN

Download and install progress can be monitored via the Installation dialogue:

Figure 4.4, Plugin SDK Installation Progress

[ ] Installing Software

1 Operation in progress...

Fetching com.nxp.mcuxpresso.sdk.sdk_2.x_fr...0/plugins/ (2.69MB of 62.76MB at 1.32MB/s)

Always run in background

Cancel Details >>

MCUXpresso IDE User Guide -

If Run in Background is clicked, control is returned to the IDE, of course the SDK will not become
available until download and installation completes — at this time a Wizard may be launched if
a Create or Import option was chosen. While the Plugin SDK Installer may be restarted, any
existing SDK installations must complete before another Install can be started.

Note: When the IDE is started for the first time, data for this display is automatically loaded in
the background. If the Plugin SDK Installer is started promptly after the IDE starts, there may be
a short pause while the data populates.
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4.2.2

4.2.3

MCUXpresso IDE User Guide -

SDK Part Support via SDK Builder

NXP also provides SDKs for toolchains (including MCUXpresso IDE) via their SDK Builder site.
Through this site (login required), NXP MCU users may request builds for NXP MCUs that can
be configured to include a range of software features. Once built, the SDK can be downloaded
and installed into MCUXpresso IDE — this is the Classic method for installing SDKs as used in
all previous versions of MCUXpresso IDE. SDKs installed in this way are now referred to as
FileSystem SDKs since they become a shared resource for any IDE installation rather than part
of a particular IDE installation.

These SDKs can be installed via a simple ‘drag and drop’ mechanism or from the dedicated
dropdown menu in the Installed SDKs view, which will then automatically enhance the IDE with
new part and board knowledge (and usually a large range of examples).

SDKs for MCUXpresso IDE can be generated and downloaded as required using the SDK Builder
on the MCUXpresso Tools website at:

https://mcuxpresso.nxp.com/
Important Note: Only SDKs built specifically for MCUXpresso IDE are compatible with

MCUXpresso IDE. SDKs created for any other toolchain will not work! Therefore, when
generating an SDK be sure that MCUXpresso IDE is specified as the Toolchain.

Obtaining and Installing an SDK via SDK Builder

Users of earlier versions of the IDE may be more familiar with this model of SDK build and
installation.

SDKs are installed and managed via the Installed SDKs view, which is located by default as the
first tab within the Console view. See item 3 for more information.

SDKs are free to download (login is required); MCUXpresso IDE offers a link to the SDK portal
(shown below) from the Installed SDK Console view, which will open in an external browser.
From this portal, required SDKs can be downloaded onto the host machine. Alternatively, you
can open the portal by going to Help -> Additional Resources -> MCUXpresso SDK Builder.
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B8 workspace - MCUXpresso IDE - X
File Edit Navigate Search Project ConfigTools Run RTOS Analysis Window Help

(=i IBv &~ Biw| b [ER e kSBONLNE KB YOYAY O vH YOI YD v Q Bk
{& Project E.. % 4 Registers 4% Faults & Peripher... ~ © ~ B Zoutline # *Global Variables =

There is no active editor that provides an outline.
There are no projects in your workspace.
To add a project:

@ Create a new MCUXpresso IDE C/C++ project.
® Import examples from SDK

9 Create a project.

23 Import projects...

10 Installed SDKs £ |2 Properties [l Problems & Console & Terminal [ Image Info ®Debugger Console_ ~ = 0 Memory # - Heap and Stack Usage ==

-s Y O = PR

O Quickstart Panel & = Variables ° Breakpoints .
A @lnstalled SDKs Monitor

MCUXpresso IDE - Quickstart Panel
= No project selected To install an SDK, simply drag and drop an SDK (zip file/folder) or an SDK Git repository into the ‘Installed SDKs' viev

G Da D Re: Installed SDKs . Available Boards| Available Devices

® p Name SDK Version Manifest Version Location
New project.
® mport SDK example(s)...
® Import project(s) from file system...
~ Build your project
) v
< > < >
0 items selected O arbenars

Figure 4.5. SDK Import

Once downloaded, an SDK package(s) can be installed by simply dragging from the downloaded
location into the Installed SDKs view or by using the dedicated dropdown menu in the view. In
case the dragging method is used, once dropped, you will be prompted with a dialog asking you
to confirm the import — click OK. The SDK package(s) will then be automatically installed into
MCUXpresso IDE part support repository.

Once complete the “Installed SDKs” view will update to show you the package(s) that you have
just installed.

O Installed SDKs % [ Properties ! Problems B Console £ Terminal & Image Info & Debugger Console crv@e&|d=n

@ Installed SDKs

To install an SDK, simply drag and drop an SDK (zip file/folder) or an SDK Git repository into the 'Installed SDKs' view[[Common ‘mcuxpresso’ folder]]
Installed SDKs . Available Boards| Available Devices

Name SDK Version Manifest Version Location
8 SDK_2.x_EVKB-IMXRT1050 2.10.0 380 B \SDK_2_10_0_EVKB-IMXRT1050.zip
# SDK_2.x_FRDM-K32L28 [2.10.0 (494 2021-07-1 5}] 3.80 £ <Common>\SDK_2_10_0_FRDM-K3212B.zip
# SDK_2.x_FRDM-K64F 2.10.0 3.80 @ \SDK_2_10_0_FRDM-K64F
# SDK_2.x_LPCXpresso55569 2.9.0 3.80 N \SDK_2_9_0_LPCXpresso55569.zip

Figure 4.6. SDK Import View

By default, SDKs will install into a Common folder and will therefore be available to any
MCUXpresso IDE instance. Alternatively SDKs can be installed into the current Workspace so
making their installation local to that Workspace. The selected install location is shown in the
SDK Window text as highlighted above. Also highlighted is the new version information string
(displayed in grey), this feature allows different SDK builds to be distinguishable. Please also
see for further information on SDK installation options.
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SDK Notes:

e Released in parallel with MCUXpresso IDE version 11.6.0 are updated SDKs

(MCUXpressoSDK v2.12.x). These are indicated by their version 2.12.x and a manifest version
3.10.0 in the Installed SDK view. While older SDKs are still compatible with the newest
MCUXpresso IDE version, it is recommended that users check and update to the latest
available SDK package.

« Installed SDK view tooltips display comprehensive version information

MCUXpresso IDE can import an SDK as a zipped package or unzipped folder (or zipped
Plugin). Typically importing as a zipped package is expected.

e The main consequence of leaving SDKs zipped is that you will not be able to create (or
import projects) into a workspace with linked references back to the SDK source files.

When an SDK is imported via drag and drop, required files are copied and the original file/folder
is unaffected. The copied files are installed into a default location allowing imported SDKs to be
shared among different IDE instances/installations and workspaces. Data from imported SDKs
is populate wizards with available MCU and board information. In addition they are parsed to
generate part support and make example projects and drivers available etc.

« By default, SDKs (like workspaces) are located in user local storage, this means they will
only be available to the user who performed the installation. Please also see
for details of how a shared location could be used if needed.

Once installed the part support provided by the SDKs is regenerated. This regeneration is
required because an MCUs part support may be specified (with different versions) within more
than one SDK. On rare occasions, it may be necessary to force a regeneration of SDK part
support, this can be done by clicking the Recreate and Reload button within the top right block
inside the Installed SDK view, or by right clicking within the view and selecting Recreate.

4.2.4 Installing SDKs by Importing a Remote SDK Git Repository

NXP also provides SDKs via its MCU SDK Git repository. These SDKs can be installed
automatically using the wizard from Installed SDKs view.

o %2 [ Properties [%]] Problems [l Console @ Terminal ==
c-@on|@d
[ Installed SDKs Import archive...

To install an 50K, simply drag and drop an 5DK (zip file/folder) or an SDK Git repos

Mame

Import folder...
Import local SDE Git repository...

Available Boards | Available Devices z :
Import remote SDK Git repository...

SDK Version MManifest Version Location

Figure 4.7. Import Remote SDK Git Repository
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After selecting Import Remote SDK Git Repository... from the menu, the following window will
be opened:
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. Import Remote SDK Git

Import remote SDK Git repository

Location

Git

Ch\Repository

Remote Git information

Local folder where the files will be saved. Folder should be empty.

Repository

Revision

https://github.com/NXPmicro/mcux-sdk

main

@

K Cancel

Figure 4.8. Import Remote SDK Git Repository Wizard

You'll have to select an empty folder where the SDK Git repository will be cloned. Revision can
be “main” if you want the latest state, or any commit SHA.

After clicking OK a window showing operation’s progress will be opened.

MCUXpresso IDE User Guide -

All information provided in this document is subject to legal disclaimers

© 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022

33




NXP Semiconductors MCUXpresso IDE User Guide

B8 Getting remote SDK Git repository O x

@ Performing 'west' update

updating mecux-sdk-examples (examples)

[ Jiabways run in background:

Run in Background Cancel Details = =»

Figure 4.9. Import Progress

Please note that, depending on your Internet connection’s speed, the operation may take a few
minutes to complete. After this, the SDKs will be automatically imported and shown in the Installed
SDKs view.

{0 Instalied SOs &7 [T] Properties [&] Problems [ Console 8 Terminal 3 Image Info [} Debugger Console 2, Offfine Peripherals c-Pe&|0=n0
O Installed SDKs

To install an DK, simply deag and drop an 50K (zip filefolder) or an SDK Git repository into the “Installed $DKs' view. [Common ‘mouspresso’ folder]
Installed SDKx . Svailable Boards | Avadshle Devices

Name SDK Version Manifest Version Lecation o
w [ 88 SDK Gat Repositony 2800 - 2100 380 (= C\Repository
8 S0K_2x_EVK-MCIMXTULP 2100 180 (B < S0K G4 Repooiton \examplesimendests) EVK- MCIMXTULP_manifest
8 S0K_2x_EVEK-MIMGEMM 2100 180 - - st Rl \examples\manifests EVE-MIMCEMM_manifest_v:
Ejr SDE_2u_EVE-MINXERN 2100 380 = - tory > \examples maniests) EVE-MIMICEMM_manifest_v:
B & S0E_2x_EVE-MIMAOEEMNDDRIL 2100 380 o= - by = ex arnplesh ranidestsh EVE-MIBCEMMDDRIL rnand
B & SDE_Lx_EVE-MINXEMP 2100 380 L] tony = e arnples rmpnidests) EVE-MIMXEMP_mandest vi
B 8 SOE_2x_EVK-MIMXEMG 2100 380 O « tory >\ exarmplesimenidests EVE-MIMXEMO manifest_v:
8 50K _2x_EVE-MIMXRTI00 2100 380 - - ory+ \exarnples\ manifests) EVE-MIMXRT1010_manifest
8 50K _2x_EVK-MIMXETI0NS 2100 180 = - tomy > \examples\ manifests\ EVE- MIMUXATI0N 5_manifest_
B & SDK_22_EVE-MIMXET1020 2100 380 &= - tony = ex armplesh manifestsh EVEK-MIMXORT1020_manifest_
] 8 SOE_2o EVE-MINNRTI06 2100 380 & = v \exarnples\ rnpnifests) EVK - MIBMRT1 060_rmamnifest_
B 8 SOE_2x_EVK-MIMXRT1064 2100 380 = « ooy ex arnphes’ rnsndests\ EVE- MIBUCRT 064_manifest_
B & SDK_2x_EVE-MIMXRTSS 2100 380 ] ey = \exarnphes' manidests) EVE-MIBMICRTSSS mandest v
B 8 S0K_2x_EVEK-MIMXRTESS 2100 380 - - ory* \examples\manifests) EVE-MIMXRTEES_manifest_v
B # SDE_2x_EVKE-IMXETI050 2.100 380 = - ry’ \exarmplest manifests) EVKB-IMXRTI0E_manifest_u
B & SOK_2x_FRDM-KZZF 2100 380 o= tony = \exarmples\ rmanifests FROM-K22F_manifest_v3 8.«
] & SDE_2x_FROM-K2ERA 250 380 o « v \exarnplesirnanifests\ FROM-K2BFA_manifest w3 8
B 8 SDE_2x_FROM-KIZL2A4S 2100 380 o oy =exarnples ranifests) FROM-KI2L2ALS_manifest v
B #8 S0k _2x_FROM-K32L2E8 2100 380 & ary\exarnplesi mendests FROM-K32L2E_mandfest v
[ 88 50K_2x_FROM-K32L385 2100 380 - - ory* \examples\manifests\ FROM-K32L148_manifest w3
] & SDK_Zx_FROM-K6SF 2100 130 = < v+ \exarmples\ranifests) FRDM-K64F_manifest v3_8x w

Figure 4.10. Installed SDK Git Repository

Important Note: You need to have both Git and West installed in order to use this wizard. If
West is not installed or not found in the PATH environment variable, IDE will display the following
warning:
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‘ ‘west' tool not found g

. Please install 'west' before importing a remote SDK Git repository. Details can be
_l”i found here. Also, please include the path to 'west' in the PATH envircnment variable

and restart MCUXpresso IDE.

oK

Figure 4.11. Import Remote Warning

On MacOS one way to add West to Path environment variable is to use “launchctl” command.
Usage:

sudo | aunchct!| config user path $PATH: { Wst absol ute path}

4.2.5 Installing SDKs by Importing a Local Clone of an SDK Git Repository

If you used command line to obtain a local copy of the remote SDK Git repository, you can import
it using Import Local SDK Git Repository... menu form Installed SDKs view.

[ Installed SDKs 22 [ Properties [2] Problems [ Console & Terminal .D';,Ia @ &|B=0

Import archive...

I Installed SDKs

Import folder...
To install an SDK, simply drag and drop an SDK (zip file/folder) or an SDK Git repository I Import local SDK Git repository
Installed SDKs . Available Boards | Available Devices Import remote SDK Git repository,
Name SDK Version Manifest Version Location

Figure 4.12. Import Local SDK Git Repository

4.2.6 Installed SDKs Operations

The installed SDKs view now incorporated 3 tabs. In addition to the Installed SDKs tab, new
Available Boards and Available Devices tabs are provided. These tabs expose the supported
boards and devices provided by the installed SDKs and allow the direct invocation of New Project

and Example Import Wizards:

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide Rev. 11.6.0 — 19 December, 2022 35




NXP Semiconductors MCUXpresso IDE User Guide

I Installed SDKs 5% | [C] Properties . Problems & Console )'J Terminal ,;; Image Info E Debugger Console

0 Installed SDKs

ssallesirbblmrin e sl i whafolder) into the Installed SDKs' view. [Common 'mcuxpresso’ folder]
istalled SDKS [ Available Boards . Available Devices|

| type to filter MCU selection

Board Device

5 HTIRRTRRES MIMXRT1062DVLE6A
Create a New Project...
""" 1 Import Bxamples...
o EVK-MIMXRT1060-AGMO1 MIMXRT1062DVLEA

Figure 4.13. SDK Tabbed Views

Various other operations are available from the Installed SDK view some from a right click menu
options:

& Import archive...
< Import folder...

i,

Import local SDK Git repository...
Import remote SDK Git repository...

B ¢

& Copy SDK
T Paste SDK
= Open Default Location
[L-U] SDK Documentation > ]
i SDK Info >

~ Open Location
& Unzip archive
¥ Uninstall SDK

24 Recreate

Important Note: Plugin SDKs cannot be unzipped or deleted from this view, however they can
be converted to Do not attempt to manually modify a Plugin SDK in
any way, doing so could lead to a loss of SDK part support from the IDE. Plugin SDKs can only
be deleted using the

From here you can perform many actions such as view associated embedded SDK
documentation that would otherwise require the unzipping and exploration of the SDK structure.

The Installed SDKs view will show whether the SDKs are stored as zipped archives or regular
folders. MCUXpresso IDE offers the option to unzip a filesystem SDK archives in place via a right
click option onto the selected SDK (as below).

< Import archive...
< Import folder...

i,

Import local SDK Git repository...
Import remote SDK Git repository...
Copy SDK

Paste SDK

Open Default Location

e

y

F
=

SDK Documentation >

SDK Info >
= _Open Location

[.@ Unzip archive ]
% Uninstall SDK

-8 0

“4 Recreate
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Note: Unzipping an SDK may take some time and is generally not needed unless you wish to
make use of referenced files or perform many example imports (where some speed improvement
will be seen).

Once an SDK has been unzipped, its icon will be updated to reflect that it is now stored internally
as a folder.

@ Installed SDKs % [ Properties [£! Problems B Console & Terminal & Image Info & Debugger Console

cv@on M= n0

o Installed SDKs

To install an SDK, simply drag and drop an SDK (zip file/folder) or an SDK Git repository into the ‘Installed SDKs' view. [Commen 'mcuxpresso’ folder]

Installed SDKs

Available Boards| Available Devices

Name SDK Version Manifest Version Location
# SDK_2.x_EVKB-IMXRT1050 2.10.0 3.8.0 B \SDK_2_10_0_EVKB-IMXRT1050.zip
# SDK_2.x FRDM-K32L2B 2.10.0 380 L \SDK_2_10_0_FRDM-K32L2B.zip
# SDK_2.x_FRDM-K64F 2.10.0 (494 2021-07-15) 3.8.0 ommon>\SDK_2_10_0_FRDM—K64F
# SDK_2.x_LPCXpresso55569 2.9.0 3.8.0 £ \SDK_2_9_0_LPCXpresso55569.zip

Figure 4.14. SDK Unzipped
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Many other options are available such as examining SDK XML description files, Copying and
Pasting SDKs and managing the library of installed SDKs.

Tip

@ To edit (and save) SDK XML files, the SDK must first be unzipped and the following
preference changed: Preferences -> MCUXpresso IDE -> SDK Handling -> Misc,
uncheck the read only mode option. Once saved, changes will become permanent
for that SDK installation.

Tip
@ In addition to the other SDK options, an SDK can be pasted into the Installed SDK
view from the file system or another IDE instance.

Finally, SDK part support automatically regenerates when a new SDK is installed. If a project is
imported and the expected part support is not available then select Recreate from the right click
menu option to force a recreation of the SDK part support.

Converting a Plugin SDK into a FileSystem SDK

On occasion it may be useful to migrate a Plugin SDK to become a FileSystem SDK — for example
if you require the SDK to be unzipped or to be shared with other IDE installations. To do this
simply select the Plugin SDK within the Installed SDK view then from the right click menu select
Copy followed by Paste. This will launch an Import operation and copy the SDK contents from
the Plugin into the default SDK FileSystem location. This SDK will be used in preference to the
Plugin version.

Note: A Plugin SDK is a part of an IDE installation and can only be deleted via the

Uninstalling (Deleting) an Installed SDK
Plugin SDKs become part of the IDE and so cannot simply be deleted. If for any reason it is

necessary to remove a Plugin SDK then this must be done via the Eclipse plugin management
mechanism. This can be launched via Help -> About -> Installation Details:
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[ ] MCUXpresso IDE Installation Details

MName

g GNU ARM PEMlicro Interface Debugging Support
4k Libhover for Newlib Feature
gk Library Hover help for devhelp documentation
» (L MCUXpresso IDE
[§-MCUXpresso IDE add-ons
{J-MCUXpresso IDE add-ons - GNU LD Editor
» L MCUXpresso |DE additional plugins
- MCUXpresso |IDE base functionality
4k MCUXpresso IDE Build Tools
» Lg MCUXpresso IDE Configuration Tools Integration
4k MCUXpresso IDE Documentation
g MCUXpresso IDE FreeRTOS Task Aware Debug
- MCUXpresso IDE LinkServer and Pre-installed part support

4k MCUXpresso IDE Pre-installed part support wizards and exa...

[§- MCUXpresso IDE SDK handling
kMCUXpresso IDE Third-party debug solution support

ware | Installation History | Features | Plug-ins _Conﬂguration:

Version

4.4.1.201911122108 com.pemicro.debug.gdbjtag.pne.feature.fe...
7.4.0.201909110158 org.eclipse.linuxtools.cdt.libhover.newlib.fe...
7.4.0.201909110158 org.eclipse.linuxtools.cdt.libhover.devhelp.f...
11.1.0.201911181...
11.1.0.2019111561...
11.1.0.201811011...
11.1.0.201909161...
11.1.0.201911151...
11.1.0.201909161...

11.1.0.201911181

Id

MCUXpressolDE

com.nxp.mcuxpresso.addons.feature.featur...
com.nxp.mcuxpresso.addons.gnuscript.edi...
com.cri.lpcxpresso.feature.product.feature....

com.cri.lpcxpresso.feature.feature.group

com.nxp.mcuxpresso.tools.feature.feature....
1.1.0.201911142217 com.nxp.swtools.mcuxpressoide.feature.fe...
11.1.0.201909161...
11.1.0.201909161...
11.1.0.201911181...
11.1.0.201909161...
11.1.0.201811181...
11.1.0.201811061...

com.crt.documentation.feature.group

com.nxp.mcuxpresso.freertos.gdb.tad feat...
com.nxp.mcuxpresso.tools.core.feature.fea...
com.nxp.mcuxpresso.tools.lpc.feature.feat...
com.nxp.mcuxpresso.core.datamodels.feat...
com.nxp.mcuxpresso.thirdparty.feature.feat...

com

(- SDK_2.x_EVK-MIMXRT1060
I-E:l SDK_2.x_FRDM-KG4F

Provider

P&E Microcomputer Systems

Eclipse Linux Tools
Eclipse Linux Tools

NXP Semiconductors
NXP Semiconductors

NXP Semiconductors BY
NXP Semiconductors BV

NXP Semiconductors

NXP Semiconductors, N.V.
NXP Semiconductors BV

NXP Semiconductors
NXP Semiconductors
NXP Semiconductors
NXP Semiconductors
NXP Semiconductors

2.6.0.201911101507 com.nxp.mcuxpresso.sdk.sdk_2.x_evk-mim.. NXP Semiconductors
2.6.0.201911101507 com.nxp.mcuxpresso.sdk.sdk_2.x_frdm-k6... NXP Semiconductors

)

Update...

Figure 4.15. Plugin SDK Delete

Note: A FileSystem SDK will always be used in preferences to a Plugin SDK, so a Plugin SDK
can effectively be replaced by the installation of a FileSystem SDK offering equivalent features.

If an SDK has been installed by the ‘Drag and Drop’ method, then a copy of the SDK will have
been installed into the Default Location. SDKSs installed into this location can be uninstalled and
deleted via a right click option. Once an SDK has been uninstalled, part support will automatically
be recreated for the remaining SDKs. Please see for more
information.

Alongside each installed SDK is a check box, if this is unchecked the SDK will be hidden
from MCUXpresso IDE until re-checked. If multiple SDKs are installed that contain shared part
support, then this feature may be useful to force the selection of part support from a particular
SDK. Please see for more information.

SDKs installed into non default file system locations must be manually deleted or hidden if they
are no longer required. Note: you may have to quit MCUXpresso IDE to delete these SDKs.
Please see for more information.

SDKs installed from a Git repository can only be uninstalled by deleting the entire repository from
the Installed SDKs view.

4.2.7 Installed SDKs Features

You can explore each of the SDKs within the Installed SDKs View to examine content such as
Components, Memory Settings, included Examples etc.
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— '™ : = : = T o=
@ install ¢ [ Propert [l Proble = Progres § ™ Outine 2t L =R B
SDK Details
Selected SDK content: SDK_2.x_EVK-MIMXRT 1060
@ Installed SDKs
C. Boards )
To install an SDK, simply drag and dmp an SDK (zip fil e,ffnl vEVK-MIMXRT 1080 1.0.0
mﬁvallab}e Boards | Available Dewcﬂ » %5 Debug Configurations
Name SDK Version » =F Examples
v illi Memory Settings
__L_ 5[);( 2 X FRDM K32L2B 9, 5 0 1 BOARD_FLASH 0x60000000 0x80C
11 SDK_2.x_LPC55569 2.6.2 1| BOARD_SDRAM 0x80000000 0x20C
£ SDK_2.x_EVK-MIMXRT1020 26.0 X | » EVK-MIMXRT 1060-AGMO1 1.0.0
1 SDK_2.x_EVKB-IMXRT1050  2.6.0 { | ¥ ©Devices
i SDK_2.x_FROM-K64F 26.0 1| > emmxrTI062 100
4 SDK_2.x_board_FROM-K32L2A:2.6.0 ¥ s Compilers
gee
‘1 v i Toolchains
»MCUXpresso_IDE 11.0.0
v (2 Toolchain Settings
P MCUXPresso 11.0.0
v
4} Components o y
Figure 4.16. SDK Explore

4.2.8 Advanced Use: SDK Importing and Configuration

SDK importing via drag and drop incorporates two features. Firstly the location where the SDK
will be copied, and secondly the automatic scanning of this location to create the required
Part Support. The behaviour can be explored and changed via a preference Preferences ->
MCUXpresso IDE -> SDK Handling -> Installation leading to the window below:
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Installation O v v
[ e
A (Ciecneral Manage SDK usage within MCUXpresso IDE
- Ht | S5 SDK locations
e
» InstZIUUpdat& SDK Drag&Drop install location
» Java Workspace e Common ‘mcuxpresso’ folder User defined folder

» Library Hover
MCUXpresso Config Tools
¥MCUXpresso IDE
» Debug Options

User defined folder

SDK search roots:

g l {Users/nxp/mcuxpresso/02SDKPackages l New.
De_faUIt Tool settings 'sers/nxp/mcuxpresso ackages
> Editor Awareness [Users/nxp/mcuxpresso/SDKPackages
FreeRTOS TAD
General
MCU settings
Paths and Directories
Quickstart Panel
¥SDK Handling
Components SDK refresh policy on startup
[nétallatlon Refresh and recreate part info
Misc
SWO Trace Other options
User Interface Enablement Always unzip SDK zipped files when installing
Utilities +| Do not ask for unzipping SDK on import
»Run/Debug
» Team Do not ask for confirmation on SDK Drag and Drop install
¥ Terminal Make missing SDK reference persistent
Validation Do not ask user action for missing SDK reference in project
= XML
Enable SDK/manifest versions switch (needs an IDE restart)
Automatically delete wrong/incompatible SDKs
Restore Defaults Apply

Cancel Apply and Close

Figure 4.17. SDK Installation Preferences

You can see in the above graphic that two search locations are present. The 02 path is the
default search path for MCUXpresso IDE version 11.0, earlier versions of MCUXpresso IDE
used the 01 path. This older path will only appear if the location actually contains installed SDKs
(typically installed via an earlier version of MCUXpresso IDE). The reason for these separate
paths is to allow users to have both the latest and older versions of MCUXpresso IDE installed
without presenting incompatible versions of SDK to older versions of the tools. Please see

for more information.

« Workspace
e Common (the default)
e User Defined

The default Common install location can be changed to either the currently selected Workspace
or a User Defined location. Once this is done, a new SDK Search Root path will automatically
be added to the search roots list.

Note: while other search roots can be removed if desired, the currently selected drag and drop
location root cannot.

In addition, from this dialogue you can add new search paths to folders where you have stored
or plan to store SDK folders/zips. Those SDKs will appear in the Installed SDKs View along with
those from the default location when the Installed SDK view is refreshed.

The main differences between having SDKs in the default location(s) or leaving them in other
folders are:
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“Delete SDK” function is disabled when using non-default locations
 since these SDKs are not imported, they may be original files
The knowledge of the SDKs and their part support is per-workspace

The order of the SDKs in the SDK location list may be important on occasion: if you have multiple
SDKs for the same part in various locations, you can choose which to load by reordering. If
multiple SDK are found, a warning is displayed into the Installed SDK view.

Note: Only the default SDK location(s) is persistent between workspaces. Any other locations
must be created for each Workspace as required.

Also displayed in the dialogue (above) are a number of ‘checkbox’ options that are discussed
below:

Always Unzip SDK ... if checked, a zipped SDK will be unzipped on import.

Do not ask for unzipping ... if checked (default) the IDE will not prompt the user to consider
unzipping the SDK.

Do not ask for confirmation ... if checked, the IDE will import and SDK via drag and drop without
requesting user confirmation.

Make missing SDK reference persistent ... this setting controls the persistence setting when
the option below is checked.

Do not ask for User action ... see - if checked, this SDK association
setting will be made without prompting the user.

Enable SDK/manifest version... if multiple SDKs for the same part are installed, this option if
checked also allows an older SDK to be selected from within the Installed SDK view via a drop
down menu on the SDK Version

« also, some SDKs include older versions of the manifest (XML description) ... if checked, this
option allow an older manifest version to be selected from within the Installed SDK view via
a drop down menu on the Manifest Version.

Automatically uninstall ... if checked an SDK found in drag and drop install location that is
incompatible with MCUXpresso IDE will be deleted.

Advanced Use: SDK Misc Options

Additional miscellaneous SDK preferences are also available. These checkbox options are
shown below:
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[ ereferences m] X
type filter text Misc =34 - §
¥ MCUXpresso IDE ™ | sDK management misc options

~ Debug Options

Prioritize IDE supplied flash driver

J-Link Options ) ]
+ LinkServer Options [[] Default SDK debug console to semihost on project creationfimport
Advanced Include semihost hardfault handler by default on project creation/import
DFU Options [ Enable SDK options check

Selected files from SDK View open in read-only mode
[l 0pen project main files after importing multiple SDK examples
[ Enable "SDKs for selected MCU" selection in SDK Import Wizard

Miscellaneous
PEMicro Options
Probe Discovery
Default Tool settings
Editor Awareness
Energy Measurement
General
MCU settings
Paths and Directories
Quickstart Panel
RTOS TAD
~ SDK Handling
Components
Installation
Misc
SWO Trace
User Interface Enablement
Utilities
Run/Debug
SWTChart

Terminal . Restore Defaults Apply

Apply and Close

Validation

Cancel

Figure 4.18. SDK Preferences Misc

4.2.10

MCUXpresso IDE User Guide -

Where:

Prioritize IDE supplied flash drivers ... typically LinkServer flash drivers are supplied as part
of the SDK part support for a particular MCU. However these LinkServer flash drivers are
usually duplicated within the IDE installation where newer versions might be found. This option,
checked by default causes the IDE supplied drivers to be used in preference to SDK supplied
flash drivers. Searching the IDE’s flash driver directory in preference to SDK dynamically part
support files also simplifies flash driver development

Default SDK debug console to semihost ... this option, checked by default, sets project defines
to select semihosting as the output format

Include semihost hardfault handler ... this option, checked by default, causes a minimal
hardfault handler to be included within new and imported projects. The purpose of this handler
is to send semihost operations to null when no debug tools are connected. Without such a
handler, any semihosted operation will halt the MCU when no debug tools are connected. This
is probably the most useful option for early project development, however this may clash with
any real hardfault handler.

Enable SDK options check ... this option, checked by default, allows the IDE to check an SDK
examples options on import and attempt to resolve any incompatible options found.

Selected files from SDK view ... this option, checked by default, forces any file opened from
the Installed SDK view to be opened in Read Only mode. This is to protect SDK files from
accidental corruption. Note: this option only applies to SDK that are imported unzipped.

Open Project main files ... when an example project is imported it will be opened within the
project explorer view and the source file containing the main function will be opened. This
option, unchecked by default, will allow this to occur if multiple files are imported at the same
time.

Important notes for SDK Users

Installing an SDK into MCUXpresso IDE adds to its default capabilities, but SDKs come in many
different configurations, and versions. The section below discusses some of the issues that users
may experience when working with SDKs.
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Only SDKs created for MCUXpresso IDE can be used

If an error of the form MCUXpresso IDE was unable to load one or more SDKs is seen, the most
likely reason is that the SDK was not built for MCUXpresso IDE. Within the SDK Builder, verify
that the Toolchain is set to MCUXpresso IDE. If necessary, reset the toolchain to MCUXpresso
IDE and rebuild the SDK.

SDK compatibility with earlier versions of MCUXpresso IDE

A new SDK version 2.12.0 has been released in parallel with MCUXpresso IDE version 11.6.0.
However, this SDK format includes features that are not compatible with earlier versions of
MCUXpresso IDE. As a result, these new SDKs may fail to install or offer reduced features when
used in older versions of MCUXpresso IDE.

To support users who might have both this and also older versions of MCUXpresso IDE installed
on their system, we have adopted a new default SDK installation location but also maintained
support for the default used by older versions (now effectively Read Only from version 10.1.0
onwards).

The result of this is that MCUXpresso IDE version 10.1.0 and later will automatically inherit any
SDKs installed into the (old) default location by previous versions of the IDE. While older versions
of the IDE will not ‘see’ any SDKs installed with MCUXpresso IDE version 10.1.0 or later.

Note: If there is no need to maintain compatibility with older versions of the IDE, it is
recommended that users migrate to using the latest SDKs where available.

Shared Part Support Handling

Each SDK package will contain part support for one or more MCUSs, therefore it is possible
to have two (or more) SDK packages containing the same part support. For example, a user
might request a Tower K64 SDK and later a Freedom K64 SDK that both target the same
MK64FN1MOxxx12 MCU. If both SDKs are installed into the IDE, both sets of examples and
board drivers will be available, but the IDE will select the most up to date version of part support
specified within these SDKs. This means the various wizards and dialogues will only ever present
a single instance of an MCU, but may offer a variety of compatible boards and examples. Note: If
a board is selected (from one SDK) and part support is provided by another SDK, a message will
be displayed within the project wizard to show this has occurred but no user action is required.

If two SDKs with matching part support are installed, and the SDK providing part support later
deleted, then part support will automatically be used from the remaining SDK.

Finally, if a project created with one SDKs part support — for example Freedom K64, and then:
- that SDK is changed to another SDK with compatible part support — for example TWR K64 -
the project is shared with another user who has a different SDK that includes compatible part
support (perhaps an SDK that has only device support).

A dialogue similar to the one below will be generated for each project where this occurs:

[ ] Project SDK management
! The project '"MKE4FN1MOxxx12_My Shared_Project’ SDK 'SDK_2.x_FRDM-KB4F' cannot be
found.

Please select a compatible SDK for chip '"MKG64FN1TMOxxx12' to use:

SDK_2.x_TWR-KB4F120M [2.4.0] | T ] Make SDK persistent

Cancel | |CLIN
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Where the option to Make persistent will permanently change the project to be associated with
the selected SDK. If unticked, the IDE will accept the change as temporary and no data will be
written back to the project.

Note: When this new association is made, the project will contain files from one SDK but be
associated with another. If the project is refreshed or the component management feature is
used, then incompatible code may be copied into the project.

Building a Fat SDK

An SDK can be generated for a selected part (processor type/MCU) or a board. If just a part is
selected, then the generated SDK will contain both part support and also board support data for
the closest matching development board.

Therefore, to obtain an SDK with both Freedom and Tower board support for say the Kinetis
MK®64... part, simply select the part and the board support will be added automatically.

If a partis chosen that has no directly matching board, say the Kinetis MK63... then the generated
SDK will contain:

e part support for the requested part i.e. MK63...

¢ part support for the recommended closest matching part that has an associated development
board i.e. MK64...

« board support packages for the above part i.e. Freedom and/or Tower MK64...
Uninstallation Considerations

MCUXpresso IDE allows SDKs to be installed and uninstalled as required (although for most
users there is little benefit in uninstalling an SDK). However, since the SDK provides part support
to the IDE, if an SDK is uninstalled, part support will also be removed. Any existing project built
using part support from an uninstalled SDK will no longer build or debug. Such a situation can
be remedied by re-installing the missing SDK. Note: if there is another SDK installed capable of
providing the ‘missing’ part support, then this will automatically be used.

Sharing Projects
Note: Also see below:

If a project built using part support from an SDK and is then exported — for example to share the
project with a colleague who also uses MCUXpresso IDE, then the colleague must also install
an SDK providing part support for the projects MCU.

Enhanced Project Sharing Features

MCUXpresso IDE has a range of features designed to improve the ease of project sharing. These
features combine to streamline the sharing and collaboration process.

Project Drag and Drop

In addition to the existing project import and export capabilities available from the Quickstart
panel, a new set of features has been introduced to ease the transfer of projects.

Previously, the import of a project required browsing to a project location followed by an import.
Now ...

* Projects can now be imported into a Workspace by simply dragging and dropping a folder (or
zip) containing one or more projects into the Project Explorer view

¢ Projects can be copied from one IDE instance to another by simply dragging and dropping
from one Project Explorer view to another
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Eclipse also offers the following functionality:

* Projects can also be exported by dragging from the Project Explorer view onto a host filer

* Warning: Care must be used here since the default Eclipse behaviour when dragging is
to move files from the workspace rather than performing a copy. This behaviour can be
modified to copy on Mac via holding the Option Key, and on Windows via holding Ctrl. Note
that if the underlying files of a project are moved, the project will remain visible within the
project explorer view but will no longer be usable. A project explorer refresh (F5) should be
performed.

Tip

@ If a project is moved accidentally (as described above), it can be re-imported by
dragging back from the filer location into to the project explorer view (the original
project must be removed first otherwise a clash of names will prevent import).

Project Local SDK Part Support

One weakness of the SDK model of extending the capabilities of the IDE comes when sharing
projects with colleagues — since they must also have the same SDK installed to use this shared
project.

To avoid this problem, SDK projects (and examples) can be modified to contain a local copy of
the required SDK part support.

SDK project may be enhanced to contain local SDK part support

« SDK based projects can now import a cache of part knowledge from an installed SDK
« Simply right click on a project and select add SDK Part Support
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Close Project
Close Unrelated Projects

Build Configurations
Build Targets
Index

Validate

Run As

Debug As

Profile As

Restore from Local History...
Launch Configurations
Smart update

v & MK64FN 1MOxxx12_My Shared_Project
» & Project Settings 4 |
> ﬁ' Binaries New »
» il Includes Go Into
» B CMSIS 3 ‘Open In New Window
» 2 board ‘Show in Local Terminal
» (B drivers S
» (2 source - E‘%
& st?!‘t'up X Delete =
> (2 utilities S >
» (= Debug Move...
» (=doc Rename... F2
P i Import...
=5 Export...
Build Project
Clean Project
“ | Refresh F5

yrvy

¥ =5 MKB4FN TMOx00c1 2_My Shared_Project
¥ =i Project Part Support
¥ o SDK version 2.4.0 package for FRDM-K84F board
» il Boards
¥ lus Compilers
» 441 Components
» £ Devices
» (5 Toolchain Settings
» & Toolchains
» € Project Settings
» ¥ Binaries
» il Includes
» (2 CMSIS
» (B board
» ([Bdrivers
» (& source
» (2 startup
» (Z utilities
» (= Debug
» (= doc

SDK Management
Tools

B Mcuxp

 dacia Al

resso Config Tools

YYRAY YY

Team
Compare With
Configure
Source

Properties

Figure 4.19. Add SDK Local Part Support

YYvYYE

f# Manage SDK Components
“, Refresh SDK Components
™. Add SDK Part Support

¢ Such projects can then be used (in other user's MCUXpresso IDEs version 10.2.0 or later)
without first downloading and installing the appropriate SDK

* In such cases, the project local part support will be visible as an installed SDK

(9 Installed SDKs 2 [T Properties & Console [£] Problems [J Memory &3 Debugger Console € Instruction Trace B3 Power Measurement Tool [ SWO Tra

@ Installed SDKs

To install an SDK, simply drag and drop an SDK (zip file/folder) into the ‘Installed SDKs' view. [Common ‘mcuxpresso’ folder]

Name SDK Version Manifest Version Location
5 SDK_2.x_EVK-MIMXRT1020 2.4.0 3.3.0 [1:} /SDK_2.4_EVK-MIMXRT1020.zip
g 2 x EVKER-IMYXRTI1080 240 240 i) i = 2 i
(= SDK_2.x_FRDM-K64F 242 1) 33.0 (® < Workspace> [MKB4FN1MOxxx12_Project_My_Shared_Project I
ﬁ T X FROM-RETSZ T T30 T TSDR_2.8_ TROM-RET5Z.zip
2 SDK_2.x_LPCXpressc54618 2.4.1 3.3.0 [} /SDK_2.4.1_LPCXpresso54618.zip

Figure 4.20. View SDK Local Part Support

Note: this feature is not designed to replace the need for ultimately installing an SDK, since there
are implications in project size etc. rather it is intended as short term solution to decouple projects

from the requirement for an SDK.
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4.3.3
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Finally, local part support can be removed in the same way as it was added. Simply right click on
a project and select SDK Management -> Remove SDK Part Support. Once this has been done,
an appropriate SDK must be installed for the project to be used.

Project Local Support files

Supporting files required for debug such as flash drivers, LinkServer Connect and Reset scripts
will usually be found (automatically) either within an SDK or installed by default within the IDE.

However, on occasion, bespoke flashdrivers and/or scripts may be required. While these files
could be stored and referenced from various locations within the file system, to enhance project
sharing such files can now be included directly within a project and locally referenced.

To use script and flash driver files in this way, first they can simply be dragged into the local
Project structure:

¥ =5 MKE4FN 1MOxxx12_My Shared_Project <Debug>
» € Project Settings
> ! Includes
» (2 CMSIS
» (2 board
» (B drivers
» (2 source
b (2 startup
» (2 utilities
» (=doc
(B MKBAFN1MOxxx 12_My Shared_Project LinkServer Debug.launch
=| my_connect.scp
=| my_flash.cfx

=| my_reset.scp

LinkServer launch configurations can now be used to directly browse to local scripts (connect
or reset) as shown below:
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[ RN ] Edit Configuration
<

Modify configuration and continue. ﬁ\’

Name: | frdmk641_bubble LinkServer Debug
[51 Main | %% GDB Debugger ([ LinkServer,Debugger’, € GUI Flash Tool | Other Symbols| b= Startup | & Source | (] Common
LinkServer Debugger

Debug Options

Debug Connection |SWp [

LinkServer Options

~ Debug Connection
Settings for the debug connection

Attach only | Reset on Connect | Disable use of precannect script

Reset seript B Workspace... File System...
Connect script | - Workspace... B UL =
[ & @ Connect script
BOOtROM stall
" - Select the elements from the tree:
Flash driver reset handling B reset handing
Disconnect behavior cont B seminosting support | On j| | * & settings
> (=CMSIS
~ Advanced Settings | »(=Debug
Advanced options » = board
Memory checking Debug memory cache [ Enable range stepping Enable flash hashing =-doc
= drivers
Debug level 2 =

Override core index

Wi H:
irespeed (Hz) ¥ (=rpart-support

IR T VY R Y WY S

Additional options > (= source
Pre launch command > Cstartup
> (= utilities

-

Revert

@ Cancel

Figure 4.21. Local Script file

Similarly a project local flash driver can be referenced by editing a project's memory configuration
and again browsing for the required flash driver within the project as below:
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Memory details (MK64FN1MOxxx12)*

Default LinkServer Flash Driver:

Default LinkServer Flash Driver Browse...

Type Name Alias  Location Size Qrive —
Flash PROGRAM_FLASH Flash Ox0 0):10000 i
RAM SRAM_UPPER RAM 0x20000000 0x30000 =
RAM SRAM_LOWER RAM2 Ox1fff0000 0x10000 =
RAM FLEX_RAM RAM3 | OyaeoBacEaianns T
LinkServer flash driver

Add Flash Add RAM

Import... Merge...
P g Flash Driver

Flash driver | S{workspace loc:}/S(ProiName)/MyFlash.cix || = Browse projsct... Browse workspace...

@ @ LinkServer flash driver

Select the elements from the tree:

| A

B MFIash.cfx
~>» DOard

(=doc

> (=drivers

¥ (> part-support

» (= source

> (= startup

¥ = utilities

Selected flash driver: MyFlash.cfx

@ [ ce | EECEED

Figure 4.22. Local flash driver

See additionally

The features described above will rarely be required, but on the occasions where shared projects
have bespoke debug files, the above scheme should simplify the sharing and use of MCUXpresso

IDE projects.

4.3.4 Export Project to Local SDK Git Repository

A project can now be exported into a local SDK Git Repository. The board and device for which
the project was created have to be supported by the local SDK otherwise it can’t be exported.

In order to export a certain project, right click on it inside the Project Explorer and select SDK

Management -> Export to SDK Git repository....

MCUXpresso IDE User Guide -
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Figure 4.23. Export to Local SDK Git Repository

. Export project to SDK Git repository. X

Name: | custom_example

Local SDK Git repository
Select the local SDK Git repository where the projects will be added.

C:\Repository
Choose a manifest where the new example will be referred:

examples\manifests\FROM-K64F_manifest_v3_9.xml o

Category
Select a category for the example.

demo_apps

Example Location:
Select a location where the example will be saved.

CA\Repository\examples\frdmké4f\demo_apps Browse...

Description
Short text describing the functionality demonstrated by this example

My custom example.

Cance

MCUXpresso IDE User Guide -

The name of the new example will be the name of the project, but it can be modified. For SDKs
with split manifests, the user can also select the manifest where the project will be referred. A
combo box presents all the categories available in the SDK for the current board. For the new
example you can select one of the available categories or select a new one. The project location
can also be chosen and it has to be in the same folder or in a subfolder of the manifest where the
project will be exported. After clicking OK the example will be added in the SDK Git repository.

The new example will be available in the SDK Import Wizard.
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B DK Import Wizard o *
(D) You have selected 1" project to import: 'frdmkBf_frdmk64f_custom_example’ x ,_’ 7
. Import projects
Project name prefix: | framkeaf | Project name suffix: |
Use default location
CAUsersinxal4933\ Documents\MCUXp _slphatworkspace\frdmicé4f Browse...
Project Type Project Options
@CProject () Ces Project ) C Static Library () G+ Static Library SDK Debug Console O Semihost @ UART | Example default
[ Copy sourcss
[import othes files
Examples mlERl BE
[typetofier
Name Description Version
v (8] £ demo_spps
[ % adc16_low_power_peripheral The ADC Low Pawer demo application demonstrates the usage of the ADC peripheral wh...
[ = bubbie pesipheral The bubble level demo demsnstrates basic usage of the on-bosrd secelerometer te impl.
[0 = dac_ade_peripheral The DAC / ADC demo application demenstrates the use of the DAC and ADC pesipherals....
[ = ecompass pesipheral The E-Compass demo the use of the . The tilt-...
| B = custom_example My custom examgle.
[T~ fimpdb_adcle The FTR7 POE deme application demonstrates how to use the FTM extermal trigger to st.
[ % ftm_quad_decoder This dema describes the usage of Quad Decader fezture in FTM module, which can be us...
[0 fim_quad_decoder_peripheral This demo describes the usage of Quad Decoder feature in FTM module, which can be us.
[ = hello_world The HelloWarld demo prints the “Hello World" string to the terminal using the SDK UART ...
O % ted_blinky The LED Blinky deme application provides a sanity check for the new SOK build emvirenm...
[ power_manager The Power manager demo application demonstrates the use of power modes in the KSD...
[0 7 power_mode_switch The Pawer mode switch demo application demonstrates the use of power modes in the ..
[0 = se_func The RIC deme application demonstrates the important features of the RTC Module by usi...
O 7 rtc_func_peripheral The RTC deme application demonstrates the important features of the RTC Module by usi...
O sheil The Shell Demo application demenstrates to control Leds by commands.
> O E driver_examples
[0 & mmeou_examples
O E rtos_examples
» [0 B sdmme_examples
< Back HNext > Finish Cancel

Figure 4.24. New Example Exported to Local SDK Git Repository

MCUXpresso IDE User Guide -

Limitations - Projects using linked references to the SDK source code are not supported. - Once
exported to the local SDK Git repository, the new example can be imported only with “Copy
Sources” set (source code files will be copied inside the project).
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5. Creating New Projects using installed SDK Part
Support

For creating a project using Preinstalled Part Support please see:

Locate the at the bottom left of the MCUXpresso IDE perspective and see
the first entry New project.

) Quickstart Panel 22 Variables Breakpoints = ]

MCUXpresso IDE - Quickstart Panel

(_Uee | No project selected

~ Create or import a project

. New project... ]
Import SDK example(s)...

® Import project(s) from file system...

~ Build your project

a;

~ Debug your project ' E' H'
~ Miscellaneous

. MCUXpresso Config Tools>>
[f,:? Quick Settings>>

oo Build all projects []

Figure 5.1. SDK Projects

The New Project Wizard, guides the user in creating new projects from the installed SDKs (and
also from preinstalled part support — which will be discussed in a later chapter).

Click New project to launch the New Project Wizard as detailed below:

5.1 New Project Wizard

The New Project Wizard will begin by opening the “Board and/or device selection” page, this
page is populated with a range of features described below:
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|
. Board and/or Device selection page

s from installed SDKs

Available boards

[@ Creating project for device: MK64FN1MOxxx12 with no board. ]4_ i g i

Please select an available board for your project.

NXP MKBAFN1MOwooc12

TKEx

> LPC540xx
*LPCB4Bxx
»MIMXRT1050

Target
»LPC1102
»LPC112x
¥ LPC11AxXX

| »LPC11E6X

| »LPC11Exx
»LPC11UBx
»LPC11Uxx
»LPC11xx

| »LPC11xxLV

Target Core:
| Description:

MKBAFN1MOxx12

aeinstalfed MCUs
s from preinstalled LPC and generic

Cortex-M part support

Selected Device: MK64FN1MOxxx 12 with no board.

FROMSTEC AGHE: FROM KEF

.

frdmk64f agm04

(62

S
SDK ) "
evkbimxrt10650 om13588

i B
+_SDK }

evkbimxrt1060

F o =
|_SDK )

evkbimxrt 1050 agmQ1 Xpresso812

SDKs for selected MCU
Name
4 SDK_2.x_FRDM-KB4F

SDK Version
2.40

Manifest Versj
3.3.0

Location
(% <Default Location>/SDK_2.x_FRD

cortex-m4

K64_120: Kinetis® K64-120 MHz, 256KB SK
(MCUs) based on ARM® Cortex®-M4 Core

pontrollers

Cancel

" Next> |

Figure 5.2. New Project Wizard first page

MCUXpresso IDE User Guide -

1. Adisplay of all parts (MCUSs) installed via SDKs. Click to select the MCU and filter the available

matching boards. SDK part support can be hidden by clicking on the triangle (highlighted in
the blue oval)

2. A display of all preinstalled parts (these are all LPC or Generic M parts). Click to select the

MCU and filter the available matching boards (if any). Preinstalled part support can be hidden
by clicking on the triangle (highlighted in blue)

3. A display of all boards from both SDKs or matching LPCOpen packages. Click to select the

board and its associated MCU.
* Boards from SDK packages will have SDK superimposed onto their image.

4. Some description relating to the user’s selection
5. A display to show the matching SDK for a chosen MCU or Board. If more than one matching

SDK is installed, the user can select the SDK to use from this list

6. Any Warning, Error or Information related to the current selection
7. An input field to filter the available boards e.g. enter ‘64’ to see matching MK64... Freedom

or Tower boards available

8. 3 options: to Sort boards from A-Z, Z-A or clear any filter made through the input field or a

select click.
Tip
. Once a project has been created the selected board and/or MCU will be
remembered and selected the next time the wizard is entered. To remove this

selection, click the clear filter button (or any background white space)
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This page provides a number of ways of quickly selecting the target for the project that you want
to create.

In this description, we are going to create a project for a Freedom MK64xxx board (The required
SDK has already been imported).

First, to reduce the number of boards displayed, we can simply type ‘64’ into the filter (7). Now
only boards with MCUs matching ‘64" will be displayed.

Figure 5.3. New Project Wizard selection

e o SDK Wizard
‘ (@ Creating project for device: MKB4FN1MOxxx12 using board: FROM-K64F

|
. Board and/or Device selection page

~ SDK MCUs
MCUs from installed SDKs

Available boards
Please select an available board for your project.
NXP MKE4FN1MOxxx12
YKBx
[ mxBarN1MOXxx12 |
P LPCha0xx
»LPC546xx
»MIMXRT1050

FROMSTEC-AGIE

FROREAF

SDK

as®

frdmk64f om13588

frdmk641 agmo4

frdmk64f

frdmk64f mult2b

~ Preinstalled MCUs
MCUs from preinstalled LPC and generic
Cortex-M part support
Target
»LPC1102
FLPC112x
FLPC11Axx
»LPC11E6x
»LPCT1Exx
»LPC11U6x
FLPC11Uxx
FLPC11xx
»LPC11xxLV

frdmk64f agm01

Selected Device: MK684FN1MOxxx 12 using board: FRDM-K64F SDKs for selected MCU
Name

+ SDK_2.x_FRDM-KE4F

SDK Version
2.4.0

Manifest Versior Location

3.3.0 (# <Default Locatiun>,'5DK_2.x}RB]

Target Core: cortex-md

Description:

K64_120: Kinetis® K64-120 MHz, 256KB SRAM Microcontrollers
(MCUs) based on ARM® Cortex®-M4 Core

(‘:ﬂ Cancel

s

When the (SDK) board is selected, you can see highlighted in the above figure that the matching
MCU (part) and SDK are also selected automatically.

With a chosen board selected, now click ‘Next'...

5.1.1 SDK New Project Wizard: Basic Project Creation and Settings

The SDK New Project Wizard consists of two pages offering basic and advanced configuration
options. Each of these pages is pre-configured with default options (the default options offered
on the advanced page may be set based on chosen selections from the basic page).

Therefore, to create a simple ‘Hello World’ C project for the Freedom MK64... board we selected,
all that is required is simply click ‘Finish’.

Note: The project will be given a default name based on the MCU name. If this name matches a
project within the workspace e.g. the wizard has previously been used to generate a project with
the default name, then the error field will show a name clash and the ‘next’ and ‘finish’ buttons
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will be ‘greyed out’. To change the new project’s name; the blank ‘Project Name Suffix’ field can

be used to quickly create a unique name but retain the original prefix.

This will create a project in the chosen workspace taking all the default Wizard options
board.

However, the wizard offers the flexibility to select/change many build, library and source code

for our

options. These options and the components of this first Wizard page are described below.

B8 spk Wizard o X
RE™ G
1, The source from the SDK will be copied into the workspace. If you want to use linked files, please unzip the "SDK_2.x_FRDM-K64F' SDK. ‘ :L i /
. Configure the project
m ( L § )
Project name: [ MK64F12_Project V x lProject name suffix: I
J \ J
Use default location
C:\Users\nxa11975\Documents\MU¥s ke¥solDE_11.6.0_8174_alpha\workspace_30_06 .r,@f’rqec( Brofust i
Device Packages Board Project Type Project Options
O MKB4FNTMOVDC12 ~ || ® Default board files @ C Project @) ot P SDK Debug Console (O Semihost @ UART
E board fil Copy s s
® MKB4FNTMOVLL12 S E e s O C Static Library ) C++ Static Library & I“r:;mi“t::rm“
(O MKB4FNTMOVLQ12 =
Components =] Eornponents selection summary + T-'-\
Add or remove SDK szlt.»ére components . . ) ) ) ‘ type to filter
[ Operating Systems | Drivers ._CMSIS Drivers | CMSIS Include | Utilities {[Middleware | Board Components | Abstraction Layer| 5 —
Name Description  Ver... Info
Drivers = CMSIS Include
type to filte g I = Drivers
Lypeto e — . £ Operating Systems
Name Description Version Info ~ = Others
I ade ADC16 Driver 220 £ Project Template
I clock Clock Driver 251 S SOte L ot onen
O cmp CMP Driver 202 = Utilities
[ emt CMT Driver 203
[ ¢ common COMMON Driver 231
[ < cre CRC Driver 203
[ & dac DAC Driver 202
[ 4 dmamux DMAMUX Driver 2.05
[ & dspi DSPI Driver 2.24
[ 4# dspi_edma DSPI Driver 2.24
[ 4 edma EDMA Driver 243
[ & enet ENET Driver 253
[ 43 ewm EWM Driver 203
[ 4 flash Flash Driver 3.00 v
/
3\
&) < Back Next > Cancel

Figure 5.4. New Project Wizard basic SDK settings

1. Project Name: The default project name prefix is automatically selected based on the part

selected on the previous screen

* Note: Due to restrictions in the length of filenames accepted by the Windows version of the
underlying GCC toolchain, it is recommended that the length of project names is kept to 56
characters or less. Otherwise you may see project build error messages regarding files not

being found, particularly during the link step.
. Project Suffix: An optional suffix to append to a project name can be entered here.

N

3. Errors and Warnings: Any error or warning will be displayed here. The ‘Next’ option will not be
available until any error is handled. Errors may include such things as dependency problems or
for example, a project name may have been selected that matches an existing project name in
your workspace. The suffix field (2) allows a convenient way to create a unique project name.

4. MCU Package: The device package can be selected from the range contained with the SDK.

project

The package relates to the actual device packaging and typically has no meaning for
creation.
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5. Board files: This field allows the automatic selection of a default set of board support files, else
empty files will be created. If a part rather than a board had been selected on the previous
screen, these options will not be displayed.
 If you intend to use board specific features such as output over UART, you should ensure

Default board files are selected.

6. Project Type: C or C++ projects or libraries can be selected. Selecting ‘C’ will automatically

select RedLib libraries, selecting C++ will select NewlibNano libraries. See

7. Project Options:

¢ Semihost: will cause the Semihosted variant of the chosen library to be selected. For C
projects this will default to be Redlib Semihost-nf. Semihosting allows IO operations such
as printf and scanf to be emulated by the debug environment.

* UART: will cause the nohost variant of the chosen library to be selected. For C projects this
will default to be Redlib Nohost. IO operations such as printf and scanf will occur via UART
(or emulated UART provided by the debug probe over USB).

e Copy Sources: For zipped SDKs, this option will be ticked and greyed out. For unzipped
SDKs, projects can be created using linked references to the SDK sources.

8. Components:

« OS: This provides the option to pull in and link against Operating System resources such
as FreeRTOS.

« Driver: enables the selection of supporting driver software components to support the MCU
peripheral set.

« CMSIS Drivers: code and headers for standard arm hardware

¢ CMSIS Include: will cause a CMSIS folder containing a variety of support code such as
Clock Setup, header files to be created. It is recommended to leave the associated options
ticked.

« Utilities: a range of optional supporting utilities.

* For example select the debug_console to use SDK Debug Console handling of 10
 Selecting this option will cause the wizard to substitute the (SDK) PRINTF() macro for C
Library printf() within the generated code
» The debug console option relies on the debug probe communicating to the host via
VCOM over USB (LPC-Link2 and OpenSDA debug probes support this feature)

« Middleware: enables the selection of various middleware components

* Project Template: adds support files for the selected device/board

« Depending on the SDK selected, additional options may also appear

9. Each set of components support a filter and check boxes for selection. These icons allow
filters to be cleared, all check boxes to be set, all check boxes to be cleared.

10. Enable or Disable Component Selection Summary view: Since the selected software
components cannot be viewed together, an optional summary view can be selected via this
button. This setting will be remembered as a workspace preference.

11. Summary view of the software components selected for the project being created enabled
as enabled via the above option.

Finally, if there is no error condition displayed, ‘Finish’ can be selected to finish the wizard,
alternatively, select ‘Next’ to proceed to the Advanced options page (described next).

Important Note: Any components (OS, driver, utilities, middleware etc.) selected by default
within this wizard will be available for use within the project. However the linker may remove
the components supporting functions from the generated image if they are not referenced from
within the user’s project code. Additionally, selecting a component will automatically select any
dependencies. Finally, please also note that this is an additive process, removing components
may leave unresolved dependencies resulting in a project that will not build.

Note: Some middleware components are not currently compatible with the New project wizard

functionality and so will be hidden. The recommended approach if such components are required

is to import an example including the component and then modify this as required. Please see
for details of how this might be done.
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Note: By default, new project files are stored within the current MCUXpresso IDE workspace,
this is recommended since the workspace then contains both the sources and project
descriptions. However, the New Project Wizard allows a non default location to be specified if
required. To ensure that each project’s sources and local configuration are self contained when
using non standard locations, the IDE will automatically create a sub directory inside the specified

location using the Project name prefix setting. The newly created project files will then be stored
within this location.

5.1.2 SDK New Project Wizard: Advanced Project Settings

The advanced configuration page will take certain default options based on settings from the

first wizard project page, for example a C project will pre-select Redlib libraries, where as a C+
+ project will pre-select NewlibNano.

[ BN ) SDK Wizard

@,

. Advanced project settings

~ CiC++ Library Settings O

Set library type (and hosting variant) = Rediib (semihost-nf) B

Redlib: Use floating point version of printf
Redlib: Use character rather than string based printf

Redirect SDK "PRINTF" to C library "printf* Redirect printf/scanf to ITM
Include semihost HardFault handler Redirect printf/scanf to UART

[~ Hardware settings

Set Floating Point type | £py4 (HardABI) H
\
(~ MCU C Compiler

Language standard = Compiler default B
\

[~ MCU Linker
Link application to RAM

~Memory Conliguration Q
Memory details

Default LinkServer Flash Driver Browse...
Type Name Alias Location Size Driver -
Flash PROGRAM_FLASH Flash Ox0 0x100000 FTFE_4K.cfx hal
RAM SRAM_UPPER RAM 0x20000000 0x30000 -
RAM SRAM_LOWER RAM2 Ox1fff0000 0x10000 |
RAM FLEX_RAM RAM3 0x14000000 0x1000

Add Flash Add RAM Split Delete

\mport... Merge... Export... Generate... /

) < Back cancel I

Figure 5.5. New Project Wizard advanced SDK settings

1. This panel allows the selection of library variants. See . Note: if
a C++ project was selected on the previous page, then the Redlib options will be greyed out.
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Redlib (none)
Redlib (nohost)
Redlib (semihost)
Redlib (nohost-nf)

v Redlib (semihost-nf)
Redlib (semihost-mb)
Redlib (semihost-mb-nf)
NewlibNano (none)
NewlibNano (nohost)
NewlibNano (semihost)
Newlib (none)

Newlib (nohost)
Newlib (semihost)

¢ Also, based on the selection, a number of options may be chosen to modify the capability
(and size) of printf support

* Redlib Floating Point printf: If this option is ticked, floating point support for printf will
automatically be linked in. This will allow printf to support the printing out of floating point
variables at the expense of larger library support code. Similarly for Newlib.

« Redlib use Character printf: selecting this option will avoid heap usage and reduce code
size but make printf operations slower.

2. This panel allows options to be set related to Input/Output. See

* Redirect SDK “PRINTF": many SDK examples use a PRINTF macro, selecting this optlon
causes redirection to C library 10 rather than options provided by the SDK debug console.

¢ Include Semihost Hardfault Handler: selected by default, this option when checked will add

a hardfault handler to the project sources. This handler is specifically written to deal with

the situation that will occur if a semihosted function such as printf is executed when no

debug tools are attached to support the operation. If this occurs, this handler will catch

the operation and safely return to the executing application. Uncheck this option if you do

not wish to use semihosted libraries or you intend to use your own hardfault handler. See
for more information.

¢ Redirect printf/scanf to ITM: causes a C file 'retarget_itm.c to be pulled into your project.
This then enables printf/scanf 1/0 to be sent over the SWO channel. The benefit of this is
that 1/0O operations can be performed with little performance penalty. Furthermore, these
routines do not require debugger support and for example could be used to generate logging
that would effectively go to Null unless debug tools were attached. Note: This feature is not
available on Cortex MO and MO+ parts.

* More information can be found in the MCUXpresso IDE SWO Trace Guide.

¢ Redirect printf/scanf to UART: Sets the define SDK_DEBUGCONSOLE_UART causing the
C libraries printf functions to re-direct to the SDKs debug console UART code.

3. Hardware Settings: from this drop down you can set options such as the type of floating point

support available/required. This will default to an appropriate value for your MCU.

None
FPv4 (SoftABI)
Set Floating Point typé v EPy4 (HardABI)

~ Hardware settings

. MCU C Compiler: from this drop down you can set various compiler options that can be set

for the GNU C/C++ compiler.

| GNU C99 (-std=gnu99)
~ Hardware settin o\ ¢11 (-std=gnutt)
Set Floating Point{ SO C90 / ANSI C88 (-std=c90)
ISO C99 (-std=c99)
- MCUC Compilt SO C11 (-std=c11)
GNU C90 (-std=gnu80)
Language standar¢  Compiler default

. Link Application to RAM checkbox reflects or sets the option to force the linker to ignore any

defined flash regions and link the application to the first RAM region defined. This option is
a copy of the flag at Properties -> C/C++ Build -> Settings -> Managed Linker Script -> Link
application to RAM Note: This setting is only sensible for projects under development, since
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debug control or a bootloader is required to load the code/data into RAM and simulate a
processor reset.

6. Memory Configuration: This panel shows the Flash and RAM memory layout for the MCU
project being created. The pre-selected LinkServer Flash driver is also shown. Note: this Flash
driver will only be used for LinkServer (CMSIS-DAP) debug connections.

« From this dialogue, the project’'s default memory setting may be edited in place if required
and hence also the automatically generated linker scripts. See

5.2 Project Build

To build a project (created by the New Project Wizard), simply select the project in the ‘Project
Explorer’ view, then go to the ' Quickstart' Panel and click on the build button to build the project.
This will build the active configuration of the selected project, where newly created projects
default to the Debug configuration.

Note: MCUXpresso IDE projects are created with two build configurations, Debug and Release
(more can be added if required). These differ in the default level of compiler optimization. Debug
projects default to None (-O0), and Release projects default to (-Os). For more information
on switching between build configurations, see

The build log will be displayed in the console view as below.

(j) Installed SDKs [ Properties & Console 52 |[2! Problems [} Memory € Instruction Trace [ SWO Trace Config ED Power Measurement Tool 4 4 55 LH RE % MBE-9-= 8
CDT Build Console [MK64FN1MOxxx12_Project]

Building file: ../(MSIS/system_MKG4F12.c

Invoking: MCU € Compiler

arm-none-eabi-gecc -DCR_INTEGER_PRINTF -DSDK_DEBUGCONSOLE=® -D__MCUXPRESSO -D__USE_CMSIS -DDEBUG -DSDK_OS_BAREMETAL -DFSL_RTOS_BM -DCPU_MKE4FNIM@VDC12 -DCPU_MK&4FNIMAVDC1Z_cmd -1
Finished building: ../startup/startup_mk64F12.c

Finished building: ../source/MK64FNIMBxxx12_Project.c

Finished building: ../CMSIS/system_MK64F12.c

Building target: MKG4FNIMBxxx12 Project.axf
Invoking: MCU Linker
arm-none-eabi-gcc -nostdlib -Xlinker -Map="MKG4FN1M3xxx12 Project.map" -Xlinker --gc-sections -Xlinker -print-memory-usage -mcpu=cortex-md -mfpu=fpv4-sp-dle -mfloat-abi=hard -m

Memory region Used Size Region Size Hage Used
PROGRAM_FLASH: 3216 8 1 MB 0.78%
SRAM_UPPER: 3302 8 182 KB 4.27%
SRAM_LOWER: D G8 64 KB 8.90%
FLEX_RAM: 0GB 4 KB 0.90%

Finished building target: MKE4FN1M@xxx12_Project.axf

make --no-print-directory post-build

Performing post-build steps

arm-none-eabi-size "MKBAFNIM@xxx12_Project.axf"; # arm-none-eabi-objcopy -v -0 binary "MKB4FNIM@xxx12 Project.oxf" "MKB4FN1MBxxx12_Project.bin” ; # checksum -p MKE4FNIMBxxx12 -
text data bss dec hex filename
8212 4 8388 16604 4@dc MKEAFNIMAxxx12_Project.axf

15:15:38 Build Finished (took 66%ms)

Figure 5.6. New Project Wizard Build

The project’'s memory usage as highlighted above is shown below:

Menory region Used Size Region Size %age Used

PROGRAM_FLASH: 8216 B 1M 0. 78%
SRAM_UPPER: 8392 B 192 KB 4.27%
SRAM_LOVER: 0GB 64 KB 0. 00%
FLEX_RAM 0GB 4 KB 0. 00%

Fi ni shed buil ding target: MG64FNLM)xxx12_Proj ect . axf

By default, the application will build and link against the first Flash memory found within the
device's memory configuration. For most MCUs there will only be one Flash device available.
In this case our project requires 8216 bytes of Flash memory storage, 0.78% of the available
Flash storage.
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5.2.1
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RAM will be used for global variable, the heap and the stack. MCUXpresso IDE provides a flexible
scheme to reserve memory for Stack and Heap. The above example build has reserved 4KB
each for the stack and the heap. Please See

for detailed information.

Please also see for details of how to explore the composition of an
image in detail.

Build Configurations

By default, each project will be created with two different “build configurations”: Debug and
Release. Each build configuration will contain a distinct set of build options. Thus a Debug build
will typically compile its code with optimizations disabled ( - ) and Release will compile its code
optimizing for minimum code size ( -cs). The currently selected build configuration for a project
will be displayed after its name in the Quickstart Panel’s Build/Clean/Debug options.
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6. Importing Example Projects (from installed SDKS)

In addition to drivers and part support, SDKs also deliver many example projects for the target
MCU.

To import examples from an installed SDK, go to the Quickstart panel and select Import SDK
example(s).

Figure 6.1. SDK Example

) Quickstart Panel 2 Variables Breakpoints = =]

MCUXpresso IDE - Quickstart Panel
_me | No project selected

~ Create or import a project

proiect
B import SDK example(s)... ]

~ Build your project

~ Debug your project ' E' H'

8-

~ Miscellaneous

. MCUXpresso Config Tools>>
& Quick Settings>>

lo Build all projects []

MCUXpresso IDE User Guide -

This option invokes the Import SDK Example Wizard that guides the user to import SDK
example projects from installed SDKs.

Like the New Project wizard, this will initially launch a page allowing MCU/board selection.
However now, only SDK supported parts and boards will be presented.
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@ @ SDK Import Wizard
= 2

(T) Importing project(s) for device: MKG4FN1MOu01 2 using board: FRDOM-KG4F | i 7
. Board and/or Device selection page

~ SDKMCUs ® Available boards B 1%
MCUs from installed SDKs. Please Please select an available board for your project

click above or visit

MEYXRIESs0.Xp.COM to obtain

additional SDKs

NXP MKEAFNTMOxex 12

FK2x
vKEx
MKBAFN MO0 2
[ mousse SDK ) Froistc acus o SDK | Moemn e sox )
frdmkE41_agm01 framk64f_agmod frdmk64f_mult2b

Selected Device: MKEAFN1MO0xxx 12 using board: FRDM-K64F SDKs for selected MCU

Target Core: cmd MName SDK Version  Manifest Versic Locaticn

Description: Kinetis K64-120 MHz, 256KB SRAM Microcontroliers (MCUs) based on ARM Gy : § Y ins 3.8, i Al

Cortex-Md Cors ] SDK_2.x_FRDM-KE4F 2.9.0 (Eplugins 3.8.0 B . 5
@ Cance
Figure 6.2. SDK Example Board
Selection and filtering work in the same way as for the but please be

MCUXpresso IDE User Guide -

aware that examples are created for particular development boards, therefore a board must be
selected to move to the ‘Next’ page of the wizard.

In the case of " SDK Example Import Wizard", the " SDKs for selected MCU" control is disabled
and the selection of the proper SDK source for a specific chosen board/device is automatically
performed. This is done in order to prevent unwanted selection of a SDK which can lead on

getting files from a wrong source. This situation can occur when the same device is presented
in multiple SDKs.
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* KOx
YK2x

* KEx

Target Core:
Description:

| .,
(@) Importing project(s) for device: MK22FNS 1 2x00e1 2 using board: FRDM-K22F 1 x i 7

. Board and/or Device selection page

~ SDK MCUs
MCUs from installed SDKs. Please Please select an avallable board for your project
click above or visit

MCUXpes50.0xp.cOM to obtain
additional SDKs.

NXP MK22FNG12xxx12

MK22FN5 1230012

Selected Device: MK22FNG12xxx 12 using board: FRDM-K22F

Figure 6.3. SDK Importer Multiple SDKs

SDK Import Wizard

® Available boards g 0

. ‘ y
[e— B Sy e T re——
sDK *(sox ) SDK
fedmi2 21 frdmk22{_agm01 fradmk22f_agmp03

(Pending)

ST Bisiand e T8 Bl e T
| e \ i I L
frdmic2 21 frdmk221_agm01 frdmk22f_agmp03 frdmk22f_sa8500

SD¥s for selected MCU
cm4

Name SDK Version  Manifest Versic Location
Kinetis K22-120 MHz, Cost Effective, Full-Speed USB Microcontroliers (MCUs) & - meux|
based on ARM Cortex-M4 Core RISDIC2 FROM-K22E " 12.0.0 (Eplegine 3.8.0 L <plugins>/com.nxp.meuxpresso.sd|
B SOK.2.x MKOZFN1 28010 2.9.0 3.8.0 B <plugins>/com.nxp.meuxpresso.sd
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Note: Even if not recommended, if it is absolutely necessary, the user can still force the
option. This hard-coded selection can be removed by selecting the option from Preference ->
MCUXpresso IDE -> SDK Handling -> Misc -> Enable “SDKs for selected MCU” selection in SDK
Import Wizard. Then, a different SDK can be selected.
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Figure 6.4. SDK Importer Force Manual SDK Selection

e @ Preferences
Misc =1
» General
»C/Cos SDK management misc options
» Help Pricritize IDE supplied flash driver

¥ Install/Update

» Library Hover Default SDK debug console to semihost on project creationjfimport

MCUXpresso Config Tools Include semihost hardfault handler by default on project creationf/import
¥MCUXpresso IDE
» Debug Options Enable SDK options check
Default Tool settings Selected files from SDK View open in read-only mode
¥ Editor Awareness
General Open project main files after importing multiple SDK examples
MCU settings Enable "SDKs for selected MCU" selection in SDK Import Wizard

Paths and Directories
Quickstart Panel
B RTOS TAD
¥ SDK Handling
Components
Installation

SWO Trace
User Interface Enablemer
Utilities
» Run/Debug
SWTChart Extensions
» Terminal
Validation
» Version Control (Team)
» XML Restore Defaults Apply

@ Cancel " Apply and Close

6.1.1
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SDK Example Import Wizard: Basic Selection

The SDK Example Import Wizard consists of two pages offering basic and advanced
configuration and selection options. The second configuration page is only available when a
single example is selected for import. This is because examples may set specific options, and
therefore changing settings globally is not sensible.

The first page offers all the available examples in various categories. These can be expanded to
view the underlying hierarchical structure. The various settings and options are explained below:
Note: The project will be given a default name based on the MCU name, Board name and
Example name. If this name matches a project within the workspace e.g. the wizard has
previously been used to generate an example with the default name, then the error field will show
a name clash and the ‘next’ and ‘finish’ buttons will be greyed out. To change the new example
name, the blank ‘Project Name Suffix’ field can be used to quickly create a unique name but
retain the original prefix e.g. add ‘1.

MCUXpresso IDE will create a project with common default settings for your chosen MCU and

board. However, the wizard offers the flexibility to select/change many build, library and source
code options. These options and the components of this first Wizard page are described below.
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[ ] [ ] SDK Import Wizard

€3 Please select one or more examples to import ] k

. Import projects
[ Project name prefix: frdmk64f_ i [Prujec1 name suffix: i

Use default location

MCUXpresso IDE User Guide

Location:

[Proiect Type

Project Options

SDK Debug Console * Semihost UART Example default

Examples

Copy sources

Import other files

o et

Version
» £ aws_examples \
» = cmsis_driver_examples
] » £ demo_apps
» £ driver_examples
» = emwin_examples
» S Iwip_examples
~1 » = mmcau_examples
| » = multiprocessor_examples
» = rtos_examples
~1 » = se_hostlib_examples
P = usb_examples

Figure 6.5. SDK Example Selection

< Back Cancel
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1. Project Name: A project name is automatically created with the form:
boardname_examplename

2. Project Suffix: An optional suffix to append to a project name can be entered here. This is
particularly useful if you are repeating an import of one or more projects since an entry here
can make all auto generated names unique for the current workspace...

3. Project Type: These will be set by the pre-set type of the example being imported. If more
than one example is imported, then these options will appear greyed out.

4. Project Options:

¢ ‘SDK Debug Console’: Once an example(s) has been selected, this option can be used to
control IO between semihost console, UART or the examples default setting.

e ‘Copy sources’: For unzipped SDKs, you can untick this option to create project containing
source links to the original SDK files. This option should only be unticked with care, since
editing linked example source will overwrite the original files!

« ‘Import other files’: By default, non source files such as graphics are filtered out during
import, check this box to import all files.

. Examples Filter: Enter text into this field to find possible matches, for example enter ‘LED’ or

‘bubble’ to find examples present in many SDKs. This filter is case insensitive.

. Examples: The example list broken into categories. Note: for some parts there will be many

potential examples to import

7. Various options (from left to right):
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¢ Opens a filer window to allow an example to be imported from an XML description. This is
intended as a developer feature and is described in more detail below.

¢ Clear any existing filter

¢ Select (tick) all Examples

¢ Clear all ticked examples

¢ Open the example structure
¢ Close the example structure

Finally, if there is no error condition displayed, ‘Finish’ can be selected to finish the wizard,
alternatively if only one example has been selected the option to select ‘Next’ to proceed to the
Advanced options page is available (described in the next section).

Note: SDKs may contain many examples, 146 is indicated for the FRDM MK64 SDK example
shown below. Importing many examples will take time ... Consider that each example may consist
of many files and associated description XML. A single example import may only take a few
seconds, but this time is repeated for each additional example. Furthermore, the operation of
the IDE maybe impacted by a large number of projects in a single workspace, therefore it is
suggested that example imports be limited to sensible numbers.

Note: Due to restrictions in the length of flenames accepted by the Windows version of the
underlying GCC toolchain, it is recommended that the length of project names is kept to 56
characters or less. Otherwise you may see project build error messages regarding files not being
found, particularly during the link step.

Figure 6.6. SDK Example Selection Many

i, The source from the SDK will be copied into the workspace. z 7
If you want to use linked files, please unzip the 'SDK_2.x_FRDM-K64F' SDK. The advanced options page is disabled when either
. Import projects
Project name prefix: framk6af Project name suffix:
¥| Use default location
Location:
Project Type Project Options
C Project (' C++ Project | C Static Library () C++ Static Library SDK Debug Console () Semihost | | UART (= Example default
MCUXpresso IDE
You have selected '146' projects to import.
Import may take a considerable amount of time.
Examples 2 4 MK BE
———

3
3

Version

‘S cmsis_driver_examples
v'E dspi
= cmsis_dspi_edma_b2b_transfer_master
= cmsis_dspi_edma_b2b_transfer_slave
= cmsis_dspi_int_b2b_transfer_master
£ cmsis_dspi_int_b2b_transfer_slave
vE j2¢
= cmsis_i2c_edma_b2b_transfer_master
" emsis_i2c_edma_b2b._transfer_slave
5 cmsis_i2c_int_b2b_transfer_master
" cmsis_i2c_int_b2b_transfer_slave
cmsis_i2c_read_accel_value_transfer
vE uart

NENRRRFRRREERNE

3
@ < Back Cance
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SDK Example Import Wizard: Advanced options

The advanced configuration page (shown below) will take certain default options based on the
examples selected; for example, a C project will pre-select Redlib libraries, whereas a C++ project
will pre-select NewlibNano.
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. Advanced project settings

SDK Wizard

@,

~ CiC++ Library Settings O

Set library type (and hosting variant) = Rediib (semihost-nf) B

Redlib: Use floating point version of printf
Redlib: Use character rather than string based printf

Redirect SDK "PRINTF" to C library "printf*
Include semihost HardFault handler

Redirect printf/scanf to ITM
Redirect printf/scanf to UART

[~ Hardware settings

Set Floating Point type | £py4 (HardABI) H
\
(~ MCU C Compiler

Language standard = Compiler default B
\

Type
Flash
RAM
RAM
RAM

Add Flash

\m port...

[~ MCU Linker
Link application to RAM
p’ emory Con |gurat|nn Q
’ Memory details

Default LinkServer Flash Driver

Browse...
Name Alias Location Size Driver -
PROGRAM_FLASH Flash Ox0 0x100000 FTFE_4K.cfx hal
SRAM_UPPER RAM 0x20000000 0x30000 =
SRAM_LOWER RAM2 Ox1fff0000 0x10000 o=
FLEX_RAM RAM3 0x14000000 0x1000
Add RAM Split Delete

Merge... Export... Generate... /

Figure 6.7. New Project Wizard advanced SDK settings

< Back cancel I

6.1.3
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These settings closely match those in SDK New Project Wizard description. Therefore see

for a description of these options. Note: Changing
these advanced options may prevent an example from building or executing.

SDK Example Import Wizard: Import from XML fragment

This option works in conjunction with the ‘Project Explorer’ -> Tools -> Generate Example XML
(and is also used to import project created by the MCUXpresso Config Tools Project Generator).

The functionality here is to merge existing sources within a selectable board package framework.

To create an XML “fragment” for an existing project in your workspace, right click on the project

in the ‘Project Explorer’ (or just in the ‘Project Explorer’ view with no project selected) and choose
Tools->Generate examples.xml file

The selected project or all the projects in the workspace (if no projects are selected) will be
converted into a fragment within a new folder created in the workspace itself:
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(5 Project Explorer 52 2. Peripherals+ i} Regi

(=]=]

¥ [=r boards
v (= frdmke4f
¥ (= dummy
¥ [ Category
> (> MKB4FN1MOxxx12_Project
[£] examples.xml
b =5 frdmk64f_demo_apps_bubble

To create a project from a fragment, click on “Import SDK examples...” in the Quickstart Panel
view:

Then select a board and then click on the button “Import from XML...” (highlighted below and
described in the previous section). You will see the examples definitions from the external
fragment in list of examples as shown and selected below.

. @ @ SDK Import Wizard
A r’ y
| () You have selected '1° projects to import. } L LE_I/
I . Import projects :
Project name prefix  fromusdf Project name suffix: yyy Iraqmsnﬂ

Usa default location

Location;

Project Typa Project Options

O C Project Capy sources

Examples @ vV R BB
| Mamo irnion

» = cmais_driver_examples

» = dema_apps

» = driver_examples

» 5 emwin_examples

¥ 5 mmcau_sxamples

r = multiprocessor_examples
» o ros_sxamples

¥ & dummy
a ¥ = Category
a MKBAFN 1MOxxx12_Project

@ < Back Next » Cancel [ Finish |

Select the external examples you want to re-create and click on “Finish”. The project(s) will be
created in the workspace.
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6.1.4 Importing Examples to non default locations

By default, imported example sources will be stored within the current MCUXpresso IDE
workspace, this is recommended since the workspace then contains both the sources and
project descriptions. However, the Import SDK Example Wizard allows a non default location
to be specified if required. To ensure that each project’s sources and local configuration are self
contained when using non standard locations, the IDE will automatically create a sub directory
inside the specified location using the Project name prefix setting. Single or multiple imported
projects will then be stored within this location.
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7. SDK Project Component Management

Projects and examples created from SDKs contain a number of software components such as
peripheral drivers and/or middleware. In previous versions of MCUXpresso IDE, the option to
add components was only available when creating a new project and not possible for imported
examples. MCUXpresso IDE version has the ability to easily add (or remove) SDK components
to a previously created or imported example project via a new Manage SDK components wizard.
To launch the Manage SDK Components wizard, simply select the chosen project in the Project
explorer view and then click the package icon as indicated below:

5 Project... X 2 Periphe.. Ui Registers fgFaults = O
v 125 MKBAF12_Project <Debugs>
€ Project Settings
il Includes
@ CMSIS N — - - e——— S— e —
n. mponent " MIKG4F12_Pr
(2 board B Manage SDK components for project MKB4F12_Project = s
(2 component
(£ device i, Adding/removing components could potentially bresk your project, Plesse use this festure carefully. &.‘. 1
8 drivers
v B source Available SDK components
[& MK84F12_Project.c
(& semihost hardfault.c i b
(8 startup
2 utilities Com H o
Add ove SDK software components
Operating Systems |Drivers ™. CMSIS Drivers| CMSIS Include | Utilities | Middleware| Board Components | Abstraction Layer Software Components| ™ info
Drivers B %| B S CMSIS Include
— Drivers
iaid Operating Systems
Name Description Version Info ~ S Others
(A4 ade ADC16 Driver 220 g Project Template
A48 dock Clock Driver 25.1 £ Software Components
O cmp - CMP Driver 202 Utilities
O omt chck to add CMT Driver 203
[ & commen COMMON Driver 231
C14&s ere CRC Driver 203
148 dac DAC Driver 202
(] 3 #efarmun DMAMUX Drives 205
48 aspi DSPI Driver 224
[J43 dspi_edma DSPI Driver 224
43 edma EDMA Driver 243
143 enet ENET Driver 253
D14 ewm EWM Driver 203
143 flash Flash Driver 300
483 flexbus FLEXBUS Driver 211
M3 flevcan EIEYCAM Neivar 202 M
< >
2 Cancel

Figure 7.1. Manage SDK Components

7.1
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Note: This powerful feature can add (or remove) SDK components and their dependencies at
a source file level, relying on meta data contained within the SDK. However the following points
should also be noted:

e The IDE can only maintain dependencies between SDK components. SDK component
functions referenced from user-created files or from sources such as an SDK example’s main()
function will not be taken into account when determining the safe removal of components.
Therefore, the IDE cannot always prevent users removing components that may actually be
required for a successful project build.

« Defined symbols will not be removed when components are removed, therefore users should
ensure only required symbols are present if components are removed. Failing to do this may
lead to project build failures.

Various SDK Component Management options are available from Preferences -> MCUXpresso
IDE -> SDK Handling -> Components .

SDK Project Component Management example

To demonstrate the use of this feature, the dac driver will be added to a project. To do this, launch
the Manage SDK components wizard, and click on the dac driver component then click ‘OK’.
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Next, a dialogue will be presented listing all of the source files required by this component — as
below.

2] [ ] SDK Component Management

' The following files will be added or updated if required:
Component source Project Path(s) Infio

v
\ -

v Eédac drivers 2.0.1
v =i devices/MKB64F12/drivers drivers SRC
= fsl_dac.c
v =i devices/MKB4F12/drivers drivers C_INCLUDE
= fsl_dac.h
v A

Skip addfremove components confirmation in future

No [ Yes ]

Figure 7.2. SDK Component Management

Note: Many of these files may already be included within your project.

Click ‘Yes’ to add these source files to your project.

Important Note: Since your project may contain edited or entirely new versions of the required
source files, MCUXpresso IDE will perform a comparison between the new files to be included

and any existing files already within the selected project.

Should a source file difference be found, then a dialogue as below will be launched:
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The file 'system_MKG4F12.¢' already exists in your project but is different from the SDK
component file.

NOTE: 'system_MKG&4F12.c' could belong to the selected compenent(s) or one of its
dependent components.

Please select from the following options:

Remember my decision.

Replace Keep existing Compare

Figure 7.3. SDK Component Management file difference

From here you can choose from the following options:

¢ Replace click to overwrite the project’s file from the SDK version.
« Keep Existing click to keep the existing project file unchanged.

e Compare click to compare the two files — this will launch the Eclipse file compare utility so the
new SDK file can be compared with the projects copy.

In this example, we will click ‘Compare’ ...

Below, you can see that a user project source modification has been found:

C Compare

[ [€ Translation Unit

| | C Compare Viewer =

| :.Wor.kspace: Wo.ri'cspace: fMP.(.éﬂfF“.uiect}.CMSi.S.fsystem_.MKﬁﬁ.F‘l 2._c

Compare

bld| [
| £ SDK: devices/MKB4F12/system.MKBAF12.c

.;‘.

P

[J1177 A user code change has been made here
12

T

N\ e

@

[123 void SystemInit (void) {
[124 #1F ((__FPU_PRESENT == 1) && (__FPU_USED == 1))
i 128 CrR-~(PAFR |= (U wrer 10%2Y | CUN e 11%230- /* I 7g CFR-~FPAFR 1= CUN e 10%2% | FUN o, 11%23)

1114 -- Core clock
EN S| mrmmm e e e [
116 16
1117 uint32_t SystemCoreClock = DEFAULT_SYSTEM_CLOCK; 117 uint32_t SystemCoreClock = DEFAULT_SYSTEM_CLOCK
118 118
L 110 /® —mm e e
L1120 SystemInit() 128 SystemInit()
21 -
2z

1123 void SystemInit (woid) {

Left: 116 : 1, Right: 111 : 1, no diff

Cancel

[124 #iF ((__FPU_PRESENT == 1) && (__FPU_USED == 1))

Figure 7.4. SDK Component Management file compare

The Compare utility allows any change to be examined and a decision made regarding which
code lines to choose or ignore. When the decisions have been made, click ‘Commit’ to use these
changes or ‘Cancel’ to leave the project file unchanged.

Finally please note the application build sizes before the addition:

Menory region Used Size Region Size %age Used
PROGRAM_FLASH: 13348 B 1 MB 1.27%
SRAM_UPPER: 8444 B 192 KB 4.29%

SRAM _LOVER: 0GB 64 KB 0. 00%

MCUXpresso IDE User Guide -
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7.2

FLEX_RAM 0GB 4 KB 0. 00%
Fi ni shed buil ding target: MG64FNLIM)xxx12_Proj ect . axf

Followed by the application sizes after the addition.

Menory regi on Used Size Region Size %age Used
PROGRAM_FLASH: 13348 B 1 MB 1.27%
SRAM_UPPER: 8444 B 192 KB 4.29%
SRAM_LOVNER: 0 & 64 KB 0. 00%
FLEX_RAM 0 & 4 KB 0. 00%

Fi ni shed building target: MG64FNLM)xxx12_Proj ect . axf

These are exactly the same!

This is because although new source files have been added to the project, they will (probably)
not be referenced by any code in the project and hence no new functions or data will be included
in the final image. To make use of any new component, some of its new functionality must of
course be referenced.

Note: Some middleware components such as USB, are not compatible with the Add/Remove
component functionality and so will be hidden from the Add/Remove dialogue. The recommended
approach if such components are required is to import an example including the component and
modify as required. This restriction will be addressed in a future release.

Please also see for details of how to explore the composition of an
image in detail.

SDK Project Refresh

Using the above technology, MCUXpresso IDE projects can be refreshed with updated SDK
components.

When new SDKs are released for a particular MCU/Board, many source files will be updated,
bugs fixed, features added etc. If an existing SDK is replaced within MCUXpresso IDE by such a
new SDK, any updated (or changed) source files or source file sections can optionally be added
to existing project using an identical mechanism as described above.

To use this feature, simply select a project in the project explorer view and click to Refresh SDK
Components as indicated below.

Figure 7.5. SDK Component Management Project Refresh

» & frdmk64f_bubble

i I OO TR YU A PUPY W 1) Oy Tgag—"y
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The SDK Component Management wizard will guide you through the update process.

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022 73



NXP Semiconductors MCUXpresso IDE User Guide

8. Creating New Projects using Preinstalled Part Support

For Creating project using SDKs please see

To explore the range of preinstalled parts/MCUs simply click ‘New project’ in the Quickstart
panel. This will open a page similar to the figure below:

Target

[ BeN SDK Wizard

MD -
(D Creating project for device: LPC1548 with no board. A :‘ /
. Board and/or Device selection page
~ SDK MCUs Available boards B 1% &

MCUs from installed SDKs.
Please visit mcuxpresso.nxp.com to
obtain additional SDKs.

Please select an available board for your project.

LPCXpresso1549 LPCXpresso1347 LPCXpresso1343 LPCXpresso1227

NXP LPC1548
LPC1517
LPC1518
LPC1518
LPC1547
LPC1548
LPC1548

»LPC1700
»LPC177x_8x

»LPC18xx
wﬂﬂdﬂ?: Ry

(ﬂreinstatlad MCUs \ f
MCUs from preinstalled LPC and

generic Cortex-M part support

LPCXpresso11C24 LPCXpresso1115 LPCXpresso11U37H LPCXpresso11U14

Selected Device: LPC1549 with no board. SDKs for selected MCU

Target Core: cm0 Name SDK Version  Manifest Versiol Location
Description: Cortex-M3 based microcontraoller, with USB and up to 256KB Flash
and 36K RAM
?) Cancel

Figure 8.1. New Project Wizard Preinstalled

8.1
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The list of preinstalled parts is presented on the bottom left of this window.

You will also see a range of related development boards indicating whether a matching board
support library (LPCOpen or CodeBundles) is available.

For details of this page see:

New Project Wizard

This wizard page provides a number of ways of quickly selecting the target for the project that
you want to create.

In this description, we are going to create a project for an LPC4337 MCU. For this MCU an

LPCOpen library is available, so we can locate this MCU using the board filter. Note: Boards will
be displayed where either LPCOpen or CodeBundle projects exist.

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022 74



NXP Semiconductors MCUXpresso IDE User Guide

Note: LPCOpen is described in section

To reduce the number of boards displayed, we can simply type ‘4337’ into the filter so only boards
with MCUSs containing ‘4337’ will be displayed.

* SDK MCUs

Target

NXP LPC4337
LPCa325
LPC4325-M0
LPCa327
LPC4327-M0
LPC4330
LPC4330-M0
LPCa3a3
PCA333-MO

LPC4337-M0

Target Core:
Description:

(D) Creating project for device: LPC4337 using board: LPCXpresso4337 ‘ L :” F

. Board and/or Device selection page

MGt "‘.”!‘ inatalled SDKS. Bleasagelect an available board for your project.
Please visit mcuxpresso.nxp.com to
obtain additional SDKs, 4337

- Preinstalled MCUs
MCUs from preinstalled LPC and
generic Cortex-M part support

Selected Device: LPC4337 using board: LPCXpresso4337 SDKs for selected MCU

Figure 8.2. New Project Wizard selection for Preinstalled MCUs

SDK Wizard

b Y &

Available boards 13 18, | &

LPCXpresso4337

cmO Name SDK Version  Manifest Versio Location
Multicore Cortex-M4/Cortex-MO based microcontroller, with up to TMB
Flash and 136KB RAM

8.2
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When a board is selected as highlighted in the above figure, the matching MCU (part) is also
selected automatically.

Note: if no matching board is available, the required MCU can be selected from the list of
Preinstalled MCUs.

Note: Boards added to MCUXpresso IDE from SDKs will have an ‘SDK’ graphic superimposed
on the board image. Boards without the SDK graphic indicate that a matching LPCOpen package
(or Code bundle) is available for that board and associated MCU.

With a chosen board selected, now click ‘Next’ to launch the next level of wizards. These wizards

for Preinstalled MCUs are very similar to those featured in LPCXpresso IDE and are described
in the next section.

Creating a Project

MCUXpresso IDE includes many project templates to allow the rapid creation of correctly
configured projects for specific MCUs.

This New Project wizard supports 2 types of projects:
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¢ Those targeting LPCOpen libraries
e Standalone projects

In addition, certain MCUs like the LPC4337 support multiple cores internally, for these MCUs,
Multicore options will also be presented (as below):

@ e
New project...

LPC43xx (Cortex-M4 basic) -» C Project (Semihosted)

. Wizard selection page.

Wizard
YLPC1800 /LPC4300
¥ LPC43xx (Cortex-M4 basic)

( LPCOpen - C Project
LPCOpen - C Static Library Project
LPCOpen - C++ Project

\ LPCOpen - C++ Static Library Project
C Project
C Project (Semihosted)
C Static Library Project
C++ Project

4+ jc Libri ject
¥LPC43xx Multicore M4
LPCOpen - C Project
L LPCOpen - C++ Project
[ C Praject
C Project (Semihosted)
L C++ Project
@ [ Next> IR

Figure 8.3. New project: wizard selection

You can now select the type of project that you wish to create (see below for details of Wizard
types).

In this case, we will show the steps in creating a simple C ‘Hello World’ example project.

8.2.1 Selecting the Wizard Type

For most MCU families MCUXpresso IDE provides wizards for two forms of project: LPCOpen
and non-LPCOpen. For more details on LPCOpen, see
. For both kinds, the main wizards available are:

C Project

e Creates a simple C project, with the min() routine consisting of an infinite wiie(1) loop that
increments a counter.

« For LPCOpen projects, code will also be included to initialize the board and enable an LED.

C++ Project

¢ Creates a simple C++ project, with the nai n() routine consisting of an infinite wni1e(1) loop that
increments a counter.

« For LPCOpen projects, code will also be included to initialize the board and enable an LED.
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8.2.2

8.2.3
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C Static Library Project

¢ Creates a simple static library project, containing a source directory and, optionally, a directory
to contain include files. The project will also contain a “liblinks.xml” file, which can be used by
the smart update wizard on the context-sensitive menu to create links from application projects
to this library project. For more details, please see the FAQ at:

https://community.nxp.com/message/630594

C++ Static Library Project

¢ Creates a simple (C++) static library project, like that produced by the C Static Library Project
wizard, but with the tools set up to build C++ rather than C code.

The non-LPCOpen wizard families also include a further wizard:

Semihosting C Project

« Creates a simple “Hello World” project, with the mai n() routine containing a printf() call, which
will cause the text to be displayed within the Console View of MCUXpresso IDE. This is
implemented using “semihosting” functionality. See the section on for
more information.

Configuring the Project

Once you have selected the appropriate project wizard, you will be able to enter the name of
your new project, this must be unique for the current workspace.

Finally you will be presented with one or more “Options” pages that provide the ability to set
a number of project-specific options. The choices presented will depend upon which MCU you
are targeting and the specific wizard you selected, and may also change between versions of
MCUXpresso IDE. Note: if you have any doubts over any of the options, then we would normally
recommend leaving them set to their default values.

The following sections detail some of the options that you may see when running through a
wizard.

Wizard Options

The wizard will present a set of pages (that will vary based on the chosen MCU), many of these
pages will typically require no user change since the common default values are already preset.
The pages may include:

LPCOpen Library Project Selection

When creating an LPCOpen-based project, the first option page that you will see is the LPCOpen
library selection page.
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[ ] [ ]
New project..

@ Select an LPCOpen Chip library project within the current workspace

. Wizard properties page.

Select the LPCOpen Chip and (optionally) Board library project(s) that you want your new project
to link against.

Selected library project(s) must be present in this workspace. If they are not,

= Import...
then click the 'Import' button to run the Import Wizard

Select LPCOpen Libraries

LPCOpen Chip Library Project Ipe_chip_43xx “ Browsa...

LPCOpen Board Library B
Project

Browse...

If a Board Library Project is selected, then the corresponding Chip Library Project must also be
selected

@ < Back Cancel

Figure 8.4. LPCOpen library selection

This page allows you to run an “Import wizard” to download the LPCOpen bundle for your target
MCU/board from https://www.nxp.com/Ipcopen and import it into your Workspace, if you have
not already done so.

You will then need to select the LPCOpen Chip library for your MCU using the Workspace
browser (and for some MCUs an appropriate value will also be available from the drop down next
to the Browse button). Note: the wizard will not allow you to continue until you have selected a
library project that exists within the Workspace.

Finally, you can optionally select the LPCOpen Board library for the board that your MCU is fitted
to, using the Workspace browser (and again, in some cases an appropriate value may also be
available from the drop down next to the Browse button). Although selection of a board library is
optional, it is recommended that you do this in most cases.

CMSIS-CORE Selection

For backwards compatibility reasons, the non-LPCOpen wizards for many parts provide the
ability to link a new project with a CMSIS-CORE library project. The CMSIS-CORE portion of
ARM'’s Cortex Microcontroller Software Interface Standard (or CMSIS) provides a defined
way of accessing MCU peripheral registers, as well as code for initializing an MCU and accessing
various aspects of functionality of the Cortex CPU itself. MCUXpresso IDE typically provides
support for CMSIS through the provision of CMSIS library projects. CMSIS-CORE library projects
can be found in the Examples directory of your MCUXpresso IDE installation.

Generally, if you wish to use CMSIS-CORE Ilibrary projects, you should use
OMBI S_CORE_<part fani | y> (these projects use components from ARM’s CMSIS v3.20 specification).
MCUXpresso IDE does in some cases provide libraries based on early versions of the CMSIS
specification with names such as cvsi svip3o_<part fani I y>, but these are not recommended for use
in new projects.
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The CMSIS library option within MCUXpresso IDE allows you to select which (if any) CMSIS-
CORE library you want to link to from the project you are creating. Note: you will need to import
the appropriate CMSIS-CORE library project into the workspace before the wizard will allow you
to continue.

For more information on CMSIS and its support in MCUXpresso IDE, please see the FAQ at:
https://community.nxp.com/message/630589

Note: The use of LPCOpen instead of CMSIS-CORE library projects is recommended in most
cases for new projects. (In fact LPCOpen actually builds on top of many aspects of CMSIS-
CORE.) For more details see

CMSIS DSP Library Selection

ARM’s Cortex Microcontroller Software Interface Standard (or CMSIS) specification also
provides a definition and implementation of a DSP library. MCUXpresso IDE provides prebuilt
library projects for the CMSIS DSP library for Cortex-M0/MO0+, Cortex-M3 and Cortex-M4 parts,
although a source version of it is also provided within the MCUXpresso IDE Examples.

Note: The CMSIS DSP library can be used with both LPCOpen and non-LPCOpen projects.
Peripheral Driver Selection

For some parts, one or more peripheral driver library projects may be available for the target
MCU from within the Examples area of your MCUXpresso IDE installation. The non-LPCOpen
wizards allow you to create appropriate links to such library projects when creating a new project.
You will need to ensure that you have imported such libraries from the Examples before selecting
them in the wizard.

Note: The use of LPCOpen rather than these peripheral driver projects is recommended in most
cases for new projects.

Enable use of Floating Point Hardware

Certain MCUs may include a hardware floating point unit (for example NXP LPC32xx,
LPC407x_8x, and LPC43xx parts). This option will set appropriate build options so that code is
built to use the hardware floating point unit and will also cause startup code to enable the unit
to be included.

Code Read Protect

NXP’s Cortex based LPC MCUs provide a “Code Read Protect” (CRP) mechanism to prevent
certain types of access to internal Flash memory by external tools when a specific memory
location in the internal Flash contains a specific value. MCUXpresso IDE provides support
for setting this memory location. See the section on for more
information.

Enable use of rondivide Library

Certain NXP Cortex-M0 based MCUs, such as LPC11Axx, LPC11Exx, LPC11Uxx, and LPC12xx,
include optimized code in ROM to carry out divide operations. This option enables the use of
these Romdivide library functions. For more details see the FAQ at:

https://community.nxp.com/message/630743
Disable Watchdog

Unlike most MCUs, NXP’s LPC12xx MCUs enable the watchdog timer by default at reset. This
option disables that default behaviour. For more details, please see the FAQ at:

https://community.nxp.com/message/630654
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LPC1102 ISP Pin

The provision of a pin to trigger entry to NXP’s ISP bootloader at reset is not hardwired on the
LPC1102, unlike other NXP MCUs. This option allows the generation of default code for providing
an ISP pin. For more information, please see NXP’s application note, AN11015, “Adding ISP to
LPC1102 systems”.

Memory Configuration Editor

For certain MCUs such as the LPC18xx and LPC43xx, the wizard will present the option to edit
the target memory configuration. This is because these parts may make use of external SPIFI
Flash memory and hence this can be described here if required. For more information please
see: and also

Note: Memory configuration can of course also be edited after a project has been created.
Redlib Printf Options

The “Semihosting C Project” wizard for some parts provides two options for configuring the
implementation of printf family functions that will get pulled in from the Redlib C library:

¢ Use non-floating-point version of printf
« If your application does not pass floating point numbers to printf () family functions, you can
select a non-floating-point variant of printf. This will help to reduce the code size of your
application.
« For MCUs where the wizard does not provide this option, you can cause the same effect by
adding the symbol cr | NTEGER PRI NTF tO the project properties.

¢ Use character- rather than string-based printf

» By default printf() and puts() make use of maioc() to provide a temporary buffer on the
heap in order to generate the string to be displayed. Enable this option to switch to using
“character-by-character” versions of these functions (which do not require heap space). This
can be useful, for example, if you are retargeting printf() to write out over a UART — since
in this case it is pointless creating a temporary buffer to store the whole string, only to print
it out over the UART one character at a time.

« For MCUs where the wizard does not provide this option, you can cause the same effect by
adding the symbol cr_pri NTF_cHAR tO the project properties.

Note: if you only require the display of fixed strings, then using puts() rather than printf() will
noticeably reduce the code size of your application.

For more information see

Project Created

Having selected the appropriate options, you can then click on the Finish button, and the wizard
will create your project for you, together with appropriate startup code and a simple min. ¢ file.
Build options for the project will be configured appropriately for the MCU that you selected in
the project wizard.

You should then be able to build and debug your project, as described in Section 9.5 and
Chapter 11.
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9. Importing Example Projects (from the file system)

9.1

MCUXpresso IDE User Guide -

MCUXpresso IDE supports two schemes for importing examples:

¢ From SDKs — using the Quickstart Panel -> Import SDK example(s). See

« From the filing system — using the Quickstart Panel -> Import project(s) from file System
« this option is discussed below:

Drag and Drop

@ MCUXpresso IDE project(s) can be imported directly into a workspace by simply
dragging a folder (or zip) containing MCUXpresso IDE projects onto the Project
Explorer view. Note: this will import all projects within a folder (or zip). Projects
can also be exported by dragging directly from the Project Explorer view onto a
filer, or directly into another instance of the IDE. See

for more information. Due to underlying Eclipse changes in Version

11.1.0, Drag and Drop can only be used to import projects, when one or more project
already exists within a Workspace

Note: This option can also be used to import projects exported from MCUXpresso IDE. See

MCUXpresso IDE installs with a large number of example projects for preinstalled parts, that can
be imported directly into a workspace: These are located at:

<install_dir>/idel/ Exanpl es

and consist of:

« CMSIS-DSPLIB
 asuite of common signal processing functions for use on Cortex-M processor based devices.
CodeBundles for LPC800 family

« which consist of software examples to teach users how to program the peripherals at a basic
level.

FlashDrivers
« example projects to create Flash driver used by LinkServer
* Legacy
» arange of historic examples and drivers including CMSIS / Peripheral Driver Library
e LPCOpen
« High quality board and chip support libraries for LPC MCUs, plus example projects

Code Bundles for LPC800 Family Devices

The LPC800 Family of MCUs are ideal for customers who want to make the transition from 8
and 16-bit MCUs to the Cortex MO/MO+. For this purpose, we've created Code Bundles which
consist of software examples to teach users how to program the peripherals at a basic level. The
examples provide register level peripheral access, and direct correspondence to the memory
map in the MCU User Manual. Examples are concise and accurate explanations are provided
within any readme and source file comments. Code Bundles for LPC800 family devices are made
available at the time of the series product launch, ready for use with a range of tools including
MCUXpresso IDE.

More information on code bundles together with latest downloads can be found at:

https://www.nxp.com/LPC800-Code-Bundles
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9.2

9.3
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LPCOpen Software Drivers and Examples

Note: LPCOpen is no longer under active development, new MCU'’s from NXP are supported by
SDKs. Certain parts such as some members of the LPC54xxx families are available with both
LPCOpen and SDK support.

LPCOpen is an extensive collection of free software libraries (drivers and middleware) and
example programs that enable developers to create multifunctional products based on LPC
microcontrollers. Access to LPCOpen is free to all LPC developers.

Amongst the features of LPCOpen are:

¢ MCU peripheral device drivers with meaningful examples

* Common APIs across device families

« Commonly needed third party and open source software ports

¢ Support for Keil, IAR and LPCXpresso/MCUXpresso IDE toolchains

LPCOpen is thoroughly tested and maintained. The latest LPCOpen software now available
provides:

« MCU family-specific download package

¢ Support for USB ROM drivers

« Improved code organization and drivers (efficiency, features)

e Improved support for MCUXpresso IDE

CMSIS / Peripheral Driver Library / code bundle software packages are still available, from
within your install_dir/ide/Examples/Legacy folder. However, these should only be used for
existing development work. When starting a new evaluation or product development, we would
recommend the use of LPCOpen if available.

More information on LPCOpen together with package downloads can be found at:

https://lwww.nxp.com/Ipcopen

Importing an Example Project

To import an example project from the file system, locate the Quickstart panel and select ‘Import
projects from Filesystem’
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MCUXpresso IDE - Quickstart Panel

_oe | No project selected
~ Create or import a project

. New project...
/ . Import SDK example(s)...
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® Import project(s) from file system...

~ Build your project
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~ Debug your project

~ Miscellaneous
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& Quick Settings>>
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lo¢ Build all projects []
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Figure 9.1. Importing project(s)
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From here you can browse the file system.
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® @ Import project(s) from file system...
Import project(s) from file system... i
Select the examples archive file to import. Z y

Projects are contained within archives (.zip) or are unpacked within a directory. Select your
project archive or root directory and press <Nexts. On the next page, select those projects you
wish to import, and press <Finish>.

Project archives for LPCOpen and 'legacy’ examples are provided.

Project archive (zip)

Archive || Browse...

Project directory (unpacked)

Root directory Browse...

LPCOpen

LPCOpen is the recommended code base for Cortex-M based NXP LPC Microcontrollers.

MCUXpresse IDE includes the LPCOpen packages which can be imported directly by pressing the Browse
button in the Project archive (zip) section, above, and navigating to the Examples/LPCOpen directory.

Alternatively, press the button below to Browse the nxp.com website for latest resources.

Browse LPCOpen resources on nxp.com...

@ Cancel

Figure 9.2. Importing examples

9.3.1
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* Browse to locate Examples stored in zip archive files on your local system. These could
be archives that you have previously downloaded (for example LPCOpen packages from
https://www.nxp.com/Ipcopen or the supplied, but deprecated, sample code located within the
Examples/Legacy subdirectory of your MCUXpresso IDE installation).

« Browse to locate projects stored in directory form on your local system (for example, you can
use this to import projects from a different Workspace into the current Workspace).

« Browse LPCOpen resources to visit https://www.nxp.com/lpcopen and download an
appropriate LPCOpen package for your target MCU. This option will automatically open a web
browser onto a suitable links page.

To demonstrate how to use the Import Project(s) functionality, we will now import the LPCOpen
examples for the LPCXpresso4337 development board.

Importing Examples for the LPCXpresso04337 Development Board

First of all, assuming that you have not previously downloaded the appropriate LPCOpen
package, click on Browse LPCOpen Resources, which will open a web browser window. Click
on LPC4300 Series, and then locate NXP LPCXpress04337, and then download 2.xx version
for LPCXpresso Toolchain (LPCOpen packages created for LPCXpresso IDE are compatible
with MCUXpresso IDE).

Note: LPCOpen Packages for the LPC4337 are preinstalled and located at:

<install_dir>/ide/ Exanpl es/ LPCOpen/ . ..

Once the package has downloaded, return to the Import Project(s) dialog and click on the Browse
button next to Project archive (zip); then locate the LPCOpen LPCXpresso4337 package
archive previously downloaded. Select the archive, click Open and then click Next. You will then
be presented with a list of projects within the archive, as shown in Figure 9.3.
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Figure 9.3. Selecting projects to import

@ e Import project(s)
Import project(s) il —
¢ Select a directory to search for existing Eclipse projects. / /
|
Projects:
freertos_blinky (freertos_blinky) Select All
lib_lpcspifilib {lib_lpespifilib)
I|pc_board_nxp_lpexpresso_4337 (lpe_board_nxp_lpcxpresso_4337) Deselect All
|pc_board_nxp_lpcxpresso_4337_m0 (lpc_board_nxp_lpcxpresso_4337 _n
1 lpc_chip_43xx (lpc_chip_43xx) Refresh
Ipc_chip_43xx_m0 (Ipc_chip_43xx_m0)
LPCUSBIib_AudioOutputHost (LPCUSBIib_AudicOutputHost)
LPCUSBIib_KeyboardHost (LPCUSBIib_KeyboardHost)
LPCUSBIlib_MassStorageHost (LPCUSBIlib_MassStorageHost)
LPCUSBIib_SerialHost (LPCUSBIib_SerialHost)
Iwip_freertos_tcpecho (Iwip_freertos_tcpecho)
Iwip_freertos webserver (lwip_freertos webserver)
i , |
Options
i i
3
Working sets
Add project to working sets
Working sets:

9.4
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Select the projects you want to import and then click Finish. The examples will be imported into
your Workspace.

Note: generally, it is a good idea to leave all projects selected when doing an import from a zip
archive file of examples. This is certainly true the first time you import an example set, when you
will not necessarily be aware of any dependencies between projects. In most cases, an archive
of projects will contain one or more library projects, which are used by the actual application
projects within the examples. If you do not import these library projects, then the application
projects will fail to build.

Exporting Projects

MCUXpresso IDE provides the following export options from the Quickstart panel:

¢ Export project(s) to archive (zip)
« Export project(s) and references to archive (zip)

« choose this option to export project(s) and automatically also export referenced libraries
To export one or more projects, first select the project(s) in the Project Explorer then from the
Quickstart Panel -> Export project(s) to archive (zip). This will launch a filer window. Simply
select the destination and enter a name for the archive to be exported then click ‘OK’.

Also please see for information about dragging and
dropping projects.
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9.5 Building Projects

Building the projects in a workspace is a simple case of using the Quickstart Panel to “Build all
projects”. Alternatively, a single project can be selected in the ‘Project Explorer’ View and built.
Note: building a single project may also trigger a build of any associated or referenced project.

9.5.1 Build Configurations

By default, each project will be created with two different “build configurations”: Debug and
Release. Each build configuration will contain a distinct set of build options. Thus a Debug build
will typically compile its code with optimizations disabled ( - ) and Release will compile its code
optimizing for minimum code size ( -cs). The currently selected build configuration for a project
will be displayed after its name in the Quickstart Panel’s Build/Clean/Debug options.

For more information on switching between build configurations, see
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10. Debug Solutions Overview

MCUXpresso IDE installs with built-in support for 3 debug (hardware) solutions; comprising the
as used in LPCXpresso IDE. Plus support for

both and . This support includes the installation of all
necessary drivers and supporting software.

The rest of this chapter discusses these different Debug solutions. For general information on
debugging please see the chapter

Note: Within MCUXpresso IDE, the debug solution used has no impact on project setting or build
configuration. Debug operations for basic debug are also identical.

10.1 Starting a Debug Session

With a suitable board and debug probe connected (usually via USB), to start a debug session:

1. select a project to debug within the MCUXpresso IDE Project View
2. click Debug from within the MCUXpresso IDE Quickstart View

) Quickstart Panel &3 Variables ]

I Project: evkmimxrt1060_iled_blinky [Debug] i

~ Create or import a project

B8 New project...
. Import SDK example(s)...

& Import project(s) from file system..

~ Build your project

& Build
& Clean
~ Debug your project ‘ E" ﬂ'

| 4% Debug ]
~ Miscellaneous

B Edit project settings

. MCUXpresso Config Tools> >

®2 Quick Settings>>

& Export project(s) to archive (zip)

B Export project(s) and references to archive (zip)
we Build all projects [Debug]

) B

¢ adebug probe discovery operation is automatically performed to display the available debug
connections (i.e. the detected debug probes), including LinkServer, PEmicro and J-Link
compatible probes.

3. select the required debug probe and click OK

« at this stage a project is automatically created within the project
containing debug specific configurations

« if the debug connection is successful a Debug view will appear typically showing the project
has stopped on main()

%5 Debug 2 i v= A
v evkmimxrt‘l060j\ed,blinky LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application]
v 2 evkmimxrt1060_iled_blinky.axf [MIMXRT1062xxxxA (cortex-m7)]
¥ Thread #1 1 (Suspended : Breakpoint)
= main() at led_blinky.c:57 0x60002572
s arm-none-eabi-gdb (8.2.50.20181213)
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Tip

@ Once a project has been debugged, the launch configuration will contain details of
the debug probe used. Subsequent debug sessions will automatically select this
probe if it is available.

From this point onwards, the low level debug operations are controlled by one of the debug
solutions mentioned above.

However, from the user’s point of view most common debug operations within the IDE will appear
the same (or broadly similar), for example:

¢ Automatic inheritance of part knowledge
¢ Automatic downloading (programming) of generated image to target Flash memory
« LinkServer/CMSIS-DAP Flash programming — see the chapter

¢ Automatic
e Setting and
. (single, step in step out etc.)

e Viewing and editing , , '
* Viewing and editing
¢ Viewing

« Instruction Trace is supported for all debug solutions, please see Instruction Trace Guide for
more information

* SWO Trace is supported for all debug solutions including profiling, interrupt trace etc. please
see SWO Trace Guide for more information

* Viewing details of execution faults via the (automatically displayed for faults
generated during LinkServer debug, a pause will be required for other debug solutions)

Additional documentation is also available covering:

« Power/Energy Measurement — please see Energy Measurement Guide
FreeRTOS Debug — please see FreeRTOS Debug Guide

Azure RTOS ThreadX Debug — please see Azure RTOS ThreadX Debug Guide
Zephyr RTOS Debug — please see Zephyr RTOS Debug Guide

MQX RTOS Debug — please see MQX RTOS Debug Guide

Note: In addition MCUXpresso IDE will dynamically manage each debug solutions connection
requirements allowing multiple sessions to be started without conflict. For debug of Multicore
MCUs please refer to the section

It is important to note that certain operations such as the handling of features via

may be different for each debug solution. Furthermore, advanced debug
features and capabilities may vary between solutions and even similar features may appear
different within the IDE.

PEmicro and SEGGER debug solutions also provide a number of advanced features, details can
be found at their respective web sites.

10.2 An Introduction to Launch Configuration Files
The debug properties of a project in MCUXpresso IDE are held locally within each project in
Jaunch files (known as Launch Configuration files).
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Launch configuration files are different for each debug solution (LinkServer, PEmicro, SEGGER)
and contain the properties of the debug connection (SWD/JTAG, and various other configurations
etc.) and can also include a debug probe identifier for automatic debug probe matching and
selection.

If a project has not yet been debugged, for example a newly imported or created project, then
the project will not have a launch configuration associated with it.

When the user first tries to debug a project, MCUXpresso IDE will perform a Debug Probe
Discovery operation and present the user with a list of debug probes found. Note: The Debug
Solutions searched can be filtered from this dialogue as highlighted, removing options that are
not required will speed up this process.

[ AN Probes discovered
Connect to target: MK64FN1MOxxx12

1 probe found. Select the probe to use:

Available attached probes

Name Serial number/ID Type Manufacturer IDE Debug Mode

LPC-LINK2 CMSIS-DAP V5.361 _[IQCYI2IV NXP Semico...

Supported Prebes (tick/untick to enable/disable)

MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes

SEGGER J-Link probes

Probe search options

Search again

'@' Cancel -ir-

Figure 10.1. Debug Probe Discovery

Once the debug probe is selected and the user clicks ‘OK’, the IDE will automatically create a
default launch configuration file for that debug probe (LinkServer launch configuration shown
below).

5 Project 52 | 2, Periph  }if Regist #sFaults = O
S #% B <
» & Project Settings
» 1)l Includes
» (2 CMSIS
» (2 accel
» (2 board
» B drivers
» (2 source
» (2 startup
» (2 utilities
eioHo~

[ B frdmk&4f_bubble LinkServer Debug.launch]

Figure 10.2. Launch Configuration Files

Note: a launch configuration will only be created for the currently selected build configuration.
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For many debug operations, these files won't require any attention and can essentially be
ignored. However, if changes are required, these files should not be edited manually, rather their
properties should be explored within the IDE.

The simplest way to do this is to click to expand the Project within the ‘Project Explorer’ pane,
then simply double click a launch configuration file to automatically open the launch configuration
Edit Configuration dialogue.

Note: This dialogue has a number of internal tabs, the Debugger tab (as shown below) contains
the Debug main settings. See also the

| @ edit Configuration u} x

| L
| Medify configuration and continue. @\ |
| & |

|
|
Name: | Ipoxpresso55569_threadx_demo LinkServer Debug

Main | 1 GDE Debuggdr [ LinkServer Debugger ¢ GUI Flash Tool | % Other Symbols| & Startup | %+ Source| ] Common
® LinkServer Debugger
Debug Options
Debug Connection WD~
LinkServer Options
= Debug Connection
[ Attach only []Reset on Connect [] Disable use of preconnect script
Reset script ~ | Workspace_.  File System...
Connect script Workspace—. File System..
BootROM stall | 050000040
Flash driver reset handling *~ | Reset handling
Disconnect behavior cont | Semihosting support On

= Advanced Settings

[IMemory checking ] Debug memory cache [ Enable range stepping [ Enable flash hashing
Debug level 2

Overide core index

Wirespeed (Hz

Additional options

Pre launch command

2 Cancel

Figure 10.3. Launch Configuration

Some debug solutions support advanced operations (such as the recovering of badly
programmed parts) from this view.

Note: Once a launch configuration file has been created, it will be used for the projects future
debug operations. If you wish to use the project with a different debug probe, then simply delete
the existing launch configuration and allow a new one to be automatically used on the next debug
operation.

Tip

@ To simplify this operation, a probe discovery can be forced by holding the SHIFT
key while launching a debug session from the Quickstart panel. If the new debug
connection is completed, a new project launch configuration will be created replacing
any existing launch configurations. Alternatively, the are
available to force the use of a particular debug solution.
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10.3

10.4
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Tip

@ When exporting a project to share with others, launch configurations should usually
be deleted before export (along with other IDE generated folders such as build
configuration folders (Debug/Release if present)).

For further information please see the section

LinkServer Debug Connections

MCUXpresso IDE’s native debug connection (known as LinkServer) supports debug operation
through the following debug probes:

¢ MCU-Link and MCU-Link Pro with CMSIS-DAP firmware

« Evaluation boards incorporating MCU-Link with CMSIS-DAP firmware

¢ LPC-Link2 with CMSIS-DAP firmware

e LPCXpresso V2/V3 Boards incorporating LPC-Link2 with CMSIS-DAP firmware

¢ CMSIS-DAP firmware installed onto on-board debug probe hardware (as shipped by default
on LPCXpresso MAX and CD boards)

« For more information on LPCXpresso boards see: https://www.nxp.com/Ipcxpresso-boards
» Additional driver may be required:
* https://developer.mbed.org/handbook/Windows-serial-configuration

¢ CMSIS-DAP firmware installed onto on-board OpenSDA debug probe hardware (as shipped
by default on certain Kinetis FRDM and TWR boards)

¢ Known as DAP-Link and mBed CMSIS-DAP: https://www.nxp.com/opensda
» Additional driver may be required:
« https://developer.mbed.org/handbook/Windows-serial-configuration

e Other CMSIS-DAP probes such as Keil uLINK with CMSIS-DAP firmware: https:/
www?2.keil.com/mdk5/ulink

¢ Legacy RedProbe+ and LPC-Link
 RDB1768 development board built-in debug connector (RDB-Link)
* RDB4078 development board built-in debug connector

Note: MCUXpresso IDE will automatically try to softload the latest CMSIS-DAP firmware onto

LPC-Link2 or LPCXpresso V2/V3 boards. For this to occur, the DFU link on these boards must
be set correctly. Please refer to the board’s documentation for details.

LinkServer Debug Operation

When the user first tries to debug a project, MCUXpresso IDE will perform a Debug Probe
Discovery operation and present the user with a list of debug probes found.

Note: To perform a debug operation within MCUXpresso IDE, select the project to debug within
the ‘Project Explorer’ view and then click Debug from the Quickstart View.

If more than one debug probe is presented, select the required probe. For LinkServer compatible
debug probes, you can select from Non-Stop (the default) or All-Stop IDE debug mode.

Non-Stop uses GDB'’s “non-stop mode” and allows data to be read from the target while

an application is running. Currently this mechanism is used to support the
and features.

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022 91


https://www.nxp.com/lpcxpresso-boards
https://developer.mbed.org/handbook/Windows-serial-configuration
https://www.nxp.com/opensda
https://developer.mbed.org/handbook/Windows-serial-configuration
https://www2.keil.com/mdk5/ulink
https://www2.keil.com/mdk5/ulink

NXP Semiconductors MCUXpresso IDE User Guide

Probes discovered
Connect to target: MK64FN1MOxxx12

1 probe found. Select the probe to use:

Available attached probes

Name Serial number/ID Type Manufacturer IDE Debug Mode
LPC-LINKZ CMSIS-DAP... IWFUATEW LinkServer NXP Semico..] Non-Stop

Non-Stop

Supported Probes (tick/untick to enable/disable}

@ MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes

SEGGER J-Link probes

Probe search options

Search again

Remember my selection (for this Launch configuration)

2) Cancel OK

Figure 10.4. Debug Probe Discovery Non-Stop

Click ‘OK’ to start the debug session. At this point, the projects launch configuration files will be
created. LinkServer Launch configuration files will contain the string ‘LinkServer’ and have an
LS icon.

Note: If “Remember my selection” is left ticked, then the probe details will be stored within the
launch configuration file, and this probe will be automatically selected on subsequent debug
operations for this project.

For a description of some common debugging operations using supported debug probes see
MCUXpresso IDE defaults to the selection of “Non-Stop” mode when a LinkServer probe
discovery operation is performed. This default can be changed from an MCUXpresso IDE

Preference via:

Preferences -> MCUXpresso IDE -> Debug Options -> LinkServer Options -> Miscellaneous
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e e Preferences
Miscellaneous o g

P General 5

»C/Ces LinkServer Debug Miscellaneous Options

»Help RedLink Server Connection Timeout (s) 10

P Install/Update

¥ Library Hover SWV Packet Timeout 0

MCUXpresso Config Tools Extended debug trace (DEBUG_TRACE)
¥MCUXpresso IDE
¥Debug Options Stream all stub messages to Console

J-Link Options
¥LinkServer Options
Advanced Show debug log when written to
DELI O

Probe Discovery
Default Tool settings

Show stub warnings as notes

Display asynchranous error messages
Disable Auta-select device on multicore target

Enable Auto-debug slave project(s) for multicore projects

» Editor Awareness Auto-debug slave project(s) delay for multicore projects (ms) | 1000
General
MCU settings Always show JTAG selection dialog
Paths and Directories | Show progress messages in log
Quickstart Panel
»RTOS TAD @ Show extended debug messages _
¥ SDK Handling Enable Non-Stop Mode
SWO Trace
User Interface Enablemer Enable Registers View Double-Precision registers group
Utilities SWV Server Port 9
¥ Run/Debug
SWTChart Extensions LPC-Link DFU boot wait tima 10
> Terminal
Validation
I Version Control {Team) Restore Defaults Apply
XML
@ g e Cancel

Figure 10.5. LinkServer Non Stop Preference

For a given project, the Non-Stop mode option is stored within the project’s launch configuration.
For projects that already have launch configurations, this option can be changed from the GDB
Debugger tab as shown below.

[} Main | 35 GDB Debugger | (IE) LinkServer Debugger | 3 Other Symbals & GUI Flash Tool | g Startup | 5 Source | [] Common

Debugger Options

GDE debugger: arm-none-eabi-gdb Browse.

GDB command file: Browse.

(Warning: Some commands in this file may interfere with the startup operation of the debugger, for example "run".)

Non-stop mode (Note: Requires non-stop GDB) I

Enable Reverse Debugging at startup using: | Software Reverse Debugging (detailed but slower) B
Force thread list update on suspend

Automatically debug forked processes (Note: Requires Multi Process GDB)

Tracepeint mode: |~ Normal B

Figure 10.6. LinkServer Non Stop Control

10.4.1 LinkServer Debug Scripts

LinkServer debugging support a scripting language which is discussed in the section

A LinkServer debug connection has 3 potential callouts where scripts can be referenced typically
to perform some non standard behaviour.

Connect Script a Connect Script overrides the default debug connection behaviour. Typically
such scripts are used to prepare the debug target (MCU) for a debug operation that may
otherwise fail due to some target setting that cannot be guaranteed post reset. A common
requirement could be to ensure that RAM is available for Flash Programming operations. If
required, a Connect Script is referenced within a LinkServer debug Launch Configuration.

Reset Script a Reset Script overrides the default debug reset behaviour. Reset Scripts are
less commonly required than Connect Scripts but can be used to work around issues where
a standard Reset may not allow debug operations to survive. If required, a Reset Script is
referenced within a LinkServer debug Launch Configuration.
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10.5

10.5.1
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On rare occasions it may be useful to add a Connect or Reset Script to a project, see
for more information on how this can be done.

Preconnect Script a Preconnect Script is a little different. Such a scripts (if present) prepares
the target MCU for an initial debug connection that may/would otherwise fail. Preconnect Scripts
are not specified within a launch configuration, rather they are automatically invoked by the IDE
for a given target based on built in intelligence. However, their use can be disabled by a checkbox
within the project’s Launch Configuration. On rare occasions it may be useful to add a preconnect
script to a project —this can be done by placing a file called LS_preconnect.scp within the project’s
directory.

Note: In most circumstances, such scripts are supplied and referenced (via SDKs) automatically
SO no user intervention or action is required.

LinkServer Troubleshooting

Debug Log

On occasion, it can be useful to explore the operations of a debug session in more detail. The
steps are logged into a console known as the Debug log. This log will be displayed when a Debug
operation begins, but by default, will be replaced by another view when execution starts. The
debug log is a standard log within the IDE’s Console view. To display this log, select the Console
and then click to view the various options (as below):

El Console 2 S BEELE M B. .= 8

- 1 RedlinkServer /

2 FreeRTOS Task Aware Debugger Console version 11.0.0 (201903291224)
& 3 CDT Global Build Console
£l 4 CDT Build Console [frdmk&4f_bubble]

+ (NXP Semiconductors) MCU Application] gdb traces
+ [ 6 frdmk64f_bubble Debug messages
7 frdmk64f_bubble LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application] frdmk64f_bubble.axf

The debug log displays a large amount of information which can be useful in tracking down
issues.

In the example debug log below, you can see that an initial Connect Script file has been run.
Connect scripts are required for debugging certain parts and are automatically added to launch
configuration files by the IDE if required. Next, the hardware features of the MCU are captured
and displayed, this includes the number of breakpoints and watchpoints available along with
details of various hardware components indicating what debug features might be available, for
example Instruction Trace.

Further down in this log you will see the selection of a Flash driver (FTFE_4K), the identification
of the part being debugged (in this case a K64), the programming progress and the speed of the
Flash programming operation (in this case over 95 KB/sec).

Tip

@ a line similar to flash variant ‘K 64 FTFE Generic 4K’ detected (1MB = 256*4K at
0x0) will be displayed for LinkServer Flash programming operations. The size of the
detected flash (in this example itis 1MB) and sector size (4KB) will be displayed here.
The sector size may be important since multiples of this size represent valid base
addresses for flash programming operations. For example, if the programming of
more than one image is required, the second image must begin on a 4KB boundary
beyond the end of any previously programmed image.
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Found part description in XM. file MK64F12_i nternal . xm
Reconnected to existing LinkServer process.

== SCRI PT: ki netisconnect.scp =============
Ki neti s Connect Scri pt

Connecting to Probe Index =1

This probe =1

This TAP = 0

This core = 0

Dpl D = 2BA01477

Assert NRESET

Reset pin state: 00

Power up Debug

MDM- AP API D:  0x001C0000

MDM AP Syst em Reset/ Hol d Reset/ Debug Request

MDM AP Control : 0x0000001C

MDM AP St atus (Fl ash Ready) : 0x00000032

Part is not secured

MDM AP Control : 0x00000014

Rel ease NRESET

Reset pin state: 01

MDM AP Control (Debug Request): 0x00000004

MDM AP St atus: 0x0001003A
MDM AP Core Hal ted
============= END SCRI PT
Probe Firnware: LPC-LINK2 CVSI S-DAP V5. 361 (NXP Semi conduct or s)

Serial Nunmber: | QCYI2lV

VID: PID: 1FC9: 0090

USB Pat h: USB_1f c9_0090_314000_f f 00

Using nenory fromcore O after searching for a good core

debug interface type = Cortex-M3/4 (DAP DP | D 2BA01477) over SWD TAP 0
Cortex-M4 (CPU | D 00000C24) on DAP AP 0O

nunber of h/w breakpoints = 6

processor type

nunmber of flash patches =2

nunber of h/w watchpoints = 4

Probe(0): Connected&Reset. Dpl D: 2BA01477. Cpul D 00000C24. |nfo: <None>
Debug protocol: SWD. RTCK: Disabl ed. Vector catch: Disabled.

Cont ent of CoreSi ght Debug ROV S):

RBASE EOOFF000: CI D B105100D PI D 04000BB4C4 ROM (type 0x1)

ROM 1 EOOOE000: CI D B1O5E00D PI D 04000BBOOC Gen SCS (type 0x0)

ROM 1 E0001000: CI D B1O5E00D PI D 04003BB002 Gen DWI (type 0x0)

ROM 1 E0002000: CI D B1O5E00D PI D 04002BB003 Gen FPB (type 0x0)

ROM 1 E0000000: CI D B1O5E00D PI D 04003BB001 Gen | TM (type 0x0)

ROM 1 E0040000: Cl D B105900D PI D 04000BB9A1 TPIU type Ox11 Trace Sink -
ROM 1 E0041000: CI D B105900D PI D 04000BB925
ROM 1 E0042000: CI D B105900D PI D 04003BB907
ROM 1 E0043000: CI D B105900D PI D 04001BB908
NXP: MK64FN1MDxxx12

DAP stride is 4096 bytes (1024 words)
Inspected v.2 On chip Kinetis Flash nmenory nodul e FTFE_4K. cf x

I mage 'Kinetis Sem Generic Nov 7 2019 19:12:49'

Openi ng flash driver FTFE 4K cf x

Sendi ng VECTRESET to run flash driver

Fl ash variant 'K 64 FTFE Generic 4K detected (1MB = 256*4K at 0x0)
C osing flash driver FTFE 4K cfx

Connect ed: was_reset=true. was_stopped=true

CSt
CSt
CSt ETB type 0x21 Trace Sink -
CSt

Awai ting tel net connection to port 3330 ...

MCUXpresso | DE RedlinkMilti Driver v11.1 (Nov 21 2019 14:13:54 - crt_enmu_cmredlink build 204)

TPIU

ETM type 0x13 Trace Source - Core
ETB
CSTF type 0x12 Trace Link - Trace funnel/router
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GDB nonst op node enabl ed

Openi ng flash driver FTFE 4K cfx (already resident)

Sendi ng VECTRESET to run flash driver

Fl ash variant 'K 64 FTFE Generic 4K detected (1MB = 256*4K at 0x0)
Witing 26880 bytes to address 0x00000000 in Fl ash

00001000 done 15% (4096 out of 26880)

00002000 done 30% (8192 out of 26880)

00003000 done 45% (12288 out of 26880)

00004000 done 60% (16384 out of 26880)

00005000 done 76% (20480 out of 26880)

00006000 done 91% (24576 out of 26880)

00007000 done 100% (28672 out of 26880)

Sectors witten: 7, unchanged: 0, total: 7

Erased/ Wote sector 0-6 with 26880 bytes in 276nsec

Cl osing flash driver FTFE 4K cfx

Fl ash Wite Done

Fl ash Program Sunmary: 26880 bytes in 0.28 seconds (95.11 KB/ sec)
Starting execution using systemreset and halt target

St opped (Was Reset) [Reset from Unknown]

St opped: Breakpoint #1

Flash Programming

Most debug sessions begin with the programming of Flash, followed by a reset of the MCU. Note:
If flash programming should fail then the debug operation will be aborted.

Starting with MCUXpresso IDE version 11.1.0 — most LinkServer flash drivers now implement a
Verify Same operation (via a flash hashing mechanism) for any flash sector that are unchanged
from previous debug operations.

Below is a fragment of a debug log repeating the previous debug operation. The log reports the
Sectors that were unchanged from the previous operation and the resultant overall speed of the
flash operation — in this case the equivalent of a programming speed of 937 KB/sec.

Opening flash driver FTFE_4K. cfx (al ready resident)

Sendi ng VECTRESET to run flash driver

Fl ash variant 'K 64 FTFE Ceneric 4K detected (1MB = 256*4K at 0x0)
Witing 26880 bytes to address 0x00000000 in Flash

Sectors witten: 0, unchanged: 7, total: 7

Erased/ Wote sector 0-6 with 26880 bytes in 28nsec

Closing flash driver FTFE_4K. cfx

Fl ash Wite Done

Fl ash Program Summary: 26880 bytes in 0.03 seconds (937.50 KB/ sec)
Starting execution using systemreset and halt target

St opped (Was Reset) [Reset from Unknown]

St opped: Breakpoi nt #1

Note in the unlikely event of this feature causing problems, it can be disabled from a project
LinkServer Launch Configuration by unchecking the Enable Flash hashing option. Alternatively,
the feature can be disabled as a workspace preference via MCUXpresso IDE -> Debug Options
-> LinkServer Options -> Enable flash hashing

Below is a brief discussion of the most common low level flash operations:

1. Sector Erase: internally Flash devices are divided into a number of sectors (or blocks), where
a sector is the smallest size of Flash that can be erased in a single operation. A sector will be
larger than a page (see below). Sectors are usually the same size for the whole Flash device,
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however this is not always the case. A sector base address will be aligned on a boundary that
is a multiple of its size. A sector erase is usually the first step in a flash programming sequence.

2. Page Program: internally Flash devices are divided into a hnumber of pages, where a page is
the smallest size that can be programmed in a single operation. A page will be smaller than a
sector. A page base addresses will be aligned on a boundary that is a multiple of its size.

3. Mass Erase: a mass erase will reset all the bytes in Flash (usually to Oxff). Such an
operation may clear any internal low level structuring such as protection of Flash areas (from
programming).

The programming of an image (or data) comprises repeated operations of sector erase followed
by a set of program page operations; until the sector is fully programmed or there is no more
data to program.

One of the common problems when programming Kinetis parts relates to their use of Flash
configuration block at offset 0x400. For more information please see:

. Flash sector sizes on Kinetis MCUs range from less than 1KB to
8KB, therefore the first Sector Erase performed may clear the value of this block to all OXFFs,
if this is not followed by a successful program operation and the part is reset, then it will likely
report as ‘Secured’ and subsequent debugging will not be possible until the part is recovered.

Such an event can occur if a debug operation is accidentally performed to the ‘wrong board’ so
a wrong Flash programmer is invoked.

Note: LinkServer mass erase operations will restore this Flash configuration block automatically
for Kinetis parts. However, if a Kinetis device is mass erased by sector, this mechanism will be
bypassed, therefore this operation should not be performed to Kinetis parts!

Should you need to recover a ‘locked’ part please see the section

LinkServer executables

LinkServer debug operations rely on 3 main debug executables.

e arm-none-eabi-gdb — this is a version of GDB built to target ARM based MCUs

e crt_emu_cm_redlink — this executable (known as the debug stub) communicates with GDB
through network sockets and passes low level commands to the LinkServer executable (also
known as Redlink server)

e redlinkserv — this is the LinkServer executable and takes stub operations and communicates
directly with the ARM Cortex debug hardware via the debug probe.

If a debug operation fails, or a crash occurs, it is possible that one or more of these processes
may fail to shut down correctly. Therefore, if the IDE has no active debug connection but is
experiencing problems making a new debug connection, ensure that none of these executables

is running. To simplify this process an IDE button ® is provided to kill all low level debug

executables (for all debug solutions). Therefore should a debug operation fail or a crash occur,
simply click this button before starting a new debug operation.

PEmicro Debug Connections

PEmicro software and drivers are automatically installed when MCUXpresso IDE installs. There
is no need to perform any additional setup to use PEmicro debug connections.

Currently we have tested using:

e Multilink Universal (FX)
¢ Cyclone Universal (FX) (USB and Ethernet)
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e PEmicro firmware installed into on-board OpenSDA debug probe hardware (as shipped by
default on certain Kinetis FRDM and TWR boards)

Note: Some Kinetis boards ship with OpenSDA supporting PEmicro VCOM but with no debug
support. To update this firmware visit the OpenSDA Firmware Update pages linked at: Help ->
Additional Resources -> OpenSDA Firmware Updates

PEmicro Debug Operation

The process to debug via a PEmicro compatible debug probe is exactly the same as for a native
LinkServer (CMSIS-DAP) compatible debug probe. Simply select the project via the ‘Project
Explorer’ view then click Debug from the Quickstart panel and select the PEmicro debug probe
from the Probe Discovery Dialogue.

If more than one debug probe is presented, select the required probe and then click ‘OK’ to start
the debug session. At this point, the projects launch configuration files will be created. Note:
PEmicro Launch configuration files will contain the string ‘PE’.

MCUXpresso IDE stores the probe information, along with its serial number in the projects launch
configuration. This mechanism is used to match any attached probe when an existing launcher
configuration already exits.

To simplify debug operations, MCUXpresso IDE will automatically start PEmicro’s GDB Server
and select and dynamically assign the various ports needed as required. This means that multiple
PEmicro debug connections can be started, terminated, restarted etc. all without the need for
any user connection configuration. These options can be controlled if required by editing the
PEmicro launch configuration file.

For more information see

Note: If the project already had a PEmicro launch configuration, this will be selected and used.
If they are no longer appropriate for the intended connection, simply delete the files and allow
new launch configuration files to be created.

Important Note: Low level debug operations via PEmicro debug probes are supported by
PEmicro software. This includes, Part Support handling, Flash Programming, and many other
features. If problems are encountered, PEmicro maintain a range of support forums at https://
www.pemicro.com/forums/

Note: If a debug operation fails, or a crash occurs, it is possible that one or more debug processes
may fail to shut down correctly. Therefore, if the IDE has no active debug connection but is
experiencing problems making a new debug connection, ensure that none of these executables

is running. To simplify this process an IDE button ™ is provided to kill all low level debug
executables (for all debug solutions). Therefore should a debug operation fail or a crash occur,
simply click this button before starting a new debug operation.

PEmicro Differences from LinkServer Debug

MCUXpresso IDE core technology is intended to provide a seamless environment for code
development and debug.

When used with PEmicro debug probes, the debug environment is provided by the PEmicro
debug server. This debug server does not 100% match the features provided by native
LinkServer connections. However basic debug operations will be very similar to LinkServer
debug.

For a description of some common debugging operations using supported debug probes see
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Note: LinkServer advanced features such as Power Measurement will not be available via a
PEmicro debug connection. However, additional functionality maybe available using PEmicro
supplied plugins.

PEmicro Software Updates

PEmicro support within MCUXpresso IDE is via an Eclipse plugin. The PEmicro update site is
automatically added to the list of Available Software Update sites.

To check whether an update is available, please select:
Help -> Check for Updates
Any available updates from PEmicro will then be listed for selection and installation.

Note: PEmicro may provide news and additional information on their website, for details see
https://www.pemicro.com

SEGGER Debug Connections

SEGGER J-Link software and documentation pack is installed automatically with the
MCUXpresso IDE Installation for each host platform. No user setup is required to use the
SEGGER debug solution within MCUXpresso IDE.

Currently we have tested using:

¢ J-Link debug probes (USB and Ethernet)

¢ J-Link firmware installed into on-board OpenSDA debug probe hardware (as shipped by default
on certain Kinetis FRDM and TWR boards)

¢ J-Link firmware installed onto LPC-Link2 debug hardware and LPCXpresso V2/V3 boards
« for details see https://www.segger.com/lpc-link-2.html
« also for firmware programming see https://www.nxp.com/LPCSCRYPT

SEGGER software installation

Unlike other debug solutions supplied with MCUXpresso IDE, the SEGGER software installation
is not integrated into the IDE installation, rather it is a separate SEGGER J-Link installation on
your host.

The installation location will be similar to:

On Wndows: C:/Program Fil es/ SEGGER/ JLi nk
On Mac: /Applications/ SEGGER/ JLi nk
On Linux: /opt/SEGGER/ JLi nk

Note: SEGGER J-Link package is available in two flavors. The 64-bit version is currently installed
and used by MCUXpresso IDE on all operating systems. The legacy 32-bit Windows package
was used by older IDE versions but starting with MCUXpresso IDE v11.5.0, the 64-bit package
is shipped. The installation folder for the 32-bit Windows version is usually:

On Wndows: C:/Program Fil es (x86)/SEGGER JLi nk

MCUXpresso IDE automatically locates the required executable and it is remembered as a
Workspace preference. This can be viewed or edited within the MCUXpresso IDE preferences
as below.
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Figure 10.7. Segger Preferences

&) preferences o x®
J-Link Options A S
g:-cneral SEGGER J-Link probe preferences
H‘gp J-Link Server executable C\Program Files\SEGGERWLink\JLinkGDBServerCLexe Browse..
Install/Update [[] Enable discovering of SEGGER J-Link IP probes
Java [#] Enable SEGGER J-Link user actions
Library Hover

J-Link Server. initial auto discover port 2331
Maven

v MCUXpresso IDE
w Debug Options

J-Link Server SWO: initial auto discover port 2332

J-Link Server Telnet: initial auto discover port 2333

J-Link Options J-Link port auto discover retries attempts 100
LinkServer Options
PEMicro Options [] Enable Instruction Trace service
Probe Discovery Enable Live Variables service
Default Tool settings Enable Registers View Double-Precision registers group
Editor Awareness [] Enable SEGGER FreeRTOS support for new launch configs
Energy Measurement [] Enable auto-debug secondary project(s) for multicore projects
General Auto-debug secondary project(s) delay for multicore projects (ms) | 1000
MQU sattings Disable use of reset on initialization
Paths and Directories
Quickstart Panel New...
RTOS TAD
SDK Handling

SWO Trace
User Interface Enablement
Utilities
Run/Debug Disable use of reset before running
SWTChart
Terminal
Validation
Version Control {Team)
XML

New...

Restore Defaults Apply

Apply and Close Cancel
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Note: this preference also provides the option to enable scanning for SEGGER IP probes (when
a probe discovery operation is performed). By default, this option is disabled.

From time to time, SEGGER may release later versions of their software, which the user could
choose to manually install. For details see https://www.segger.com/downloads/jlink

MCUXpresso IDE will continue to use the SEGGER installation path as referenced in a project’'s
workspace unless the required executable cannot be found (for example, the referenced
installation has been deleted). If this occurs:

1. The IDE will automatically search for the latest installation it can find. If this is successful, the
Workspace preference will automatically be updated
2. If a SEGGER installation cannot be found, the user will be prompted to locate an installation

To force a particular workspace to update to use a newer installation location simply click the
Restore Default button.

To permanently select a particular SEGGER installation version, the location of the SEGGER
GDB Server can be stored in an environment variable.

For example, under Windows you could set:

MCUX_SEGGER_SERVER="C: / Program Fi | es (x86)/ SEGGER/ JLi nk_V630k/j Li nkGDBSer ver CL. exe"

This location will then be used, overriding any workspace preference that maybe set.
SEGGER software un-installation

If MCUXpresso IDE is uninstalled, it will not remove the SEGGER J-Link installation. If this is
required, then the user must manually uninstall the SEGGER J-Link tools.

Note: If for any reason MCUXpresso IDE cannot locate the SEGGER J-Link software, then the
IDE will prompt the user to either manually locate an installation or disable the further use of the
SEGGER debug solution.
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SEGGER Debug Operation

The process to debug via a J-Link compatible debug probe is exactly the same as for a native
LinkServer (CMSIS-DAP) compatible debug probe. Simply select the project via the ‘Project
Explorer’ view then click Debug from the Quickstart Panel and select the SEGGER Probe from
the Probe Discovery Dialogue.

If more than one debug probe is presented, select the required probe and then click ‘OK’ to start
the debug session. At this point, the projects launch configuration files will be created. Note:
SEGGER Launch configuration files will contain the string ‘JLink’.

To simplify debug operations, MCUXpresso IDE will automatically start SEGGER’s GDB Server
and select and dynamically assign the various ports needed as required. This means that multiple
SEGGER debug connections can be started, terminated, restarted etc. all without the need for
any user connection configuration. These options can be controlled if required by editing the
SEGGER launch configuration file.

In MCUXpresso IDE, SEGGER Debug operations default to using the SWD Target Interface.
When debugging certain multicore parts such as the LPC43xx Series, the JTAG Target Interface
must be used to access the internal Secondary MCUs. To select JTAG as the Target Interface,
simply edit the SEGGER launch configuration file and select JTAG.

For more information see

Note: If the project already had a SEGGER launch configuration, this will be selected and used.
If an existing launch configuration file is no longer appropriate for the intended connection, simply
delete the files and allow new launch configuration files to be created.

Tip

@ If Reset before running is set in the Launch configuration, then a default intelligent
reset will be used. This reset automatically supports running from Flash or RAM.
A specific reset type can optionally be set from the free form text field if required,
please consult SEGGER’s documentation for available reset types.

Important Note: Low level debug operations via SEGGER debug probes are supported by
SEGGER software. This includes, Part Support handling, Flash Programming, and many other
features. If problems are encountered, SEGGER'’s provide a range of support forums at https://
forum.segger.com/

SEGGER Differences from LinkServer Debug

MCUXpresso IDE core technology is intended to provide a seamless environment for code
development and debug. When used with SEGGER debug probes, the debug environment is
provided by the SEGGER debug server. This debug server does not 100% match the features
provided by native LinkServer connections. However basic debug operations will be very similar
to LinkServer debug.

For a description of some common debugging operations using supported debug probes see

Note: LinkServer features such as Power Measurement will not be available via a SEGGER
debug connection. However, additional functionality maybe available using external SEGGER
supplied applications.

SEGGER Troubleshooting

When a debug operation to a SEGGER debug probe is performed, the SEGGER GDB server
is called with a set of arguments provided by the launch configuration file. The command and
resulting output are logged within the IDE SEGGER Debug Console. The console can be viewed
as below:
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SehAEI AR ~B-r= O
1 RedlinkServer
2 FreeRTOS Task Aware Debugger Console version 11.0.0 (201903291224)
£ 3 CDT Global Build Console
£l 4 CDT Build Console [frdmk6&4f_bubble]
v B 5 JLinkServer JLink600102843 for frdmk64f_bubble
6 frdmk64f_bubble JLink Debug [GDB SEGGER Interface Debugging] gdb traces

7 frdmk64f_bubble JLink Debug [GDB SEGGER Interface Debugging] frdmk64f_bubble.axf

Figure 10.8. Segger Server

The command can be copied and called independently of the IDE to start a debug session and

explore connection issues.

Below is the shortened output of a successful debug session to a Kinetis K64 Board.

[07-12-2022 10: 01: 25] Executing Server: "C:\Program Fil es\ SEGGER\ JLi nk\ JLi nkGDBSer ver CL. exe" -no
SEGCER J-Link GDB Server V7.82c Command Line Version
JLi nkARM dI | V7.82c (DLL conpiled Nov 16 2022 17:01: 56)
Command |ine: -nosilent -swoport 2332 -sel ect USB=174505240 -tel netport 2333 -singlerun -endian
----- CDB Server start settings-----

GDBInit file: none

GDB Server Listening port: 2331

SWO raw out put |istening port: 2332

Terminal 1/0 port: 2333

Accept renpte connection: | ocal host only
Generate logfile: of f

Verify downl oad: on

Init regs on start: of f

Si | ent node: of f

Singl e run node: on

Target connection timeout: 0 ns

------ J-Link related settings------

J-Link Host interface: UsB

J-Link script: none

J-Link settings file: none

------ Target related settings------

Tar get devi ce: M<K64FNLIMDxxx12

Target device paraneters: none

Target interface: SWD

Target interface speed: 4000k Hz

Target endi an: little

Connecting to J-Link..

J-Link is connected

Devi ce "MK64FNLMDXXX12" sel ected

Firmvare: J-Link Pro V4 conpiled Sep 22 2022 15:00: 37
Har dwar e: V4. 00

S/I'N: 174505240

Feature(s): RD, FlashBP, FlashDL, JFl ash, GDB
Checki ng target voltage..

Target voltage: 3.30 V

Li stening on TCP/IP port 2331
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Connecting to target...

I ni t Tar get ()

Found SWDP with | D 0x2BA01477
DPI DR 0x2BA01477

Cor eSi ght SoC-400 or earlier

Scanning AP map to find all avail abl e APs

AP[ 2]: Stopped AP scan as end of AP nmap has been reached
AP[ 0] : AHB-AP (I DR 0x24770011)

AP[1]: JTAG AP (I DR 0x001C0000)

Iterating through AP map to find AHB-AP to use

AP[0]: Core found

AP[ 0] : AHB- AP ROM base: OxEOOFF000

CPUI D regi ster: 0x410FC241. |nplenenter code: 0x41 (ARM

Found Cortex-M4 rOpl, Little endian.
FPUnit: 6 code (BP) slots and 2 literal
Cor eSi ght conponent s:

ROMTbI [ 0] @ EOOFF000

slots

[0][0]: EOOOEO00 Cl D B105EO00D Pl D 000BBOOC SCS- M7
[0][1]: EO0001000 CI D B105E00D PI D 003BB002 DWI
[0][2]: E0002000 CI D B105E00D PI D 002BB003 FPB
[0][3]: EO0000000 CI D B105E00D PI D 003BB001 |TM
[0][4]: EO0040000 CI D B105900D PI D 000BB9A1l TPI U
[0][5]: E0041000 CI D B105900D PI D 000BB925 ETM
[0][6]: EO0042000 CI D B105900D PI D 003BB907 ETB
[0][7]: EO0043000 CI D B105900D PI D 001BB908 CSTF
Connected to target

Waiting for GDB connection...Connected to 127.0.0.1

Readi ng common regi sters:
Connected to 127.0.0.1

Readi ng common regi sters:

RO, Rl, R2, R3,

RO, R1, R2, R3,

Read 4 bytes @ address 0x00001D52 (Data = OxAF00B082)
Read 4 bytes @ address 0x00001CAC (Data = 0x681B4B06)
Readi ng 64 bytes @ address 0x20000540
Readi ng 64 bytes @ address 0x200028C0
Readi ng 64 bytes @ address 0x20000500
Read 4 bytes @ address 0x00001D52 (Data = OxAF00B082)
Read 4 bytes @ address 0x00001CAC (Data = 0x681B4B06)

Readi ng 64 bytes
Readi ng 64 bytes
Readi ng 64 bytes
Recei ved nonitor
Reset : reset via DEMCR VC_CORERESET.

Reset: Reset device via Al RCR SYSRESETREQ

Af t er Reset Tar get ()

Resetting target

Downl oadi ng 16112 bytes @ address 0x00000000 - Verified OK
Downl oadi ng 6168 bytes @ address Ox00003EFO - Verified OK
Downl oadi ng 16 bytes @ address 0x00005708 - Verified OK
J-Li nk:
J-Li nk:
J-Li nk:

@ addr ess 0x20000540
@ addr ess 0x200028C0
@ addr ess 0x20000500
command: reset

Halt core after

Fl ash downl oad:

Fl ash downl oad: Total: 0.722s (Prepare: 0.239s,
Program & Verify speed: 79 KB/s
Witing register (PC = 0x 1d4)

Read 4 bytes @ address 0x000001D4 (Data =
Read 4 bytes @ address 0x000001D4 (Data =

RO, Rl, R2, R3,

Conpar e:
Fl ash downl oad:

0xF001B672)
0xF001B672)
Readi ng common regi sters:

Read 4 bytes @ address 0x000001D4 (Data = OxFO01B672)
Readi ng 64 bytes @ address 0x000005C0
Read 2 bytes @ address 0x000005E2 (Data = OxF107)

R4, R5, R6, R7, R8, R9, R10, Rl11l, R12, SP, LR PC, XPSR

R4, R5, R6, R7, R8, R9, R10, Rl11l, R12, SP, LR PC, XPSR

Bank 0 @ 0x00000000: 1 range affected (24576 bytes)
0.118s,

R4, R5, R6, R7, R8, R9, R10, Rl11l, R12, SP, LR PC, XPSR

Erase: 0.041s, Program & Verify: 0. 3(
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Recei ved nonitor command: sem hosting enabl e

Sem - hosting enabl ed (Handl e on breakpoint instruction hit)

Recei ved nonitor conmand: exec SetRestartOnd ose=1

Execut ed Set RestartOnCl ose=1

Recei ved nonitor conmand: reset

Reset: Halt core after reset via DEMCR VC_CORERESET.

Reset: Reset device via Al RCR SYSRESETREQ

Af t er Reset Tar get ()

Resetting target

Setting breakpoint @address 0x000005E2, Kind = 2, Type = THUMB, BPHandl e = 0x0001
Starting target CPU...

... Breakpoi nt reached @ address 0x000005E2

Readi ng common registers: RO, Rl, R2, R3, R4, R5, R6, R7, R8, R9, R10, Rl1l, R12, SP, LR PC, XPSR
Renovi ng breakpoi nt @ address 0x000005E2, Size = 2
Read 4 bytes @ address 0x000005E2 (Data = 0x031CF107)
Readi ng 64 bytes @ address 0x2002FFCO

Read 4 bytes @ address OXEOOFFFF4 (Data = 0x00000010)

Note: If a SEGGER debug operation is not successful, the IDE will generate an error dialogue,
the 'Details' button can be clicked to display a copy of the SEGGER server log. One possible
reason for a SEGGER debug operation to fail is due to a Device hame mismatch. MCUXpresso
IDE will try to supply the expected Device name to SEGGER server, however on rare occasions
this may not be the name expected. The SEGGER launch configuration Device entry can be
populated via a drop down list or via a user supplied device name.

If required, additional server options can be set within the SEGGER launch configuration. For
example to capture logging information to a file, you can set the additional server option:

-log $(CWD)/ ny. | og

where $(CWD) represents the current working directory of the debug connection, i.e. the
dynamically created project build configuration folder.

Note: If a debug operation fails, or a crash occurs, it is possible that one or more debug processes
may fail to shut down correctly. Therefore, if the IDE has no active debug connection but is
experiencing problems making a new debug connection, ensure that none of these executables
is running. To simplify this process an IDE button " is provided to kill all low level debug
executables (for all debug solutions). Therefore should a debug operation fail or a crash occur,

simply click this button before starting a new debug operation.

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022 104



NXP Semiconductors MCUXpresso IDE User Guide

11. Debugging a Project

11.1

11.1.1

MCUXpresso IDE User Guide -

This chapter describes many of the common debug features supported by the debug solutions
within MCUXpresso IDE. Please also refer to the chapter for
more details of the supported debug solutions and management of debug operations.

Debugging Overview

A debug operation requires a physical connection between the host computer and the target
MCU via a debug probe. The debug probe translates the high level commands provided by
MCUXpresso IDE into the appropriate low level operations supported on the target MCU.

This connection to the debug probe is usually made via USB to the host computer (although IP
probes from PEmicro and SEGGER are also supported). Some debug probes such as LPC-Link2
or SEGGER J-Link Plus are separate physical devices, however many LPCXpresso, Freedom,
Tower, EVK boards also incorporate a built in debug probe accessed by one of the development
boards USB connections.

Note: If a separate debug probe is used, you must ensure that the appropriate cables are used
to connect the debug probe to the target board, and that the target is correctly powered.

Typically, an on board debug probe connection will also provide power to the development board
and target MCU. In contrast, an external debug probe will not usually power the target, and
a second connection (often USB) will be required to provide power to the board and MCU.
Some external debug probes such as the LPC-Link2 can also provide power to the target board
— this is enabled by connecting the link JP2. For other debug probes, refer to their supplied
documentation.

External debug probes will usually provide superior features and performance compared to on-
board debug probes, however please note that LPCXpresso V2 and V3 boards incorporate a full
featured LPC-Link2 debug probe.

Note: Some LPCXpresso development boards have two USB connectors fitted. Make sure that
you have connected the lower connector marked DFU-Link. Many Freedom and Tower boards
also have two USB connectors fitted. Make sure that you have connected to the one marked
‘OpenSDA’ - this is usually (but not always) marked on the board. If in doubt, the debug processor
used on these designs is usually a Kinetis K20 MCU, it is approximately 6mm square. The USB
nearest this MCU will be the OpenSDA connection.

Debug Launch

To debug a project on your target MCU, simply highlight the appropriate project in the ‘Project
Explorer’, and then in the Quickstart Panel click on the large Debug, as in Figure 11.1,

alternatively click the blue bug icon F to perform the same action.
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Figure 11.1. Launching a debug session

) Quickstart Panel 23 Variables Breakpoints =

\_oe_ /] Project: evkmimxrt1060_iled_blinky [Debug]

~ Create or import a project

. New project...
)
Import SDK example(s)...
® Import project(s) from file system...

+ Build your project

4, Build
¢ Clean
~ Debug your project ' E' ﬂ'

[ ’K& Debug ]

¥ Miscellaneous

& Edit project settings

. MCUXpresso Canfig Tools>>

& Quick Settings>>

B Export project(s) to archive (zip)

J{B Export project(s) and references to archive (zip)
ay Build all projects [Debug]
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Note: The green bug icon should not be used because this invokes the standard Eclipse debug
operation and so skips certain essential MCUXpresso IDE debug steps.

For a newly created project a debug operation will perform a number of steps. By default, it will
first build the selected project and (assuming there are no build errors) launch a debug probe
discovery operation (see next section) to allow the user to select the required debug probe. A
launch configuration file will automatically be created with default options (per build configuration)
and will be associated with the project. Like a project’s build configuration, launch configuration
files control what occurs each time a debug operation is performed. Please see the section

for more information.

Note: This default behaviour can be changed by editing the Workspace preference located at
Preferences -> Run/Debug -> Launching -> Build (if required) before launching. For individual
projects, the Main tab of the launch configuration allows the workspace preference to be
overridden.

By default, once a debug probe has been selected (and ‘OK’ clicked) the binary contents of
the .axf file will automatically be downloaded to the target via the debug probe connection.
Typically, projects are built to target MCU Flash memory, and in these cases, a suitable Flash
driver will automatically be selected to perform the Flash programming operation. Next a default
breakpoint will be set on the first instruction in nai n() , the application will be started (by performing
or simulating a processor reset), and code will be executed until the default breakpoint is hit. See
the section on for additional information.

Debug Probe Selection Dialog (Probes Discovered)

The first time you debug a project, the IDE will perform a probe discovery operation and display
the discovered Debug Probes for selection. This will show a dialogue listing all supported probes
that are attached to the host computer. In the example shown in Figure 11.2, a LinkServer (LPC-
Link2), a PEmicro Multilink and also a J-Link (OpenSDA) probe have been found.
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e ® Probes discovered
Connect to target: MK64FN IMOxxx12

3 probes found. Select the probe to use:

Available attached probes

Name Serial number/ID Type Manufactur IDE Debug Mode
B8 LPC-LINK2 CMSIS-DAP V5.18 IWFUA1EW LinkServe NXP SemiNon-Stop
4 USB1 - Multilink Universal Rev PEM834663 usBe1 P&E Micrc All-Stop
ﬂ J-Link OpenSDA 621000000 use SEGGER All-Stop

Supported Probes {tick/untick to enable/disable)

MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes

SEGGER J-Link probes

Probe search options

Search again

Remember my selection (for this Launch configuration)

®

Cancel

Figure 11.2. Attached probes: debug emulator selection

MCUXpresso IDE User Guide -

Note: if only one probe is found, it will be selected automatically, so simply click OK or hit return
to use the probe displayed.

MCUXpresso IDE supports unique debug probe association.

Debug probes can return an ID (Serial number) that is used to associate a particular debug
probe with a particular project. Some debug probes will always return the same ID, however
debug probes such as the LPC-Link2 will return a unique ID for each probe — in our example
IWFUAL1EW.

For any future debug sessions, the stored probe selection will be automatically used to match the
project being debugged with the previously used debug probe. This greatly simplifies the case
where multiple debug probes are being used.

However, if a debug operation is performed and the previously remembered debug probe cannot
be found, then a debug probe discovery operation will be performed from within the same family
e.g. LinkServer, PEmicro or SEGGER.

See also

Sometimes a probe discovery will find no debug probes and return a dialogue as below:

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022 107



NXP Semiconductors MCUXpresso IDE User Guide

[ BuN Probes discovered

Connect to target: LinkServer

€3 LinkServer not found.
This could be because it is disconnected, not powered, or already in use

Available attached probes

Name Serial number/ID Tvpe Manufactur IDE Debug Mode

Supperted Probes {tick/untick to enable/disable)
MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes

Probe search options

Search for LinkServer again Search for any enabled probe

?) Cancel

Figure 11.3. LPC-Link2 no longer connected

MCUXpresso IDE User Guide -

This might have been because you had forgotten to connect the probe, in which case simply
connect it to your computer and select Search again. If you are using a different debug probe
from the same family of debug probes, simply select the new probe and this will replace the
previously selected probe.

Notes:

The “Remember my selection” option is enabled by default in the Debug Emulator Selection
Dialog, and will cause the selected probe to be stored in the launch configuration for the current
configuration (typically Debug or Release) of the current project. You can thus remove the
probe selection at any time by simply deleting the launch configuration.

You will need to select a probe for each project that you debug within a Workspace (as well
as for each configuration within a project).

If you wish to debug a project using a different family of debug probe(s), then the simplest
option is to delete the launch configuration files associated with the project and start a debug
operation. Please see the section "An Introduction to for more
information. Please also see

Firmware version check on MCU-Link / MCU-Link Pro probes

For MCU-Link and MCU-Link Pro probes, the Probes Discovered will provide an indication if
a newer firmware version is available.
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Figure 11.4. MCU-Link available firmware update indication

[ N Probes discovered

Connect to target: MK64FN1MOxxx12
I !, Firmware update(s) available for 1 of the discovered probesl 1

Available attached probes

Name Serial number/ID Type Manufacturer |DE Debug Mode
IS Y evJ firmware vrsion .08 is availalé. T A
N PC-LINK2 CMSIS-DAP the iatest firmware package can be downloaded from
a https://www.nxp.com/downloads/en/device-drivers/MCU-LINK_CMSIS-DAP-mac.zip

>

Supported Probes (tick/untick to enable/disable)

MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes

SEGGER J-Link probes

Probe search options

Search again

Remember my selection (for this Launch configuration)

® corcel (D
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1. Once the Probes Discovered opens, a warning will indicate if there are debugger probes that
would require firmware update.

2. Each discovered probe will warn if a firmware update is available.

3. A tooltip (on each probe marked by a warning icon) will specify the firmware’s download
location and its version.

Note For details on how to wupdate the MCU-Link firmware, follow the
link from https://www.nxp.com/design/microcontrollers-developer-resources/mcu-link-debug-
probe:MCU-LINK and https://www.nxp.com/design/microcontrollers-developer-resources/mcu-
link-pro-debug-probe:MCU-LINK-PRO.

Controlling Execution

When you have started a debug session a default is set on the first instruction
in mai n(), the application is started (by simulating or performing a processor reset), and code is
executed until the default "breakpoint is hit.

Program execution can now be controlled using the common debug control buttons, as listed

in Table 11.1, which are displayed on the global toolbar. The call stack is shown in the Debug
View, as in Figure 11.5.
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b= (]

1 Debug £2
v [ frdmk64f_driver_examples_gpio_led_output LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application]
v [ frdmk64f_driver_examples_gpio_led_output.axf [MKE4FN1MOxxx12 (cortex-m4)]
¥ o Thread #1 1 (Stopped) (Suspended : Signal : SIGINT:Interrupt)
= delay() at gpio_led_output.c:61 0x806
= main() at gpio_led_output.c:91 0x852
w arm-none-eabi-gdb (7.12.0.20161204)

Figure 11.5. Debug controls and Debug Call Stack

Table 11.1. Program execution controls

Button Description Keyboard Shortcut
& Restart program execution (from reset)

e Run/Resume the program F8

0o Pause Execution of the running program

Terminate the debug Session Ctrl + F2
B, Clean up debug

e ) Run, Pause, Terminate all debug sessions

[ Step over a C/C++ line F6

S Step into a function F5

@ Return from a function F7

T R Step in, over, out all debug sessions

i Show disassembled instructions

MCUXpresso IDE User Guide -

Tip

@ Clean up debug will kill all debug processes associated with LinkServer, PEmicro
and SEGGER debug connections. This may be necessary if the IDE is restarted
with a connected debug session or if a crash occurs — and will remove any failed or
orphaned debug processes. Note: a warning will be issued with the option to cancel
before any action is performed since this will kill all connected debug sessions.

Note: The debug controls for ‘all’ debug sessions will perform identically to their single session
counterparts if only one debug session exists.

Note: Typically a user will only have a single active debug session. However if there is more
than one debug session, the active session can be chosen by clicking within the debug call stack
within the Debug view. All debug views will reflect the selected session.

Setting a breakpoint

To set a breakpoint, simply double-click on the left margin area of the line on which you wish to
set the breakpoint (before the line number).

Restarting the application
If you hit a breakpoint or pause execution and want to start execution of the application from the

beginning again, you can do this using the Restart button.
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Stopping debugging

To stop debugging just press the Terminate/Stop button. This action will disconnect
MCUXpresso IDE from the target (board). The subsequent behaviour is controllable by the
Pause debugging

Typically, debugging is paused due to the action of a or

since these will be set to observe the target when an event of interest has occurred. However,
the pause button can be used to pause the target at an instant of time.

To pause debugging

If you are debugging using the Debug Perspective, then to switch back to the C/C++

Perspective when you stop your debug session, just click on the C/C++ tab in the upper right
area of MCUXpresso IDE (as shown in Figure 3.4).

11.2 Launch Configurations
Launch Configuration files will be automatically created within the root directory of a project the
first time a debug operation is performed. They will typically be named:
{proj nane} {debug sol uti on}Debug. | aunch
{proj nane} {debug sol uti on}Rel ease. | aunch
A file will be created for the build variant being debugged, and is used to store the settings for
the debug connection for that build configuration.
Normally, there is no need to edit launch configurations, as the default settings created by the
IDE will be suitable. However, in some circumstances, you may need to manage them — typically
under direction from an FAQ. In such cases this can be done via the “Launch Configurations”
entry on the context sensitive menu available from the Project Explorer view...
MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.
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Figure 11.6. Create a Launch Configuration
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Note: to view the contents or edit an existing launch configuration file, you can also simply double
click to open an edit view.

A number of options are available here:

Edit...

< Allows various debug settings to be modified
« Typically not required since the default options will be correct for most debug operations

Create new...

¢ Create a launch configuration for a particular debug solution, if they do not already exist.

« Normally you will not need this option as it is carried out automatically the first time that you
debug your project. However, if you want the flexibility to debug a project with different debug
solutions for example, LinkServer and SEGGER, then both sets of launch configurations
can be created. On the next debug operation, the user can select the launch configuration
to use for that session.

Create and edit new...

¢ Allows new launch configurations to be created and immediately opened for editing.

Delete...

< Allows the launch configurations for the selected project (or projects) to be deleted.

e This can be useful as it allows you to put the debug connection settings back to the default
after making modifications for some reason, or if you are moving your project to a new version
of the tools, and want to ensure that your debug settings are correct for this version of the tools.

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022 112



NXP Semiconductors MCUXpresso IDE User Guide

Delete JTAG Configuration...

¢ Allows the JTAG configuration files for the selected project (or projects) to be deleted. These
files are stored in the Debug/Release subdirectories.

11.2.1 Editing a Launch Configuration (LinkServer)

WARNING: - Modifying the default settings for a launch configuration can prevent a successful
debug connection from being made.

After selecting the “Edit...” or “Create and edit New” launch configuration menu entry, you will
then see a new dialog box pop up, which looks similar to the following...

| @ Edit Configuration o

x
| L,
| Modify configuration and continue. ﬁ\
| -

Name: | Ipopressa$5s69_threadx_demo LinkServer Debug

Main| % GDB Debugodr (I LinkServer Debugger | § GUI Flash Tool | # Other Symbols| & Startup| ' Source| ] Common
® LinkServer Debugger
Debug Options
Debug Connection 'Swp ~
LinkServer Options
= Debug Connection
[J Attach only [ Reset on Connect [] Disable use of preconnect script
Reset script Workspace_.  File System
Connect script Workspace.. File System.
BootROM stall | 0x50000040
Flash driver reset handling “ Reset handling
Disconnect behavior <cont ~ | Semihosting support |On
= Advanced Settings
[IMemory checking [] Debug memory cache [-] Enable range stepping 4] Enable flash hashing
Debug level 2
Override core index
Wirespeed (Hz
Additional options

Pre launch command

G Cancel

Figure 11.7. Edit a Launch Configuration

Most settings that you may need to modify can be found in the Debugger tab, in the Target
configuration sub-tab (as shown in the above screenshot).

Some examples of modifications that you may need to make in particular circumstances are:

¢ Changing the initial on debug startup

* When the debugger starts, it automatically sets an initial (temporary) breakpoint on the first
statement in main(). If desired, you can change where this initial breakpoint is set, or even
remove it completely.

« Modifying the Debugger connect behaviour
* via a Connect Script e.g. kinetisconnect.scp
« Modifying the Debugger reset behaviour.

» Flash driver reset handling is used to run the RAM-loaded flash driver, while Reset handling
is used to start the image loaded into flash/RAM. Possible choices:

« SOFT: Maintain current software environment but change the SP and PC. Note that the
values for SP and PC are read from the first two words of the binary image, so SOFT is
not applicable in case of flash images which begin with a bootheader / configuration block.
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« VECTRESET: Execute a hardware reset of the core & catch the vectored ‘reset’ event.
ARMv8-M cores lack this reset mechanism, so SOFT reset will be used instead.

« SYSRESETREQ: Execute a hardware restart of the system & catch the vectored ‘reset’
event.

» Default: For Flash driver reset handling it usually means VECTRESET, except for specific
parts. For Reset handling it means SYSRESETREQ for flash and VECTRESET for RAM.

« If the Reset script input field is not empty, the specified reset script is executed instead of
the selected Reset handling.

« BootROM stall: Temporarily stall the boot loader post initialization on a read watchpoint to
restablish debug control. Useful for ARMv8-M cores which lack vector catch.

¢ Connecting to a target via JTAG rather than SWD

« if supported by the target, you can edit the Debug type
¢ Connecting to a running target

« set Attach only to True (see also
* Changing the debug stub connection parameters

« By default, the IDE attempts to start the GDB stub when initiating a debug connection. As
result, the launch configuration is automatically created with the “Automatically start debug
server” checkbox enabled. If the GDB stub is already running, and the GDB client must
connect to that instance, it must be unchecked.

« Controls associated with the host name and with the network port number that will be used
for listening to GDB client connections are grayed-out by default. These parameters can be
changed by disabling “Automatically start debug server”.

3 &dit Configuration o X
Modify configuration and continue. @
J

Name: | Ipcxpresso55s69_hello_world LinkServer Debug

Main | 3 GDB Debugger [ LinkServer Debugger | @ GUI Flash Tool | %5 Other Symbols| # Startup % Source| ] Common:

[JMemary checking [[] Debug memory cache [] Enable range stepping [ Enable flash hashing
Debug level 2

Override core index

Wirespeed (Hz)

Additional options

Pre launch command

[ Automatically start debug server

2 Continue Cancel

Figure 11.8. Debug Server Connection

Note that the Debug Server Connection parameters can be also changed using the Preferences
page. All launch configurations will be created using the values specified there. Existing launch
configurations will not be affected by any change in the Preferences page. Go to Window ->
Preferences -> MCUXpresso IDE -> Debug Options -> LinkServer Options in order to change
any of the debug server-related parameters.
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Figure 11.9. Debug Server Connection
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Paths and Directories [ Use PowerShell instead of cscript
Quickstart Panel [J Use dfu-util during discovery
RTOS TAD [ Show timestamps in Redlink console
SDK Handling [ Enable range stepping
SWO Trace [ Enable flash hashing
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Run/Debug
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¢ Changing target boot configuration
« LinkServer debug configuration has a section for Target Boot Control (highlighted below):

Figure 11.10. Target Boot Control

B8 Edit Configuration o X

Modify configuration and continue. ﬁ\

Name: | 21_evkbmimxrt1060_hello_world LinkServer Debug |
[5) Main| %5 GDB Debugger | (I LinkServer Debugger| € GUI Flash Tool | 45: Other Symbols| = Startup| & Source|[] Commen

Debug server host name | localhost

Debug server port number | 10929

~ Target Boot Control
Settings for Target Boot Control using MCU-Link ISP control pins (x-do not drive, 0-drive low, 1-drive high)

[Enabie Target Boot Control:

Target Boot Mode | Custom v

15P control pins [3:0] [ x01x

v v

Revert Apply
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The main purpose of this feature is to configure how the device boots on the reset requests
issued during the debug session. This feature requires an MCU-Link debug probe with the
ISPx boot control features implemented.

By default, the target boot control is disabled when the launch configuration is created. If
a specific target boot configuration is required, you need to enable the target boot control
and change the value present in the edit box and/or select the boot mode from the list. At
this moment, there are no predefined target boot mode entries in the list. The combo box
has two generic entries:

e Custom entry: at least one ISP control pin is configured to be driven (custom
configuration)

* Empty entry: no ISP control pin is driven (default).

When the target boot control is enabled, the selected configuration is stored on the probe
and a wire reset is issued to apply it at the very beginning of the debug session. Also, it
overrides the Pull ISP on reset option from Window -> Preferences -> MCUXpresso IDE
-> Debug Options -> LinkSery
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* Note: The on-board MCU-Link probes have support for up to 4 ISP control pins, being able
to drive up to 4 target device pins, but this depends on how the target board is designed.
MCU-Link Pro and the MCU-Link base probes have one ISP control pin (ISPO).

« WARNING: Depending on the selected target boot mode (ISP control pins state), debug
session failures might occur in cases where code exists in the source of the boot media (e.qg.
in flash) and that code prevents the debugger from gaining control.

Tip

@ Multiple launch configurations are supported for each build configuration. Multiple
launch configurations may be created using standard Eclipse functionality — for
example from the main menus, select Run -> Debug Configurations and double click
on the C/C+ entry. Alternatively you can clone an existing launch configuration. Once
this has been done, a debug operation will present the user will a list of available
launch configurations. Simply double click the required launch configuration to start
the debug session.

11.3 Common Debug Operations and Launch Configurations

Where possible MCUXpresso IDE attempts to provide a common debug experience regardless
of the debug solution being used. However some debug tasks require launch configuration
modifications and these will be different for each debug solution. In this section, some common
debug operations are discussed for each debug solution.

11.3.1 Debug Quickstart Shortcuts

MCUXpresso IDE Quickstart panel incorporates Debug shortcut buttons. These buttons invoke
actions only from their respective debug solutions.

) Quickstart Panel &2 Variables Breakpoints |

. MCUXpresso IDE - Quickstart Panel
[_1ee ]} Project: evkmimxrt1060_iled_blinky [Debug]

~ Create or import a project

B new project...

P
Import SDK example(s)...

& import project(s) from file system...
~ Build your project

& Build
J/ Clean

~ Debug your project

¥ Debug + Debug using LinkServer probes (CTRL+SHIFT+ALT+L)
Attach to a running target using LinkServer (CTRL+ALT+L)
Program flash action using LinkServer

Erase flash action using LinkServer
® Edit project settings F

. MCUXpresso Config Tools>>

2 Quick Settings>>

JB Export project(s) to archive (zip)

& Export project(s) and references to archive (zip)

~ Miscellaneous

a9 Build all projects [Debug]

Figure 11.11. Debug Shortcuts (LinkServer shown)

Each button provides the same 4 options for each debug solution:

Debug (default) : make a Debug connection to the chosen debug probe. A launch configuration
will be created if not present. The attach mode will be set to False. Note: a normal debug
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11.3.2
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operation will inherit a launch configuration attach setting, whereas this operation will force attach
mode to False. If a launch configuration already exists, its attach setting will be set to False, no
other changes will be made.

Attach : make an Attach connection to a LinkServer compatible debug probe. A launch
configuration will be created if not present. The attach mode will be set to True. The launch

configuration will be given a A decorator to show that Attach is the set configuration. ¥ button.
If a launch configuration already exists, its attach setting will be set to True, no other changes
will be made.

Program Flash : perform the launch configuration Program action, by default this will program the
‘project’ into flash. The selected project will be built if required and a default launch configuration
will be created if one is not present.

Erase Flash : perform the launch configuration Erase action, by default this will erase the flash
memory via a mass erase. A default launch configuration will be created if one is not present.

Note: the selected action will be remembered for subsequent shortcut uses, the tooltip will show
the action to be performed.

Tip

@ If an attach operation is performed, the created launch configuration will have Attach
setto True. Therefore any subsequent debug operations will be in Attach Mode, until
either the launch configuration is edited to set Attach to false, or the Debug short cut
is used again to force the attach mode to false.

Connecting to a running Target (attach)

A typical debug session will begin by downloading code to Flash and then debugging from main()
onwards. However, to explore an already running system a debug connection (attach) can be
made to the target MCU without affecting the code execution (at least until the user chooses to
halt the MCU!).

Note: Source level debug of a running target is only possible if the sources of the project to be
attached exactly match the binary code running on the target.

Important Note: Please be sure to read and understand the section on
and also the implications in the related section on

LinkServer

Edit the project launch configuration by double clicking on the launch config file, select the
Debugger tab and Target configuration view, then set the ‘Attach only’ setting to True as below:
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Name: | evkmimxrt1060_iled_blinky LinkServer Debug

_ ¢ GUI Flash Tool | &= Startup | i~ Source

»,
1

LinkServer Debugger

Debug Options

Debug Connection SWD | ¥

LinkServer Options

~ Debug Connection
Settings for the debug connection

Attach only Reset on Connect

Reset script ﬂ Workspace... File System...
Connect script ﬁ Workspace... File System...
BOOtROM stall

Flash driver reset handling ﬁ Reset handling ﬂ
Disconnect behavior cont B seminosting support  On il

Figure 11.12. Debug Launch Attach Mode

When a debug connection is made, the target will continue running until it is paused. However,

if the IDE Debug Mode is set to Non-Stop (the default) then Global variables values can be
explored and displayed.

Other operations such as ITM console 10 will also function. See the LinkServer SWO Trace
Guide for further information.

PEmicro

Edit the project launch configuration by double clicking on the launch config file, select the Startup
tab, then set the ‘Attach to a running target’ check box as below:
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® @ Edit Configuration

Modify configuration and continue. ﬁ,

Name: MKB4FN1MOxxx12_Project PE Debug

[ 2] Main [%5 Debugger | € GUI Flash Todl (i
Semihosting Settings

% Source | [T] Common

Enable semihosting  Console routed to: Telnet GDB client
Enable Telnet console Telnet Port: 51794

Load Symbols and Executable

Load symbols
i | o Use project binary: MK64FN1MOxxx12_Project.axf

| Use file:
Symbols offset (hex):

Load executable
° Use project binary: MKB4FN1MOxxx12_Project.axf

Use file:
Executable offset (hex):

Runtime Options

[ Attach to Running Target ] Run on reset
Set PC (absolute hex address or symbol): Set breakpoint at: | main

GDB run commands:

Figure 11.13. Debug Launch Attach mode PEmicro

When a debug connection is made, the target will continue running until it is paused.

SEGGER JLink

Edit the project launch configuration by double clicking on the launch config file, select the
Debugger tab, then set the ‘Attach to a running target’ check box as below:

Name: | frdmk64f_bubble_peripheral JLink Debug
[ Main | % GDB Debugger | 3% JLink Debugger | € GUI Flash Tool | %5 Other Symbols| ¥ Startup| &~ Source| ] Common

2332

2333
Endianess little v
Disconnect behaviour Run ~

] Power Target [~] Enable Semihosting
GDB Client Settings
Halt target on startup [ Initialize CPU registers
2331
Additional Options
[ silent (] Verify [ Single run
Reset before running l:l

Script ‘ ‘ Browse

[] Select RTOS plugin GDBServer/RTOSPlugin_FreeRTOS

Other server options ‘ |

Revert Apply

Figure 11.14. Debug Launch Attach Segger

When a debug connection is made, the target will continue running until it is paused.

11.3.3 Controlling the initial Breakpoint (on main)

When the debugger starts, it automatically sets an initial (temporary) breakpoint on the first
statement in main(). If desired, you can change where this initial breakpoint is set, or even remove
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it completely. One common requirement is to debug an application from startup. The entry point
(startup) in a standard example application can be identified by a symbol called ResetISR, a
breakpoint can be set on this symbol to halt execution at the first instruction within an application.

LinkServer

To debug from the start of the image, edit the project launch configuration by double clicking on
the launch config file, select the Debugger tab, replace main with ResetISR

Figure 11.15. Debug Launch ResetISR

=) Main i’: GDB Debugger LinkServer Debugger | € GUI Flash Tool | %5 Other Symb) Source ™

Initialization Commands
Reset and Delay (seconds):
Halt
set non-stop on
set pagination off
set mi-async
set rematetimeaut GOOO0
Load Image and Symbols
Load image
© Use project binary: MKG64FN1MOxxx12_Project.axf
Use file:
Image offset (hex):
Load symbols
© Use project binary: MKB4FN1MOxxx12_Project.axf

Use file:

Symbols offset (hex):

Run Commands

Set program counter at (hex);

Set breakpoint at:

Request hardware breakpoint

MCUXpresso IDE User Guide -

When a debug connection is made, the target should halt at this symbol.
To disable the initial breakpoint, uncheck the option ‘Stop on startup at...". To restore the original

behaviour, replace the symbol ResetISR with main, and check the option ‘Stop on startup at...".
Alternatively, you could delete the launch configuration and allow the IDE to create a new one.

PEmicro

Edit the project launch configuration by double clicking on the launch config file, select the Startup
tab, replace main with ResetISR
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[ Main | %5 Debugger | € GUI Flash Tdbl (|

Semihosting Settings
Enable semihosting  Console routed to: [ Telnet
Enable Telnet console Telnet Port: 51794

Load Symbols and Executable

Load symbols
0 Use project binary: MKE4FN1MOxxx12_Project.axf

Use file:

Symbols offset (hex):
Load executable
° Use project binary: MKB4FN1MOxxx12_Project.axf

Use file:
Executable offset (hex):

Runtime Options

Attach to Running Target Run on reset

Set PC (absolute hex address or symbol):

GDB run commands:

Figure 11.16. Debug Launch ResetISR PEmicro

5 Fource | ] Common

GDB client

Set breakpoint af: | ResetisR |

When a debug connection is made, the target should halt at this symbol.

To disable the initial breakpoint, uncheck the option ‘Set breakpoint at...". To restore the original
behaviour, replace the symbol ResetISR with main, and check the option ‘Set breakpoint at...".
Alternatively, you could delete the launch configuration and allow the IDE to create a new one.

SEGGER JLink

Edit the project launch configuration by double clicking on the launch config file, select the Startup
tab, replace main with ResetISR

[ Main |5 Debugger | €& GUI Flash To Source| [ Common
Initializaticn Commands

Reset and Delay (seconds): |3

Halt
monitor reset

Load Image and Symbols

Load image

O Use project binary: MK64FN1MOxxx12_Project.axi
Use file:

Image offset (hex):

Load symbols

© Use project binary: MKB4FN1MOxxx12_Project.axf
Use file:

Symbols offset (hex):

Run Commands

Set program counter at (hex):

Set breakpoint at:

Figure 11.17. Debug Launch ResetISR Segger

When a debug connection is made, the target should halt at this symbol.

To disable the initial breakpoint, uncheck the option ‘Set breakpoint at...". To restore the original
behaviour, replace the symbol ResetISR with main, and check the option ‘Set breakpoint at...".
Alternatively, you could delete the launch configuration and allow the IDE to create a new one.

MCUXpresso IDE User Guide -
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11.3.4

Debugging Pre-loaded binaries (Add Symbols)

In a typical debug scenario, a project is built, programmed into flash and debugged. However,
a common requirement may be to debug via a bootloader, or debug additional code preloaded
(into flash) generated by another project(s).

For a good debug experience, symbolic information (and source) for additional project code is
must be made available to the debug environment.

Symbolic information from additional projects can now easily be added via the Other Symbols
tab on a project’s launch configuration as shown below.

Figure 11.18. Debug Launch Additional Symbols

[ BaN ) Edit Configuration

Modify configuration and continue. @

Name: | MyApp_LinkServer Debud

[ Main | %5 GDB Debugger LinkServer Debugger i3 | € GUI Flash Tool | & Startup | %~ Source | ] Common

Load symbols: ${workspace_loc:/bootloader/Debug/bootioader.axf} Workspace. File System..

© Use addresses from file
Use load address (hex):

11.3.5
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To add symbolic information from other projects, simply browse to their .axf files and either use
either the default address or set a new base address for the image data. Use the + button to
add further symbolic information.

Disconnect Behaviour

Once the user has completed a debug session, the debugger connection can be terminated via
the IDE’s Terminate button! The exact behaviour of the target will depend on the particular debug
solution.

LinkServer

For LinkServer, the launch configuration contains a set of options to control what the target should

do when terminated. The default option is for the target to continue running from the current PC
value, however this can be changed by selecting a new setting within the launch configuration.
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Figure 11.19. Debug Launch Disconnect Mode

Name: evkmimxrt1060_iled _li
[E/ Main | %5 GDB Debuggsd
LinkServer Debugger

¢ GUI Flash Tool | Other Symhuls‘ ¥ Startup | % Source 1 Common

Debug Options

Debug Connection SWD |¥

LinkServer Options

~ Debug Connection
Settings for the debug connection

Attach only Reset on Connect Disable use of preconnect script

Reset script E Waorkspace... File System...
Connect script .ﬁ Workspace. .. File System..
BootROM stall
Flash driver reset handling ﬂ Reset handling |7}
Disconnect behavior cont Semihosting support | On [T}

nochange

stop

v cont
run_cont
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Where:

¢ nochange - will leave the target in its current state

e stop - will leave the target in debug state i.e. halted

e cont - the default, will either start the image from its current PC value or leave it running
¢ run cont - will reset the target and let it run

PEmicro

The Terminate button will force the target to halt. Alternatively, for PEmicro debug the IDE
supports another option — to disconnect and force the target to run. This can be achieved via

the IDE’s disconnect ' button.

SEGGER JLink

The target will Run on disconnect by default. The launch configuration option, Disconnect
behaviour can be changed to Halt causing the target to halt on disconnect.

Project Flash Programming
Launch configuration dialogues now contain a GUI Flash Tool tab. This along with the
and provide access to the flash programming

capabilities each of the supported debug solutions.

For each debug solution, the options will vary slightly but the presentation is broadly the same
as shown below. These options are self describing.
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[5] Main [35- Debugger] /= GUI

GUI Flash™TSS
Program e& into flash Debug/MKG4FN1MOxxx12_Project.axf

Target: MKGAF
J Main %5 Debugger > Startup - Source| [[] Common
"""Q‘, o GUI Flash ™50
g et flesly Program file into flash: Debug/MK64FN1MOxxx12_Project.axf
Erase| Ra

Opti @
e Target: MK64j %ﬂ 2
Select the options tg

Format 1o use forpy  Taraet Opeltions

ormattouseTorB  select the target flash [ 5] Main [%5 Debugger (5 Sourt [ common

Base podess Programi, Erase| GUI Flash Tool

Reset target on Fmgram file into 6 Debug/MK64FNIMOxxx12_Project.axf

Actions
Select the action &

© Erase, blank | Ter9et weaww%@

General Options Program and| Target Ope
Flash programming tool Verify Only Select tfe & flash operation to perform
Preview command p_.p’h&vase Resurrect locked Kinetis device
Options
m Select the options| AELio0s

Reset targatl] Select the action to perform

> Startup | &> Source | ] Common

© Program Program (mass erase first)

Verify only Check file areas blank

General Options Options
Flash programming 16} Select the options to apply

Preview comman Format to use for programming @ axf ) bin

Base address

1

Reset target on completion

General Options
Flash programming tool options
Preview command [ Clear console

Figure 11.20. Debug Launch Flash Programming
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To perform the selected operation, simply click the Run button.

Important Note: By default, a launch configuration will be created with Program as the default
Program action, and Mass Erase as the default Erase action. When settings are changed by the
user they will be stored within that project’s launch configuration and will remain until manually
changed (or the launch configuration is deleted). When are used, they
will action the current settings within the selected projects launch configuration (or if none exists,
create a new default launch configuration) - therefore if the Program action is set to Verify, a
Verify will be performed as the Program action.

Breakpoints

When viewing source (or disassembly) during a debug session, you can toggle breakpoints by
simply clicking/double clicking in the left most side of the source view, typically shown as a light
blue column. This is also where the breakpoint symbol is shown when one is set. This can be
done when the target is paused or running.

Breakpoints (and Watchpoints) are also displayed, and can be deleted or disabled in the
Breakpoints View. If you are using the “Develop” perspective, then by default it will be in the
bottom left of the MCUXpresso IDE window tabbed with the Quickstart and other views

If you have closed the Breakpoint view at some point, then you can re-open it using the “Window
-> Show view” menu or ‘Window -> Perspective -> Reset Perspective".

Breakpoint Types

At a basic level there are 2 types of breakpoints:

e Hardware: these are limited in quantity but can be set on ROM (Flash) or RAM. These
breakpoints are provided by the debug hardware built into to the CPU.

e Software: these are implemented by a software instruction BKPT and can in normal
circumstances only be placed on addresses within RAM (since the underlying code must be
changed). These breakpoints can be applied in any quantity and are invisibly placed (and
removed) by the debugger.
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11.4.2

11.4.3
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Usually the debugger will automatically decide the best breakpoint to use for a particular memory
type or circumstance and this is invisible to the user.

Simplistically, software breakpoints will be placed in RAM and Hardware breakpoints are placed
in ROM (Flash).

Tip

@ On some systems, a bootloader may copy code from ROM into RAM for execution —
if a symbol within this code is breakpointed — such as main(), then the debugger may
select a software breakpoint since it knows that main() will reside in RAM. A problem
can arise if the software breakpoint is set by the debugger before the bootloader has
relocated the code. If this occurs, any software breakpoint will be overridden by the
relocated code. MCUXpresso IDE includes support for
- to ensure this problem does not arise in this case, MCUXpresso IDE will force a
hardware breakpoint onto main(). This will not be overridden since this breakpoint
type makes no changes to memory.

Breakpoints Resources

When debugging code running from Flash memory, the debugger is limited on how many
breakpoints it can set at any time by the number of hardware breakpoint units provided by the
ARM CPU within the MCU.

Note: Code located in RAM can use a different breakpoint mechanism offering the capability of
essentially unlimited breakpoints.

Typically, the number of hardware breakpoints/watchpoints that can be set are as follows:

Cortex- M)/ M+ (LPC) - 4 breakpoints, 2 watchpoints
Cortex- M)/ M+ (Kinetis) - 2 breakpoints, 1 watchpoints
Cortex-M3/ Md/ M/ - 6 breakpoints, 4 watchpoints

ARM does provide a level of implementation flexibility, so always consult your MCU
documentation.

If you try to set too many breakpoints/watchpoints when debugging, then the precise behaviour
will depend on the debug solution you are using. For LinkServer an error of the form below will
be generated.

15: Target error from Set break/watch
Unabl e to set an execution break - no resource avail able.

To fix the problem, simply remove the excess breakpoint(s).

Also remember that a breakpoint will be (temporarily) required for the initial breakpoint set by
default on the function main() when you initially debug your application. A breakpoint may also
be required (temporarily) when single stepping code.

Note: When the target is paused, any number breakpoints may be set within the source or
disassembly views of the IDE, however only when the target is Resumed (Run) will the low level
debug hardware attempt to set the required breakpoints. Therefore it is possible to request many
more breakpoints that are supported by the target MCU leading to the error described above.

Skip All Breakpoints

You can use the “Skip all breakpoints” button ® in the Breakpoints view (or on the main toolbar)
to temporarily disable all breakpoints. This can be particularly useful on parts with only a few
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breakpoints available, particularly when you want to reload your image, which will typically cause
the default breakpoint on main() to be temporarily set again automatically by the tools.

11.5 Watchpoints

Watchpoints are Breakpoints for Data and are often referred to as Data Breakpoints. Watchpoints
are a powerful aid to debugging and work by allowing the monitoring of global variables,
peripheral accesses, stack depth etc. The number of watchpoints that can be set varies with the
MCU family and implementation.

Watchpoints are implemented using watchpoints units which are data comparators within the
debug architecture of an MCU/CPU and sit close to the processor core. When configured they
will monitor the processor’s address lines and other signals for the specific event of interest. This
hardware is able to monitor data accesses performed by the CPU and force it to halt when a
particular data event has occurred.

The method for setting Watchpoints is rather more hidden within the IDE than some other
debugging features. One of the easiest ways to set a Watchpoint is to use the Outline View,
which by default this will be located within the IDE Quickstart panel.

From this view you can locate global and static variables then simply select Toggle Watchpoints.

) Quickst )= Global (x Variabl ©g Breakp EE Outline 82 = O

BV ok ¥

= LPC8Bxx.h

= cr_section_macros.h

= stdio.h

' giobs :Itl S Open Declaration Fa

o o Open Call Hierarchy AN H

Open Include Browser L Eel
Refactor >
Declarations >
References >

Smart update >
Utilities >

Figure 11.21. Toggle Watchpoint

Once set, they will appear within the Breakpoint pane alongside any breakpoints that have been
set.

Watchpoints can be configured to halt the CPU on a Read (or Load), Write (or Store), or
both. Since watchpoints ‘watch’ accesses to memory, they are suitable for tracking accesses to
global or static variables, and any data accesses to memory including those to memory mapped
peripherals.

Note : To easily distinguish between Breakpoints and Watchpoints within the Breakpoint view,
you can choose to group entries by Breakpoint type. From within the Breakpoints view, click the
Eclipse Down Arrow Icon Menu, then you can select to Group By Breakpoint Types as shown
below:
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) Quic ®=Glo -Vari 0= Outl % Bre | = O 67 * @brief main routine for hlinky example

coooQe

& s @\
v &5 C/C++ Line Breakpoints
~a systick.c [line: 62]

@ systick.c [line: 79

¥ gu C/C++ Watchpaints

& systick.c [expression: ‘counter1’] €0 Add Event Breakpoint (C/C++)...
i i ! ; & Ti n ~iodic P *

# systick.c [expression: ‘counter2'] €% Add Watchpoint (C/C++)... ! Timer at a periodic rate */

= 68 ¥ @return Function should not exit.
] 69 */
ayout >

@ Add Line Breakpoint (C/C++)...
@' Add Function Breakpoint {C/C++)...

lock / TICKRATE_HZ1);:
«.» Show Full Paths

 Group By > @ 1 Breakpoints
oo Select Default Working Set...
Deselect Default Working Set é 3 Breakpoint ering Sets
Working Sets... | 4 Files
B == 5 Projects
Installed SDKs [ Properties B Cor = 6 Resource Working Sets

nerinh svstick |inkSarver Dehiua [CIC++ (NX % 7 Advanced...

Figure 11.22. Watchpoints View
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As you can see from the above graphic, the option to set a Watchpoint is also available directly
from the Breakpoint view. When set from here, you will be offered an unpopulated dialogue —
simply entering an address will cause a watchpoint to be created, monitoring accesses to that
location.

Another place to set Watchpoints within the IDE is from the context sensitive menu within a
Memory view.

Note: Watchpoint resources are shared with other debug features, in particular an SWO Data
Watch item will require a dedicated watchpoint unit to monitor the value.

Note: Due to the way watchpoints are implemented, any monitored access will be performed
by the CPU before a halt occurs (unlike instruction breakpoints — which halt the CPU before
the underlying instruction executes). When a watchpoint is hit you will see some ‘skid’ beyond
the instruction that performed the watched data access. If the instruction after the data access
changes program flow (e.g. a branch or function return), then the IDE may not show the
instruction or statement that caused the CPU to halt.

Note: Application initialisation performed by the C library may write to monitored memory
locations, therefore you may see your application halting during startup if watchpoints have been
set on initialised global data.

Using Watchpoints to monitor stack depth
Watchpoints provide a very simply way of monitoring stack depth when an application is running.

Stacks on ARM based processors use a Full Descending scheme and so have the potential to
descend into areas of memory used for other purposes (typically holding global data or the heap).
Establishing the maximum depth of an applications stack can be a challenge especially since any
memory corruption due to excessive stack use may not be immediately apparent. Watchpoints
may be used to monitor and trap the stack exceeding a particular depth during execution enabling
positive reassurance that the true stack depth is understood.

The graphic below shows the use of the breakpoint view feature Add Watchpoint (C/C++) ...
where an address has been selected to watch for the Stack reaching 0x10007D00.
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[ NaN ) Broperties for C/C++ Watchpaint
Common Common - - v
Class: C/C++ Watchpoint

Expression to watch: | Ox10007D00
Range:

Read

Write
Enabled
Condition:
Ignore count: 0
@ cancel | (CTHEN |

Figure 11.23. Watchpoint on Stack Depth
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Registers

The Register view, by default located next to the Project Explorer view, will display the internal
ARM CPU registers when the core is halted i.e. when there is an active debug connection but
the target is paused. The contents of the registers view will vary depending on the nature of the
ARM CPU inside the MCU being debugged, however the base register set will be available for
all MCUs.

The Register list as displayed is made up from, the Basic Register set (Core Registers), Fault
and Status Registers, Pseudo Registers, and finally Floating point Registers (for Cortex M4/M7
etc.). Since the register set for many MCUs is large, individual register groups can now be hidden
if required to reduce screen usage.

Note: For many debug tasks, the values of the CPU registers will be of little concern, however
when debugging at the disassembly level (and single stepping), these values can be a powerful
debugging aid. For an in depth understanding of the ARM register set for the CPU within your
NXP MCU, please consult the documentation available from ARM.

Tip
@ Even when operating in LinkServer None Stop mode, registers cannot be read or
written when the target is executing and the register display may appear blank.

Basic Register set (Core Registers)

The basic register set comprises the CPU’s 16 32 bit core registers (rO — r15), plus the program
status register, certain registers have a special function:

¢ r13 — SP Stack Pointer, this holds the address of the last entry on the stack

¢ rl4 — LR Link Register, this holds the return address for a BL (branch with link) instruction

¢ r15 — PC Program Counter, this holds the address of the instruction (to be) executed

e Xpsr — program status register, this combines the Application (APSR), Interrupt (IPSR) and
Execution (EPSR) program status registers, reflecting the state of the CPU

« flags — set by certain instructions performing arithmetic operations (contained within the APSR)

The register set (for a Cortex M4 CPU) is displayed below:
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iitr7 0x2002ffb0 Variable Register 4
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Figure 11.24. Registers View

Note: in this graphic the floating point registers have been hidden

Four blocks of registers are highlighted within the graphic

 registers rO —r15 and the xpsr (the components of this are shown below in the status registers)

« status registers apsr ipsr and epsr, these registers together combine to form the xpsr

« certain bit fields such as the CPU flags are expressed alpha-numerically in this view

¢ Cycles is a memory mapped register that increments for each core clock tick. CycleDelta is a
pseudo register that records the cycles since the last pause (see more below).

 details view displays the selected register in various formats

When paused, all of these registers can be read (or written). The ability to write values to the
registers set is a powerful debug feature but should be used with care.

CycleDelta

CycleDelta holds the number of core clock ticks that have occurred since the last time the
CPU was paused. For example, if you run from the default breakpoint on main to a breakpoint,
cycledelta will contain the number of clock ticks that occurred while executing this section of code.
If a step is performed, the cycledelta will be the number of clock ticks for code being stepped. If
stepping at the instruction level, this value will often be 1 because many instructions will execute

within a single clock cycle.
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Vectpc

In previous versions of MCUXpresso IDE the pseudo register VectPC was used to display a
value when the CPU has experienced a Hard Fault. This functionality has been replaced by the

Faults

During application development, errors within a program or algorithm may lead to a CPU fault
(Hard Fault). These faults include:

» usage fault — such as a divide by zero

¢ bus fault — such as abort triggered by a memory controller

*« mem manage — such as a fault triggered by a memory protection unit

Such errors can be difficult to locate, so to aid the debugging of such problems MCUXpresso
IDE incorporates a Faults view.

If a fault occurs, the new Faults view will automatically appear and the CPU will halt (LinkServer).
The view offers a set of features including identifying the nature of the fault, the location (link) of
the code that caused the fault, the location (link) of the function that called the ‘fault’ function.

Note: for non LinkServer debug probes, a fault may leave the application running within the

default fault handler (usually implemented as a while(1)), hence a pause might be necessary to
see that a fault has occurred.
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| Peripherals+ Registers 't; Faults &2 Symbol View = O

roject Ex

o

1+ Active faults @ main.c [line 195]

( Hard Fault (HFSR)

Indicates a forced hard fault, generated by escalation of a fault with
4% FORCED (30) configurable priority that cannot be handled, either because of priority
\ or because it is disabled

[ Usage Fault (UFSR)
4 DIVBYZERO (9) Divide by zero
.

/I:autt Status Registers

Name Value Description

XPSR 0x61000003 Exception Status Register

CFSR 0x02000000 Configurable fault Status Register
UFSR 0x0200 User fault Status Register

HFSR 0x40000000 Hard fault Status Register

DFSR 0x00000000 Debug fault Status Register
AFSR 0x00000000 Auxiliary fault Status Register

.

b

@ckeﬂ Registers (LR/JEXC_RETURN=0xffffff{9)

Name Value Description

RO 0x00000018B

R1 Ox1FFFO1B8

R2 Ox1FFFO1B8

R3 0x00000000

R12 0x00000011

LR 0x00000513 = main()

PC 0x0000261E = DivideByZero()
PSR 0x61000000

Q Ox1FFFO1 CO/

Figure 11.25. Faults View major features

MCUXpresso IDE User Guide -

This view will be titled with the source file and line number that caused the error. The view
contains the following features:

1. The Fault that occurred — in this example a Usage Fault of type Divide by Zero

« certain faults may need to be enabled within the CPU, for example Divide by Zero is enabled
in the Cortex M4 Configuration and Control register

. The Action that was taken — in this example a Hard Fault was generated
. Links to the source of the fault function and its caller function, located from stacked registers
. values of the registers automatically stacked on entry to the fault handler
. fault status registers that may offer further information
. additional options including:
¢ button to cause disassembly to be opened in parallel with sources (3)
« button to copy the fault details to the clip board
« button to display all fault registers and descriptions rather than the

O WDN

In some circumstances, a hard fault might be caused early on during the initialisation of the
system before the breakpoint on main() is hit. This may mean that the fault is triggered before
the debugger can take action to display the faults view. If this happens, try setting a breakpoint in
the startup code — this might then allow your code to load without the hard fault being triggered.
You should then be able to single step / run until the cause of the hard fault is hit. You will then
see Faults View displayed.
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Tip

@ if a repeated fault occurs that is difficult to debug, instruction trace could be enabled
(when supported by the MCU) and the captured trace dumped when the fault is
trapped. Looking back at the captured instructions should help find the reason for the
fault condition. Please see the MCUXpresso IDE Instruction Trace guide for more
information.

Note: Typically a Fault on an embedded system will be fatal, however this view will also assist
for users developing and testing fault handlers for recoverable fault situations.

Peripherals

Peripherals is a generic term referring to both core peripherals, for example the System Timer
(SysTick) and SOC/MCU peripherals such as an ADC or UART. In both instances these hardware
blocks are exposed within the MCUs address space (known as memory mapped peripherals)
and so can be interrogated by accesses to their specific memory locations.

MCUXpresso IDE’s debug support (whether built in or provided by an SDK) includes knowledge

of an MCU'’s peripheral set, this is available via the Peripherals tab within the Project Explorer
pane (once a debug connection is made).
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[ty Project Explorer ifii Registers #% Faults 3, Peripherals+ i3 §B|lit g = O
Mame Value Access  Location Description -~
» 7 ADCO Ox1c034000  LPC3410x% 12-bit ADC controller (ADC)

» &, ASYNC_SYSCON 0x40080000  LPC5410x Asynchronous system configuration (ASY
» F, CRC_ENGINE Ox1c010000  LPC3410x CRC engine
> E'-—e, CTIMERD Ox400b4000  LPC5410x Standard counter/timers (CTIMERO to 4)
» =, CTIMER1 Ox400b8000  LPC3410x Standard counter/timers (CTIMERO to 4)
> % CTIMER2 Ox40004000  LPC5410x Standard counter/timers (CTIMERO to 4)
> 2, CTIMER3 0x40008000  LPC5410x Standard counter/timers (CTIMERD to 4)
» E CTIMER4 Ox4000c000  LPC3410x Standard counter/timers (CTIMERD to 4)
v %‘ DMAD Ox1c004000  LPC5410x DMA controller
» o1 CTRL Ox 00000000 RW Ox1c004000  DMA control,
» ' CFG 000000000 RW Ox1c004000  Configuration register for DMA channel .
» o INTSTAT 0x00000000 R Ox1c004004  Interrupt status.
» 33 CTLSTAT (00000000 R Ox1c004004  Control and status register for DMA channel .
> 457 SRAMBASE 000000000 RW Ox1c004008  SRAM address of the channel configuration table.
» 33 XFERCFG DxD(I}(I}ODD RW Ox1c004008  Transfer configuration register for DMA channel
3 Mol ENARLESETO Ox1c004020  Channel Enable read and Set for all DMA channels.
__-__
» 8 ACTIVED RW Ox1c004030  Channel Active status for all DMA channels.
> i BUSYO OXOOOUODOD RW 0x1c004038  Channel Busy status for all DMA channels,
s 33 ERRINTO 000000000 RW Ox1c004040  Error Interrupt status for all DMA channels.
> 4h8 INTENSETD 0:00000000 RW Ox1c004048  Interrupt Enable read and Set for all DMA channels.
| >MINTENCLRO W Ox1c004050

RW Ox1c004058  Interrupt A status for all DMA channels.

RW O 1c004060  Interrupt B status for all DMA channels.
W 0x1c004068  Set ValidPending control bits for all DMA channels.
W (xIc004070  SetTrigger control bits for all DMA channels.
W 0x1c004078  Channel Abort control for all DMA channels.

> & GINTO 0x40010000  LPC5410x Group GPIO input interrupt (GINT0/1)

> Z, GINTI 040074000  LPC3410x Group GPIO input interrupt (GINTO/1)

b ?-h GPIO 0x1c000000  LPC5410x General Purpose |/0 (GPIO)

> E 12C0 040094000  12C-bus interface 0

» % 12C1 Oxd0098000  12C-bus interface 0

» & l2Q2 0x4009c000  12C-bus interface 0

< 3

Figure 11.26. Peripherals View

In this view each peripheral is listed along with its value, base address, access and a brief
description. The view also exposes the inner peripheral registers and offers bit field enumerations
to greatly simplify both reading existing configurations and setting new values.
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| iy Project Explorer LiLi Registers 4 Faults 7, Peripherals+ 13 Bl i =D
Name Value Access  Location Description !
» 1 MAILBOX O1e02e000  LPCS10x Mailbox
v &, MRTD (x40074000  LPC5410x Multi-Rate Tirer (MRT)
» 7y NVIC Oue000e100  Mested Vectored Interrupt Controller
¥ 5 PINT 0aD018000  LPCHI0x Pin internupt and pattern match (PINT)
& RT 80070000  Repetitive Interrupt Timer
» Fa FIC (003000 LPC5410x Real-Time Clock (RTC)
y B 3CTO 01018000 SCTimer/PWM (5CT)
» 5L SPID (480024000  SP1
» B, SPIN 040028000  5PI
w 7 SYSCON (0000000  System configuration
» 4ii SYSMEMREMAP 0500000002 RW 00000000 Systern memary remap
s M3 AHEMATPRIO O Q0000000 RW (40000004 AHE multilayer matrix prionty contrel
» a1l SYSTCKCAL Do OODO0000 RW (20000014 System tick counter calibration
DacDOD00000 RW Dae8000001 € MM Source Select
) O 0000000 RW (0000020 Asynchronous APB Control
» a1l SYSRSTSTAT 0000001 RW (20000040 °  System reset status reguster
» 3y PRESETCTRLO DeeDODO0000 RW e 200000 Penipheral reset control n
» O 00D0000 " RW (ed0000043  Peripheral reset control n
» itsl PRESETCTRLSETO) Do OOOOO0D0 RwW (xd000004c  Set bits'in PRESETCTRL n
5 3 PRESETCTRLSET]1) O 00000000 RW (80000050  Set bits in PRESETCTRL n
) PRESETCTRLCLR[D]) Qe DO000000 RW DedD000054  Clear bits in PRESETCTRL n
» 4 PRESETCTRLCLR{1] O OO0OO0D0 RwW (40000058 Clear bits in PRESETCTRL n
s Mt PIOPORCAPD O T9e2 3t RwW (000005  POR captured PIO status 0
» PIOPORCARY D DO RW Oe0000060  POR captured PIO status 1
¥ PIORESCAPD Ox T3 RW (0000068 Reset captured PIO status
L Ll PIORESCAP) QL0003 BW 0000006 Resel Cactured PIO gtatys |
w 1 MAIMCLKSELA D 00000000 RwW Ow40000020  Main clock source select A
L1 IRC OSCILLATOR  ~ | RW 101 Clock source for main clock source selector A
> 8t MAINCLKSELB W (40000084 Main clock source select B
5 I8 ADCCLKSEL CLKIN (x4000008c  ADC clock source select
» aiy CLKOUTSELA Wﬁ'{EHI}DG GKIL"&TO.R... OcdD000034  CLEQUT clock source select A
> a0 CLROUTSELE [T RW DHal0ues  LLROUT clock source select B
» 214 SYSPLLCLKSEL 00000000 RW 02000000  PLL clock source select
W AHBCLKCTRLO 00000211k RW Oc200000c0  AHB Clock control n
AHBCLKCTRL1 O 000O0000 RW (000004 AHE Clock contrel n
AHBCLKCTRLSETIO] 000000000 Rw (4000008 Set bits in AHBCLKCTRL n
» 38 AHBCLKCTRLSET[1) CocOOOO00D0 RW (ud00000cc  Set bits in AHBCLECTRL n
AHBCLKCTRLCLRIO] 000000000 RW (40000040  Clear bits in AHBCLECTRL n
3 AHBCLKCTRLCLR{1] 000000000 RW (40000044  Clear bits in AHBCLECTRL n
» 418 SYSTICKCLKDIV CocOOOOO0D0 RwW (000000 SYSTICK clock divider
Do OO00000 RW Q000004 TRACE clock divider
3 000000001 RwW (40000100  Systern clock divider
» 48 ADCCLKDIV CocOOOOO0N0 RW (40000108 ADC clock divider s
3

Figure 11.27. Peripheral Register View Modifying Bit Field Value

Important Note: When an MCU powers up, many peripherals will be unavailable because they
are unpowered/not clocked. Attempting to access a peripheral in this state will result in failure, and
the peripheral view will simply display them in red. Certain peripherals may be partially available,
unavailable sections will again display in red. Entries that have changed, will display in yellow.

Tip

Even when operating in LinkServer None Stop mode, peripherals can not be read or
written when the target is executing. The main peripheral display may appear blank
when the target is executing regardless of LinkServer mode.

Warning: It is strongly advised that only peripherals that are well understood are accessed
in this manner since attempting to view certain peripherals can break a debug connection or
perform other unexpected actions. MCUXpresso IDE’s debug features cannot offer protection
from such occurrences.
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The view also lists in the main menu the device memory regions. If these memory regions are
selected, a standard hex memory display will be created. Memory regions are not peripherals in
the normal sense but are included here so their memory space can be easily displayed.

5 Project Explorer  Ulf Registers % Faults 2, Peripherali+ 32 SIB|ri § 0O {5Dewg
Name Vslue Access Location  Description 0 Addmemory monitor > |1 PROGRAM FLASH 7+ I8 swrecondctard w1 Cemeson)
. TP G caan D5 1Y (comex-ma)]
7, ADCO e1e034000  LPCS410x 12-bit ADY camtrolles (ADC) | v o Tread 2 e
7, ASYNC_SYSCON (40080000 LPCS410x Asynchrofous system configuration (ASYN. " e
7, CRC_ENGINE (e1c10000  LPCS410x CRC engifle 8 amuenand [
2, CTIMERQ Ox400B4000  LPC5410x Standard flountes/timers (CTIMERD to 4)
#, CTNMER] 040068000 LPCS5410x Standard |uur|leu't|m!rs {CTIMERD to 4)
CTIMER2 40004000  LPC5410x Standard counter/timers (CTIMERD to 4)
CTIMERS 0xd0008000  LPCS410x Standard counter/timers (CTIMERD to ) €] hellowordc 57 [€] main{) at hello_world.c:35 Ond2e
7, CTIMERS 0x4000<000  LPES410x Standard counter/timers (CTIMERD to 4) 16 #include "f3l_debug_console.h”
7, DMAQ De1¢004000  LPCS410x DMA controlles 11 minclude “board.h”
2, GINTD 040010000 LPCS410x Group GPO input interrupt (GINTD/) it R
2, GINTI 0640014000 LPC3410x Growp GPIC input intemupt (GINTO/ 1) L2 Sinchule  pinmuwch)
., GPIO 0x1c000000  LPC5410x Genersl Purpose 110 (GPIO) -
, 1200 (ed0024000  12C-bus interface 0
2, 12C1 Oed0098000  12C-bus interface 0
1262 OxA009000 120 bus interfacs O
Figure 11.28. Peripherals View Memory Regions

11.8.1 Custom SVD File

User can specify a custom SVD file location inside of a project. This can be achieved from Project
Properties -> Run/Debug Settings -> MCU Settings -> SVD Selection. The file will be used by

Peripherals+ view when debugging that project.

n Properties for Ipcxpresso54102_hello_world

*| | MCU settings

» Resource .
Builders SVD selection
5 C/C++ Build Location | using default SVD file

C/C++ General
Project Matures
Project References
~ Run/Debug Settings
MCU settings
Task Tags
+ Validation

Browse Project...

Restore Defaults

Apply and Close

O *
- ~ 8
[
Browse...
Apply
Cancel

Figure 11.29. SVD Custom Selection

The SVD file can be imported from:

« the selected project
¢ acustom file location
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In the default case, where this file is not specified, the SVD is loaded from the associated SDK.

11.9 Offline Peripherals

MCUXpresso IDE provides a way to inspect the peripheral registers without the need for an
active debug session. Registers are shown with the fields, but of course without the actual values.
Instead the view shows the reset value for the registers.

[ Installed SDKs  [[] Properties |2 Problems B Console 3 Terminal |5 Image Info E Debugger Con... =, Offline Periph.. 22 = O

(mHe]x e

=i

La
Context: LPC34102)512 - crmlplus
Name Reset Value Access  Location Description i
> 2, ADCO (1034000 LPC5410x 12-bit ADC controller (ADC)
=2, ASYMNC_SYSCON 0x40080000  LPC3410x Asynchrenous system configuration (ASYN...
=2, CRC_ENGINE Ox1c010000  LPC53410x CRC engine
w o CTIMERD (eAD0b4000  LPC3410x Standard counter/timers (CTIMERD to 4)
w IR Ox 00000000 RW Ox400b4000  Interrupt Register. The IR can be written to clear interr...
il TCR Ox 00000000 RW 0x400b4004  Timer Control Register, The TCR is used to control the ..
T Ox 00000000 RW 0x400b4008  Timer Counter, The 32 bit TC is incremented every PR..
18 PR 0z 00000000 RW Ox400b400c  Prescale Register. When the Prescale Counter (PC) is ...
i PC Ox 00000000 RW 0x400b4010  Prescale Counter. The 32 bit PC is a counter which is i...
i MCR 0w 00000000 RW 0400b4014  Match Control Register, The MCR is used to control if ...
8 MR[O] Ox 00000000 RW 0x400b4018  Match Register. MR can be enabled through the MC...
i MR[1] Ox 00000000 RW Ox400b401c  Match Register . MR can be enabled through the MC...
w 301 MR[2] Ox 00000000 RWw Ox400b4020  Match Register . MR can be enabled through the MC...
& MATCH 0x0 RW [31:0] Tirmer counter match value,
i MR[3] Ox 00000000 RW 0x400b4024  Match Register. MR can be enabled through the MC...
i CCR Ox 00000000 RW Ox400b4028  Capture Control Register. The CCR controls which ed...
88 CRIO] Ox 00000000 R xd00b402c  Capture Register . CR is loaded with the value of TC w...
w 308 CR[1] Ox 00000000 R On400b4030  Capture Register . CR is loaded with the value of TC w..,
& cap 00 R [31:0] Tirmer counter capture value,
w 0 CR[2] 0z 00000000 R Ox400b4034  Capture Register . CR is loaded with the value of TC w...
o cap Ox0 R [31:0] Timer counter capture value.
w 38 CRI3] O 00000000 R (40004038 Capture Register . CR is loaded with the value of TC w..,
& cap 00 R [31:0] Tirmer counter capture value, ]

Figure 11.30. Offline Peripherals View

The view provides three ways of importing peripherals:

e from a local file
« for the device/core used by the selected project
« from a list of available devices
Tip
Holding the mouse over the bit field, it will show a tooltip that includes the detailed

description for the current value and also the descriptions for the other possible
values.
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({30 Installed SDKs [ Properties [#] Problems B Console (® Terminal |5} Image Info [l DebuggerCon.. 2, OffinePeriph.. 22 = B
@ X8|

Context: LPC541021512 - emlplus

Name Reset Value Access  Location Description e
» ‘.=il, CTIMER1 Ox40002000  LPC5410x Standard counter/timers (CTIMERD to 4)
» £, CTIMER2 Ox40004000  LPC5410x Standard counter/timers (CTIMERD to 4)
» &, CTIMER3 040008000  LPCS5410x Standard counter/timers (CTIMERD to 4)
% "Eil-| CTIMER4S Ox4000c000  LPC5410x Standard counter/timers (CTIMERD to 4)
w = DMAD Ox 1004000  LPC5410x DMA controller
w 1 CTRL Oae 00000000 RW Ox1c004000  DMA control.
& ENABLE DISABLED RW 0] DMA controller master enable.
w it CFG Che0OD0O000 RW 01004000  Configuration register for DMA channel .
& PERIPHREQEN DISABLED RW [0] Peripheral request Enable. If a DMA channel is used to...
® HWTRIGEN DISABLEM— g A . . nable for this channel.
3: TRIGPOL ACTIVE. Disabled. Hardware triggering is not used. | the polarity of a hardware trig. .
o TRIGTYPE EDGE  |possible values: erdware trigger as edge triggere...
& TRIGBURST SIMGLE | - DISABLED (0nx0) - Disabled. Hardware triggering is not used. phether hardware triggers cause...
& BURSTPOWER o0 - ENABLED (0x1) - Enabled. Use hardware triggering. two ways. It always selects the ...
& SRCBURSTWRAP DISABLED RW [14] Source Burst Wrap. When enabled, the source data ad...
& DSTBURSTWRAP DISABLED RW [15] Destination Burst Wrap. When enabled, the destinatio...
:, CHPRIORITY 00 RW [18:16] Priority of this channel when multiple DMA requests ...
» Che0OOO0000 R 01004004 Interrupt status.
> Wit CTLSTAT 00000000 R (1004004  Control and status register for DMA channel .
SRAMEBASE (b 0ODDO000 RW Ox1c004008  SRAM address of the channel configuration table.
XFERCFG 000000000 RW Ox1c004008  Transfer configuration register for DMA channel ,
Wit ENABLESETD Oae 00000000 RW Ox1c004020  Channel Enable read and Set for all DMA channels.
% MW ENABLECLRO 0600000000 w 0x1c004028  Channel Enable Clear for all DMA channels. v

Figure 11.31. Offline Peripherals View Bit Field Information

11.9.1 Loading Custom SVD File in Offline Peripherals view

To load the custom SVD file which was set into Project Properties, just push the “Load peripherals
for device used by selected project” button. The location from where it was provided can be found

in Context.
@) Installed SD... [T] Properties [£] Problems ) Console (8 Terminal |5 Image info GJ DebuggerC.. & OfflinePerip.. 32 = B
uf@e| % el
Context: ${workspace_loc)/${ProjName)/startup/LPC54102_cmdxml ]
Mame Reset Value Access  Location Description o
> 2 ADCO 0x1c034000  LPC5410x 12-bit ADC controller (ADC)
» % ASYNC_SYSCON (40080000  LPC5410x Asynchronous system configuration (ASYN
» 7 CRC_ENGINE 01010000 LPC3410x CRC engine
» ﬁ CTIMERD Ox400b4000  LPC5410x Standard counter/timers (CTIMERO to 4)
» % CTIMER1 Ox400b8000  LPC5410x Standard counter/timers (CTIMEROQ to 4)
» .71.'. CTIMER2 0x40004000  LPC5410x Standard counter/timers (CTIMERO to 4)
» % CTIMER3 0x40008000  LPC5410x Standard counter/timers (CTIMERQ to 4)
» 2, CTIMER4 0x4000c000  LPC5410x Standard counter/timers (CTIMERO to 4)
> 2, DMAD Cx1c004000  LPC5410x DMA controller
» &, GINTO 040010000 LPC5410x Group GPIO input interrupt (GINTD/1)
» #a GINTI 0x40014000  LPC35410x Group GPIO input interrupt (GINTO/1)
=TT [ANEPC T ST, Yol FET, Oy SSNE'Y SN Vo W71, 7,0
< >

Figure 11.32. Load Custom SVD File

11.10 Global and Live Global Variables

Global and Static variables are stored within system RAM memory and can therefore be
accessed by the debug chain (read and potentially written) while an application is both paused
and running.
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Note: ARM processor inside the NXP MCU utilises a load store architecture, this means that a
global variable must be read (loaded) from memory and then written back by the processor (if
changed). The value of the variable displayed will correspond to the value in memory and this
may potentially be different from the value held by the processor. Modern MCUs execute millions
of instructions every second, so any variable observed while an application is running may have
been changed many times from the value displayed in the view, therefore take care that this is
understood before attempting to change a variable value within the Global variable view.

This view can be populated from a selection of a project’s global variables. Simply click the “Add
global” button to launch a dialogue:

Quickstar - GlobalVa 3¢ (- Variables o Breakpo Outine = O
ar 3K t i -
—r
Mariaths Type *Adﬂ global variables jus

Figure 11.33. Add Global Variables

This will then display a list of the global variables available in the image being debugged. Select
the ones of interest via their checkboxes and click OK :

L] [ ] Select symbols.
Name ~ Address Size
_Ciob 0x2000007¢ 180
_end_of_heap 0x20000130 4
__heaps 0x20000134 4
_num_Ciob_streams 0x00008670 4
_Vectors 0x00000000 408
errno 0x20000138 4
Flash_Config 0x00000400 16
g.accel_address O0x00005974 4
g_MasterHandle 0x20000014 40
a_pfnVectors 0x00000000 408
I g_xAngle 0x2000003¢ 2
g_xDuty 0x20000040 2
g_xtal0Freq 0x20000044 4
g _xtal32Freq 0x20000048 4
g_yAngle 0x2000003e 2
g_yDuty 0x20000042 2
Select All Deselect All
@ Cancal | (L

Figure 11.34. Global Variable Selector

Note: to simplify the selection of a variable, this dialogue supports the option to filter (highlighted)
and sorts on each column.

Once selected, the chosen variables will be remembered for that occurrence of the dialogue.

For all supported debug chains there is now the capability to view global variable values when the
debug target (MCU) is running. When this feature is used, these are known as " Live Variables".

For variables to be “Live”:

* the target must be running
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« the enable/disable (run) button clicked (as shown highlighted below)

Once done, the display will update at the frequency selected (selectable from 500 ms to 10 s).

) Quickstart Panel ()= Global Variables 83 ()= Variables 9 Breakpoints 5= Outline = 0

X & @ 1000 o 4B I =
Variable Type Value Address

v (#®array uint32_t (4] 0x20000018 <array>  0x20000018

09=array[0] uint32_t 1 0x20000018
oa-array[1] uint32_t 85 0x2000001¢
co=array[2] uint32_t 10 0x20000020
-=array[3) uint32_t 7 0x20000024
9:g_xAngle volatile int16_t 25 0x20000120
©9:g_yAngle volatile int16_t 1 0x20000122

5 Add new expression

Figure 11.35. Global Variable Display

Also available is the ability to enter an expression (using standard C notation) or symbol. The
expression will be evaluated and the address displayed in the Address column.

Quickstart Panel ®)= Global Variables 23 Variables Sreakpoints Outline =0
R4 Q1000 == =
variable Type Value Address
b (Barray uint32_t [4] 0x20000018 <array> 0x20000018

=g_xAngle volatile int16_t 86 0x20000120
(-9 gle volatile int16_t 3 0x20000122

0
0 t32_t *) 0x20000018 fuint32_t 103 0x20000018

Figure 11.36. Global Variable Display Expression

Live Variables like normal Globals can also be edited in place. Simply click on the variable value
and edit the contents. During the edit operation, the display will not update. This mechanism
provides a powerful way of interacting with a running target without impacting on any other aspect
of system performance.

Note: If you wish to have some global variables ‘Live’ and others not, then this can be achieved
by spawning a second Globals display via the ‘New View’' button and populating this without
enabling the ‘run’ feature for that view.

The usefulness of Live Variables reduces as the number of Globals monitored increases, and
ultimately there will be a limit as to how many variables can be updated at the selected frequency.
However, complex list of variables can be monitored if required. For example:
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) Quickstart Pa ¢ Global Variabl 82 (- Variables ©p Breakpoints 5= Outline = 8
Variable Type p.
©)=_random_j <data variable, no debug info> 25
©9=_random_k <data variable, no debug info> 2
©=b _Bool frue
e-f float 62.9931755
®=d double -0.88162727834732613
»p void * 0x20000130 <bi_a>
=i volatile int 5
®=] int 3
=k int 3
¥ (®=uni_a double [5] 0x20000108 <uni_a>
6d=uni_a[0] double 0.64644408768343009
©9=uni_a[1] double 0.52534067329267975
69-uni_af2] double 0
6d=uni_a[3] double 0
(d=uni_a[4] double -0.69493926395426475
v (®bi_a float [3][3] 0x20000130 <bi_a>
¥ (=bi_a[0] float [3] 0x20000130 <bi_a>
69-bi_a[0][0] float 77.4734955
©9=bi_a[0][1] float 92.8390503
©4-bi_a[0][2] float 46.7962074
v (= bi_a[1] float [3] 0x2000013c <bi_a+12>
©9-bi_a[1][0] float 63.3472824
69=bi_a[1][1] float 95.4246292
©9-bi_a[1)[2] float 30.6657524
» (®bi_a[2] float [3) 0x20000148 <bi_a+24>
» (*=s example char [15] 0x20000154 <s_example>
v ®s ex1 struct Struct_example {--}
> #name char [5] 0x20000168 <s_ex1>
=5 | int 3

Figure 11.37. Global Variable Display Complex

11.11 Live Global Variable Plotting

MCUXpresso IDE User Guide -

In addition to displaying Live Variables the IDE can also trace (sample) their values for plotting
as graphs, logging, or calculating statistics.

By default it is assumed that variables values may be traced but alternatively their values can be
displayed in a details view via a right click menu selection.

View Memory

Number Format >
Find... ®F
Show Details As | v 1 Trace Data Viewer
2 Number Formats Viewer
&, Cast To Type... L

«[] Display As Array...
Restore Original Type
%Y Watch

Variables can only be traced if they have first been added to the Global Variable panel as
discussed in the previous section. The selection of variables to plot is simply made by clicking
to highlight the variable of interest.

Note: Once a variable has been selected, the timebase (uptime) will begin and variables values
will be sampled and displayed. If additional variables are selected, their values will join the
display at the current uptime. If a variable is unselected its values will no longer be sampled and
displayed. If however, it is selected again within the same debug session, it will be displayed
along with any previously captured values. During any period it was not selected its values will
show as zero.

Tip

If the display is paused, data will still be captured but the new values will not be
displayed, this can help detailed viewing of the data. Once un-paused, the captured
data will be added to the display.

Note: If the target is paused, time (x-axis) will continue to advance although the display will not
update until the target is resumed.
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11.11.1 Live Global Variable Graphing details

In the example below, two variables have been added to the Global variable view and both have

been selected for tracing.

2= Qutline | #9- Clobal Variables £ X 57 Q500 " #@O ™Y 20
Variable Type Value Address
69=sin_angle int32_t 74 0x2000011¢c
t9-=angle uint32_t 12 0x20000118
w"e Add new expre...
O ¥ EH X (=
Trace | Statistics f f
BARNRE Th 4 whsal-@ 3]
frdmk641_bubble O
411.8 O
g 200 - O
2
s, ]
%
®)
.7 T- - Y SO NS WS FSUESUUS VSRS RS UOUSISIVR UNPSNISSS NUsmils RS ve—
10 ds 14s 24s 34s 44s 54s 1mds 1mids 1m3ds
t0 = 1m 58s O
Baa4 = @k @ FLK23100
frdmk64f_bubble
394.8
300
2 200
-
m
100 L
-34.4 i 2 oot e
10 4s 14s 24s 34s 44s 54s 1mds Imids 1m34s
W=0

Figure 11.38. Global Variable Graphing major features

The highlighted features are explained below:

MCUXpresso IDE User Guide -

1.

Selected variables for . Click the checkbox to select a variable for plotting

¢ Once selected the variable will exist in the internal database of values and will remain until
the debug session is terminated (even if it is later unselected)

. Plot types: the traced data may be viewed in 3 ways:

« Plot — display as a graph over time
 trace — log the values
« Statistics — calculate statistics for the traced values (max, min, average)

. Resume and Pause: Click Resume to start plotting variables. Click to pause the graph display

updated. Variables values will still be captured but the screen will not update

. Save: Click to save the captured data.

« the size of the png will be proportional to the size of the global view. Therefore, for more
detail, increase the size of the global view before saving

« this button will offer the option to save each of the Plot types of Plot (png), Trace (tsv),
Statistics (tsv)

. Clear Data: Display: Click to discard any traced date
. Show or Hide the Graph Toolbar
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7. Multiple/Single Graphs: Click to toggle the display between separate graphs for each variable
and all variables plotted on a single graph

8. Click on the graph to see the X,Y co-ordinates for the selected point
9. Graph Toolbar — explained below

Clicking the button marked as (7) will combine individual graphs into a single graph view.

9= Qutline - Global Variables ® &7 Q500 ¢ foff® Y =2 0
Variable Type Value Address |
4 )-sin_angle int32_t 74 0x2000011¢

4| t2=angle uint32_t 12 0x20000118

o= Add new expre...

o G X =
lgﬂfg;ﬂ__Tra c'e'_ Statistics ,

waQhFH R 40 Frtal@
430.8

300
200 -

100 -

=100 -
-200 -

=300

-430.8 T T T T T T T T
10 4s 14s 24s 3d4s 44s 54s 1mds 1mids 1m3ds

——sin_angle —angle

Figure 11.39. Multiple Global Variable Graph

Each graph view has an optionally visible Toolbar (6). The annotated image below shows a
magnified version of the Toolbar.
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\Plot , Trace Siatistics

% a s Ok

5.5U.8
30 —_

‘-r IEIIJL_‘ \.I

Q,
1o o
0 | ‘I'
-100 '
-200 \

-300 \—f
-430.8

t0 ds 14s 24s 3ds
|

W=0

545 Tmds Tmids

|——sin_angle

Figure 11.40. Global Variable Graph Toolbar

Where:

1. Autoscale the display to show all of the data

2. Zoom In and Out: Select the desired button and then click into the area of the graph where

zoom is required

3. Zoom Horizontally and Vertically: Select the desired button and then select and drag within

the graph to perform the desired zoom

4. Panning and None: Select Panning to click and drag a zoomed display. Select None to prevent

interaction with the graph

5. Undo and Redo: Click these button to cycle through previous actions

6. Add a Legend (shown)

7. Add and remove Annotations. Annotations can be named and will snap to a plotted point and

display its value

8. Measure Horizontally or Vertically: Click and drag to snap between plotted points to measure

the value of their separation
9. Save the graph as a png file

11.12 Heap and Stack View

Located by default in the MCUXpresso IDE Develop perspective, along with the Memory view

at the bottom right of the perspective.

One of the common issues within embedded system development is allocating the appropriate
memory for heap and stack usage. The Heap and Stack View offers the ability to monitor heap
and stack usage within their allocated regions of memory. The View allows the monitoring of heap
usage in real time (while an application is running). However. since the value of the Stack is held
within a processor register, Stack usage can only be updated when the application is paused.

The Heap and Stack view displays usage with respect to the configured heap and stack sizes as
set within the Projects Properties at: C/C++Build -> Settings -> Manager Linker Script -> Heap

and Stack placement
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] Memory )= Heap & Stack Usage &2 Q -
Type Usage (%) Used Free Last Used Address Address Range
Heap 81.54% 1.26 KB 2.74 KB 0x2000062¢c 0x20000120 - 0x20001120

stack NS 335«s 6648 o0x2002f208

Figure 11.41. Heap and Stack View

:..z,)f v = "8

0x2002f000 - 0x20030000

This view will automatically update when the target is paused. To enable updating of the heap
usage when the debug target is running, click the Run icon at the top of the view to enable or
disable updates to the view. The frequency of the updates can be set between 500ms and 10

seconds.

Tip

@ Although real time monitoring of the stack is not possible, a watchpoint could be used
to force a target halt when an access to a particular stack depth is performed. Please
see further details in the section on

The symbols used to generate this view are created by the Managed Linker Script mechanism.
However, other symbols can be substituted if required via the workspace preferences as show

below:
¥ C/C++ Build
5“"# Variables #Build steps Build Artifact  |iid Binary Parsers @ Error Parsers
Environment
Logging ] ¥ I3 MCU C Compiler Last used address of the heap _end_of_heap
MCU settings & Dialect
?e“llgg: - @& Preprocassor First address of the heap _pvHeapStart
ool Lty Baor #Includes Maximum extent of heap _pvHeapLimit

»C/C++ General
MCUXpresso Config Too
Project Natures
Project References S

. - (£ Miscellaneous
Run/Debug Settings 5 Architecture
Tas‘kTrfags ¥ ) MCU Assembler
» o
Validation # General
(2 Architecture & Headers
¥ 3 MCU Linker
(2 General
(# Libraries
(# Miscellaneous
(%2 Shared Library Settings
(2 Architecture

=

¥ Managed Linker Script

( Optimization
(22 Debugging
& Warnings

Figure 11.42. Heap and Stack View Symbols

Tip
@ As a guide the memory usage % display will be colored green when more than half
of the available memory is free, then changing through yellow to red if more memory

is used

11.13 Additional Debug Features

11.13.1 Local Variables

Situated alongside the Quickstart panel, the local variable view displays the local variables in
scope when the target is paused. Typically, local variables are held within processor registers
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and so are cannot be accessed when the processor is running. From this view registers can be
viewed and their values edited if required.

Quickstart Panel ()= Variables £3 Breakpoints =
5B et v
Name Type Value
» (= fxosHandle fxos_handle_t {.}
» (#sensorData fxos_data_t $ud
» (= config fxos_config_t {.}
9=sensorRange uint8_t 1 001"
(x)-dataScale uint8_t 4 004"
9=xData int16_t -537
(9-yData int16_t -37
=i uint8_t 11001"
(d-array_addr_size uint8_t 4 '\004'
9-result status_t 0
Figure 11.43. Local Variables View

11.13.2 Disassembly view

The Disassembly view allows an application’s code to be viewed at the assembler level (as
generated by the compiler).

The view can be enabled (if required) via the Instruction Stepping button within a debug
stack view. This button has two functions, in that it both spawns the view and also switches
stepping mode from source level to assembler level. Assembler level stepping is typically used
in conjunction with the Registers view to examine the detailed behaviour of short pieces of code.

Stepping mode can be returned to source level by re-clicking this button.

45 Debug 2 = = |
¥ B frdmké4f_bubble LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application]
¥ [ frdmk64f_bubble.axf [MKE4FN1MOxxx12 (cortex-mé)]
¥ ® Thread #1 1 (Suspended : Breakpoint)
= main() at bubble.c:364 Oxaae
. arm-none-eabi-gdb (8.2.50.20181213)

Figure 11.44. Disassembly Enable

Once enabled, the disassembly view will display the low level assembler instructions usually
from the current PC.
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20000ala:
359
00000a9c:
A0en0ale:
00@00aald:
00000aaZ:
A000daad:
00000aa6:
361
poedoaad:
20@00aaa:
Aevddaac:

2364

> 0000Paae:
Beedoabe:
00000ab2:
20000abd:
00000ab6 :
20000ab8:
Aoeddaba:
00000abc:
ABeddabe:
foedoaca:

Figure 11.45. Disassembly View

strh

dr
ldrh
sxth
uxth
cmp
bhi.n

ldr
movs
strh

dr
ldrh
sxth
mov
ldr
ldrh
sxth
mov
ldr
bl

[ Enter location here

B aslE)e ~=0o

r2, [r3, #0]

if (g_yAngle < ANGLE_LOWER_BOUND)
; (@xafc <main+824>)

r3, [pc, #92]

r3, [r3, #0]
r3, r3
r3, r3
r3, #4

@xaae <main+746>

g_yDuty = 8;
r3, [pc, #88]

r2, #@
r2, [r3, #0]

; (@xbe4 =main+832>)

PRINTF("x= %2d y = %2d\r\n", g_xAngle, g_yAngle);
; (@xaf8 <main+820>)

r3, [pc, #72]

r3, [r3, #0]
r3, r3

r3, [r3, #8]
r3, r3
re, 3

re, [pc, #72]

r3
r3, [pc, #68]

; (exafc <main+824>)

i (8xbe8 <main+836>)

@x3c94 < printf>

11.13.3

The view has a number of features including:

Setting a new address to view
Refreshing the view contents (this might be useful if the underlying code may have changed)
The linking and unlinking from the current debug session (PC)

The intermixing of source code lines with their related assembler instructions
« the usefulness of this feature decreases as compiler optimisation increases

Memory view

Stacked by default in the MCUXpresso IDE Develop perspective, along with the Heap and Stack
view. The memory view allows debug target memory to be explored in a traditional manner. The

view can be populated with target memory regions via the

required address values.

or by entering

0 Memory 52

Monitors

¢ O0x0

tion

(::::)‘ %i:'u!:'u!.”.;.‘f.:; S
- x@8080000 20030000

Figure 11.46. memory View

@ 0x20000000 | exeeeeeale POBOD255
| 0xe0000020 00000000
|0xﬁeﬂﬂﬂﬁ3ﬂ aoeen2sd

® © Monitor Memory p4395
B43B5

Enter address or expression to monitor: B43D5

. < B43F5
[l M paa1s
B4435

04455

e = _ B4475
@ | concel | (IS basos
B44B5

00000105
00000257
@ooooe0e
faeo0eee
620084390
000043BD
000043DD
000043FD
0000441D
00080443D
0000445D
0000447D
00004490
00004480
000044DD

0e20e6B1

00@R44ES

my e [ 4 [ 8] (% %

.57 New Renderings...
00008251 0DER4TTE 0...0...{G
00008259 0oceeood Ueao Waaa Yous wuus
00000000 0GBBOB25E  .... iias weas |
00eeR25F @oeew261 Vi wwwn _swe e
POOBA3AS 0BAR4A3AD R " S o
000043C5 000@43CD  pC.. %C.. AC.. IC
POBO43ES 0BB@43ED  DC.. YC.. &C.. iC
00004405 00804480  6C.. yC.. .D.. .D
00004425 @GoOR442D D...D..%D..-D
00004445 000e444D 5D..=D.. ED.. MD
00004465 00e446D up.. 1D.. eD.. mD
008084485 @oae448D WDes Haa oDisiD
000R44A5 0GBOAB44AD D...D..¥D..D
P00B44C5 POAB4A4ACD  uD.. %D.. AD.. 1D

0D.. YD.. ... 8D..

MCUXpresso IDE User Guide -

Note: Although it is technically possible to populate this view while the target is running, this
mode of operation is not currently supported. Particular memory of interest can be monitored live
via Global variable expressions if required.
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12. Configuring a Project

12.1

When a project is imported or generated using a wizard, there are many configuration options
available at creation time. However, once a project has been created or if a project is shared by
other means, then there still may be a requirement to make changes.

The range of possible project changes is almost infinite but below we will discuss a number of
common changes that may be required and the potential ramifications that may be encountered.
Note that many of these changes can be started from a project’s

Note: This section only discusses a few of the common changes that may be made. Please
also see the sections on , .

, and the additional Config Tool documentation for a more comprehensive
description of the options available.

Changes available via Quickstart Quick Settings

MCUXpresso IDE provides quick access to a range of project settings via the Quickstart Panel
as shown below:

Figure 12.1. Quick Settings

~ Miscellaneous

@) Edit project settings

. MCUXpresso Config Tools>>
3 Quick Sett

1 % Defined symbols [frdmk64f_bubble Debug]
Export pra

2 B3 Undefined symbols [frdmk6&4f_bubble Debug]
3 4 Include paths [frdmk64f_bubble Debug]

4 & Library search paths [frdmk6&4f_bubble Debug]
5 & Libraries [frdmk64f_bubble Debug]

6 (& SDK Debug Console
7
8

R

=R =

Export pra
¢ Build all pt

A

0

>
(% Set Floating Point type >
(# Set library/header type >

MCUXpresso IDE User Guide -

Note: These settings apply to the selected project’s active build configuration only and simplify
access to commonly used settings hormally accessed from Properties -> C/C++ Build -> Settings
Also note Quick Settings changes may be made to multiple projects if more than one project is
selected (where their settings are compatible).

Tip
@ The current setting for Debug Console, Floating Point and Library type is shown

. Defined symbols — select to edit the (-D) symbols

. Undefined symbols — select to edit the (-U) symbols

. Include paths — select to edit the (-I) the include paths

. Library search paths — select to edit the (-L) the library

. Libraries — select to edit the () the linker libraries search

. SDK Debug Console — select the SDK Debug Console’s PRINTF output to be via UART or
to redirect via the C libraries printf function
« selecting printf will increase the size of the project binary compared to UART output
« for semihosted printf output to be generated, the project must be linked against a suitable

library

OOk, WDNPRE
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« for more information see the section on

7. Set Floating Point type — select to switch between the available Floating Point options
« for more information see the section on

8. Set Library/Header type — select to switch the current C/C++ Library
« for more information see the section on

12.2 Project Settings

Many features of a a Project can be viewed (and edited) via Virtual Nodes. Project Virtual Nodes
are contained within a Project structure and provide virtual folders to display and allow the easy

editing of project settings.

1010
010l

{5 Project Explorer 52 |7, Peripherals+
v =5 frdmk64f_led_blinky

| N @ Project Settings |

¥ =\ Associated SDK

o name = 'SDK_2.x_FRDM-K64F"

o version = '2.4.0' ;
v =i Libraries (and semihosting)

(] LibraW
v @& MCU [

o chip = '"MK64FN1MOxxx12"

o package = 'MK64FN1MOVLL1

© processor = '‘corf
¥ ifs Memory

o Flash name='PROGRAM_FLASH' typgs=
AM' address="0x20000000" size='0x30000"
R' type='RAM' address="0x1fff0000" size="0x10000"
RAM' type="RAM' address="'0x14000000" size="0x1000"

o RAM name="SRAM_UPPER'
o RAM2 name='SRANM_J
o RAM3 names
v [T Options

o Defined symbols (-D) (C) = [

> ﬁ;’ Binaries

» )l Includes

» (2 CMSIS

» (2 board

» (B drivers

> (B source

> (5 startup

» (2 utilities

» (= Debug

» (= doc

Registers .1 Symbol Viewer

REDLIB

=i, Edit Libraries >

¢ Edit MCU

ste Edit memory

M Edit options

sh' address="0x0" size='0x100000"' FTFE_4K.cfx

, CPU_MKB4FN1MOVLL12_cmd, CPU_MKB84FNTMOVLL12,

.frd mk64f_led_blinky LinkServer Debug.launch
.frdmkﬁdi_led_biinky LinkServer Release.launch

Figure 12.2. Project Settings

These are automatically generated for any project and provide a quick way to view many key
project settings. In addition, a right click on these nodes provides direct options to edit the
associated settings that otherwise require many more mouse clicks to reach.

12.3

Changing the MCU (and associated SDK)

All projects are associated with a particular MCU at creation time. The target MCU determines
the project memory layout, startup code, LinkServer flash driver, libraries, supporting sources,
launch configuration options etc. etc. so changing a project’'s associated MCU should not be
undertaken unless you have a total grasp of the consequence of this change.

Therefore rather than changing a project’s associated MCU, it is strongly recommended
that instead a new project is generated for the desired MCU and this new project is edited

as required.

MCUXpresso IDE User Guide -
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However, on occasion it may be expedient to reset a project’'s MCU (and associated SDK) and
this can be achieved as follows. From the project virtual nodes, select Edit MCU.

v ¢ Project Settings
¥ B\ Associated SDK
o name = 'SDK_2.x_FRDM-KG64F"
o version ='2.4.2"
» =i Libraries (and semihosting)

3 ¢ Edit MCU
o & Change Package P

o processor = ‘cortex-m4’
> 314 Memory
» [ Options

Figure 12.3. Edit MCU

You will then be presented with the MCU Setting dialogue (as below)

SDK MCUs
MCUs from installed SDKs

NXP MKB4FN1MOxxx12

Preinstalled MCUs

MCUs from preinstalled LPC and generic
Cortex-M part support

P K32WO0x2S Target
YKEX »LPC1102
MKB4FN1MOxxx12 FLPC112x
PKE1X FLPC11AXX
P KW3x »LPC11EBX
»LPC5411x »LPC11Exx
b LPC546xx FLPC11UBx
» MIMXRT1020 FLPC11Uxx
» MIMXRT1050 FLPC11xx
» MIMXRT1064 FLPCT 1xxLV

LS BTk Relalal

Target architecture: cortex-md

Preserve memory configuration

Figure 12.4. Select MCU

From here, an alternative MCU can be selected but note, there are two check boxes that must
be set as required before this is done:

* Preserve Memory Configuration — it set (the default) the original project memory settings will
be preserved, otherwise the MCU setting for the chosen MCU will replace the original settings

¢ Preserve Project Configuration — if not set (the default) the new MCUs configurations (such as
Cortex Architecture) will replace the original settings

When the new MCU is selected, a warning dialogue as below will be generated:

MCUXpresso IDE User Guide -
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. MCUXpresso IDE ‘

=S Changing selected MCU to a different one will modify project settings and may
V' prevent successfull project building and debugging.
Are you sure?

[
\

Figure 12.5. Select MCU Warning

Project changes will only be made if Yes is selected.

12.4 Changing the MCU (SDK) package type

MCUs are commonly available in a range of package types. Different packages may impact the
options available on the MCU external pins, for example the number of GPIO lines. MCUXpresso
IDE makes no use of this package type however it is significant to the included

As shown in the previous section, from the project virtual nodes, select Edit MCU.

v € Project Settings
b =) Associated SDK
b =i Libraries (and semihosting)

BEE ¢ it mcu | T

‘% Change Package MKG64FN1MOVDC12
+ MK64FN1MOVLL12

o processor = ‘cortex-m4'

= MKBAFMOVMD!2
» [ Options
» 32 Binaries MKE64FN1MOCAJ12

Figure 12.6. Edit Package

then select Change Package and choose the package required.
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13. MCUXpresso Config Tools

This chapter provides an introduction to the features of the MCUXpresso Config Tools installed
by default with MCUXpresso IDE. The Config Tools present new perspectives in addition to the

IDE’s Develop and Debug perspectives.

8 workspace - Welcome page - MCUXpresso IDE
Ele Edit Navigate Search Project ConfigTools Pins Run Window Help

- | G | tramkB2f_cmsis_i2c_edma_b2b_tri v | # | A B Update Code ~ ‘Functional Group | BOARD.InitPins

»e ®~-Q Q- = v
£ Pins 22 & Peripheral Signals = 5 B Package QeQao
SIB8I0 wiw| elele| ¥ o |ype fiter text
Pin  Pinname Label Identifier GPIO  FTM Pl LPUART 4
1 PTEO SPIPCST  LPUARTITX
2 PTET SPISCKL.]  LPUARTIRX
3 PTE2 SPI1_SOUTL.] LPUART1 CT.
4 T PTES SPI1_PCS2(.]  LPUARTI RT. o
s Vsss L = s cun o
6 |VDDIOES U fieo o rur
7 ] PTE4 SPI1_SIN LPUART3_TX V0S| fs e s
8  PTES/SPI PTES FIM3.CHO  SPIIPCSO  LPUART3RX s oo o =
9 PTES FTM3.CH1  SPIPCS3  LPUART3.CT. e s o sy
10 PTE7  FIM3.CH2  SPR.SCK  LPUART3RT. . o s s
n R PTES  FIM3CH3  SPI2.SOUT — — — —
12 PTE)  FTM3.CH4  SPI2PCST - o - -
13 10/ PTE10 FTM3_CHS SPI2_SIN — — — —
14 PTEN PTETT FTM3.CH6  SPI2.PCSO
15 |VDDIO €17
V16 vss23
17 |USBODP. MKB2FN256VLL15 - LQFP 100 package
18 |USBO.OM
/19 \vourss
20 |VREGIN i
< >
£ Routed Pins
type filter text
Routed Pins for BOARDInitP... | 2 |© @ = v
Peripheral Signal  Routeto  label Identfier Direction  GPIOinitialstate GPIOinterrupt Slewrate Open drain Drive strength Pull select Pull enable Passive filter
Bl pusrs Rx LPUART4_RX na Input n/a na Fast Disabled  Low Pulldown  Disabled  Disabled
87 LPUARTA TX LPUART4 TX na Not Specified n/a na Fast Disabled  Low Pulldown  Disabled  Disabled

<

frdmk82f_cmsis_i2c_edma_b2b_transfer_master

- o X

Quick Access| | &8 | % @l ¢ OB
=5
v Configuration - General Info
~  Configuration - HW Info
Processor: MKB2FN25610015
Part number: MK82FN256VLL15
Core: Cortex-M4F
SDK Version: ksdk2_0
v Project

~ Pins
ool for pin routing configuration, including pin
inctional roperties, power rails, and

fumctional/electial prope:

run-time configurations.
@ a

“  Generated code
[ Update code enabled

~ Functional groups
® BO/ ns &

=5~ Othertools

(an\ (D) .

 Problems i BlY =0
Digital filt

na
nfa

ype filter text
Level Issue

+ Warning Peripheral LPUART4 is not i

Warning Peripheral 120 is not iniial.

+ Warning Peripheral ADCO is not iiti

Origin
Pins:BOARD_InitPin
Pins12C0_InitPins

Pins12C0_DeinitPins

Y _workspace

Figure 13.1. Config Tools Showing Pins Perspective

Please refer to the MCUXpresso IDE Config Tools User Manual for detailed information.

13.1 Using the Config Tools

MCUXpresso IDE includes the following Config Tools:

¢ Pins Tool

« allows you to configure pin routing and generates ‘pin_mux.c & .h’ source files

Clocks Tool

« allows you to configure system clocks and generates ‘clock_config.c & .h’ source files
Peripherals Tool

« allows you to configure other peripherals and generates ‘peripherals.c & .h’ source files
Device Configuration Tool

« allows you to configure the initialization of memory interfaces of your device and generate
dcd.d and dcd.h source files in C array or binary format

TEE Tool

« allows you to configure security policies of memory areas, bus masters, and peripherals, in
order to isolate and safeguard sensitive areas of your application and generate tzm_config.c
& .h source files.

MCUXpresso Config Tools can be used to review or modify the configuration of SDK example
projects or new projects based on SDK 2.x. To open the tool, simply right click on the project in
Project Explorer and select the appropriate Open command:

MCUXpresso IDE User Guide -
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Figure 13.2. Config Tools Launch

v Validate

MCUXpresso Config Tools

B Open Pins

' %" Run C/C++ Code Analysis 11 Open Clocks

| Team > ¥ Open Peripherals

j  Compare With l [ Open Device Configuration
Configure >
Source [ 3 # Open Tools Overview

13.1.1

13.1.2

13.1.3

13.1.4

13.1.5
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If the project does not contains any configuration file (.mex) yet, it is automatically created by
importing the existing source files (from YAML comments from pin_mux.c, clock_config.c and/or
peripherals.c). If there are no source files in the project, a default configuration is created. The
configuration is stored in the root of project folder with “.mex” file extension.

Tool Perspectives

Each tool is displayed in separate perspective. Once the configuration is opened, you can switch
between perspectives to review/modify configuration of each tool — using the toolbar on the upper
right part of the IDE window:

Quick Access|:| B | X %= @& 10| ¢ O B

If your workspace contains multiple projects, please be aware that the MCUXpresso Config Tools
only support one configuration to be opened at a time and that configuration must be opened
explicitly for each project using the Open command from the popup menu. Switching perspectives
does not switch the selected configuration.

Pins Tool ®

The Pins Tool allows you to display and configure the pins of the MCU. Basic configuration can
be done in either of these views Pins, Peripheral Signals or Package. More advanced settings
(pin electrical features) can be adjusted in Routed Pins view.

Clocks Tool @)

The Clocks Tool allows you to display and modify clock sources and outputs settings in Table
view. More advanced settings can be adjusted via Diagram view and Details view. Global settings
of the clocking environment such as run modes, MCG modes and SCG modes can be modified
via main application toolbar.

Peripherals Tool ®

You can use the Peripherals tool to configure initialization of selected peripherals and generate
code for them. In the Peripherals view, select the peripheral to configure and confirm addition
of the configuration component. Then you can select the mode of the peripheral and configure
the settings within the settings editor.

Device Configuration Tool
Device Configuration tool allows you to configure the initialization of memory interfaces of your

device. Use the Device Configuration Data (DCD) view to create different types of commands
and specify their sequence, define their address, values, sizes, and polls.
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13.1.6

13.1.7

13.1.8
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TEE Tool ©

In the Trusted Execution Environment, or TEE tool, you can configure security policies of memory
areas, bus masters, and peripherals, in order to isolate and safeguard sensitive areas of your
application. You can set security policies of different parts of your application in the Security
access configuration and its sub-views, and review these policies in the Memory map and Access
overview views. Use the User Memory Regions view to create a convenient overview of memory
regions and their security levels.

Generate Code

To update sources in the project, simply hit “Update Code” button on the toolbar. The command
opens dialog with list of files that will be re-generated and allows to select which tools will generate
the code.

Alternatively, it is also possible to export select source file by hitting export button in the Sources
view.

SDK Components
Generated code uses the API of the SDK components to configure peripherals. SDK components

missing in the IDE project are reported in problems view. It is possible to add component into
IDE project by right click on the reported problem and selecting the proposed quick fix.
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14. The GUI Flash Tool

The GUI Flash tool provides flash programming capabilities for all supported debug solutions.

As well as implementing seamless programming of Flash when starting a debug session,
MCUXpresso IDE enables the Flash programming capabilities of the supported debug solutions
to be accessed directly, both via the GUI and from the command line (which might be useful for
performing small production runs).

These flash programming capabilities can be accessed from three distinct places with the IDE.

Firstly, the most feature capable (advanced) variant is launched via the IDE button (and will be
described in this section) :

el L% A

GUI Flash Tool

Clicking this will launch a dialogue similar to:
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GUI Flash Tool

GUI Flash Tool for:
MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
»;mlmf Program file into flash: MK64F12_Project.axf
Target: MKBAFN1MOxxx12

Probe Options
Probe specific options

Reset script

[ -] Warkspace.. File System..
Connect script _kinetisconnect.scp g Workspace. File System.
Default Flash Driver 8
Reset Handling Default (2]
Flash Reset Handling Default (2]
Boot ROM Stall
Wire Speed

Reset the target on connection Disable use of preconnect seript

Target Operations
Select the target flash operation to perform

lbmgram . Erase Resurrect locked Kinetis device J

Actions

Select the action to perform

© Program Program (mass erase first)

Verify only Check file areas blank

Options
Select the options to apply

File to program [ ${workspace_loc}/MKB4F12_Project/Debug/MKB84F12_Project.axf @ ] Waorkspace.. File System..

Format to use for programming € axf bin
Base address

Reset target on completion

General Options

Flash programming tosl options
Additional options

Repeat on completion Enable flash hashing
Clear console

Preview command

cancel | (CT

Figure 14.1. GUI Flash Tool

Note: This dialogue will vary subtly for each debug solution.

Secondly, project launch configurations now contain a GUI Flash Tool Tab providing project
specific flash operations. Please see for more information.

Finally, the Quickstart panel Debug Shortcuts provide easy access for simple project flash
programming. Please see for more information.

Tip
For Multicore MCUSs, core selection is usually made automatically, but for GUI flash

operations, it maybe necessary to take direct control of core selection, so this option
is made available to the user.

14.1 The Advanced GUI Flash Tool

The operations below are supported for each debug solution.

1. Programming an .axf or .bin file into flash
2. Flash Mass Erase

3. Various debug solution specific features

MCUXpresso IDE User Guide -
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When launched, each debug solution will present a dialogue similar to the LinkServer variant —
described below:

@ ] GUI Flash Tool

GUI Flash Tool for:
Y MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
“U;Wf Program file into flash: MK64F12_Project.axf
Target: MK6AFNTMOxxx12

Probe specific options
Reset script O B  Workspace... File System...
Connect script L kinellsmnnect.scd' B Workspace... File System...

Default Flash Driver 8 O
Reset Handling Default O (2]

Flash Reset Handling Default
Boot ROM Stall
Wire Speed

Reset the target on connection Disable use of preconnect script

Target Operations

Select the target flash operation to perform

li’mgram Erase | Resurrect locked Kinetis dev'\ce]

Actions
Select the action to perform
© Program Program (mass erase first)
Verify only Check file areas blank
Options
Select the options to apply
File to program [ ${workspace_loc}/MK64F12_Project/Debug/MKB4F12_Project.axf ] Workspace... File System...

Format to use for programming O

Base address

Reset target on completion

General Options
ash programming tool options

Additional options

Repeat on completion Enable flash hashing Preview command

Clear console

Cancel [ Run ]

Figure 14.2. GUI Flash Tool major features

Note: Probe options (highlighted above) will be different for each debug solution, where as Target
and General Options (also highlighted) will be broadly similar.

Tip

@ A project must first be selected before the Advanced GUI Flash Tool can be
launched. The device and other project configurations (such as flash driver) will be
inherited from this selected project. The advanced GUI Flash tool will not create or
use information within project associated launch configurations.

1. Reset and Connect scripts: Any SDK specified Reset or Connect scripts will be automatically
selected. A different script can be selected if required using the Workspace or File System
shortcut buttons. If specified, a Reset script overrides the Reset Handling.

2. Reset Handling: The device default reset handling can be overridden from the selection:
Default, SYSRESETREQ, VECTRESET, SOFT

3. Flash Reset Handling: The flash drivers default reset handling can be overridden from the
selection: Default, SYSRESETREQ, VECTRESET, SOFT
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4. Program/Erase/Resurrect locked Kinetis Device

¢ Program view (displayed) should be selected to program an application of binary into flash.
Only the Program options will be described below.

¢ Erase view should be selected for options to erase a flash device to its blank state
« offers options to Mass erase, Erase by sector, Check blank (to verify a blank flash).

« generally flashes do not need to be erased, since program operations automatically erase
sections of the flash as required. However on occasion it can be useful to erase a flash
most often because the image in flash is causing problems.

» Erase by sector is not recommended for Kinetis parts since this will leave the device fully
erased and therefore in a locked state — should this occur, use the option below ...

¢ Resurrect locked Kinetis device view should be selected to recover a locked device.
5. Programming actions:

¢ Program: the default action will program the selected application or binary erasing only the
required sections of the flash device.

¢ Program (mass erase first): will erase the whole device before program the selected
application or binary. This will ensure that any previous flash contents are erased.

« Verify only: this option will compare the contents of flash with the selected application or
binary. Note: most flash programming operations are verified at the programming stage.
Flash contents are not changed.

¢ Check file area blank: this can be used to verify that a program operation will not overwrite
any data already programmed into flash. Flash contents are not changed.

6. File selection: if the selected project contains a built .axf file, then this will automatically be
selected. Alternatively a different file can be selected using the Workspace and File System
shortcut buttons.

7. Format: these radio buttons will be preset by the File to Program type. However, if an .axf file
is selected, clicking bin will automatically generate a .bin from the selected .axf.

« for file types containing no base address information, such as .bin, a base address must
be specified.

8. Preview command: select this option to be presented with a preview programming command
to be issued and a script that can perform this action independently of the IDE (see below)

« the previewed command can be edited if required, changes will be reflected within the script.
Various shell script flavours can be selected, and finally the script can be copied to the
clipboard with a single click

Finally, click Run to execute the flash programming operation, a dialogue displaying the success
of the operation will be displayed once the program operation has completed.

14.1.1 Advanced GUI Flash Tool command Preview

As discussed in point 8 above, the GUI Flash Tool can optionally display the command to be
issued — allowing the opportunity of editing the command before execution.
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@ © Program file into flash: MK64F12_Project.axf

o Command to be executed...

crt_emu_cm_redlink --flash-load-exec "/Users/nxp/Documents/MCUXpressolDE_11.7.0/workspace/
MK64F12_Project/Debug/MK684F12_Project.axf" -g --debug 2 --vendor NXP -p MK64FN1MOxxx12 --
ConnectScript kinetisconnect.scp --probeserial FQAQBQLQ -Corelndex=0 --flash-driver= -x /Users/nxp/
Documents/MCUXpressolDE_11.7.0/workspace/MK64F12_Project/Debug --flash-dir fApplications/
MCUXpressolDE_11.7.0_9142_alpha/ide/plugins/com.nxp.mcuxpresso.tools.bin.macosx_11.7.0.202211112325/
binaries/Flash --flash-dir /Users/nxp/Documents/MCUXpressolDE_11.7.0/
workspace/.mcuxpressoide_packages_support/MK64FN1MOxxx12_support/Flash --flash-hashing

Command to use in a script

MCUX_WORKSPACE_LOC=/Users/nxp/Documents/MCUXpressolDE_11.7.0/workspace
MCUX_FLASH_DIRO=/Applications/MCUXpressolDE_11.7.0_9142_alpha/ide/plugins/
com.nxp.mcuxpresso.tools.bin.macosx_11.7.0.202211112325/binaries/Flash
MCUX_FLASH_DIR1=/Users/nxp/Documents/MCUXpressolDE_11.7.0/
workspace/.mcuxpressoide_packages_support/MK64FNTMOxxx12_support/Flash =
MCUX_IDE_BIN=/Applications/MCUXpressolDE_11.7.0 9142 _alpha/ide/plugins/ LS|
com.nxp.mcuxpresso.tools.bin.macosx_11.7.0.202211112325/binaries/ =

$MCUX_IDE_BIN/crt_emu_cm_redlink --flash-load-exec "$MCUX_WORKSPACE_LOC/MK64F1. ¢ shell
Debug/MK64F12_Project.axf” -p MK64FNTMOxxx12 --ConnectScript kinetisconnect.scp --pri

FQAQBQLQ -Corelndex=0 --flash-driver= -x $MCUX_WORKSPACE_LOC/MK64F12_Project/D¢ ¥ Bourne Shell
flash-dir $MCUX_FLASH_DIRO --flash-dir $MCUX_FLASH_DIR1 --flash-hashing Powershell

Command Shell

cncel (T

Figure 14.3. GUI Flash Tool Command Preview

In addition to displaying the command to be issued, the dialogue also contains a script that can
be issued independently of the IDE to perform the flash programming operation. Changes the

command to be executed will also be reflected within the script.

Notes

MCUXpresso IDE User Guide

MCUXpresso IDE User Guide -

» The script will setup the local environment to be independent of your local shells configuration.

However components of MCUXpresso IDE are of course referenced so the script can only be
used if MCUXpresso IDE is installed and any referenced workspace files are present.

Debug probes may install drivers when first seen by a host, this driver installation may take
some time to complete.

MCUXpresso IDE is able to maintain connection to multiple debug probes, while the IDE can
dynamically maintain knowledge of connected probes, any generated command line will be
a snapshot of a given instance. Therefore it is essential that only a single debug probe is
connected if the command script is to be captured for re-use.

Typically, LPC-Link2 or LPCXpresso V2 and V3 boards have debug probe firmware soft loaded
automatically by the IDE when a debug operation is first performed. Therefore to use these
debug probes from the command line they must either have their firmware softloaded or
have probe firmware programmed into the Flash. Probe firmware can be soft-loaded from the
command line by use of scripts boot_link1 for LPC-Link and boot_link2 for LPC-Link2, these
are located at mcuxpresso_install_dir/ide/bin. To program debug probe firmware into the Flash
memory of an LPC-Link2 debug probe, please see: https://www.nxp.com/LPCSCRYPT
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14.1.2 Advanced GUI Flash Tool logged Output

When a GUI Flash Tool operation is performed, the low level output will be logged into the debug
log. A snippet of a LinkServer successful program operation is shown below:

Loadi ng ' MK64FN1M)xxx12_Pr oj ect . axf' ELF 0x00000000 | en Ox3CF8
Opening flash driver FTFE_4K. cfx (al ready resident)

Sendi ng VECTRESET to run flash driver

Witing 15608 bytes to address 0x00000000 in Flash

1 of 1 ( 0) Witing pages 0-3 at 0x00000000 wi th 15608 bytes
( 0) at 00000000: O bytes - 0/15608

( 26) at 00000000: 4096 bytes - 4096/ 15608

( 52) at 00001000: 4096 bytes - 8192/ 15608

( 78) at 00002000: 4096 bytes - 12288/15608

(100) at 00003000: 4096 bytes - 16384/ 15608

Erased/ Wote page 0-3 with 15608 bytes in 693nsec

Closing flash driver FTFE_4K. cfx

(100) Finished witing Flash successfully.

Fl ash Wite Done

Loaded Ox3CF8 bytes in 1081nms (about 14kB/s)

Reset target (system

Starting execution using systemreset

14.1.3 Advanced GUI Flash Tool Programming an arbitrary Binary

The GUI Flash tool will usually be used to program a binary generated from a Project’s .axf file.
However on occasion, it might be required to program a binary (or .axf) file generated elsewhere.
This can be achieved by generating a project with the required memory/chip combination and
simply dropping the .bin file into this project. When the GUI Flash tool is invoked, the user can
browse for the required binary file and program this in the usual way.
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15. LinkServer Flash Support

15.1

MCUXpresso IDE User Guide -

LinkServer (CMSIS-DAP) Flash drivers are used by LinkServer debug connections only. Please
refer to the section on for details of the LinkServer debug solution.

MCUXpresso IDE’s LinkServer based debug connections makes use of a RAM loadable Flash
driver mechanism. Such a Flash driver contains the knowledge required to program the internal
Flash on a particular MCU (or potentially, family of MCUs). This knowledge may be either
hardwired into the driver, or some of it may be determined by the driver as it starts up (typically
known as a ‘generic’ Flash driver).

At the time a debug connection is started by MCUXpresso IDE, a LinkServer debug session
running on the host will typically download a Flash driver into RAM on the target MCU. It will
then communicate with the downloaded Flash driver via the debug probe in order to program the
required code and data into the Flash memory.

In addition, the loadable Flash driver mechanism also provides the ability to support Flash drivers
which can be used to program external Flash memory (for instance via the SPIFI Flash memory
interface on LPC18x, LPC40xx, LPC43xx, LPC5460x and iIMXRT families). The sources for some
of these drivers is provided in the Examples/Flashdrivers subdirectory within the MCUXpresso
IDE installation directory.

Note: Quad SPI (QSPI) and SPIFI are used interchangeably within this section. The term SPIFI
(SPI Flash Interface) is commonly used to reference LPC use of QSPI.

LinkServer Flash drivers have a .cfx file extension. For Preinstalled MCUs, the Flash driver
used for each part/family will be located in the /bin/Flash subdirectory of the MCUXpresso IDE
installation. For SDK installed MCUs, the Flash driver will generally be supplied within the SDK,
although copies may also provided in the /bin/Flash subdirectory.

Important Note: LinkServer flash drivers are fully integrated into the MCUXpresso IDE Managed
Linkerscript build mechanism and specified within SDK metadata. Other debug solutions invoke
MCU specific flash programming strategies based on their debug implementation’s knowledge
of the MCU being debugged.

Default vs Per-Region Flash Drivers

By default, for legacy reasons, Preinstalled MCUs are configured to use what is called a ‘Default’
Flash driver. This means that this Flash driver will be used for all Flash memory blocks that are
defined for that MCU (i.e. as displayed in the Memory Configuration Editor).

For most users, there is never any need to change the automatically selected Flash driver for
the MCU being programmed.

However, MCUXpresso IDE also supports the creation and programming of projects that span
multiple Flash devices. In order to allow this to work, Flash drivers can also be specified per
memory region.

For example, this allows a project based on an LPC43xx device with internal Flash to also make
use of an external SPIFI Flash device. This is achieved by removing the default Flash driver from
the memory configuration and instead explicitly specifying the Flash driver to use for each Flash
memory block (per-region Flash drivers). A typical use case could be to create an application
to run from the MCU'’s internal Flash that makes use of static constant data (e.g. for graphics)
stored in external SPIFI device. An example memory configuration is shown below:
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Figure 15.1. Per Region Drivers

‘@ MCUXpresso IDE

Memory configuration editor
Edit configuration for LPC4337 m

Memory configuration

Default flash driver Browse...

Type Name Alias Location Size Driver -
Flash MFlashA512 Flash O0x1a000000 Ox80000] LPC18x7_43x7_2x512_BootA.c v
Flash MFlashB512 Flash2 Ox1b000000 O0x80000] LPC18x7_43x7_2x512_BootA.c
Flash Flash_SPIFI Flash3 Ox14000000 O0x10000@ LPC18_43_SPIFI_GENERIC.cfx
RAM RamLoc3Z RAM  Ox10000000 OxBO0O
RAM RamLoc40 RAM2 Ox10080000 0xa000
RAM RamAHB32 RAM3 0x20000000 0x8000
RAM RamAHB16 RAM4 Ox20008000 0x4000

!'_E |

Add Flash Add RAM Split Delete

Import... Merge... Export... Generate...

Sl FCIO—

15.2

15.2.1
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Note: SDK installed MCU support always use Per-Region Flash drivers.

Advanced Flash Drivers

Most wizard generated projects or projects imported from SDKs (or LPCOpen) will be pre-
configured with an appropriate LinkServer flash driver for the target flash device. As a result,
in many cases users need to pay little attention to the actual flash driver being used. However,
for MCUs supporting complex flash strategies or external flash devices, the situation is more
complex. This section discusses these situations but note, even in these cases, the flash driver
may be automatically selected and so require no user attention.

LPC18xx / LPC43xx Internal Flash Drivers

A number of LPC18/43 parts provide dual banks of internal Flash, with bank A starting at address
0x1A000000, and bank B starting at address 0x1B000000.

* LPC18x3/LPC43x3 : Flash = 2x 256KB (512 KB total)
* LPC18x5/ LPC43x5 : Flash = 2x 384KB (768 KB total)
* LPC18x7/ LPC43x7 : Flash = 2x 512KB ( 1 MB total)

When you create a new project using the New Project Wizard for one of these
parts, an appropriate default Flash driver (from LPC18x3 43x3 2x256 BootA.cfx /
LPC18x5_43x5 2x384 BootA.cfx /LPC18x7_43x7_2x512 BootA.cfx) will be selected which
after programming the part will also configure it to boot from Bank A Flash.

If you wish to boot from Bank B Flash instead, then you will need to manually configure the
project to use the corresponding “BootB” Flash driver ( LPC18x3_43x3_2x256_BootB.cfx /
LPC18x5_43x5_2x384_BootB.cfx / LPC18x7_43x7_2x512_BootB.cfx). This can be done by
selecting the appropriate driver file in the “Flash driver” field of the Memory Configuration Editor.
Note: you will also need to delete Flash Bank A from the list of available memories (or at least
reorder so that Flash Bank B is first).
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LPC SPIFI QSPI Flash Drivers

A number of parts provide support for external SPIFI Flash, sometimes in addition to internal
Flash. Programming these Flash memories provides a number of challenges because the size
of memory (if present) is unknown, and the actual memory device is also unknown. These issues
are handled using Generic Drivers which can interrogate the memory device to find its size and
programming requirements.

At the time of writing, these LPC devices comprise:

Table 15.1. SPIFI details

LPC Part SPIFI Address Bootable Flash Driver

LPC18xx/LPC43xx | 0x14000000 Yes LPC18_43_SPIFI_GENERIC.cfx
LPC40xx 0x28000000 No LPC40xx_SPIFI_GENERIC.cfx
LPC5460x 0x10000000 No LPC5460x_SPIFI_GENERIC.cfx
LPC540xx 0x10000000 Yes LPC540xx_SPIFI_GENERIC.cfx

MCUXpresso IDE User Guide -

During a programming operation, the Flash driver will interrogate the SPIFI Flash device to
identify its configuration. If the device is recognised, its size and name will be reported in the
MCUXpresso IDE Debug log - as below:

I nspected v.2 External Flash Device on SPI using SPIFl |ib LPC18_43_SPI Fl _GENERI C. cf x
| mage ' LPC18/43 Generic SPIFI Mar 7 2017 13:14:25'
Openi ng flash driver LPC18_43_SPI FI _GENERI C. cf x

flash variant ' MX25L8035E' detected (1MB = 16*64K at 0x14000000)

Note: Although the Flash driver reports the size and location of the SPIFI device, the IDE’s view
of the world is determined by the project memory configuration settings. It remains the users
responsibility to ensure these setting match the actual device in use.

Flash devices supported by our LPC SPIFI Flash Drivers

The paragraph below contains information that is largely deprecated — please see the section

Below is a list of SPIFI Flash devices supported by our supplied Generic SPIFI Flash drivers.
Note: additional devices which identify as one of the devices below are also expected to work.
However if a device is not supported by our supplied Flash Drivers, sources to generate these
drivers are supplied in the Examples/Flashdrivers subdirectory within the MCUXpresso IDE
installation directory. Users may thus add support for new SPIFI devices if needed.

@25@B2C
MI25QL128AB
MI25Q612A
MI25@56A
N25Q256
N25Q128
N25Q64
N25Q82
PM25LQV32C
MX25L1606E
MX25L1635E
MX250.3235E
MX25R6435F
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MX25L6435E
MX25L12835E
MX25V8035F
MX25L8035E
S25FL016K
S25FL032P
S25FL064P
S25FL129P 64kSec
S25FL129P 256kSec
S25FL164K
S25FL256S 64kSec
S25FL256S 256kSec
S25FL512S
V25Q40CV
VR5@B2FV
VR5Q64FV
VR5QL28FV
W5@56FV_Unt est ed
V25Q80BV

i.MX RT QSPI and Hyper Flash Drivers

I.MX.RT MCUs support external flash via a QSPI/Hyperbus interface, a range of LinkServer flash
drivers supporting devices fitted to EVK development boards are included with MCUXpresso IDE
(as described below).

Note: these drivers are also supplied in source project form so they may be used as a base
for development of drivers for other external flash parts. These driver projects can be found at
Examples/Flashdrivers/INXP/iIMXRT

Table 15.2. Flash details

iMX RT Part Base Address Bootable Flash Driver

i.MX RT 1050 0x60000000 Yes MIMXRT1050-EVK_S26KS512S.cfx
i.MX RT 1050 0x60000000 Yes MIMXRT1050-EVK_IS25WPO064A.cfx
i.MX RT 1050 0x60000000 Yes MIMXRT1050-EcoXiP_ATXP032.cfx
i.MX RT 1020 0x60000000 Yes MIMXRT1020-EVK_1S25LP064.cfx

MCUXpresso IDE User Guide -

When used with the approriate SDK for your development board, the correct driver will
be automatically selected

Important Note: For an application to Boot and execute in place (XIP) from these flash devices
(post reset), a correct header for the specific device MUST be programmed into the flash (as
part of the Project). SDK examples will build to include an appropriate header automatically
however, MCUXpresso IDE will not prevent users programming projects without headers into
these devices. If this occurs the application will not boot and subsequent flash programming
operations may fail.

Should this occur, the recommended recovery procedure is to change the boards boot strategy
(via DIP switches) to prevent booting from QSPI or hyperflash. Power cycle the board and then
perform a Mass Erase of the flash. Next, reprogram with an image that has appropriate header,
restore the boot strategy and power cycle again.

Tip
@ In addition, these drivers are complemented by a range of self configuring drivers
supporting all current iMX RT EVK boards , please see

for more information on the drivers and this methodology.
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Flash Drivers using SFDP (LPC and iMX RT)

As discussed above, the programming these Flash memories provides a number of challenges
because the size of memory (if present) is unknown, and the actual memory device is also
unknown

LinkServer Generic flash drivers attempted to solve this problem by recognising specific devices
(via their JEDEC ID) and then setting their sizes and programming parameters accordingly.
However, this mechanism only works if the device is recognised by the flash driver, and in
consequence will fail if any device is not recognised.

This issue, combined with the sheer volume of devices available has forced a different approach
to be taken. Fortunately, modern flash devices typically contain a data block describing their
properties including device size, low level structure and programming details etc. These data
blocks and their use are collectively known as Serial Flash Discovery Protocol or SFDP. The
standard for these blocks are described by JEDEC JESD216 standard(s).

Introduced in MCUXpresso IDE version 10.2.0 are a range of Generic flash drivers built to self
configure via SFDP data and these have been extended for later MCUXpresso IDE versions.
The current list of supported SFDP drivers is shown below:

Table 15.3. SFDP Flash details

Part Base Address Bootable Flash Driver

LPC18xx/LPC43xx | 0x14000000 Yes LPC18 43 SPIFI_SFDP.cfx

LPC546xx 0x10000000 No LPC546xx_SPIFI_SFDP.cfx

LPC540xx 0x10000000 Yes LPC540xx_SPIFI_SFDP.cfx

LPC55S36 0x10000000 Yes LPC553x_FlexSPI_A MXIC_OPI.cfx
i.MX RT 1170 0x30000000 Yes MIMXRT1170_SFDP_MXIC_OPI.cfx
i.MX RT 1170 0x30000000 Yes MIMXRT1170_SFDP_QSPI.cfx

i.MX RT 1160 0x30000000 Yes MIMXRT1160_SFDP_MXIC_OPI.cfx
i.MX RT 1160 0x30000000 Yes MIMXRT1160_SFDP_QSPI.cfx

i.MX RT 1064 0x70000000 Yes MIMXRT21064.cfx

i.MX RT 1060 0x60000000 Yes MIMXRT1060_SFDP_HYPERFLASH.cfx
i.MX RT 1060 0x60000000 Yes MIMXRT1060_SFDP_QSPI.cfx

i.MX RT 1050 0x60000000 Yes MIMXRT1050_ SFDP_HYPERFLASH.cfx
i.MX RT 1050 0x60000000 Yes MIMXRT1050_SFDP_QSPI.cfx

i.MX RT 1024 0x60000000 Yes MIMXRT1024.cfx

i.MX RT 1020 0x60000000 Yes MIMXRT1020_SFDP_QSPI.cfx

i.MX RT 1015 0x60000000 Yes MIMXRT1015 SFDP_QSPI.cfx

i.MX RT 1010 0x60000000 Yes MIMXRT1010_SFDP_QSPI.cfx

i.MX RT 600 0x8000000 Yes MIMXRT600_FlexSPI_A_MXIC_OPI.cfx
i.MX RT 600 0x8000000 Yes MIMXRT600_FlexSPI_A_ SFDP_QSPI.cfx
i.MX RT 600 0x8000000 Yes MIMXRT600_FlexSPI_B_MXIC_OPI.cfx
i.MX RT 600 0x8000000 Yes MIMXRT600_FlexSPI_B_SFDP_QSPI.cfx
i.MX RT 500 0x8000000 Yes MIMXRT500_SFDP_MXIC_OSPI.cfx
i.MX RT 500 0x8000000 Yes MIMXRT500_SFDP_QSPI.cfx

PN7640 0x218000 Yes PN76xx.cfx
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Important Note: for some iMX RT parts, the current SDKs reference the device specific flash
driver rather than the SFDP version. However you can modify your project to use the SFDP
version if required. Flashdrivers cannot detect whether QSPI or Hyperflash is fitted on a board,
therefore it is the responsibility of the user to ensure the correct driver is used.
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Note: The iIMX RT 1024 and 1064 MCUs incorporate a flash device within the MCU package
itself however, the flash driver still uses the SFDP mechanism to detect the device and hence
is listed in the table above.

QSPI SFDP issues and Limitations

Some (usually older) QSPI parts do not support the SFDP mechanism and therefore will not be
programmable via this protocol. However since some of these QSPI devices are fitted to NXP
(LPC) manufactured development boards, some basic assumptions are made by these drivers
if SFDP data is not found. In such a case, the device and its size will be assumed to be 1MB and
some standard programming mechanisms will be used. This scheme should ensure that NXP
LPC development boards with QSPI can be used with this driver type.

Note: this information is correct at the time of writing and only applies to LPC Drivers — future
development of these drivers may change their capabilities.

Flash programming log

When programming code or data into flash, a portion of the debug log will display the flash
programming operations (as below):

I nspected v.2 External Flash Device on SPlI using SFDP JEDEC | D LPC18_43_SPI FI _SFDP. cfx —(1)
| mage ' LPC1843_JEDEC_SFDP May 1 2018 15:32:05'

Openi ng flash driver LPC18_43_SPIFl _SFDP.CfX  ---------ocmomm i (2)
Sendi ng VECTRESET to run flash driver
flash variant 'JEDEC SFDP_EF4014' detected (1MB = 16*64K at 0x14000000) ---------------- (3)

Closing flash driver LPC18_43_SPI FI _SFDP. cf x
NXP: LPC43S37

Connected: was_reset=true. was_stopped=fal se
Awai ting tel net connection to port 3330 ...
GDB nonstop node enabl ed

Opening flash driver LPC18_43_SPIFI _SFDP.cfx (already resident) -----------oommmoonnoon (4)
Sendi ng VECTRESET to run flash driver

Witing 1046900 bytes to address 0x14000000 in Flash ----------cmmmmmmmm e (5)
Erased/ Wote page 0-15 with 1046900 bytes in 7548mBeC -------------mmmmmmmma (6)

Closing flash driver LPC18_43_SPI FI _SFDP. cf x

Fl ash Wite Done

Fl ash Program Summary: 1046900 bytes in 7.55 seconds (135.45 KB/seC) ------------------- (7)
St opped: Breakpoi nt #1

Note: when accessing unknown flash devices, the driver will be called twice. First to identify the
device and secondly to perform the required programming. In a situation where multiple devices
are being programmed, the flash driver(s) may be (re)loaded for each use.

Where:

1. SFDP JEDEC ID is the method used to access the flash and LPC18_43_ SPIFI_SFDP.cfx is
the flash driver used

2. the driver named above is loaded and initialised (this step will setup clocks, pin muxing, and
perform some investigation of the connected device)

3. the driver returns a string JEDEC_SFDP indicating that SFDP data was found and successfully
read

« the devices JEDEC ID was read as EF4014, in this case corresponding to a Winbond
25Q80DVSIG (as fitted to the LPC-Link2 board used in Target mode)

 the devices size was read as 1MB divided up into 16 64KB Sectors/Blocks — these blocks
are the erase size that will be used for programming and so any operation to program this
flash must start on an address aligned to this 64KB size

4. the driver is opened a second time (without reloading since it remains from the previous call)
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5. the project that referenced this driver requested that 1046900 bytes of data were written to
the address starting 0x14000000, as set within the project's memory configuration
6. the write operation is performed via 16 page writes
¢ Note: this flash driver (like many LinkServer drivers) uses a virtual page size that is much
larger than the actual flash device page size to optimise driver operation
7. finally, a summary of the operation is printed showing the flash programming performance

Note: If the driver fails to find SFDP data, it will attempt to program the device with standard
routines. If this occurs, the size will be assumed to be 1MB and the flash variant will be reported
as ID rather than SFDP as shown below:

flash variant ' JEDEC | D EF4014' detected (1MB = 16*64K at 0x14000000)

On occasion, some devices that report the same JEDEC ID will actually be different, in this
particular case the device is a very similar Winbond 25Q80BVSIG i.e. ..BV rather than ..DV

QSPI Programming and Booting

When dealing with external flash, it is important to understand the difference between the
flash programming operation performed by the flash driver and the subsequent use of the
flash for executing code and/or providing data. Essentially the flash drivers responsibility ends
with a successful program operation, after this point, correct operation of the MCU/SPI flash
combination lies elsewhere.

Thus, once the MCU is reset (or power cycled), the responsibility for the devices configuration and
operation lie entirely outside of MCUXpresso IDE and instead lie with one or all of the following:

« development board/MCU boot settings
 these may be DIP switches or Jumpers providing inputs to the MCU boot flow, alternatively

these could be OTP bits programmed within the MCU
« MCU’s BootROMs ability to understand and setup the device
« BootROMs on devices such as the LPC1800 and LPC4300 have inbuilt understanding of
certain QSPI devices allowing them to be configured for boot. However, this boot process
may fail with some QSPI flash despite the fact that it has been correctly programmed

« BootROMs on devices such as the LPC540xx and RT10xx rely on correct header (XIP)
information being programmed (as part of the Application) into the QSPI flash itself. If this
data is incorrect (or not present), the boot/reset will fail.

« Devices that incorporate both internal boot flash and external SPIFI/QSPI flash such as the
LPC546xx typically place the responsibilities for QSPI configuration to the users application,
where this might include
e Setup of pinmuxing
e QSPI/SPIFI clock setup
« Flash interface initialisation
< QSPI initialisation (this may be QSPI device specific)

« including setup of appropriate waitstates for QSPI operation at the selected QSPI clock
frequency

FlexSPI Flash reset

A number of IMX RT MCUs that support external flash via the FlexSPI interface implement a
flash device reset sequence.

During FlexSPI boot the boot process requires the FlexSPI Flash device to be in a certain mode,
for example, 1-bit SPI compatible mode. The Flash device will naturally be in this mode after
a POR reset because the power-up sequence will reset it with the RT MCU device together.
However, the Flash device will not be in 1-bit SPI compatible mode if the flash device is
configured to DPI mode or QPI mode or Octal mode when any non-POR resets happen. In
such case, special processing is required by the boot process to restore the Flash device to 1-
bit SPI compatible mode before continuing access to the Flash device. In general, this can be

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022 166



NXP Semiconductors MCUXpresso IDE User Guide

15.3

MCUXpresso IDE User Guide -

achieved by using a GPIO to assert a reset pin on the Flash device. The bootloader can perform
the reset process and reset the Flash device to 1-bit SPI compatible mode based on fuses
configuration, using the GPIO specified by the combination of FLEXSPI_RESET_PIN_PORT
and FLEXSPI_RESET_PIN_GPIO.

When starting a flash-resident debug session in MCUXpresso IDE this reset sequence may need
to be performed by the flash driver as well. Flash drivers for IMX RT500 and RT600 MCUs
implement this functionality.

Note: Custom boards may not be wired identical to EVK development boards in regards to the
actual pin dedicated to flash device reset. In such cases the pre-connect script needs to be
modified in order to pass to the flash drivers the relevant information about the GPIO pin used
for flash reset.

Kinetis Flash Drivers

Kinetis MCUs make use of a range of generic drivers, which are supplied as part of the SDK
part support package. When a project is created or imported, the appropriate Flash driver is
automatically selected and associated with the project.

Kinetis Flash drivers generally follow a simple naming convention i.e. FTFx_nK_xx where:

¢ FTFx is the Flash module name of the MCU, where x can take the value E, A or L

¢ nK represents the Flash sector size the Flash device supports, where n can take the value
1,2,4,8
* asector size is the smallest amount of Flash that can be erased on that device

e XX represents an optional additional characters for special case drivers e.g. __ Tiny for use on
parts with a small quantity of RAM
« a further optional _D suffix is used to show the driver is written to target Data Flash rather

than the more common Program Flash

So for example a K64F MCU'’s Flash driver will be called FTFE_4K, because the K64F MCU
uses the FTFE Flash module type and support a 4KB Flash sector size.

When a debug session is started that programs data into Flash memory, the IDE’s debug log
file will report the Flash driver used and parameters it has read from the MCU. Below we can
see the driver identified a K64 part and the size of the internal Flash available. It also reports the
programming speed achieved when programming this device. These logs can be useful when
problems are encountered.

Note: when the Flash driver starts up, it will interrogate the MCU and report a number of data
items. However, due to the nature of internal registers with the MCU, these may not exactly
match the MCU being debugged.

Inspected v.2 On chip Kinetis Flash nenory nodul e FTFE_4K. cf x

I mage 'Kinetis Sem Generic Feb 17 2017 17:24:02'

Openi ng flash driver FTFE_4K. cf x

Sendi ng VECTRESET to run flash driver

Fl ash variant 'K 64 FTFE Ceneric 4K detected (1MB = 256*4K at 0x0)
Closing flash driver FTFE_4K. cfx

Connect ed: was_reset=true. was_stopped=true

Awai ting telnet connection to port 3330 ...

GDB nonst op node enabl ed

Opening flash driver FTFE 4K cfx (al ready resident)

Sendi ng VECTRESET to run flash driver

Fl ash variant 'K 64 FTFE Ceneric 4K detected (1MB = 256*4K at 0x0)
Witing 25856 bytes to address 0x00000000 in Fl ash

00001000 done 15% (4096 out of 25856)

00002000 done 31% (8192 out of 25856)
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00003000 done 47% (12288 out of 25856)

00004000 done 63% (16384 out of 25856)

00005000 done 79% (20480 out of 25856)

00006000 done 95% (24576 out of 25856)

00007000 done 100% (28672 out of 25856)

Erased/ Wote sector 0-6 with 25856 bytes in 301lnsec

Cl osing flash driver FTFE 4K cfx

Fl ash Wite Done

Fl ash Program Summary: 25856 bytes in 0.30 seconds (83.89 KB/sec)

Flash drivers for a number of Kinetis MCUs are listed below:

K64F FTFE_4K (1MB)

K22F FTFA_2K (512KB)
KL43 FTFA_1K (256KB)
KL27 FTFA_1K (64KB)
K40  FTFL_2K (256KB)

Configuring projects to span multiple Flash Devices

https://community.nxp.com/thread/388979

The LinkServer GUI Flash Programmer

The LinkServer GUI Flash Programmer has been replaced by the debug solution independent

The LinkServer Command Line Flash Programmer

While the information below is still current, for most users this functionality has been replaced
by features within the

Command Line Programming

Flash programming is usually invoked automatically when a debug session is launched from
within MCUXpresso IDE, but flash programming operations can also be accessed directly using
a command line utility (also known as the LinkServer debug stub). This can be useful for things
like programming the Flash for devices with limited production runs.

The MCUXpresso IDE Flash programming utility is located at:

<install_dir>/ide/bin/

To run a Flash programming operation from the command line, the correct Flash utility stub for
your part should be called with appropriate options. For boards containing Cortex-M MCUs the
utility is called crt_emu_cm_redlink.

For example:

crt_emu_cmredlink -p LPC11U68 --flash-load "LPC11U68_App. axf"

will load the AXF file LPC11U68 App.axf into Flash on an LPC11U68.

Note: typically, LPC-Link2 or LPCXpresso V2 and V3 boards have debug probe firmware soft
loaded automatically by the IDE when a debug operation is first performed. Therefore to use
these debug probes from the command line they must either have their firmware softloaded or
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have probe firmware programmed into the Flash. Probe firmware can be soft-loaded from the
command line by use of scripts boot_link1 for LPC-Link and boot_link2 for LPC-Link2, these
are located at mcuxpresso_install_dir/ide/bin. To program debug probe firmware into the Flash
memory of an LPC-Link2 debug probe, please see: https://www.nxp.com/LPCSCRYPT

Programming an image into Flash

In the simplest case the Flash programming utility takes the following options if the file to be
flashed is an AXF (or ELF) file:

crt_emu_cmredlink -p target --flash-load "filename" [--flash-driver "flashdriver"]

it is also possible to flash binary files using:

crt_emu_cmredlink -p target --flash-l1oad "fil ename" --1o0ad-base base_address [--flash-driver /
"flashdriver"]

Where:

e crt_emu_cm_redlink is the name of the Flash utility

 target is the target chip name. For example LPC1343, LPC1114/301, LPC1768 etc. (see
‘Finding Correct Parameters..." below)

« --flash-load can actually be one of a few different options. Use:

» --flash-load to write the file to Flash,

» --flash-load-exec to write it to Flash and then cause it to start running,

« --flash-mass-load to erase the Flash and then write the file to the Flash, and

» --flash-mass-load-exec to erase the Flash, write the file to Flash and then cause it to start
running.

« filename is the file to Flash program. It may be an executable (axf) or a binary (bin) file. If using
a binary file, the base_address also must be specified. Using enclosing quotes is optional
unless the name includes unusual characters or spaces.

* base_address is the address where the binary file will be written. It can be specified as a hex
value with a leading Ox.

If you are using Flash memory that is external to the main chip you will need to specify an
appropriate Flash driver that supports the device. This usually takes the name of a .cfx file held
in a default location. In unusual circumstances it is possible to specify an absolute file system
name of a file. Using enclosing quotes is optional unless the name includes unusual characters
or spaces (see ‘Finding Correct Parameters...” below).

WARNING: When crt_emu_cm_redlink Flash drivers program data that they believe will form
the start of an execute-in-place image they determine where the image’s vector table is and
automatically inserts a checksum of the initial few vectors, as required in many LPC parts. This
may not be the value held in that location by the file from which the Flash was programmed. This
means that if the content of the Flash were to be compared against the file a difference at that
specific location may be found.

WARNING: Flash is programmed in sectors. The sizes and distributions of Flash sectors is
determined by the Flash device used. Data is programmed in separate contiguous blocks — there
may be many contiguous blocks of data specified in an EFL (.AXF) file but there is only one in
a binary file. When a contiguous data block is programmed into Flash data preceding the block
start in its Flash sector is preserved. Data following data in the block in the final sector, however
is erased.

Programming Flash with SDK Part Support

The above method works for parts supported with preinstalled part support. If SDK part support
is required, then additional options must be passed to the utility.
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« sdk_parts_directory - the place where the utility can find SDK part information; and
¢ sdk_flash_directory - the place where the utility can find Flash drivers provided by the SDK.

These are supplied to the utility by adding the following two options

-x "sdk_parts_directory" --flash-dir "sdk_flash_directory"

on to the command line already described. For example:

crt_emu_cmredlink -p LPC54018 --flash-load "LPC54018_app. axf" \
-x ~/ mcuxpr esso/ 01/ . ntuxpr essoi de_packages_support/LPC54018_support \
--flash-dir ~/ ntuxpresso/ 01/. ncuxpressoi de_packages_support/LPC54018_support/ Fl ash

Since this is quite a lot to type you might wish to put the location of your SDK support directory
into an environment variable as follows:

Windows:

set DIR_SDK ...\ nctuxpresso\01\. ncuxpressoi de_packages_support\LPC54018_support
crt_emu_cmredlink -p LPC54018 --flash-1oad "LPC54018_app. axf" -x %O R_SDK% \
--flash-dir %Ol R_SDK% Fl ash

MacOS or Linux:

export DI R_SDK="~/.ncuxpresso/ 01/ . ncuxpressoi de_packages_support/LPC54018_support"
crt_emu_cmredlink -p LPC54018 --flash-load "LPC54018_app. axf" -x $DI R_SDK \
--flash-dir $DI R _SDK/ Fl ash

Use “Finding Correct Parameters from MCUXpresso IDE”, below, to determine what values you
require for these options.

Programming Flash taking MCUXpresso IDE project Memory edits into Account

MCUXpresso IDE allows the user to modify the default definition of the memory areas (including
the specification of different named Flash regions) used in a hardware using the Edit... button
found in the project’s properties at C/C++Build -> MCU Settings under the heading “Memory
details”. The editor can create multiple named Flash regions.

In order to use these updates to the project’s part information the utility must use the directory
where MCUXpresso IDE stores the project’s products for whatever configuration has been
modified (typically the configuration will be called ‘Debug’) as the source of its part information.

To find the location of this directory in MCUXpresso expand the project in the Project Editor view,
select the directory with the required configuration name (e.g. ‘Debug’), right click on it to bring
up its properties and see the ‘Resource’ heading.

Supply this directory name as the sdk_parts_directory to the utility by adding the options:

-x "sdk_parts_directory"

Even if the part is supported by an SDK this will be the correct option to use for -x.
Programming Flash for complex debug connections

Some boards or chips occasionally need additional steps to occur before a stable debug
connection can be established. Such debug connections are set up by small BASIC like programs
called Connect Scripts. A good indication as to whether your chip or board normally requires a
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connect script can be discovered when “Finding Correct Parameters from MCUXpresso IDE” (see
below).

Connect scripts are distributed within the product and do not normally need to be written from
scratch.

If a connect script is required it can be supplied by adding the following option to the command
line already described:

--connectscript "connectscript”

In addtion to connect scripts, some chips also require a preconnect script that prepares the target
MCU for the initial debug connection. A preconnect script can be supplied by adding the following
option to the command line already described:

--preconnectscript "preconnectscript"

If you are using --flash-load-exec rather than --flash-load you may also find that the part that you
are using requires its own “reset script” to replace the standard means of starting the execution of
the flashed image. Again you may discover whether one is necessary as below. When required
it can be supplied by adding the following option to the command line:

--resetscript "resetscript"

(As usual the quotes are required only if the script file name contains a space or other unprintable
character.)

Finding the correct parameters from MCUXpresso IDE

Note: A simple way of finding the correct command and options is to use the GUI Flash
Programmer described above, the completion dialog shows the exact command line invoked by
the GUI. On this line the IDE will have chosen the correct

 target name

¢ adefault Flash driver, flashdriver

e a connect script to be run, if needed

e a preconnect script to be run, if needed

* areset script to be run, if needed with --flash-load-exec

¢ an sdk_parts_directory where XML information about the part being used (if it is provided via
an SDK) can be found

« an sdk_flash_directory where flash drivers supporting the part being used (if it is provided via
an SDK) can be found

Note: that the details will only appear and be relevant only if a project supporting the relevant
chip or board is selected in the project explorer view.

For example the command line produced might be:

crt_emu_cmredlink "/Wrkspace/frdnk64f _driver_exanpl es_blinky.axf" -g --debug 2 --vendor NXP \
-p MK64FNLMDxxx12 - ProbeHandl e=1 - Corel ndex=0 -- Connect Scri pt ki netisconnect.scp -x \
/ User s/ nxp/ ncuxpresso/ 01/ . ncuxpr essoi de_packages_suppor t/ MK64FNLIMOxxx12_support --flash-dir \

/ User s/ nxp/ ncuxpresso/ 01/ . ncuxpr essoi de_packages_suppor t / MK64FN1MDxxx12_support/ Fl ash

Looking at this the target name follows -p; the flashdriver follows --flash-driver; a connectscript
follows --connectscript; a resetscript follows --resetscript; any sdk_flash_directory is provided
following --flash-dir and any sdk_parts_directory is provided following -x.

If the target does not require a connect script or reset script the relevant options will not appear.
If the project is not based on an SDK -x and --flash-dir do not appear.
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Dealing with Errors during Flash operations

If your board requires a connect script to be run in order to provide a stable environment for Flash
drivers you may see errors when you undertake a Flash operation without using it. You can use
‘Finding Correct Parameters from MCUXpresso IDE’, above, to check whether a connect script
is required.

On some boards it is possible to run an image which is incompatible with the Flash driver (which
crt_emu_cm_redlink runs on the target to help it manipulate a Flash device). This incompatibility
is likely to show in the form of programming errors signalled as the operation progresses. Often
they are due to unmaskable exceptions (such as watchdog timers) being used by the previous
image that interfere with a Flash driver's operation.

There are a number of ways to address this situation:

e Does your board support In System Processing (ISP) Reset? Using it will usually reset the
hardware and stop in the Boot ROM, thus ensuring a stable environment for Flash drivers. If
present it can usually be activated with one or more on-board switches. You may have to refer
to the board’s documentation.

¢ Use the --vc option with crt_emu_cm_redlink. This option causes a reset when the utility’s
connection to the board’s debug port is established. Most chips will be left having executed
part of the Boot ROM and usually the resulting state is suitable for running a Flash driver.
(There are exceptions however.)

¢ Erase the contents of Flash (see below) or program a (e.g. small) image that ensures no non-
maskable exceptions are involved. Naturally these solutions have the problem that they are as
likely to fail (and for the same reason) as the programming operation. It is sometimes the case
that an incompatible image will allow the Flash drivers to operate for a short period in which
there is a chance that one of these ‘solutions’ can be used.

Validating the Content of Flash

The Flash programming utility can validate the content of Flash programmed as an AXF (or ELF)
file:

crt_emu_cmredlink -p target --flash-verify "filenane" [--flash-driver "flashdriver"]

it is also possible to verify binary files using:

crt_emu_cmredlink -p target --flash-verify "filenane" --I|oad-base base_address \

[--flash-driver "flashdriver"]

Where target and Flash driver have the same meaning as above.

For example:

crt_emu_cmredlink -p LPC11U68 --flash-verify "LPC11U68_App. axf"

Note: the issues described in ‘Dealing with Errors During Flash Operation’ still apply when
executing this command.

Erasing the Flash

The Flash programming utility can also delete the content of Flash. To do so it takes the following
options:

crt_emu_cmredlink -p target --flash-mass-erase [--flash-driver "flashdriver"]

Where target and Flash driver have the same meaning as above.
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For example:

crt_emu_cmredlink -p LPC11U68 --fl ash-nass-erase

Note: the issues described in ‘Dealing with Errors During Flash Operation’ still apply when
executing this command.)

Validating that Flash has been Erased

The Flash programming utility can validate that the content of Flash has been erased:

crt_emu_cmredlink -p target --flash-check --area flash " [--flash-driver "flashdriver"]

For example:

crt_emu_cmredlink -p LPC11U68 --fl ash-check --area flash

It is also possible to check that just the specific areas that would have been programmed by a
given AXF or binary file are blank.

crt_emu_cmredlink -p target --flash-check-file "filename" [--flash-driver "flashdriver"]

it is also possible to verify binary files using:

crt_emu_cmredlink -p target --flash-check-file "filename" --1oad-base base_address \
[--flash-driver "flashdriver"]

Where target and Flash driver have the same meaning as above.

For example:

crt_emu_cmredlink -p LPC11U68 --flash-check-file "LPC11U68_App. axf"

Note: the issues described in ‘Dealing with Errors During Flash Operation’ still apply when
executing this command.)

Examples

To load the binary executable file app.bin at location 0 on an LPC54113J128 target using LPC-
Link2, use the following command line:

crt_emu_cmredlink -p LPC54113J128 --1o0ad-base 0 --flash-1oad-exec app.bin

To load the executable file app.axf and start it executing on an LPC1768 target using LPC-Link2,
use:

crt_emu_cmredlink -p LPC1768 --flash-1o0ad-exec "app. axf"

To erase Flash, program the executable app.axf into an LPC18S37 board, which has no internal
Flash but supports external Flash on the board, and then run it:

crt_emu_cmredlink -p LPC18S37 --flash-nmass-1oad-exec "app.axf" --flash-driver \
LPC18x7_43x7_2x512_Boot A. cf x

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide Rev. 11.6.0 — 19 December, 2022 173




NXP Semiconductors MCUXpresso IDE User Guide

To erase then program app.axf into a Kinetis MK64FN1MOxxx12, which is supported through an
SDK, and requiring a connect script (on MacOS/Linux):

crt_emu_cmredlink -p MK64FNIM)xxx12 --fl ash-nmass-1oad "app.axf" \
--connectscript kinetisconnect.scp \
-x ~/ mcuxpresso/ 01/ . ntuxpr essoi de_packages_support/ MK64FNLIMOxxx12_support \
--flash-dir ~/ ncuxpresso/ 01/ . ncuxpressoi de_packages_support/ MK64FN1IM)xxx12_support/ Fl ash

To delete the Flash on an LPC1343:

crt_emu_cmredlink -p LPC1343 --flash-nass-erase

To delete the Flash on an LPC54113J128 using vector catch to ensure that the currently booted
code does not interfere with the Flash driver:

crt_emu_cmredlink -p LPC54113J128 --fl ash-erase --vc

To check that the Flash is blank on an LPC54018 which is supported by an SDK and which
has modified its memory layout stored in the MCUXpresso SDK example project held at ~/ws/
Ipcxpresso54018 driver_examples_gpio_gpio_led_output:

crt_emu_cmredlink -p LPC54018 --flash-check -x \
~/ ws/ | pcxpresso54018_dri ver _exanpl es_gpi o_gpi o_| ed_out put/ Debug \
--flash-dir ~/ ncuxpresso/ 01/ . ncuxpressoi de_packages_support/LPC54018_support/Fl ash
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MCUXpresso IDE ships with three different C/C++ library families. This provides the maximum
possible flexibility in balancing code size and library functionality.

Overview of Redlib, Newlib and NewlibNano

¢ Redlib Our own (non-GNU) ISO C90 standard C library, with some C99 extensions.
* Newlib GNU C/C++ library
« NewlibNano a version of the GNU C/C++ library optimized for embedded.

By default, MCUXpresso IDE will use Redlib for C projects, NewlibNano for SDK C++ projects,
and Newlib for C++ projects for preinstalled MCUs.

Newlib provides complete C99 and C++ library support at the expense of a larger (in some cases,
much larger) code size in your application.

NewlibNano was produced as part of ARM's “GNU Tools for ARM Embedded Processors”
initiative in order to provide a version of Newlib focused on code size. Using NewlibNano can
help dramatically reduce the size of your application compared to using the standard version of
Newlib — for both C and C++ projects.

If you need a smaller application size and don’t need the additional functionality of the C99 or C+
+ libraries, we recommend the use of Redlib, which can often produce much smaller applications.

Redlib extensions to C90

Although Redlib is basically a C90 standard C library, it does implement a number of extensions,
including some from the C99 specification. These include:

 Single precision math functions

» Single precision implementations of some of the math.h functions such as sinf() and cosf()
are provided.

« stdbool.h
* An implementation of the C99 stdbool.h header is provided.
* itoa
« itoa() is non-standard library function which is provided in many other toolchains to convert

an integer to a string. To ease porting, an implementation of this function is provided,
accessible via stdlib.h. More details can be found later in this chapter.

Newlib vs NewlibNano

Differences between Newlib and NewlibNano include:

* NewlibNano is optimized for size.

e The printf and scanf family of routines have been re-implemented in NewlibNano to remove
a direct dependency on the floating-point input/output handling code. Projects that need to
handle floating-point values using these functions must now explicitly request the feature
during linking.

e The printf and scanf family of routines in NewlibNano support only conversion specifiers
defined in C89 standard. This provides a good balance between small memory footprint and
full feature formatted input/output.

¢ NewlibNano removes the now redundant integer-only implementations of the printf/scanf
family of routines (iprintf/iscanf, etc). These functions now alias the standard routines.

* In NewlibNano, only unwritten buffered data is flushed on exit. Open streams are not closed.

* In NewlibNano, the dynamic memory allocator has been re-implemented
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16.2 Library Variants

Each C library family is provided in a number of different variants : None, Nohost and Nohost-nf,
Semihost and Semihost-nf (Redlib only). These variants each provide a different set of ‘stubs’
that form the very bottom of the C library and include certain low-level functions used by other
functions in the library.

Each variant has a differing set of these stubs, and hence provides differing levels of functionality:

¢ Semihost(-mb)
 This library variant provides implementation of all functions, including file I/0. The file 1/O will
be directed through the debugger and will be performed on the host system (semihosting).
For example, printf/scanf will use the debugger console window and fread/fwrite will operate
on files on the host system. Note: emulated 1/O is relatively slow and can only be used when
debugging.
¢ Semihost(-mb)-nf (no files)
« Redlib only. Similar to Semihost, but only provides support for the 3 standard built-in streams
— stdin, stdout, stderr. This reduces the memory overhead required for the data structures
used by streams, but means that the user application cannot open and use files, though
generally this is not a problem for embedded applications.
* Nohost and Nohost-nf
 This library variant provides the string and memory handling functions and some file-based
I/O functions. However, it assumes that you have no debugging host system, thus any file
I/0 will do nothing. However, it is possible for the user to provide their own implementations
of some of these 1/O functions, for example to redirect output to the UART.
* None
* This has literally no stub and has the smallest memory footprint. It excludes low-level
functions for all file-based 1/0 and some string and memory handling functions.

Note: -mb library variants are not selected by default during any wizard project creation however
they may optionally be selected for enhanced semihost performance with the penalty of slightly
larger RAM usage. Please see for additional information.

In many embedded microcontroller applications it is possible to use the None variant by careful
use of the C library, for instance avoiding calls to printf().

If you are using the wrong library variant, then you will see build errors of the form:

* Linker error "Undefined reference to ‘xxx

For example for a project linking against Redlib(None) but using printf() :

MCUXpresso IDE User Guide -

..libcr_c.a(fpprintf.o):

In function “printf':

fpprintf.c:(.text.printf+0x38):
fpprintf.c:(.text.printf+0x4c):

undefined reference to
undefined reference to

t__sys_wite'
*__Ciob'

...libcr_c.a(_deferredl azyseek.0): In function *__ flsbuf':

...libcr_c.a(alloc.0): In function *_Csys_alloc':
alloc.c:(.text._Csys_all oc+Oxe): undefined reference to ~__sys_wite'
alloc.c:(.text._Csys_alloc+0x12): undefined reference to ~__sys_appexit'
...libcr_c.a(fseek.0): In function "fseek':

fseek.c:(.text.fseek+0x16): undefined reference to ~__sys_istty’
fseek.c:(.text.fseek+0x3a): undefined reference to ~__sys_flen'

_deferredl azyseek.c: (.text.__flsbuf+0x88): undefined reference to *~__sys_istty’
..libcr_c.a(_witebuf.o): In function *~_COwitebuf':
_writebuf.c:(.text._OCwitebuf+0x16): undefined reference to ~__sys_flen'
_writebuf.c:(.text._Owitebuf+0x26): undefined reference to *__sys_seek’
_writebuf.c:(.text._Owitebuf+0x3c): undefined reference to ~__sys_wite'

Or if linking against NewlibNano(None):
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...libc_nano.a(lib_a-witer.o): In function ~_wite_r":
witer.c:(.text._wite_r+0x10): undefined reference to "~_wite'
...libc_nano.a(lib_a-closer.o): In function “_close_r":
closer.c:(.text._close_r+0xc): undefined reference to " _cl ose'
...libc_nano.a(lib_a-lseekr.o0): In function "~_lseek_r":

| seekr.c: (.text._| seek_r+0x10): undefined reference to *_I seek’
...libc_nano.a(lib_a-readr.o): In function *_read_r"':

readr.c: (.text._read_r+0x10): undefined reference to "_read
...libc_nano.a(lib_a-fstatr.o): In function ~_fstat_r":
fstatr.c:(.text._fstat_r+0xe): undefined reference to ~_fstat'
...libc_nano.a(lib_a-isattyr.o): In function *~_isatty_r':
isattyr.c:(.text._isatty_r+0xc): undefined reference to *_isatty'

In such cases, simply change the library hosting being used (as described below), or remove the
call to the triggering C library function.

Switching the selected C library

Normally the library variant used by a project is set up when the project is first created by the
New Project Wizard. However it is quite simple to switch the selected C library between Redlib,
Newlib and NewlibNano, as well as switching the library variant in use.

To switch, highlight the project in the Project Explorer view and go to:
Quickstart -> Quick Settings -> Set library/header type

and select the required library and variant.

Manually Switching
Alternatively, you can make the required changes to your project properties manually as follows...

When switching between Newlib(Nano) and Redlib libraries you must also switch the headers
(since the 2 libraries use different header files). To do this:

1. Select the project in Project Explorer

2. Right-click and select Properties

3. Expand C/C++ Build and select Settings

4. In the Tools settings tab, select Miscellaneous under MCU C Compiler. Note: Redlib is not
available for C++ projects

5. In Library headers, select Newlib or Redlib
. In the Tools setting tab, select Architecture & Headers under MCU Assembler
7. In Library headers, select Newlib or Redlib

»

Repeat the above sequence for all Build Configurations (typically Debug and Release).

To then change the libraries actually being linked with (assuming you are using Managed linker
scripts):

. Select the project in Project Explorer

. Right-click and select Properties

. Expand C/C++ Build and select Settings

. In the Tools settings tab, select Managed Linker Script under MCU Linker

. In the Library drop-down, select the Newlib, NewlibNano or Redlib library variant that you
require (None, Nohost, Semihost, Semihost-nf).

a s wDN PP

Again repeat the above sequence for all Build Configurations (typically Debug and Release).
Note: Redlib is not available for C++ projects.
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What is Semihosting?

Semihosting is a term to describe application 10 via the debug probe. For this to operate, library
code and debug support are required.

Background to Semihosting

When creating a new embedded application, it can sometimes be useful during the early stages
of development to be able to output debug status messages to indicate what is happening as
your application executes.

Traditionally, this might be done by piping the messages over a serial cable connected to a

MCUXpresso IDE offers an alternative to this
scheme, called semihosting. Semihosting provides a mechanism for code running on the target
board to use the facilities of the PC running the IDE. The most common example of this is for the
strings passed to a printf being displayed in the IDE’s console view.

The term “semihosting” was originally termed by ARM in the early 1990s, and basically indicates
that part of the functionality is carried out by the host (the PC with the debug tools running on
it), and partly by the target (your board). The original intention was to provide I/O in a target
environment where no real peripheral-based I/0O was available at all.

Semihosting Implementation

The way it is actually implemented by the tools depends upon which target CPU you are running
on. With Cortex-M based MCUs, the bottom level of the C library contains a special BKPT
instruction. The execution of this is trapped by the debug tools which determine what operation
is being requested — in the case of a printf, for example, this will effectively be a “write character
to stdout”. The debug tools will then read the character from the memory of the target board —
and display it in the console window within the IDE.

Semihosting also provides support for a number of other I/O operations (though this relies upon
your debug probe also supporting them)... For example it provides the ability for scanf to read its
input from the IDE console. It also allows file operations, such that fopen can open a file on your
PC'’s hard drive, and fscanf can then be used to read from that file.

Semihosting Performance

It is fair to say that the semihosting mechanism does not provide a high performance 1/0O system.
Each time a semihosting operation takes place, the processor is basically stopped whilst the data
transfer takes place. The time this takes depends somewhat on the target CPU, the debug probe
being used, the PC hardware and the PC operating system. But it takes a definite period of time,
which may make your code appear to run more slowly.

In MCUXpresso IDE version 10.2.0 semihosting performance has been enhanced to deliver
roughly double the speed when compared with the previous IDE release. Furthermore, a new
MB library variant is been supplied that delivers a significant further improvement in performance
when combined with LinkServer debug connections. This library along new LinkServer debug
support provides the added benefit of no impact on code execution performance.

Important notes about using Semihosting

When you have linked with the semihosting library, your application will no longer work
standalone — it will only work when connected to the debugger.

Semihosting operations cause the CPU to drop into “debug state”, which means that for the
duration of the data transfer between the target and the host PC no code (including interrupts) will
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get executed on the target. Thus if your application uses interrupts, then it is normally advisable to
avoid the use of semihosting whilst interrupts are active — and certainly within interrupt handlers
themselves. If you still need to use printf, then you can retarget the bottom level of the C library to
use an alternative communication channel, such as a UART or the Cortex-M CPU’s ITM channel.

Semihosted printf and Debugging

Semihosting is common to all supported debug solutions so the implications of this mechanism
should be understood:

Projects linked against semihosting libraries that perform semihosted operations e.g. printf, can
not execute without a debugger connected. This is because semihosted operations make use of
a BreakPoint instruction that is intercepted by the debug tools to trigger the desired behaviour
(typically the printf string appearing within the IDE console). Without a debug connection, these
BreakPoint instructions will not be trapped and a Hard Fault exception will occur. By default, the
supplied Hard Fault handler implementation will be an infinite loop. Therefore if an ‘attach’ is
performed to such a target, the user will observe the code running within the hard fault handler. To
avoid this occurring, ensure that the project makes no use of semihosted operations via sending
output to a UART, using the ITM feature, commenting out semihosted operations etc.

In consequence, if for example a user had created an LED blinky application that also performed
semihosted printf operations, then without a debug connection the blinky would stop when the
first printf was executed.

Introduced in MCUXpresso IDE version 10.1.0: New projects and newly imported SDK example
projects will automatically include a semihost hardfault handler (as can be seen in the image
below). The purpose of this handler is to prevent the problem described above. Now, if a
semihosted operation is performed without debug tools attached, the new semihost hardfault
handler will be entered. The handler will check to see if a semihosted operation cause it to be
entered and if so, simply return.

v =5 MKL28751 2xxx7_Project

» #4 Binaries

F hil Includes

» 2 CMSIS

bk £ board

v [ source
b [£] MKL2BZ51 2xxx7_Project.c
b [ mtb.c
» |c] semihost_hardfault.c

b 2 startup

In consequence, if the user creates an LED blinky application that also performs semihosted
printf operations, then without a debug connection the blinky will continue regardless of any printf
operation that may occur.

This functionality can be disabled if required by either simply deleting the handler file, or by
defining a symbol:

__SEM HOST_HARDFAULT_DI SABLE

Note: Previously created projects imported into MCUXpresso IDE (such as LPCOpen projects),
will not inherit this feature.

Introduced in MCUXpresso IDE version 10.2.0: The inclusion of the hardfault handler can be

controlled via a preference preferences -> MCUXpresso IDE -> SDK Options -> Include semihost
hardfault handler ..., where the default is to include.
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Redlib Semihost MB

@ Introduced in MCUXpresso IDE version 10.2.0: is the optional Redlib Semihost
MB library variant. This library provides enhanced semihosting performance from
LinkServer debug connections (other debug solutions will perform as before) with
the added benefit of no impact on code execution performance. There is a small
penalty of slightly larger code and data sizes compared to other Redlib Semihost
libraries. This optional library is recommended for users needing high semihosting
performance and/or have slow debug probe performance.

Semihosting Specification

The semihosting mechanism used within MCUXpresso IDE is based on the specification
contained in the following document available from ARM’s website... => ARM Developer Suite
(ADS) v1.2 Debug Target Guide, Chapter 5. Semihosting

Use of printf

By default, the output from printf() (and puts()) will be displayed in the debugger console via the
semihosting mechanism. This provides a very easy way of getting basic status information out
from your application running on your target.

For printf() to work like this, you must ensure that you are linking with a “semihost” or “semihost-
nf” library variant.

Note: If you only require the display of fixed strings, then using puts() rather than printf() will
noticeably reduce the code size of your application.

Redlib printf Variants

Redlib provides the following two variants of printf. Many of the MCUXpresso New project wizards
provide options to select which of these to use when you create a new project.

Character vs String output

By default printf() and puts() functions will output the generated string at once, so that a single
semihosted operation can output the string to the console of the debugger. Note: these versions
of printf() /puts() make use of malloc() to provide a temporary buffer on the heap in order to
generate the string to be displayed.

It is possible to switch to using “character-by-character” versions of these functions (which do
not require heap space) by specifying the build define “CR_PRINTF_CHAR” (which should be
set at the project level). This can be useful, for example, if you are retargeting printf() to write
out over a UART (as detailed below)- as in this case it is pointless creating a temporary buffer to
store the whole string, only to then print it out over the UART one character at a time

Integer only vs full printf (including floating point)

The printf() routine incorporated into Redlib is much smaller than that in Newlib. Thus if code
size is an issue, then always try to use Redlib if possible. In addition, if your application does
not pass floating point numbers to printf, you can also select an “integer only” (non-floating point
compatible) variant of printf. This will reduce code size further.

To enable the “integer only” printf from Redlib, define the symbol “CR_INTEGER_PRINTF” (at
the project level). This is done by default for projects created from the SDK new project wizard.

NewlibNano printf Variants
By default, NewlibNano uses non-floating point variants of the printf and scanf family of functions,

which can help to dramatically reduce the size of your image if only integer values are used by
such functions.
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If your codebase does require floating point variants of printf/scanf, then these can be enabled
by going to:

Project -> Properties -> C/C++ Build -> Settings -> MCU Linker -> Managed Linker Script and
selecting the " Enable printf/scanf float" tick box.

Newlib printf variants

Newlib provides an “iprintf” function which implements integer only printf.

Printf when using LPCOpen

If you are building your application against LPCOpen, you may find that printf output does not
get displayed in MCUXpresso IDE’s debug console by default. This is due to many LPCOpen
board library projects by default redirecting printf to a UART output.

If you want to direct printf output to the debug console instead, then you will need to modify your
projects so that:

1. Your main application project is linked against the “semihost” variant of the C library, and
2. You disable the LPCOpen board library’s redirection of printf output by either:
« locating the source file board.c within the LPCOpen board library and comment out the line:
#include retarget.h, or
« locating the file board.h and enable the line: #define DEBUG_SEMIHOSTING

Printf when using SDK

The MCUXpresso SDK codebase provides its own printf style functionality through the macro
PRINTF. This is set up in the header file fs|_debug_console.h such that it can either point to the
printf function provided by the C library itself, or can be directly to the SDK function pseudo-printf
function : DbgConsole_Printf() . This will typically cause the output to be sent out via a UART
(which may be connected to an on-board debug probe which will sent it back to the host over a
USB VCOM channel). This is controlled by the macro SDK_DEBUGCONSOLE thus:

* |If SDK_DEBUGCONSOLE ==
* PRINTF is directed to C library printf()
e |f SDK_DEBUGCONSOLE ==
¢ PRINTF is directed to SDK DbgConsole_Printf()

The Advanced page of the SDK new project wizard and Import SDK examples wizard offer
the option to configure a project so that PRINTF is directed to C library printf() by setting
SDK_DEBUGCONSOLE appropriately.

In addition, if PRINTF is being directed to the C library printf(), then if
SDK_DEBUGCONSOLE_UART is also defined, then printf output will still be directed to the
UART. Again the Advanced page of the SDK new project wizard and Import SDK examples
wizard offer an option to control this.

Retargeting printf/scanf

By default, the printf function outputs text to the debug console using the “semihosting”
mechanism.

In some circumstances, this output mechanism may not be suitable for your application. Instead,
you may want printf to output via an alternative communication channel such as a UART or — on
Cortex-M3/M4 — the ITM channel of SWO Trace. In such cases you can retarget the appropriate
portion of the bottom level of the library.

The section “How to use ITM Printf” below provides an example of how this can be done.
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Note: when retargeting these functions, you can typically link against the “nohost” variant of the
C Library, rather than the “semihost” one.

Redlib

To retarget Redlib’s printf(), you need to provide your own implementations of the function
__sys_write():

int __sys wite(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of unwritten bytes if error, otherwise 0 for success

Similarly if you want to retarget scanf(), you need to provide your own implementations of the
function __sys_readc():

int _ sys_readc(void)

Function returns character read
Note: these two functions effectively map directly onto the underlying “semihosting” operations.
Newlib / NewlibNano

To retarget printf(), you will need to provide your own implementation of the Newlib system
function _write():

int _wite(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of unwritten bytes if error, otherwise 0 for success

To retarget scanf, you will need to provide your own implementation of the Newlib system function
_read():

int _read(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of characters read, stored in pcBuffer

More information on the Newlib system calls can be found at: https://sourceware.org/newlib/
libc.html#Syscalls

How to use ITM Printf

ITM Printf is a scheme to achieve application 10 via a debug probe without the usual semihosting
penalties.

ITM Overview

As part of the Cortex-M3/M4 SWO Trace functionality available when using an LPC-Link2 (with
NXP’s CMSIS-DAP firmware), MCUXpresso IDE provides the ability to make use of the ITM :
The Instrumentation Trace Macrocell (ITM) block provides a mechanism for sending data from
your target to the debugger via the SWO trade stream. This communication is achieved through
a memory-mapped register interface. Data written to any of 32 stimulus registers is forwarded to
the SWO stream. Unlike other SWO functionality, using the ITM stimulus ports requires changes
to your code and so should not be considered non-intrusive.

Printf operations can be carried out directly by writing to the ITM stimulus port. However the
stimulus port is output only. And therefore scanf functionality is achieved via a special global
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variable, which allows the debugger to send characters from the console to the target (using
the trace interface). The debugger writes data to the global variable named ITM_RxBuffer to be
picked up by scanf.

Note: MCUXpresso IDE currently only supports ITM via stimulus port 0.

Note: For more information on SWO Trace, please see the MCUXpresso IDE LinkServer SWO
Trace Guide.

ITM printf with SDK

The Advanced page of the SDK new project wizard and Import SDK examples wizard offer the
option to configure a project so as to redirect printf/scanf to ITM. Selecting this option will cause
the file retarget_itm.c to be generated in your project to carry out the redirection.

ITM printf with LPCOpen

To use this functionality with an LPCOpen project you need to: Include the file retarget_itm.c in
your project — available from the Examples subdirectory of your IDE installation Ensure you are
using a semihost, semihost-nf, or nohost C library variant. Then simply add calls to printf and
scanf to your code.

If you just linking against the LPCOpen Chip library, then this is all you need to do. However if you
are also linking against an LPCOpen board library then you will likely see build errors of the form:

../srclretarget.h:224: nmultiple definition of ~__sys_wite'

../srclretarget.h:240: nmultiple definition of ~__sys_readc’

locating the file board.h and enable the line: #define DEBUG_SEMIHOSTING, or locating
the source file board.c within the LPCOpen board library and comment out the line: #include
"retarget.h"

itoa() and uitoa()

itoa() is non-standard library function which is provided in many other toolchain to convert an
integer to a string.

Redlib

To ease porting, MCUXpresso IDE provides two variants of this function in the Redlib C library....

char * itoa(int value, char *vstring, unsigned int base);
char * uitoa(unsigned int value, char *vstring, unsigned int base);

which can be accessed via the system header....

#i ncl ude <stdlib. h>

itoa() converts an integer value to a null-terminated string using the specified base and stores
the result in the array pointed to by the vstring parameter. Base can take any value between 2
and 16; where 2 = binary, 8 = octal, 10 = decimal and 16 = hexadecimal.

If base is 10 and the value is negative, then the resulting string is preceded with a minus sign (-).
With any other base, value is always considered unsigned. The return value to the function is a
pointer to the resulting null-terminated string, the same as parameter vstring.

uitoa() is similar but treats the input value as unsigned in all cases.
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Note: the caller is responsible for reserving space for the output character array — the
recommended length is 33, which is long enough to contain any possible value regardless of
the base used.

Example invocations

char vstring [33]

itoa (value,vstring, 10); // convert to deci na
itoa (value,vstring, 16); // convert to hexadeci ma
itoa (value,vstring,8);; // convert to octa

Standards compliance

As noted above, itoa() / uitoa() are not standard C library functions. A standard-compliant
alternative for some cases may be to use sprintf() - though this is likely to cause an increase in
the size of your application image:

sprintf(vstring,"%l",value); // convert to decinal
sprintf(vstring,"%",value); // convert to hexadeci ma
sprintf(vstring,"%",value); // convert to octal

Newlib/NewlibNano

Newlib and NewlibNano now also provide similar functionality though with slightly different
naming - itoa() and utoa().

Libraries and linker scripts

When using the managed linker script mechanism, as described in the chapter “Memory
configuration and Linker Script Generation”, then the appropriate settings to link against the
required library family and variant will be handled automatically.

However if you are not using the managed linker script mechanism, then you will need to define
which library files to use in your linker script. To do this, add one of the following entries before
the SECTION line in your linker script:

Redlib (None), add

* [C project only]: GROUP (libcr_c.a libcr_eabihelpers.a)

Redlib (Nohost), add

* [C projects only]: GROUP (libcr_nohost.a libcr_c.a libcr_eabihelpers.a)
Redlib (Semihost-nf), add

* [C projects only]: GROUP (libcr_semihost_nf.a libcr_c.a libcr_eabihelpers.a)
Redlib (Semihost), add

* [C projects only]: GROUP (libcr_semihost.a libcr_c.a libcr_eabihelpers.a)

NewlibNano (None), add

 [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_none.a)

e [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++_nano.a libm.a libcr_newlib_none.a)

NewlibNano (Nohost), add

* [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_nohost.a)

o [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++_nano.a libm.a
libcr_newlib_nohost.a)

NewlibNano (Semihost), add

¢ [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_semihost.a)

o [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++_nano.a libm.a
libcr_newlib_semihost.a)
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¢ Newlib (None), add
* [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_none.a)
e [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_none.a)
¢ Newlib (Nohost), add
* [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_nohost.a)
e [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_nohost.a)
¢ Newlib (Semihost), add
* [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_semihost.a)
e [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_semihost.a)

In addition, if using NewlibNano, then tick box method of enabling printf/scanf floating point
support in the Linker pages of Project Properties will also not be available. In such cases, you
can enabling floating point support manually by going to:

Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Miscellaneous
and entering -u _printf_float and/or -u _scanf_float into the “Linker flags” box.

A further alternative is to put an explicit reference to the required support function into your project
codebase itself. One way to do this is to add a statement such as:

asm (“.global _printf_float”);

to one (or more) of the C source files in your project.
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17. Memory Configuration and Linker Scripts

17.1

Introduction

A key part of the core technology within MCUXpresso IDE is the principle of a default defined
memory map for each MCU. For devices with internal Flash, this will also specify a Flash driver
to be used to program that Flash memory (for use with LinkServer “native” debug probes).

For preinstalled MCUs, the definition of the memory map is contained within the MCU part
knowledge that is built into the product. For MCUs installed into MCUXpresso IDE from an SDK,
the definition of the memory map is loaded from the manifest file within the SDK structure.

But in both cases, the defined memory map is used by MCUXpresso IDE to drive the “managed
linker script” mechanism. This auto-generates a linker script to place the code and data from
your project appropriately in memory, as well as being made available to the debugger.

A project’s memory map can be viewed and modified by the user to add, remove (split/join) or
reorder blocks using the in place Memory Configuration Editor. For example, if a project targets
an MCU that supports external Flash (e.g. SPIFI), then it's memory map can be easily extended
to define the SPIFI memory region (base and size). In addition, an appropriate Flash driver can
be associated with the newly defined region.

Figure 17.1. Memory Configuration

Memory details (MK64FN1MOxxx12)*

Default LinkServer Flash Driver:

Default LinkServer Flash Driver Browse...
Type Name Alias Location Size Driver —
Flash PROGRAM_FLASH Flash Ox0 0x100000 FTFE_4K.cfx k'

RAM  SRAM_UPPER RAM 0x20000000 0x30000

RAM  SRAM_LOWER RAM2  Ox1fff0000 0x10000 s

RAM FLEX_RAM RAM3  0x14000000 0x1000
Add Flash Add RAM Split Delete
Import... Merge... Export... Generate..

Refresh MCU Cache
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Introduced in MCUXpresso IDE version 10.3.0 Memory configurations can be edited directly
in place rather than requiring a separate Edit to launch a separate dialogue. In place editing of
memory configurations is incorporated within all project wizards and project properties views.

Managed Linker Script Overview

By default, the use of “managed linker scripts” is enabled for projects. This mechanism allows
MCUXpresso IDE to automatically create a script for each build configuration that is suitable
for the MCU selected for the project and the C libraries being used. It will create (and at times
modify) three linker script files for each build configuration of your project:

<pr oj name>_<bui | dconfig>_lib.ld
<pr oj nane>_<bui | dconfi g>_nmem | d
<pr oj name>_<bui | dconfi g>.1d

This set of hierarchical files are used to define the C libraries being used, the memory map of
the system and the way your code and data is placed into the memory map. These files will be
located in the build configuration subdirectories of your project (typically — Debug and Release).
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Figure 17.2. Project Explorer Debug folder Linker Scripts

17.3

MCUXpresso IDE User Guide -

The managed linker script mechanism also automatically takes into account memory map
changes made in the Memory Configuration Editor as well as other configuration changes, such
as C/C++ library settings.

See also the section on

How are Managed Linker Scripts Generated?

MCUXpresso IDE passes a set of parameters into the linker script generator (based on the
“FreeMarker” scripting engine) to create an appropriate linker script for your project. This
generator uses a set of conditionally parsed template files, each of which control different aspects
of the generated linker script.

It is possible to modify certain aspects of the generated linker script by providing one or more
modified template files locally within linkscripts folder of project directory structure. Any such
templates that you provide locally will then override the default ones built into MCUXpresso IDE.
A full set of the default linker templates (.Idt) files are provided inside \Wizards\linker subdirectory
of your IDE install.
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17.4

Default Image Layout

Code and initial values of initialised data items are placed into first bank of Flash (as show in
memory configuration editor). During startup, MCUXpresso IDE startup code copies the data into
the first bank of RAM (as show in memory configuration editor), and zero initializes the BSS data
directly after this in memory. This process uses a global section table generated into the image
from the linker script.

Other RAM blocks can also have data items placed into them under user control and the startup
code will also initialise these automatically. See later in this chapter for more details.

Figure 17.3. Default Memory Layout
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Note: The above memory layout is simply the default used by the IDE’s managed linker script
mechanism. There are a number of mechanisms that can be used to modify the layout according
to the requirements of your actual project — such as simply editing the order of the RAM banks
in the Memory Configuration Editor. These various methods are described later in this chapter.

The default memory layout will also locate the heap and stack in the first RAM bank, such that:

« the heap is located directly after the BSS data, growing upwards through memory
« the stack located at the end of the first RAM bank, growing down towards the heap

Again this heap and stack placement is a default and it is very easy to modify the locations for
a particular project, as will be described later in this chapter.

Note: When you import a project, you may find that the defaults have already been modified.
Check the Project Properties to confirm the exact details.

Examining the layout of the generated image

Looking at the size of the AXF file generated by building your project on disk does not provide any
information as to how much Flash/RAM space your application will occupy when downloaded
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to your MCU. The AXF file contains a lot more information than just the binary code of
your application, for example the debug data used to provide source level information when
debugging, that is never downloaded to your MCU.

Linker --print-memory-usage

MCUXpresso IDE projects use the --print-memory-usage option on the link step of a build to
display memory usage information in the build console of the following form:

Menory region Used Size Region Size %age Used
PROGRAM_FLASH: 25960 B 1 MB 2.48%
SRAM_UPPER: 8472 B 192 KB 4.31%
SRAM_LOVNER: 0 & 64 KB 0. 00%
FLEX_RAM 0 & 4 KB 0. 00%

Fi ni shed buil ding target: frdnk64f_bubbl e. axf

The memory regions displayed here will match up to the memory banks displayed in the memory
configuration editor when the managed linker script mechanism is being used.

By default, the application will build and link against the first Flash memory found within the MCU’s
memory configuration. For most MCUs there will only be one Flash device available. In this case
our project requires 25960 bytes of Flash memory storage, 2.48% of the available Flash storage.

RAM will be used for global variable, the heap and the stack. MCUXpresso IDE provides a flexible
scheme to reserve memory for Stack and Heap. This build has reserved 4KB each for the stack
and the heap contributing 8KB to the overall 8472 bytes reported.

If using the 'LPCXpresso style' of heap and stack placement (described later in this chapter), the
RAM consumption provided by this feature is only that of your global data. It will not include any
memory consumed by your stack and heap when your application is actually executing.

Note: project imported into MCUXpresso IDE may not have been created with this option. To add
this, right click on the project and select C/C++ Build ->Settings -> MCU Linker -> Miscellaneous
then click ‘+’ and add --print-memory-usage

Comparing Code Size

This summary provides a quick method to see usage of the memory regions and also changes
in efficiency. Below are examples of Memory Usage for the same project compiled on an older
version of MCUXpresso IDE vs the current version.

Code size with MCUXpresso IDE version 11.0.x:

Menory region Used Size Region Size %age Used
BOARD_FLASH: 40244 B 64 MB . 06%
SRAM DTC: 8580 B 128 KB . 55%
SRAM | TC: 0 GB 128 KB . 00%
SRAM _CC: 0 GB 256 KB . 00%
BOARD_SDRAM 0 GB 32 MB 0. 00%

Fi ni shed buil ding target: evkbi nxrt1050_bubbl e_peri pheral . axf

o O o O

Code size with MCUXpresso IDE version 11.1.x:

Menory region Used Size Region Size %age Used
BOARD_FLASH: 36192 B 64 MB 0. 05%
SRAM DTC: 8580 B 128 KB 6. 55%

SRAM | TC: 0GB 128 KB 0. 00%
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SRAM _CC: 0GB 256 KB 0. 00%
BOARD_SDRAM 0GB 32 MB 0. 00%
Fi ni shed buil ding target: evkbi nxrt1050_bubbl e_peri pheral . axf

See the section on the view for details on further image exploration.

arm-none-eabi-size

In addition, a post-build step will normally invoke the arm-none-eabi-size utility to provide this
information in a slightly different form....

t ext data bss dec hex fil enane
2624 524 32 3180 c6e LPCXpressol1768_systi ck_twi nkl e. axf

« text - shows the code and read-only data in your application (in decimal)

« data - shows the read-write data in your application (in decimal)

¢ bss - show the zero initialized (‘bss’ and ‘common’) data in your application (in decimal)
e dec - total of ‘text’ + ‘data’ + ‘bss’ (in decimal)

¢ hex - hexadecimal equivalent of 'dec’

Typically:

 the Flash consumption of your application will then be text + data
« the RAM consumption of your application will then be data + bss

Again if using the 'LPCXpresso style' of heap and stack placement (described later in this
chapter), the RAM consumption will not include any memory allocated for your stack and heap
when your application is actually executing.

You can also manually run the arm-none-eabi-size utility on both your final application image, or
on individual object files within your build directory by right clicking on the file in Project Explorer
and selecting the Binary Utilities -> Size option.

Linker Map Files

The linker option “-map” option, which is enabled by default by the project wizard when a new
project is created, allows you to analyse in more detail the contents of your application image.
When you do a build, this will cause a file called projectname.map to be created in the Debug (or
Release) subdirectory, which can be loaded into the editor view. This contains a large amount
of information, including:

¢ A list of archive members (library objects) included with details

« Alist of discarded input sections (because they are unused and the linker option --gc-sections
is enabled).

¢ The location, size and type of all code, data and bss items that have been placed in the image

Image Information (Info)

The Image Info View provides tools for detailed analysis of an image structure and memory
footprint.

The Image Info view is stacked by default in the MCUXpresso IDE Develop perspective, along
with Problems and/or Console views.

The tool bar icons for this view are shown and detailed below:
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1.

Where:

Loads the build artifact (.axf) associated with the currently selected project’s active build
configuration for analysis. This is the simplest option to follow to populate this view.

« alternatively, an image, object or static library can be dragged onto this view

* once loaded, the selected artifact name and build information (plus warnings if any) is
displayed as a title to the view

« if more than one project (or file) is selected and more than one Image Info view is open
within the IDE, then the additional views will also be populated from the selection

« also, if more than one build configuration is available, the drop down option allows All build
configurations to be opened

« this icon will be greyed out if the selected project’s active build configuration has not been
built

. Browse to a build artifact containing symbolic information
. Reload information from the currently loaded build artifact
« this may be required when a project is rebuilt from changed sources

. Open the Map file associated with the currently selected build artifact
« this file will open up within the editor view where helps
navigation
. Open the Linker Script (.Id file) associated with the currently selected build artifact
« this file will open up with the editor view where helps

navigation and understanding
. Locate the main symbol if present in the current tab
. Enable/Disable C++ name mangling
« this uses the c++filt binutils application to demangle C++ symbols from the view
« all (mangled) items from the view will be affected — not only the current selection
. Toggle between sizes in bytes and larger units (KB, MB etc.)
. Click to compare with contents from another (new) Image Info view using the standard Eclipse
compare utility
« to use this feature, create a second Image Info view and load with another image, object
etc. click compare in both views

10(A) Copy highlighted information to the clip board

« copied information is held in .tsv format with the table headers added to the selection

Tip
@ These options are also available from a right click menu within the Image Info view

Also highlighted is the searchffilter button, this can be used to switch between the highlighting

of lines containing an entered search item and only displaying matching lines. This feature can
be useful to remove clutter from large groups of items.

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022 191



NXP Semiconductors MCUXpresso IDE User Guide

Note: information from highlighted lines is shown in the Properties view

The Image Information view (usually) consists of 3 sub views offering — Memory Usage, Memory
Contents and (static) Call Graph information.

17.6.1 Memory Usage

The Memory Usage view shows how much memory (Flash and RAM) is used by the associated
build artifact.

|Memory Usage Memory Contents | Call Graph

Region Start address End address Size Free Used Usage (%)

€ PROGRAM_FLASH 0x0 0x100000 1MB 998.65 KB 25.35 KB 2.48%
aiii SRAM_UPPER 0x20000000 0x20030000 192 KB 183.73 KB 8.27 KB 4.31%
i SRAM_LOWER Ox1f{f0000 0x20000000 64 KB 64 KB 0B 0.00%
il FLEX_RAM 0x14000000 0x14001000 4KB 4 KB 0B 0.00%

Figure 17.5. Image Info Mem Usage

The memory regions displayed will be the same as the selected project’s build artifact (typically
a project’s generated elf (.axf) file. The detailed information is broadly the same as that provided
by the Linker --print-memory-usage switch however, this view can be used to easily compare
memory usage from one build to another following code changes, improvements, different build
configurations etc.

Tip

@ As a guide the memory usage % display will be colored green when more than half
of the available memory is free, then changing through yellow to red if more memory
is used

Note: The Memory Usage tab will not be displayed in the following situations:

¢ A not-yet-linked file (*.0) was processed
e A static library (*.a) was processed

¢ A build artifact from outside the current workspace was processed — memory regions cannot
be obtained in this case

Double click a Memory region to jump its Contents.

17.6.2 Memory Contents

The Memory Contents view provides a detailed view of the contents of each memory region. The
image below shows various linker sections distributed within the memory regions.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide Rev. 11.6.0 — 19 December, 2022 192




NXP Semiconductors MCUXpresso IDE User Guide

Memory Usage |Memeory Contents Call Graph
| Name Run address Load address Size Type
| ¥ € PROGRAM_FLASH 0x0 1MB memory region
> B text 0x0 25.34 KB section
b k- data 0x20000000 0x6558 168 section
k- data_RAM2 0x1fff0000 0x6558 0B section
k- .data_RAM3 0x14000000 0x6558 0B section
b L *ABS* 0x0 0B section
¥ i SRAM_UPPER 0x20000000 192 KB memory region
> L data 0x20000000 0x8558 168 section
P 1 bss 0x20000010 2648 section
¥ % .uninit RESERVED 0x20000000 [o]:] section
> 1 .noinit 0x20000118 []:] section
P % heap 0x20000118 4KB section
- .heap2stackfill 0x20001118 4KB section
b 1= .stack 0x2002f000 [o:] section
P 1 *ABS* 0x0 0B section

Figure 17.6. Image Info Mem Contents

Double clicking or pressing the Enter key on any selected symbol will open its definition.

L€ startup,m kﬁaﬂ 2.c ZS

6@ attr1bute (tused secnun( .FlashCon flq )}) cunst struct {
unsigned int wordl;
unsigned int word2;
unsigned int word3;
unsigned int wordd;
} Flash Coan.g = {@xFFFFFFFF, ExFFFFFFFF GXFFFFFFFF @xFFFFFFFE};

SRR S S S SRS S RO o SRR R RO R R T Ve Tt T TV Lo kR

Memory Usage Memory Contents Call Graph

Name Run aadress Load address Size Type
» DMA7_DriverlRQHandler Ox262 2B weak function
A =S O S-S AR T— SedOp 0B global
l 2 _Flash _Config 0x400 l 168 global object
e LI ACLL ~ORICIS CAIN DacAan no labol

Figure 17.7. Image Info Mem Symbol linkage

Note: If a symbol cannot be found within the sources, for example the symbol is within a C library
function, a message will be displayed in the Eclipse’s status bar.

Selecting multiple lines within this view will total their memory usage.

|3 items selected, totalling & / 0x8 bytes (6 8) |

Memory Usage W Call Graph

| Name Run address Load address Size

E e B -

@ ermno 0x2000010c

‘-___
\-___

» g_xDuty 0x20000114
‘__

Figure 17.8. Image Info Mem Size

Note: When selecting multiple symbols, the sum of their individual sizes is computed without
taking into account any space that was used for padding or alignment within the section. As a
result, the actual section size might differ compared to the size of a multiple symbols selection.
Note that the real section size within the application is the size displayed next to the section
name, in the appropriate table column.

17.6.3 Call Graph

The Call Graph tab shows the static stack cost for the selected build artifact as generated via
the -fstack-usage compiler option. The generation of Stack Usage information is now a default
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option within MCUXpresso IDE version 11.0.0 but can be controlled via the Workspace project

property shown below:

Settings i i
¥ Resource
Builders . . oo - -
Configuration: = Debug [ Active ] Manage Configurations...
C/C++ Bulld 2 g B
Build variables
Environment
Logging . W #Build steps Build Artifact  |sw Binary Parsers @ Error Parsers
MCU settings
Settings ¥ ¥ MCU C Compiler Other flags -¢ -ffunction-sections -fdata-sections -ffreestanding -
Tool Chain Editor 2 Dialect
» C/C++ General E G Verbose (-v)
MCUXpresso Config Too ®includes Support ANSI programs (-ansi)

Project Natures
Project References
Run/Debug Settings
Task Tags

» Validation

(% Optimization
(% Debugging
(% Warnings
£ Miscellaneous
(2 Architecture

| v By MCU Assembler

Figure 17.9. Image Info Call Graph Enable

Position Independent Code (-fPIC)
Library headers = Redlib (Auto)

Generate Stack Usage Info (-fstack-usage)

This option enables the generation

of .su (stack usage) files by the compiler and these are

consumed (along with other information) to populate the Call Graph view. Note: the generation
of these additional files has minimal impact on project build times.

If a project has been built and loaded, the call graph information for the selected build
configuration will be available. Below is a truncated view of a call graph display, expanded and
highlighted to display the main() function.

Memory Usage | Memory Contents |Call Graph,

Function Depth Location Type Local Cost Full Cost Comment
¥ @ ResetlSR 17 startup_mk64£12.c:461 static 8B & 256 B
» @ Systeminit 1 system_MK64F12.c:130 static 8B 128
v main 16 ? /2488 No available stack cost information (library...
¥ & main 15 bubble.c:244 static 728 /4, 248 B
| v - BOARDnitPins 11 lpinmuxc:77 ____ |static 88 _____Jaz8 |
CLOCK_EnableClock ¢} fsl_clock.h:692 static 248 248
PORT_SetPinMux 0 fsl_port.h:371 static 248 248
BOARD_InitDebugConsale 13 board.c:43 static 168 176 B

""" i s 27
0 startup_mk64f12.c:436
> 9 board.c:104
» © BOARD_Accel_12C_Receive 9 beard.c:111
4]

P = exception handlers

Figure 17.10. Image Info Call Graph

static 0B
static 408 1688
static 328 160B
? 408 No available stack cost information (library...

In this view, the columns have the following meaning:

¢ Function: displays the function name
¢ Depth: displays the maximum call depth
« where N means the function has at least 1 child with a depth of N-1

+ and 0 means there are no child functions

 Location: function location within the source (file:line)

« this will be empty if no source is found

e Type: show static or dynamic allocation type
¢ Local Cost: shows the number of bytes allocation by the function itself
¢ Full Cost: shows the number of bytes allocation by the function itself plus that of the deepest

child function

« Comment: shows additional information such as recursive calls

Within the view, symbols are coloured to indicated meaning:

MCUXpresso IDE User Guide -
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Memory Usage Memory Contents m

Function Depth Location Type Local Cost Full Cost Comment
 —— 16 ? #2488 No available stack cost information (library
@ main bubble.c:260 static 728 #2488
¢ __aeabi_d2iz 0 s 0B No available stack cost information (library
¥ o yecursivefunc 4 bubble.c:98 static 16 B & 168
£y, & L —Punolo.c(g ti 168 0B Recursive call found, the cost will not cons
o - T H i 18 0 A Q
. ¥ @ main o
O _aeabi_d2iz

O ¥ o recursivefunc
¥4 recursivefunc

Figure 17.11. Image Info Call Graph Display Types

1. A symbol in black can be double clicked to open the associated source code
2. A symbol in grey has no associated source information
« this might indicate an assembly or library symbol

3. A symbol with circular arrows indicates it has a recursive call and so its stack costs cannot
be added to the full cost

4. exception handlers in grey (not show) will group any root symbol with a Handler suffix

Finally, if for any reason Call Graph information may be limited or stale, clear self describing
warnings will be displayed.

17.6.4 Use of Filters

The search filter now supports both simple and regular expression search.

Below a filter for the symbol main will locate *__main’ and ‘main’.

:PJvl#W\l_.‘m(l B :vtriv
Ipcxpresso54608_hello_world_swo/Debug/Ipcxpresso54608_hello_world_swo.axf - 27-Nov-2019 15:14:38
2 items selected, totalling Local: 8 bytes (8 B) / Full: 640 bytes (640 B) R
Memory Usage  Memory Contents |Call Graph|
Function Depth Location Type Local Cost. Full Cost Comment
¥ @ Reset/SR 18 startup_Ipc54808.c:356 static 8B 3288
» @ Systeminit 1 system_LPC54608.c:250 static 8B 12B
@ data_init 0 startup_Ipc54608.c:322 static 4B 48
@ bss_init 0 startup_lpc54608.c:331 static 0B 0B
¥ & _main 17 e} No available stack cost informatiol
> & _initio 8 7 No available stack cost informatiol
¥ & main 16 hello_world_swo.c:79 static 8B 3208
@ CLOCK_AttachClk 0 fsl_clock.c:147 static 328 32

Figure 17.12. Call Graph Simple Filter

Regular expression filter supports standard regex searching...

Ipcxpresso54608_hello_world_swo/Debug/ipcxpresso54608_hello_world_swo.axf - 27-Nov-2019 15:14:38
2 items selected, totalling Local: 8 bytes (8 B) / Full: 8 bytes (8 B)

\d[2]*Freq | =

Memory Usage | Memory Contents |Call Graph |

Function Depth  Location Type Local Cost Full Cost Comment
¥ @ CLOCK GetFreq 5 fsl_clock.c:967 static 248 1208
¥ @ CLOCK GetCoreSysClkFreq 1 fsl_clock.c:714 static 168 328

© CLOCK_GetFro12MFreq 0 fsl_clock.c:619 static 4B 4B
@ CLOCK GetExtClkFreq ) fsl_clock.c:628 static 4B 4B
@ CLOCK_GetwdtOscFreq 1] fsl_clock.c:637 static 168 168
@ CLOCK GetFroHfFreq o fsl_clock.c:657 static 4B 4B
@ CLOCK_ GetPllQutFreq o] fsl_clock.c:678 static 4B 4B
@ CLOCK GetOsc32KFreq 0 fsl_clock.c:705 static 4B 4B
» @ CLOCK_GetClockOutClkFreq 2 fsl_clock.c:310 static 168 488
> @ CLOCK GetSpifiClkFreg 2 fsl_clock.c:358 static 168 488

Figure 17.13. Call Graph RegEXx Filterl

MCUXpresso IDE User Guide -

Use of NOT searching — search for CLOCK but not containing Xtal ...
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e BMOLCEER RV

frdmk641f_bubble/Debug/frdmk64f_bubble.axf - 27-Nov-2019 10:47:34

28 items selected, totalling Local: 476 bytes (476 B) | Full: 936 bytes (936 B) CLOCK(?!*Xtal) |=

Memory Usage | Memory Contents |Call Graph/
Function Depth Location Type Local Cost. Full Cost Comment

¥ @ main 15 bubble.c:228 static 728 5208
» @ BOARD_InitPins 1 pin_mux.c:52 static 8B 328
¥ & BOARD_BootClockRUN 10 clock_config.c:168 static 8B 648

© CLOCK_SetSimSafeDivs 0 fsl_clock.h:888 static 48 4B
¥ @ CLOCK_InitOscO 1 fsl_clock.c:1186 static 248 488
® CLOCK GetOscRangeFromFreq 0 fsl_clock.c:326 static 248 248
@ OSC_SetCapLoad 0 fsl_clock.h:1190 static 248 248
@ OSC_SetExtRefClkConfig 0 fsl_clock.h:1164 static 24 248
® CLOCK_SetXtalOFreq 0 fsl_clock.h:1228 static 168 168
© CLOCK_SetinternalRefClkConfig 0 fsl_clock.c:808 static 248 248
@ CLOCK_CONFIG_SetFlIExtRefDiv 0 clock_config.c:76 static 168 168

Figure 17.14. Call Graph RegEx Filter2

17.7

MCUXpresso IDE User Guide -

Note: If an error occurs when entering a regular expression, the message becomes red as you
type and the tooltip will indicate the expression error.

Tip

@ Typically, to search for a string within a regular expression, you would write
(.*)string(.*) ... In order to remove this requirement from users, strings are guarded
by default at the beginning and end resulting in a search for anything containing the
string. A side effect of this guard is that you can't search for something starting or
ending with *.".

Enhanced Syntax Highlighting

Introduced in MCUXpresso IDE version 11.0.0, additional editor capability delivering Enhanced
Syntax Highlighting for GNU Linker Script .Id files (also Linker Script template and .map files).
The primary goal of these enhancements is to simplify the exploration of these files and also ease
the manual creation of Linker Script files for situations where MCUXpresso IDE’s auto generated
linker script mechanism cannot support the required configuration.

The new editor will be invoked automatically by double clicking on the .Id, .Idt or .map file
within the project explorer view. If needed, this functionality can be disabled via Preferences ->
MCUXpresso IDE -> Editor Awareness, the changes taking effect after restarting MCUXpresso
IDE.

Note: To ensure that enabling and disabling the editors work as expected, MCUXpresso IDE
should be launched in clean mode. This can be done either by calling the IDE executable from the
command line with the -clean argument or by adding -clean on the first line of the .ini configuration
file (which can be found in the same folder as the MCUXpresso IDE executable).
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i Project Explor 82 . Peripherals+ iii Registers % Fau
5% @9
v == frdmk64f_bubble
» € Project Settings
i 4;-?' Binaries
¥ ) Includes
» B2 CMSIS
» 2 accel
2 board
2 component
2 device
B drivers
2 source
Esrc
(= startup
(£ utilities
= Debug
» (= accel
» (= board
» (= component
» (= device
» (=drivers
» (= source
» = startup
» = utilities

4 V¥ ¥y Y Y YYVYY

S frdmk64f_bubble_Debug_library.ld

S frdmk64f_bubble_Debug_memory.ld

S frdmk64f_bubble_Debug.ld
frdmk64f_bubble.map

Figure 17.15. Project Build Configuration Files

Note: these files are automatically generated by the
for the selected build configuration when a project is built

Once a file is opened as below, a number of features are available.
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4 frdmk64f_bubble_Debug.ld 22

'.-l/x
GENERATED FILE - DO NOT EDIT
Copyright (c) 2008 - 2013 Code Red Technologies Ltd,
Copyright 2015, 2818 NXP
(c) NXP Semiconductors 2013-2019
Generated linker script file for MKG64FN1M@xxx12
Created from linkscript.ldt by FMCreatelinkLibraries
Using Freemarker v2.3.23

=W
*

L A I S

-

INCLUDE] " frdmk64f_bubble_Debug_library.1d"
INCLUDE] " frdmk64f_bubble_Debug_memory. ld"

ENTRY({ResetISR)
= SECTIONS
{

/% MAIN TEXT SECTION =/
.text : ALIGN(B)
{

288

FILL(BXTf)

__vectors_start__ = ABSOLUTE(.) ;
KEEP

/* Global Section Table */

. = ALIGN(4) ;
__section_table_start = .;
__data_section_table = .;
LONG(LOADADDR(.data));

LONG
LONG

LONG(
LONG(

LONG(
LONG(

ADDR(.data));
SIZEOF(.data));

LONG(LOADADDR (. data_RAM2) );

ADDR(.data_RAM2));
SIZEOF(.data_RAM2));

LONG (LOADADDR (. data_RAM3) );

ADDR(.data_RAM3));
SIZEOF(.data_RAM3));

__data_section_table_end = .;

39 __bss_section_table = .;

LONG(
41 LONG(
42 LONG(
43 LONG(
14 LONG(
LONG(

ADDR(.bss));
SIZEOF(.bss));

ADDR(.bss_RAMZ));
SIZEOF(.bss_RAMZ));

ADDR(.bss_RAM3) ) ;
SIZEOF (.bss_RAM3));

__bss_section_table_end = .;
__section_table_end = . ;
/* End of Global Section Table %/

Figure 17.16. Linker Description file

MCUXpresso IDE v11.0.@_alpha [Build 2495] [2019-85-15] on 19-May-2019 15:54:07

Include files and Symbols source (as highlighted) can be opened in a new editor view via CTRL

+ Click (CMD + Click for Mac) on their filename.

The Editor also provides context aware code completion accessible by pressing CTRL + SPACE.

17+ SECTIONS
19 /% MAIN TEXT SECTION =/
ALIGN(8)

20 .text :
21 {

=
LO "'=PROVIDE

L = PROVIDE_HIDDEN
L0:=quap

| QHORT

Lg

Figure 17.17. Auto Completion

MCUXpresso IDE User Guide -

The editor also provides error checking — validating that any changes are in accordance with

the linker script syntax.
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17 SECTIONS
18 {
19 /% MAIN TEXT SECTION %/
20= .text : ALIGN(B)
37 i
22
0 23 FILL(@xff)
pais —V —STart__ = ABSOLUTE(.) ;
25 KEEP( )
26 /* Global Section Table =/

Figure 17.18. Error Checking Syntax

Furthermore, INCLUDE paths are verified and any error shown as below.

- F FLUAYTESSU LULC VIL.U.Y_dlipild [DULW £93J] LZY%
10/

L; INCLUDE "frdmk64f_bubble_Debug_library.1d"

|
17 ENTRY(ResetISR)

Figure 17.19. Error Checking Files

Error markers will be shown on the navigation bar and in the title of the editor window.

The Outline view displays an outline of the file that is currently open in the editor area.
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Figure 17.20. Linker Description Outline association Id

¥4 frdmk64f_bubble_Debug.ld & =
18 /*
2 * GENERATED FILE - DO NOT EDIT
3 % Copyright (c) 2008 - 2013 Code Red Technologies Ltd,
4 % Copyright 2015, 2018 NXP
5 * (c) NXP Semiconductors 2013-2019 5= Outline £3
6 = Generated linker script file for MKG64FNIM@xxx3 -
7 % Created from linkscript.ldt by FMCreateLinkLiff Y '=frdmk64f bubble Debug
8 * Using Freemarker v2.3.23 U frdmk64f_bubble_Debug_library.ld
9 :/MCUXpressu IDE v11.0.0 alpha [Build 2495] [203 L frdmk64f_bubble_Debug_memory.Id
= ResetISR
INCLUDE "frdmk&4f_bubble_Debug_library.ld" v EISECTIONS
INCLUDE "frdmk64f_bubble_Debug_memory.ld" » ©.text
> =@ .text
ENTRY (ResetISR) » = .ARM.extab
= SECTIONS ] *exidaqtart
{ » & . ARM.exidx
/% MAIN TEXT SECTION */ = _exidx_end
S +.:text + ALIGN(8) . _etext
FILL(Oxff) > ©.m_usb_data
E;::tors;tani :)ABSOLUTE(-) - » = .data_RAM2
/% Global Section Table #/ " Ei.da.ta._RAMfi
. = ALIGN(4) ; » & .uninit_RESERVED
__section_table_start = .; » ©.data
__data_section_table = .;
LONG(LOADADDR (. data) ) ; > ©.bss RAM2
LONG( ADDR(.data)); » ©.bss_RAM3
LONG( SIZEOF(.data)); » ®.bss
LONG (LOADADDR(.data_RAM2)); init RAM?2
LONG{  ADDR(.data_RAMZ)); . S.ncinit. RAM
LONG( SIZEOF(.data_RAM2)); » ®.noinit_RAM3
LONG(LOADADDR(.data_RAM3)); » ®.noinit
LONG( ADDR(.data_RAM3)); ok .
LONG( SIZEOF(.data_RAM3)); | _HeapSize
__data_section_table_end = .; » =.heap
__bss_section_table = .; StackSi
TONG(~  ADDR(.bss}); S
LONG( SIZEOF(.bss)): » © .heap2stackfill
LONG( ADDR(.bss_RAM2) ) ; » ©.stack
LONG( SIZEOF(.bss_RAM2)); i
LONG( ADDR(.bss_RAM3) ) ; = _‘\mage_start
LONG( SIZEOF(.bss_RAM3)); = _jmage_end
‘b.s,sﬁiqcxigru‘amsﬁendv.54..;*1 = _image_size

This is particularly useful for navigations through complex auto generated .map files
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[ frdmk64f_bubble.map &2

LU B W N

=)

10

|
= /Applications/MCUXpressoIDE_11|

7= /Applications/MCUXpressoIDE_11|

/Applications/MCUXpressoIDE_11,

MppucauonslﬂcuxnressoIDE_ll“
/Applications/MCUXpressoIDE_11,
Mppluatiuns/ﬂcuxpressoIDE_llj
58 /Applications/MCUXpressuIDEﬁlli
: Mppli(atinnslMCUXpressoIDE_ll‘\
/Appllcations/MCHXpressnIDEAlli‘
Mppu:ationsmcuxpressomE_nf

1
/Applications/MCUXpressoIDE_11|

1= Archive member included to satisfy reference by file (symbol)
i= /Applications/MCUXpressoIDE_11.0.0_2495_alpha/ide/p ggéns/gom.m}p:mcuxpressa.tools.L

- /Applications/MCUXpressoIDE_11, o= Outline £

rdmk64f_bubble

9= /Applications/MCUXpressoIDE_11,  * ©Discarded input sections
‘

v ﬁMemory configuration
CJPROGRAM_FLASH
ISRAM_UPPER
LJSRAM_LOWER
LIFLEX_RAM
O*default*

|
17= /Applications/MCUXpressoIDE 11y i=|inker script and memory map

» (=LOAD DIRECTIVES
» ® SYMBOLS
v = SECTIONS

EEEES

-ARM .extab
ARM.exidx
.m_usb_data

EEEEEE

-

Figure 17.21. Map file Outline association map

v
» B Archive members

text (Address: 0x0000000000000000; Size: 0x74e8)
-glue_7 (Address: OxO0000000000074e8; Size: Ox0)
.glue_7t (Address: 0x00000000000074e8; Size: 0x0)
~vfp11_veneer (Address: 0x00000000000074e8; Size: 0x0)
v4_bx (Address: 0x00000000000074e8; Size: 0x0)

.iplt (Address: Ox00000000000074e8; Size: 0x0)

.rel.dyn (Address: 0x0000000000007 4e8; Size: 0x0)

.data_RAM2 (Address: 0x000000001fff0000; Size: Ox0)
.data_RAM3 (Address: 0x0000000014000000; Size: 0x0)
.uninit RESERVED (Address: 0x0000000020000000; Size: 0x0)
.data (Address: 0x0000000020000000; Size: 0x10)

.igot.plt (Address: Ox0000000020000010; Size: 0x0)

=0

MCUXpresso IDE User Guide -

Tip

Right clicking within the outline view will allow the opening of related source files.

All information provided in this document is subject to legal disclaimers
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e 8 Preferences

Syntax Coloring S v w

*General
FCiC++
*Help
*Install/Update
¥ Java
» Library Hover
MCUXpresso Config Tools
TMCUXpresso IDE
Debug Options (Advanced)
Debug Options (Miscellaneous)
Debug Probe Discovery
Default Tool settings
¥ Editor Awarenass
¥ GNU Linker Script

Token Styles

Comment

Default

Input section

Keyword

Memory region
Punctuation character
Section

String

Symbal

Color | |

Background [

Style

Bold
Strike through

Italic

Underline

Change...

Fant Menlo-regular-12

¥Linker Script Template
Syntax Coloring

¥Map File
Syntax Coloring

General

J-Link Options
LinkServer Opticns
LPC-Link Options
MCU settings

Paths and Directories
PEMicro Options

Restore Defaults

) g 175 Cancel

= &

Figure 17.22. Editor Awareness Syntax Highlighting Preferences

17.8

17.8.1

MCUXpresso IDE User Guide -

Other Options affecting the Generated Image

LPC MCUs — Code Read Protection

Most of NXP’s LPC Cortex-M based MCUs which have internal Flash memory contain “Code
Read Protection” (CRP) support. This mechanism uses one of a number of known values being
placed in a specific location in Flash memory to provide a number of levels of protection. When
the MCU boots, this specific location in Flash memory is read and depending upon its value, the
MCU may prevent access to the Flash memory by external devices. This location is typically at
0x2FC though for LPC18xx/43xx parts with internal Flash, the CRP location is at an offset of
0x2FC from the start of the Flash bank being used.

CRP : Preinstalled MCUs

Support for setting up the CRP memory location is provided via a combination of the Project
Wizard, a header file and a number of macros. This support allows specific values to be easily
placed into the CRP memory location, based on the user’s requirements.

The New Project wizard contains an option to allow linker support for placing a CRP word to be
enabled when you create a new project. This is typically enabled by default. This wizard option
actually then controls the “Enable CRP” checkbox of the Project Properties linker Target tab.

In addition, the wizard will create a file, ‘crp.c’ which defines the ‘CRP_WORD’ variable which will
contain the required CRP value. A set of possible values are provided by the NXP/crp.h header
file that this then includes. Thus for example ‘crp.c’ will typically contain:

#i ncl ude <NXP/crp. h>
__CRP const unsigned int CRP_WORD = CRP_NO CRP ;

which is then placed at the correct location in Flash by the linker script generated by the managed
linker script mechanism:
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. = 0x000002FC ;
KEEP(* (. crp))

Note: the value CRP_NO_CRP ensures that the Flash memory is fully accessible. When you
reach the stage of your project where you want to protect your image, you will need to modify
the CRP word to contain an appropriate value.

Important Note: You should take particular care when modifying the value placed in the CRP
word, as some CRP settings can disable some or all means of access to your MCU (including
debug). Before making use of CRP, you are strongly advised to refer to the User Manual for the
LPC MCU that you are using.

CRP : MCUs installed by Importing an SDK

The support for CRP in LPC parts imported into MCUXpresso IDE from an SDK, is generally
similar to the Preinstalled MCUs. However rather than having a separate crp.c file, the
CRP_WORD variable definition is generally found within the startup code.

Kinetis MCUs — Flash Config Blocks

Kinetis MCUs provides an alternative means of protecting the user’s image in Flash using the
Flash Configuration Block. The Flash Configuration Field is generally located at addresses
0x400-0x40F and unlike the LPC CRP mechanism only specific values give access, whereas
any other values are likely to lock the part.

The value of the Flash Configuration block for a project is provided by the following structure
which will be found in the startup code:

_attribute__ ((used,section(".FlashConfig"))) const struct {
unsi gned int wordi;
unsi gned int word2;
unsi gned int word3;
unsi gned i nt word4;

} Flash_Config = {OxFFFFFFFF, OXFFFFFFFF, OxFFFFFFFF, OxFFFFFFFE};

which is then placed appropriately by the linker script generated by the managed linker script
mechanism.

/* Kinetis Flash Configuration data */

. = 0x400 ;

PROVI DE(__FLASH CONFI G START__ = .) ;

KEEP(* (. Fl ashConfi g))

PROVI DE(__FLASH CONFIGEND = .) ;

ASSERT(! (__FLASH CONFI G START __ == _ FLASH CONFI G END ),
"Li nker Flash Config Support Enabl ed, but no .Fl ashConfig
section provided within application");

/* End of Kinetis Flash Configuration data */

Important Note: The support for placing the Flash Configuration Block can be disabled by
unticking a checkbox of the Project Properties linker Target tab. However this is generally not
advisable as it is very likely to result in a locked MCU.
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Figure 17.23. Linker Settings
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Placement of USB Data

For MCUs where part support is imported from an SDK, the managed linker script mechanism
supports the automatic placement of USB global data (as used by the SDK USB Drivers),
including for parts with dedicated USB_RAM (small or large variants).

Plain Load Image

The LPC540xx family provides no built-in flash, but rather offers a quad SPI Flash Interface
(SPIFI) so that external flash can be used. The most straight forward way of using external flash
is that the image is built to be programmed into the external flash and executed directly from the
same location (XIP — eXecute In Place).

However the LPC540xx boot rom also offers an alternative way of using the external flash — such
that the application is programmed into the flash, but the boot rom will relocate it into a bank of
the onboard SRAM for execution. Generally it is expected that the SRAMX bank (at address 0x0)
will be used for this. An application that runs in this manner is known as a “plain load image”.

MCUXpresso IDE’s managed linker script mechanism offers a simple way of configuring an
application project so that it will build as a plain load image. This can be controlled for a particular
build configuration via:
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Project -> Properties -> C/C++ Build -> Settings -> Tools Settings -> MCU Linker -> Managed
Linker Script

L §;<;'I’CU Assembler Link application to RAM
o —
bGeﬁgla' Plain load image SRAMX i
(2 Architecture & Headers ,

¥ §:‘ gfu Linker H Generate an image suitable for relocating by a Style ﬁ
(% General bootloader from its load address in Flash to an
(% Libraries g execute address in RAM - such as the "plain
BMiscellaneous load image” on the LPC540xx devices - :
% Shared Library Settings s Lo e
%\“:A hitect g Heap Default Post Data Default
A Ichtted e = Stack Default End Default
(*:Managed Linker Script
& Multicore

Figure 17.24. Plain Load Image
Please see also the shortcuts.
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Enabling the “Plain load image” option will:

1. Modify the generated linker script so that the main code section is located so that it will be
programmed into flash, but expect to be copied into specified RAM bank by the boot rom
before being executed

2. Modify the startup code, using symbols provided from the generated linker script, so that the
appropriate data is placed into the image so that the boot rom know that it needs to relocate
the image from flash into RAM.

Note 1: This functionality requires the application project to be based on the LPC540xx part
support from SDK v2.4.0 (or later).

Note 2: The size of the application image (including the initialised global data) must be less than
the size of the RAM bank that the code will execute from.

Note 3: LPC540xx supports plain load images being executed from either address 0x0 or address
0x20000000. However if the RAM at 0x20000000 is used then the debugger will not be able to
stop on the default breakpoint on main(). This is because a hardware breakpoint needs to be
used (as the copying of the code from flash into RAM by the boot rom would overwrite a software
breakpoint), but the Cortex-M4 cannot set a hardware breakpoint this high in the memory map.

Link Application to RAM

The MCUXpresso IDE managed linker mechanism defaults to placing the code and initialised
data values to first Flash region listed within a project's memory configuration as discussed in
the section.

On occasion, it can be useful to debug a project directly from RAM since this offers some benefits
such as avoiding the flash programming element of the debug session etc. Linking to RAM could
be achieved by deleting the Flash memory regions from the project's memory configuration and
rebuilding the application — however this is not the most convenient approach!

Therefore MCUXpresso IDE offers the option to tell the managed linker script mechanism to
simply ignore any flash regions listed in the project’s memory configuration via a simple checkbox
at:

Project -> Properties -> C/C++ Build -> Settings -> Tools Settings -> MCU Linker -> Managed
Linker Script
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(#2General Link application to RAM
[ Architecture & Headers R
¥ B3 MCU Linker Link all sections to RAM (i.e. ignore Flash)
2 General
(B Libraries Heap and Stack placement = MCUXpresso Style |7}
(B Miscellaneous Stack offset 0
(#2Shared Library Settings
g#\rchi!ecture Region Location Size
(¥:Managed Linker Script Heap Default Post Data Default
(2 Multicore Stack Default End Ox4
Figure 17.25. Link to RAM
Please see also the shortcuts.

With this option is set, the application will instead link to the first RAM region listed within the
project’'s memory configuration.

There are two important considerations when developing with RAM based projects:

1. They require support from the debug environment to be run and so may not execute in the
exactly the same manner as a true application running from an MCU reset. Please see the
section for more information. Please note: if you are
using debug solutions other than LinkServer, additional user setup may be required.

2. Unlike project running from Flash, global variable load and execute addresses will by default
be the same. The consequence of this is that global variables values will persist at their
current value if an application is restarted. Therefore this is not recommended, and instead a
restart should be achieved by terminating and restarting the whole debug session. See also:

Note: Some MCU/development boards make use of SDRAM. These memories are typically
initialised by the MCU BootROM during reset and this initialisation may require user supplied
configuration data to be programmed into flash. Therefore you must ensure that any SDRAM
regions are correctly initialised before they are used for RAM based debug operations.

Modifying the Generated Linker Script / Memory Layout

The linker script generated by the managed linker script mechanism will be suitable for use,
as is, for many applications. However in some circumstances you may need to make changes.
MCUXpresso IDE provides a number of mechanisms to allow you to do this whilst still being able
to use the managed linker script mechanism. These include:

¢ Changing the layout and order of memory using the Memory Configuration Editor
¢ Changing the size and location of the stack and heap using the Heap and Stack Editor

« Decorating the definitions of variables and functions in your source code with macros from the
cr_section_macros.h to cause them to be placed into different memory blocks

« Providing project specific versions of FreeMarker linker script templates to change particular
aspects of how the managed linker script mechanism creates the final linker script

The following sections describe these in more detail.

Using the Memory Configuration Editor
The Memory Configuration Editor is accessed via the MCU settings dialog, which can be found at
Project Properties -> C/C++ Build -> MCU settings

This lists the memory details for the selected MCU, and will, by default, display the memory
regions that have been defined by MCUXpresso IDE itself (from installed or SDK part support).
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Figure 17.26. LPC4337... default memory regions

17.10.1 Editing a Memory Configuration

In the example below, we will show how the default memory configuration for an LPC4337... can
be changed.

Introduced in MCUXpresso IDE version 10.3.0, the memory configuration can simply be edited
in place to create the desired memory map.
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Default LinkServer Flash Driver LPC18x7_43x7_2x512_BootA.cfx Browse...
Type Name Alias Location Size Driver —
Flash MFlashA512 Flash 0x1a000000 0x80000 L
Flash MFlashB512 Flash2  0x1b000000 0x80000 B
RAM RamLoc32 RAM 0x10000000 0x8000 -
RAM RamLoc40 RAM2 0x10080000 Oxa000

RAM RamAHB32 RAM3 0x20000000 0x8000

RAM RamAHB16 RAM4 0x20008000 0x4000

RAM RamAHB_ETB16 RAMS 0x2000c000 0x4000

Add Flash Add RAM Split Delete

Import... Merge... Export... Generate...

Figure 17.27. Memory configuration editor

Known blocks of memory, with their type, base location, and size are displayed. Entries can be
created, deleted, etc by using the provided buttons.

For simplicity, the additional memory regions are given sequential aliases, starting from 2, so
RAM2, RAMS etc (as well as using their “formal” region name — for example RamAHB32).

Table 17.1. Memory editor controls

Button Details

Add Flash Add a new memory block of the appropriate type.

Add RAM Add a new memory block of the appropriate type.

Split Split the selected memory block into two equal halves.

Join Join the selected memory block with the following block (if the two are contiguous).

Delete Delete the selected memory block.

Import Import a memory configuration that has been exported from another project,
overwriting the existing configuration.

Merge Import a partial memory configuration from a file, merging it with the existing

memory configuration. This allows you, for example, to add an external Flash bank
definition to an existing project.

Export Export a memory configuration for use in another project.

Up / Down Reorder memory blocks. This is important: if there is no Flash block, then code will
be placed in the first RAM block, and data will be placed in the block following the
one used for the code (regardless of whether the code block was RAM or Flash).
Generate Generates local part support for the selected MCU.

Driver Highlighted in blue, shows the selection of a per-Flash region Flash driver. Click
this field to see a drop down of all available drivers. Please see:

Browse(Flash driver) Select the appropriate driver for programming the Flash memory specified in
the memory configuration. For more information please see the section on

The name, location, and size of this new region can be edited in place. Note: When entering
the size of the region, you can enter full values in decimal or in hex (by prefixing with ox), or by
specifying the size in kilobytes or megabytes. For example:

¢ To enter a region size of 32KB, enter 32768, 0x8000 OF 32k.
¢ To enter a region size of 1MB, enter 0x100000 Of 1m
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Note: Memory regions must be located on four-byte boundaries, and be a multiple of four bytes
in size.

The screenshot below shows the dialog after the “Add Flash” button has been clicked. Use
the highlighted up/down buttons to move this region to be top in the list. This action forces
MCUXpresso IDE’s managed linker script mechanism to link against this new flash region.

Figure 17.28. Effect of Add Flash

Default LinkServer Flash Driver LPC18x7_43x7_2x512_BootA.cfx Browse...
Type Name Alias Location Size Driver

Flash  MFlashA512 Flash 0x1a000000 0x80000

Elash MFlashB512 Flash2 0x1b000000 0x80000

Flash Flash_00 Flash3 Ox1b080000 0x400

RAM RamLoc32 RAM 0x10000000 0x8000

RAM  RamlLoc40 RAM2 0x10080000 Oxa000

RAM  RamAHB32 RAM3 0x20000000 0x8000

RAM RamAHB16 RAM4 0x20008000 0x4000

RAM  RamAHB_ETB16 RAMS 0x2000c000 0x4000

Add Flash Add RAM Split Delete

Import... Merge... Export... Generate...

Tip
@ Once a change has been made, ensure a mouse click is made outside any
changed cell, this action will force the change to be recognised by Eclipse

Figure 17.29. Updated MCU settings
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Add Flash Add RAM Split Delete

Import... Merge... Export... Generate...
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Here you can see that the new region has been named SPIFI_1MB, its base address set to
0x14000000, its size to 1MB and the default Flash driver has been deleted and an SFDP SPIFI
driver selected for the newly created SPIFI_1MB region.

MCUXpresso IDE provides extended support for the creation and programming of projects that
span multiple Flash devices. In addition to a single default Flash driver, per region Flash drivers
can also be specified (as above). Using this scheme projects can be created that span Flash
regions and can be programmed in a single ‘debug’ operation.

Note: Once the memory details have been modified, the selected MCU as displayed on the
“Status Bar” (at the bottom of the IDE window) will be displayed with an asterisk (*) next to it.
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This provides an indication that the MCU memory configuration settings for the selected project
have been modified.

Device specific vs Default Flash Drivers

When a project is configured to use additional Flash devices via the Memory Configuration Editor,
the Flash driver to be used for programming that Flash device has to be specified in the Driver
column. Typically for a SPIFI device, this should be:

LPC18_43_SPIFI_GENERIC.cfx (for LPC18/LPC43 series MCUSs)
LPC40xx_SPIFI_GENERIC.cfx (for LPC407x/8x MCUSs)
LPC5460x_SPIFI_GENERIC.cfx (for LPC5460x MCUS).
* LPC540xx_SPIFI_GENERIC.cfx (for LPC540xx MCUSs).

For further information please also see the section on

Restoring a Memory Configuration

To restore the memory configuration of a project back to the default settings, simply reselect the
MCU type, or use the “Restore Defaults” button, on the MCU Settings properties page.

Copying Memory Configurations

Memory configurations can be exported for import into another project. Use the Export and Import
buttons for this purpose.

Global Data Placement

By default, global data items are located at run time in the ‘default’ memory region (i.e. the first
RAM block displayed in the memory configuration area).

However, MCUXpresso IDE version 10.2 introduced a mechanism to the Managed Linker Script
mechanism to allow the user to specify a specific memory region to be used for the global data,
without the need to change the order of the RAM blocks in the memory configuration editor.

This can be done via the Managed Linker Script page of Project Properties:

Figure 17.30. MCUXpresso IDE Global Data Placement
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¥ & MCU Debugger
(2 Debug
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Extra linker script input sections 4 X

Input section description Region Section Type
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To change the memory region to be used, simply use the drop down box to select the memory
region you wish to locate the global data.

Note: the above placement of global data applies to global data items that are not explicitly placed

elsewhere in the memory map see:

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022 210



NXP Semiconductors MCUXpresso IDE User Guide

17.12 Modifying heap/stack placement

MCUXpresso IDE provides two models of heap/stack placement. The first of these is the
“LPCXpresso Style”, which is the mechanism provided by the previous generation LPCXpresso
IDE. This is the default model used for projects created for Preinstalled MCUs. The second model

is the “MCUXpresso style”. This is the default model used for projects created for MCUs imported
from SDKs.

The heap/stack placement model being used for a particular project/build configuration can be
modified by right clicking on the project and selecting:

Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Managed Linker Scripts

[ NN ] Properties for MK64FN1MOxxx12_Project
Settings L= R
» Resource
Builders > A . |~ : .
2 M Confi t
vC/C++ Build Configuration: = Debug [ Active ] H anage Configurations.

Build Variables
Environment
Legging

MCU settings
Settings

X # Build steps Build Artifact

) Binary Parsers @ Error Parsers

Tool Chain Editor

» C/C++ General
MCUXpresso Config Too
Project Natures
Project References
Run/Debug Settings
Task Tags

» Validation

¥ 3 MCU C Compiler

(2 Dialect

(2 Preprocessor

(EIncludes

(# Optimization

# Debugging

(# Warnings

(2 Miscellaneous

(& Architecture
¥ i MCU Assembler

(= General

(£ Architecture & Headers
¥ 3 MCU Linker

(¥ General

(£ Libraries

2 Miscellaneous
(2 Shared Library Settings
(2 Architecture

£ Managed Linker Script
(2 Multicore

v I3 MCU Debugger
(#2Debug

# Miscellaneous

Manage linker script

Linker script
Script path

Enable automatic placement of Flash Configuration field in image

Library Redlib (semihost-nf) ﬂ
Link application to RAM
Plain load image SRAM_UPPER

Heap and Stack placement [ MCUXpresso Style

Stack offsat 0
Region Location Size

Heap Default Post Data Default

Stack Default End Default

Global data placement Default B

Extra linker script input sections & X

Input section description Region Section Type
Restore Defaults Apply
Cangel

Figure 17.31. MCUXpresso IDE Linker Settings

In the dialogue above, highlights show the managed linker script option along with the selection
of the MCUXpresso Style scheme.

17.12.1 MCUXpresso style Heap and Stack

By default the heap and stack are placed in the “default” memory region (i.e. the first RAM block

displayed in the memory configuration area), with the heap placed after the application’s data
and the stack rooted at the top of this block.
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However, using the Heap and Stack editor in Project Properties, it is very simple to individually
change the stack and heap locations (both the memory block used, and the location within that
block), and also the size of the memory to be used by each of them.

Region

e Default : Place into first RAM bank as shown in Memory Configuration Editor
« List of memory regions, and aliases, as show in Memory Configuration Editor

Location

e Start : Place at start of specified RAM bank.
e Post Data : Place after any data in specified RAM bank. Default for heap.
* End : Place at end of specified RAM bank. Default for stack.

Size

e Default: 1/16th of the memory region size, up to a maximum of 4KB (and a minimum of
128bytes). Hovering the cursor over the field will show the current value that will be used.

¢ Value : Specify exact required size. Must be a multiple of 4. Note: When entering the size of
the region, you can enter full values in decimal or in hex (by prefixing with 0x), or by specifying
the size in Kilobytes (or Megabytes). For example:
* To enter a size of 32KB, enter 32768, 0x8000 or 32k.
« Avalue of 0 can be entered to prevent any heap use by an application.

* Note: For semihosted printf to operate without any heap space, you must enable the
“character only” version. For Redlib, define the symbol “CR_PRINTF_CHAR” (at the
project level) and remove other semihosting defines such as CR_INTEGER_PRINTF.
Character only semihosted printf is significantly slower than the default version and may
display differently depending on your debug solution.

Note: The MCUXpresso style of setting heap and stack has the advantage over the LPCXpresso
style described below in that the memory allocated for heap/stack usage is also taken into
account in the image size information displayed in the Build console when your project is built.

LPCXpresso style Heap and Stack

By default the heap and stack are still placed in the “default” memory region (i.e. the first RAM
block displayed in the memory configuration area), with the heap placed after the application’s
data and the stack rooted at the top of this block.

To relocate the stack or heap, or provide a maximum extent of the heap, then the linker “--defsym”
option can be used to define one or more of the following symbols:

__user_stack_top
__user_heap_base
_pvHeapLim t

To do this, use the MCU Linker -> Miscellaneous -> Other Options box in Project Properties.
For example:
--defsym=__user_stack_top=__top_RAM?2

¢ Locate the stack at the top of the second RAM bank (as listed in the memory configuration
editor)

¢ Note: The symbol _ top RAM2 is defined in the project by the managed linker script
mechanism at:

<proj nane>_<bui | dconfig> nmem | d
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--defsym=__user_heap_base=__end_bss_RAM2
¢ Locate the start of the heap in the second RAM bank, after any data that has been placed there
--defsym=_pvHeapLimit=__end_bss_RAM2+0x8000

¢ Locate the end of the heap in the second RAM bank, offset by 32KB from the end of any data
that has been placed there

--defsym=_pvHeapLimit=0x10004000

¢ Locate the end of the heap at the absolute address 0x10004000

Reserving RAM for IAP Flash Programming

The IAP Flash programming routines available in NXP’s LPC MCUs generally make use of some
of the onchip RAM when executed. For example on the LPC1343 the top 32 bytes of onchip RAM
are used. Thus if you are calling the IAP routines from your own application, you need to ensure
that this memory is not used by your main application — which typically means by the stack.

However, with the managed linker script mechanism, it is easy to modify the start position of the
stack (remember that stacks grow down) to avoid this clash with the IAP routines. To do this go to:

Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Manager Linker Script

and modify the value in the “Stack Offset” field from 0 to 32. This will work whether you are using
LPCXpresso style or MCUXpresso style of heap/stack placement.

) MCU Linker Plain load image SRAM_UPPER
(% General _
&2
= Libraries Heap and Stack placement  MCUXpresso Style ﬂ
(%2 Miscellaneous Stack offsat §|32 I
(%2 Shared Library Settings = =

é‘? Architecture Region Location Size

(%2 Managed Linker Script Heap Default Post Data Default

(5 Multicore Stack Default End Default

¥ £ MCU Debugger

(2 Debug

(#=Miscellaneous =
Global data placement Default ﬁ
Extra linker script input sections & K
Input section description Region Section Type

Figure 17.32. MCUXpresso IDE Linker Reserve Stack Space
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The value you enter in this field must be a multiple of 4.

You are also advised to check the documentation for the actual MCU that you are using to confirm
the amount of memory required by the IAP routines.

Stack Checking

Although, as described above, it is possible to define a size of memory to be used for the stack,
Cortex-M CPUs have no support for hardware stack checking. Thus if you want to automatically
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detect if the stack exceeds the memory set aside for it — other mechanisms must be used. For
example:

« ldentify a suitable memory region (or portion of one) that will fault for accesses below the
regions base address, then locate the stack as desired within this region and watch for a
possible fault

« Include code that sets the stack to a known value, and periodically checks whether the lowest
address has been overwritten

« When debugging, set a watchpoint on the lowest address the stack is allowed to reach
« Use the Memory Protection Unit (MPU) to detect overflow, on parts which implement one

Heap Checking

By default, the heap used by the malloc() family of routines grows upwards from the end of the
user data in RAM up towards the stack — a “one region memory model”.

When a new block of memory is requested, the memory allocation function _sbrk() will make a
call to the following function to check for heap overflow:

unsi gned __check_heap_overflow (void * new end_of _heap)

This should return:

e 1 - If the heap will overflow
¢ 0 - If the heap is still OK

If 1 is returned, Redlib’s malloc() will set errno to ENOMEM and return a null pointer to the caller

The default version of __check_heap_overflow() builtinto MCUXpresso IDE supplied C libraries
carry out no checking unless the symbol “_pvHeapLimit” has been created in your image, to mark
the end location of the heap.

This symbol will have been created automatically if you are using the MCUXpresso style of heap
and stack placement described earlier in this chapter. Or alternatively if using the LPCXpresso
style of heap and stack placements, you can use the --defsym option to set this.

If you wish to use a different means of heap overflow checking, then you can find a reference
implementation of __check_heap_overflow() in the file _cr_check_heap.c that can be found
in the Examples subdirectory of your IDE installation.

This file also provides functionality to allow simple heap overflow checking to be done by
looking to see if the heap has reached the current location of the stack point, which of course
assumes that the heap and stack are in the same region. This check is not enabled by default
implementation within the C library as it can break in some circumstances — for example when
the heap is being managed by an RTOS.

Checking the Heap from your Application

The symbol __end_of_heap indicates the current end of the heap and can be used by user code
to track heap usage. For instance:

extern unsigned int __end_of _heap;

end_of _heap = __end_of _heap;
nmyBuf f ptr=(ui nt 32_t*) nal | oc(20*si zeof (uint32_t));
new_end_of _heap = __end_of _heap;
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However it should be noted that the location this points to includes any last block that has been
free’d. In other words it effectively provides the maximal extent of the heap so far, not the end
of the currently “active” last block.

Thus in some cases, if you check __end_of heap before calling malloc(), then again afterwards,
it is possible that the value will not change if the heap request can be fulfilled using the free'd
last block i.e. there is no need to extend the heap further. In certain cases, __end_of heap can
reduce, for example if a block at the end of the heap is freed and a smaller block is subsequently
allocated.

Placement of specific code/data Iltems

It is possible to make changes to the placement of specific code/data items within the final image
without modifying the FreeMarker linker script templates. Such placement can be controlled via
macros provided in an MCUXpresso IDE supplied header file which can be pulled into your
project using:

#i ncl ude <cr_section_nacros. h>

Alternatively Introduced in MCUXpresso IDE version 10.2, the managed linker script
mechanism now also provides a means of placing arbitrarily named code or data sections into a
specified memory region of the generated image and is described in the next section. (See also

Placing code and data into different Memory Regions

Unlike the macros provided by cr_section_macros.h (described later), this method does not
require any change to the source code declaring the affected code/data (which basically rename
the generated code/data sections to match the memory region name). And in many cases it can
avoid the need to provide project local FreeMarker linker script templates (described later in this
chapter).

To place the code or data, you simply need to add the details of the section nhame, the memory
region to place it in, and the type of the code/data, as per the below screenshot(s):

¥ B MCU Linker

( General Heap and Stack placement = MCUXpresso Style ﬂ

:“’ Libraries Stack offset 0

l';gi ;L:::lc:al.nii?:rs Settings Reden i i

:g’—?.ﬂrchitecture % . Heap Default Post Data Default

lgiwlaneged Linker Script Stack Default End Default

o

(= Multicore

v i) MCU Debugger

(#Debug =
Global data placement Default w
Extra linker script input sections & )
Input section description Region Section Type
*(NonCacheable.init) SRAM_DTC data
*(NonCacheable) SRAM_DTC .bss

Figure 17.33. Adding an Extra Linker Section
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which will modify the generated linker script to contain the sections specified in the appropriate
region:
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/* Main DATA section (SRAM_DTC) */
.data : ALIGN(4)
{

FILL(@xfF)

_data = . ;

*(wvtable)

*(NonCacheable . init)

. = ALIGN(4) ;
_edata = . ;
} > SRAM_DTC AT>BOARD_FLASH

R OV W S S N A A oY o o o o

/* MAIN BSS SECTION */
.bss : ALIGN(4)
{

*(NonCacheable)

*(COMMON)

. = ALIGN(4) ;

_ebss = .;

PROVIDE(end = .);
} > SRAM_DTC

Figure 17.34. Extra Linker Section Script

The second example graphic shows both the placement of a constant data table and also the
powerful technigue of specifying a project source folder and placing the entire contents of that
folder (flash2’s .text sections) into a chosen flash device. Using this scheme the user can drag
and drop source files within the project structure to choose which location will be used for their
linkage and so their flash storage.

Extra linker script input sections & %
Input section description Region Section Type
*(.big_const_data_table) ELASH2 .rodata
*flash2/*(.text*) FLASH2 Jtext

Figure 17.35. Adding an Extra Linker 2 Section

Note: that the format of the “input section description” is as detailed in the GNU Linker
documentation, which can be found within the IDE’s built-in help system :

Help -> Help Contents -> Tools (Compilers, Debugger, Utilities) -> GNU Linker -> Linker Scripts
-> SECTIONS Command -> Input Section Description

or directly in the online GNU documentation at:
https://sourceware.org/binutils/docs/ld/Input-Section-Basics.html

Also, this functionality only allows you to add sections to the linker script, not to remove something
that the managed linker script already puts in. Thus if you need to remove part of the generated
linker script’s contents — then you will still need to modify the underlying FreeMarker linker script
templates.

Finally, remember that the GNU linker script mechanism functions such that the first match
encountered for a section will win (not the best match found). Thus this mechanism is just a
request, not a guarantee. Always check the generated linker script and the map file output by
the link step to confirm the expected placement of sections. In some problem cases, you may
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be able to force the required placement by use of an EXCLUDE in one memory region, as well
as the section in the required region.

Placing data into different RAM blocks using Macros

Many MCUs provide more than one bank of RAM. By default the managed linker script
mechanism will place all of the application data and bss (as well as the heap and stack) into
the first bank of RAM.

However it is also possible to place specific data or bss items into any of the defined banks for the
target MCU, as displayed in the Memory Configuration Editor, by decorating their definitions in
your source code with macros from the cr_section_macros.h MCUXpresso IDE supplied header
file

For simplicity, the additional memory regions are named sequentially, starting from 2, so RAM2,
RAM3 etc (as well as using their “formal” region name — for example RamAHB32).

For example, the LPC1768 has a second bank of RAM at address 0x2007c000. The managed
linker script mechanism creates a data (and equivalent bss) load section for this region thus:

.data_RAM2 : ALI G\N(4)
{
FI LL(Oxff)
*(. dat a. $RAMR*)
* (. dat a. $RamAHB32*)
} > RamAHB32 AT>MFl ash512

To place data into this section, you can use the _ DATA macro, thus:

/] create an unitialised 1k buffer in RAM2
__DATA(RAMR) char data_buffer[1024];

Or the _ BSS macro:

/] create a zero-init buffer in RAM2
__BSS(RAMR) char bss_buffer[128];

In some cases you might need a finer level of granularity than just placing a variable into a specific
memory bank, and rather need to place it at a specific address. In such a case you could then
edit the predefined memory layout for your particular project using the “Memory Configuration
Editor” to divide up (and rename) the existing banks of RAM. This then allows you to provide a
specific named block of RAM into which to place the variable that you need at a specific address,
again by using the attribute macros provided by the “cr_section_macros.h” header file.

Noinit Memory Sections

Normally global variables in an application will end up in either a “.data” (initialized) or
“.bss” (zero-initialized) data section within your linked application. Then when your application
starts executing, the startup code will automatically copy the initial values of “.data” sections from
Flash to RAM, and zero-initialize “.bss” data sections directly in RAM.

MCUXpresso IDE’s managed linker script mechanism also supports the use of “.noinit” data
within your application. Such data is similar to “.bss” except that it will not get zero-initialized
during startup.

Note: Great care must be taken when using “.noinit” data such that your application code makes
no assumptions about the initial value of such data. This normally means that your application
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code will need to explicitly set up such data before using it — otherwise the initial value of such
a global variable will basically be random (i.e. it will depend upon the value that happens to be
in RAM when your system powers up).

One common example of using such .noinit data items is in defining the frame buffer stored in
SDRAM in applications which use an onchip LCD controller (for example NXP LPC178x and
LPC408x parts).

Making global variables Noinit

The linker script generated by MCUXpresso IDE’s managed linker script mechanism will contain
a section for each RAM memory block to contain “.noinit” items, as well as the “.data” and “.bss”
items. Note: For a particular RAM memory block, all “.data” items will be placed first, followed
by “.bss” items, and then “.noinit” items.

However, normally for a particular RAM memory block where you are going to be put “.noinit”
items, you would actually be making all of the data placed into that RAM “.noinit”.

The “cr_section_macros.h” header file then defines macros which can be used to place global
variables into the appropriate “.noinit” section. First of all include this header file:

#i ncl ude <cr_section_nacros. h>

The _ NOINIT macro can then be used thus:

/] create a 128 byte noinit buffer in RAM2
__NO NIT(RAM2) char noinit_buffer[128];

And if you want “.noinit” items placed into the default RAM bank, then you can use the
__NOINIT_DEF macro thus:

/] create a noinit integer variable in the main bl ock of RAM
__NO NIT_DEF int noinit_var ;

Placing code/rodata into different FLASH Blocks

Most MCUs only have one bank of Flash memory. But with some parts more than one bank may
be available — and in such cases, by default, the managed linker script mechanism will still place
all of the application code and rodata (consts) into the first bank of Flash (as displayed in the
Memory Configuration Editor).

For example:

¢ most of the LPC18 and LPC43xx parts containing internal Flash (such as LPC1857 and
LPC4357) actually provide dual banks of Flash.

« some MCUs have the ability to access external Flash (typically SPIFI) as well as their built-in
internal Flash (e.g. LPC18xx, LPC40xx, LPC43xx, LPC546xx).

However it is also possible to place specific functions or rodata items into the second
(or even third) bank of Flash. This placement is controlled via macros provided in the
"cr_section_macros.h" header file.

For simplicity, the additional Flash region can be referenced as Flash2 (as well as using its
“formal” region name — for example MFlashB512 — which will vary depending upon part).

First of all include this header file:

#i ncl ude <cr_section_nacros. h>
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Then, for example, to place a rodata item into this section, you can use the __ RODATA macro,
thus:

__RODATA(Fl ash2) const int roarray[] = {10, 20, 30, 40, 50};

Or to place a function into it you can use __ TEXT macro:

__TEXT(Fl ash2) void systick_delay(uint32_t del ayTicks) {

In addition, the _ RODATA_EXT and _ TEXT_EXT macros can be used to place functions/
rodata into a more specifically named section, for example:

__ TEXT_EXT(Fl ash2, systi ck_del ay) void systick_del ay(uint32_t del ayTi cks) {

will be placed into the section “.text.$Flash2.systick_delay” rather than “.text.$Flash2”.

17.13.5 Placing specific functions into RAM Blocks

In most modern MCUSs with built-in Flash memory, code is normally executed directly from Flash
memory. Various techniques, such as prefetch buffering are used to ensure that code will execute
with minimal or zero wait states, even a higher clock frequencies. Please see the documentation
for the MCU that you are using for more details.
However it is also possible to place specific functions into any of the defined banks of RAM for
the target MCU, as displayed in:
Project -> Properties -> C/C++ Build -> MCU settings
and sometimes there can be advantages in relocating small, time critical functions so that they
run out of RAM instead of Flash.
For simplicity, the additional memory regions are named sequentially, starting from 2, (as well
as using their “formal” region name — for example RamAHB32). So for a device with 3 RAM
regions, alias names RAM, RAM2 and RAMS3 will be available.
This placement is controlled via macros provided in a header file which can be pulled into your
project using:

#i ncl ude <cr_section_nacros. h>
The macro __RAMFUNC can be used to locate a function into a specific RAM region.
For example, to place a function into the main RAM region, use:

__RAMFUNC(RAM) void fooRAMvoid) {...
To place a function into the RAM2 region, use:

__RAMFUNC( RAMR) voi d fooRAM2(void) {...
Alternatively, RAM can be selected by formal name (as listed in the memory configuration editor),
for example:
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__RAMFUNC( RamAHB32) voi d Handl erRAMvoid) {...

In order to initialize RAM based code (and data) into specified RAM banks, the managed linker
script mechanism will create a “Global Section Table” in your image, directly after the vector
table. This contains the addresses and lengths of each of the data (and bss) sections, so that the
startup code can then perform the necessary initialization (copy code/data from Flash to RAM) .

Long branch veneers and Debugging

Due to the distance in the memory map between Flash memory and RAM, you will typically
require a “long branch veneer” between the function in RAM and the calling function in Flash. The
linker can automatically generate such a veneer for direct function calls, or you can effectively
generate your own by using a call via a function pointer.

One point to note is that debugging code with a linker generated veneer can sometimes cause
problems. This veneer will not have any source level debug information associated with it, so that
if you try to step in to a call to your code in RAM, typically the debugger will step over it instead.

You can work around this by single stepping at the instruction level, setting a breakpoint in your
RAM code, or by changing the function call from a direct one to a call via a function pointer.

Reducing Code Size when support for LPC CRP or Kinetis Flash
Config Block is Enabled

One of the consequences of the way that LPC CRP and Kinetis Flash Configuration Blocks work
is that the memory between the CPU’s vector table and the CRP word/ Flash Config Block is
often left largely unused. This can typically increases the size of the application image by several
hundred bytes (depending upon the MCU being used).

However this unused space can easily be reclaimed by choosing one or more functions to be
placed into this unused memory. To do this, you simply need to decorate their definitions with
the macro __ AFTER_VECTORS which is supplied in the “cr_section_macros.h” header file

Obviously in order to do this effectively, you need to identify functions which will occupy as much
of this unused memory as possible. The best way to do this is to look at the linker map file.

MCUXpresso IDE startup code already uses this macro to place the various initialization functions
and default exception handlers that it contains into this space, thus reducing the ‘default’ unused
space. But you can also place additional functions there by decorating their definitions with the
macro, for example

__AFTER VECTORS voi d nyStartupFunction(void);

Note: you will get a link error if the _ AFTER_VECTORS space grows beyond the CRP/Flash
Configuration Block (when this support is enabled):

nyproj _Debug. | d: 98 cannot nove |ocation counter backwards (from 00000334
to 000002f c)

collect2: Id returned 1 exit status

make: *** [nyproj.axf] Error 1

In this case, you will need to remove the _ AFTER_VECTORS macro from the definition of one
or more of your functions.

FreeMarker Linker Script Templates

By default, MCUXpresso IDE projects use a managed linker script mechanism which
automatically generates a linker script file without user intervention — allowing the project code
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and data to be laid out in memory based on the IDE’s knowledge of the memory layout of the
target MCU.

However sometimes the linker script generated in this way may not provide exactly the memory
layout required. MCUXpresso IDE therefore provides a highly flexible and powerful linker script
template mechanism to allow the user to change the content of the linker script generated by
the managed linker script mechanism

Basics

FreeMarker is a template engine: a generic tool to generate text output (HTML web pages, e-
mails, configuration files, source code, etc.) based on templates and changing data. Built into
MCUXpresso IDE are a set of templates that are processed by the FreeMarker template engine
to create the linker script. Templates are written in the FreeMarker Template Language (FTL),
which is a simple, specialized language, not a full-blown programming language like PHP. Full
documentation for FreeMarker can be found at https://freemarker.org/docs/index.html .

MCUXpresso IDE automatically invokes FreeMarker, passing it a data model that describes
the memory layout of the target together with a ‘root’ template that is processed to create the
linker script. This root template, #includes further ‘component’ templates. This structure allows
a linker script to be broken down into various components, and allows a user to provide their
own templates for a component, instead of having to (re-)write the whole template. For example,
component templates are provided for text, data and bss sections, allowing the user to provide a
different implementations as necessary, but leaving the other parts of the linker script untouched.

MCUXpresso IDE Project

Target System User
Definition Templates Templates

Freemarker
Template engine

Linker script

Reference

FreeMarker reads input files, copying text and processing FreeMarker directives and ‘variables’,
and writes an output file. As used by MCUXpresso IDE’s managed linker script mechanism,
the input files describe the various components of a linker script which, together with variables
defined by the IDE, are used to generate a complete linker script. Any of the component template
input files may be overridden by providing a local version in the project.

The component template input files are provided as a hierarchy, shown below, where each file
#includes those files nested below. This allows for individual components of the linker script to be
overridden without having to supply the entire linker script, increasing flexibility, while maintaining
the benefits of Managed Linker Scripts.
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Linker script template hierarchy

linkscript.ldt (top level)

user.ldt (an empty file designed to be overridden by users that is included in linkscript, memory
and library templates)

user_linkscript.ldt (an empty file designed to be overridden by users that is included in
linkscript only)

linkscript_common.ldt (root for main content)

header.ldt (the header for scripts)

« listvars.Idt (a script to output a list of all predefined variables available to the template)

includes.Idt (includes the memory and library scripts)

section_top.ldt (top of the linker script SECTION directive)

sgstubs_fixed.ldt (allow absolute veneer table for TrustZone application)

text_section.Idt (text sections for each secondary Flash)

» text_section_multicore.ldt (text sections for multicore targets)
 text_section_multicore_checks_partfamily.ldt (part specific sanity checks)

» extrasections_text.ldt ( )

* text.Idt (for inserting *text)

« extrasections_rodata.ldt ( )

 rodata.ldt (for inserting rodata)

boot_hdr.Idt (allows placement of optional header before main code section)
* boot_hdr_partfamily.ldt

main_text _section.ldt (the primary text section)

» global_section_table.ldt (the global section table)

« crp.ldt (the CRP information)

« flashconfig.ldt (flash security prototype)

+ extrasections_text.ldt ( )

¢ main_text.ldt (for inserting *text)

e extrasections_rodata.ldt ( )

« freertos_debugconfig.ldt (to force placement of FreeRTOSDebugConfig rodata section)
e main_rodata.ldt (read-only data)

e cpp_info.ldt (additional C++ requirements)

exdata.ldt (placement of LPCXpresso style exdata sections)
sgstubs.Idt (allow absolute veneer table for TrustZone application)
end_text.Idt (end of text marker)
usb_ram_section.Idt (placement of SDK USB data structures)
stack_heap_sdk_start.ldt (placement of MCUXpresso style heap/stack)
data_section.ldt (data sections for secondary ram)
» data_section_multicore.ldt (data sections for multicore targets)

» data_section_multicore_checks_partfamily.ldt (part specific sanity checks)
* extrasections_data.ldt ( )
 data.ldt (for inserting *data)

mtb_default_section.ldt (special section for MTB (cortex-m0+ targets)
uninit_reserved_section.Idt (uninitialised data)

main_data_section.ldt (primary data section)
 extrasections_data.ldt ( )

« main_data.ldt (for inserting *data)

ecrp.ldt (Enhanced Code Read Protection support)
bss_section.ldt (secondary bss sections)
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» extrasections_bss.Idt ( )
 bss.Idt (for inserting *bss)

¢ main_bss_section.ldt primary bss section)
» extrasections_bss.Idt ( )
* main_bss.Idt (for inserting *bss)

¢ noinit_section.ldt (no-init data)
« extrasections_noinit.Idt ( )

 noinit_noload_section.ldt (no-load data)
e exdata_sdk.ldt (placement of MCUXpresso style exdata sections)
» data_section_exceptions_multicore_sdk.ldt  (additional multicore exdata sections
information)
« text _section_exceptions_multicore_sdk.ldt  (additional multicore  exdata sections
information)

e stack_heap_sdk_postdata.ldt (placement of MCUXpresso style heap/stack)
» stack_heap_sdk_end.ldt (placement of MCUXpresso style heap/stack)
¢ stack_heap.ldt (define the stack and heap)
e checksum.ldt (create the LPC checksum)
e image_size.ldt (provide basic symbols giving location and size of image)
« symbols.Idt (provide additional symbols needed to built image)
e symbols_partfamily.ldt (part specific “symbol”)

¢ section_tail.ldt (immediately before the send of linker SECTION directive)

library.ldt (the standard libraries used in the application)

« user.ldt (an empty file designed to be overridden by users that is included in linkscript, memory
and library templates)
e user_library.ldt (an empty file designed to be overridden by users that is included in library only)

memory.ldt (the memory map)

« user.ldt (an empty file designed to be overridden by users that is included in linkscript, memory
and library templates)
e user_memory.ldt (an empty file designed to be overridden by users that is included in memory

only)

Linker script search paths

Whenever a linker script template is used, MCUXpresso IDE will search in the following locations,
in the order shown:

* project/linkscripts

« the searchPath global variable
» The searchPath can be set in a script by using the syntax <#global searchPath="c:/windows/
path;d:/another/windows/path”>

» each directory to search is separated by a semicolon ;'

* mcuxpresso_install_dir/ide/Data/Linkscripts
« linker templates can be placed in this directory to override the default templates for an entire
installation

« MCUXpresso IDE internally provided templates (not directly visible to users)

Thus, a project can simply override any template by simply creating a linkscript directory within
the project and placing the appropriate template in there. Using the special syntax “super@” an
overridden template can reference a file from the next level of the search path
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e.g. <#include “super@user.ldt">
Linker script templates

Copies of the default linker script templates used within MCUXpresso IDE can be found in the
Wizards/linker directory within the MCUXpresso IDE installation. These can be used as the basis
of any project local scripts you wish to write.

Predefined variables (macros)
List (sequence) variables (used in #list)

librariesl]

« list of the libraries to be included in the “lib” script
« for example (Redlib nohost)

libraries[0O]=libcr_c.a
libraries[1] =libcr_eabihel pers.a

configMemory(] list of each memory region defined in the memory map for the project. Each
entry has the following fields defined

¢ name - the name of the memory region

« alias — the alias of the memory region

* location — the base address of the memory

* size —the size of the memory region

¢ sizek — the printable size of the memory region in k or M

* mcuPattern

« defaultRAM — boolean indicating if this is the default RAM region
 defaultFlash — boolean indication if this is the default Flash region
¢ RAM - boolean indicating if this is RAM

¢ Flash — boolean indicating if this is Flash

for example:

confi gMenory[ 0] = nane=MFl ashA512 al i as=Fl ash | ocati on=0x1a000000
si ze=0x80000 si zek=512K bytes ntuPattern=Fl ash flash=true RAM=fal se
def aul t Fl ash=true def aul t RAM=f al se

confi gMenory[ 2] = nanme=RaniLoc32 al i as=RAM | ocati on=0x10000000
si ze=0x8000 si zek=32K byt es ntuPattern=RAM f| ash=f al se RAM:true
def aul t Fl ash=f al se def aul t RAM=t r ue

Slaves]] list of the Secondaries in a Multicore project. This variable is only defined in Multicore
projects. Each entry has the following fields defined

« name — name of the Secondary reference

« enabled — boolean indicating if this Secondary reference is enabled

« objPath — path to the object file for the Secondary image

« linkSection — name of the section this Secondary entity is to be linked in
e runtimeSection

 textSection — name of the text section

« textSectionNormalized — normalized name of the text section

« dataStartSymbol — name of the Symbol defining the start of the data

¢ dataEndSymbol — name of the Symbol defining the end of the data
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for example:

sl aves[ 0] = name=MDAPP obj ect Pat h=%{ wor kspace_| oc: / MCB4357_BI i nky_Dual M)/ Debug
/ MCB4357_Bl i nky_Dual M. axf. o}l i nkSecti on=Fl ash2 runti neSecti on= text Secti on=
.core_nDapp textSectionNormalized=_core_nDappdata StartSynbol =__start_data

dat aEndSynbol =__end_dat a enabl ed=true; </ notextil e>

Simple variables include:

* CODE - name of the memory region to place the default code (text) section

* CRP_ADDRESS - location of the Code Read Protect value

« DATA — name of the memory region to place the default data section

¢ LINK_TO_RAM - value of the “Link to RAM” linker option

e STACK_OFFSET - value of the Stack Offset linker option

¢ FLASHnN — defined for each FLASH memory

¢« RAMnN - defined for each RAM memory

¢ basename — internal name of the process

« bss_align — alignment for .bss sections

 buildConfig — the name of the configuration being built

¢ chipFamily — the chip family

» chipName — name of the target chip

« data_align — alignment for .data section

« date — date string

¢ heap_symbol — name of the symbol used to define the heap

« isCppProject — boolean indicating if this is a C++ project

 isSlave — boolean indicating if this target is a Secondary — true if is a secondary core in a
multicore system

e library_include — name of the library include file

* libtype — C library type

« memory_include — name of the memory include file

* mtb_supported — boolean indicating if mtb is supported for this target

« numCores — number of cores in this target

¢ procName — the name of the target processor

e project — the name of the project

* script — name of the script file

« slaveName — is the name of the Secondary (only present for Secondaries)

e stack_section — the name of the section where the stack is to be placed

e start_symbol — the name of the start symbol (entry point)

« scriptType — the type of script being generated (one of “script”, “memory”, or “library”)

e text align — alignment for .text section

e version — product version string

« workspace_loc — workspace directory

e year — the year (extracted from the date)

Extended variables
Two ‘extended’ variables are available:

environment

¢ The environment variable makes the host Operating System environment variables available.
For example, the Path variable is available as ${environment[“Path”]}.

Note Environment variables are case sensitive.
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systemProperties

¢ The Java system properties are available through the systemProperties variable. For example
the “os.name” system property is available as ${systemProperties[‘0s.name”]}. Note: System
properties are case sensitive.

Outputting variables

A list of all predefined variables and their values can be output to the generated linker script
by setting the Preference: MCUXpresso IDE -> Default Tool settings -> ... and list predefined
variables in the script

A list of extended variables and their values can be output to the generated linker script by
creating a linkscripts/user.ldt file in the project with the content

<#assign |istvarsext=true>

(This is likely to be used less often, hence the slightly longer winded method of specifying the
option)

17.15 FreeMarker Linker Script Template Examples
The use of FreeMarker linker script templates allows more wide ranging changes to be made to
the generated link script than is possible using the cr_section_macros.h macros. The following
examples provide some examples of this.
17.15.1 Relocating code from FLASH to RAM

If you have specific functions in your code base that you wish to place into a particular block
of RAM, then the simplest way to do this is to decorate the function definition using the macro
__RAMFUNC described earlier in this chapter.
However once you want to relocate more than a few functions, or when you don't have direct
access to the source code, this becomes impractical. In such case the use of FreeMarker linker
script templates will be a better approach. The following sections provide a number of such
examples.
Relocating particular objects into RAM
In some cases, it may be required to relocate all of the functions (and rodata) from a given object
file in your project into RAM. This can be achieved by providing three linker script template files
into a linkscripts folder within your project. For example if it was required that all code/rodata
from the files foo.c and bar.c were relocated into RAM, then this could be achieved using the
following linker script templates:
main_text.ldt

*( EXCLUDE_FI LE(*fo00.0 *bar.o) .text*)
main_rodata.ldt

*( EXCLUDE_FI LE(*f 00. 0 *bar.o0) .rodata)

*( EXCLUDE_FI LE(*f00.0 *bar.o) .rodata.*)

*( EXCLUDE_FI LE(*f00. 0 *bar.o0) .constdata)

*( EXCLUDE_FI LE(*f00. 0 *bar.o0) .constdata.*)

. = ALIGN(${text_align});
main_data.ldt
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*foo.0(.text*)

*foo.o0(.rodata .rodata.* .constdata .constdata.*)
*bar. o(.text*)

*pbar.o(.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

*(.data*)

What each of these EXCLUDE_FILE lines (in main_text.Idt and main_rodata.ldt) is doing in
pulling in all of the sections of a particular type (for example .text), except for the ones from the
named object files. Then in main_data.ldt, we specify explicitly that the text and rodata sections
should be pulled in from the named object files. Note: that with the GNU linker, LD, the first
match found in the final generated linker script is always used, which is why the EXCLUDE_FILE
keyword is used in the first two template files.

Note: EXCLUDE_FILE only acts on the closest input section specified, which is why we have
4 separate EXCLUDE_FILE lines in the main_rodata.ldt file rather than just a single combined
EXCLUDE_LINE.

Once you have built your project using the above linker script template files, then you can check
the generated .Id file to see the actual linker script produced, together with the linker map file to
confirm where the code and rodata have been placed.

Relocating particular libraries into RAM

In some cases, it may be required to relocate all of the functions (and rodata) from a given library
in your project into RAM. One example of this might be if you are using a flashless LPC43xx
MCU with an external SPIFI Flash device being used to store and execute your main code from,
but you need to actually update some data that you are also storing in the SPIFI Flash. In this
case, the code used to update the SPIFI Flash cannot run from SPIFI Flash.

This can be achieved by providing three linker script template files into a linkscripts folder
within your project. For example if it was required that all code/rodata from the library
MYLIBRARYPROJ were relocated into RAM, then this could be achieved using the following
linker script templates:

main_text.ldt

*(EXCLUDE_FI LE(*| i bMYLI BRARYPRQJ. a:) . text*)

main_rodata.ldt

* (EXCLUDE_FI LE(*1 i bMYLI BRARYPRQJ. a:) . rodat a)

* (EXCLUDE_FI LE(*1 i bMYLI BRARYPRQJ. a:) .rodat a. *)

* (EXCLUDE_FI LE(*1 i bMYLI BRARYPRQJ. a:) . const dat a)
* (EXCLUDE_FI LE(*1 i bMYLI BRARYPRQJ. a:) . const dat a. *)
. = ALIGN(${text_align});

main_data.ldt

*| i bMYLI BRARYPRQJ. a: (. t ext *)

*| i bMYLI BRARYPRQJ. a: (.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

*(.data*)

Note: When extending this example to more than one library, please mind the semantic of
EXCLUDE_FILE directive which is pulling in all of the sections of a particular type, except for
the ones from the named object files. Therefore, all of the library objects need to be specified
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in EXCLUDE_FILE for a particular section type (in main_text.Idt and main_rodata.ldt templates).
For example:

* ( EXCLUDE_FI LE(*I'i bMYLI BRARYPRQJ1. a *| i bMYLI BRARYPROJ2. a *| i bMYLI BRARYPRQJ3. a:) .text*)

On the other hand, the library objects in main_data.ldt template, since they are not using
EXCLUDE_FILE, need to be listed on separate lines:

*1 i bMYLI BRARYPRQJ1. a: (. t ext *)
*1 i bMYLI BRARYPRQJ2. a: (. t ext *)
*1 i bMYLI BRARYPRQJ3. a: (. t ext *)

Relocating majority of an application into RAM

In some situations, you may wish to run the bulk of your application code from RAM — typically
just leaving startup code and the vector table in Flash. This can be achieved by providing three
linker script template files into a linkscripts folder within your project:

main_text.ldt

*startup_*.o (.text.*)
*(.text. min)
*(.text.__main)

main_rodata.ldt

*startup_*.o (.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

main_data.ldt

*(.text*)

*(.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

*(.data*)

The above linker template scripts will cause the main body of the code to be relocated into the
main (first) RAM bank of the target MCU, which by default will also contain data/bss, as well as
the stack and heap.

Important Note: The code that performs this relocation is executed early within the reset handler
(within startup_xx file). However, there is the potential for other critical functions to be called
before this relocation is performed, for example Systeminit() may be called first to perform
essential operations such as enabling RAM!

Any function that is called before the relocation is performed must not itself be relocated! For the
specific case above, the following changes to main_text.Idt and main_rodata.ldt are required:

main_text.Idt

*startup_*.o (.text.*)
*system*.o (.text.*)
*(.text. main)
*(.text.__main)

main_rodata.ldt
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*startup_*.o (.rodata .rodata.* .constdata .constdata.*)
*system*.o (.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

Finally, If the MCU being targeted has more than one RAM bank, then the main body of the code
could be relocated into another RAM bank instead. For example, if you wanted to relocate the
code into the second RAM bank, then this could be done by providing the following data.ldt file
instead of the main_data.ldt above:

data.ldt

<#i f menory. al i as==" RAM2" >

*(.text*)

*(.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

</ #if>

*(.data. $${nenory. al i as}*)

*(.dat a. $${ nenory. nane} *)

Note: memory.alias value is taken from the Alias column of the Memory Configuration Editor.

Configuring projects to span multiple Flash Devices

Most MCUs only have one bank of Flash memory. But with some parts more than one bank may
be available — and in such cases, by default, the managed linker script mechanism will still place
all of the application code and rodata (consts) into the first bank of Flash (as displayed in the
Memory Configuration Editor)..

For example

¢ most of the LPC18 and LPC43xx parts containing internal Flash (such as LPC1857 and
LPC4357) actually provide dual banks of Flash.

* some MCUs have the ability to access external Flash (typically SPIFI) as well as their built-in
internal Flash (e.g. LPC18xx, LPC40xx, LPC43xx, LPC546xx).

The macros provided in the “cr_section_macros.h” header file provide some ability to control the
placement of specific functions or rodata items into the second (or even third) bank of Flash.
However the use of FreeMarker linkers script templates allow this to be done in a much more
powerful and flexible way.

One typical use case for this is a project which stores its main code and data in internal Flash,
but additional rodata (for example graphics data for displaying on an LCD) in the external SPIFI
Flash.

For instance, consider an example project where such rodata is all contained in a set of specific
files, which we therefore want to place into the external Flash device. One very simple way to do
this is to place such source files into a separate source folder within your project. You can then
supply linker script templates to place the code and rodata from these files into the appropriate
Flash.

For example, for a project using the LPC4337 with two internal Flash banks, plus external SPIFI
Flash, if the source folder used for this purpose were called ‘spifidata’, then placing the following
files into a linkscripts directory within your project would have the desired effect:

text.ldt

<#if menory.alias=="Fl ash3">
*spifidatal/ *(.text*)
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</ #if>

*(.text_${nenory.alias}*) /* for conpatibility with previous rel eases */
*(.text_${nenory.nane}*) /* for conpatibility wth previous releases */
*(.text.$${nenory. al i as}*)

*(.text.$${nenory. nane}*)

rodata.ldt

<#i f menory.alias=="Fl ash3">
*spi fidatal*(.rodata*)

</ #if>

*(rodata. $${menory. al i as}*)
*(rodat a. $${ menory. nane} *)

Note: the check of the memory.alias being Flash3 is to prevent the code/rodata items from ending
up in the BankB Flash bank (which is Flash2 by default).

Disabling Managed Linker Scripts

It is possible to disable the managed linker script mechanism if required and provide your own
linker scripts, but this is not recommended for most users. In most circumstance, the facilities
provided by the managed linker script mechanism, and its underlying FreeMarker template
mechanism should allow you to avoid the need for writing your own linker scripts. But if you do
wish to do this, then untick the appropriate option at:

Properties -> C/C++ Build -> Settings -> MCU Linker -> Managed Linker Script

And then in the field Script Path provide the name and path (relative to the current build directory)
of your own, manually maintained linker script.

In such cases you can either create your own linker script from scratch, or you can use the
managed linker scripts as a starting point. One very important point though is that you are advised
not to simply modify the managed linker scripts in place, but instead to copy them to another
location and modify them there. This will prevent any chance of the tools accidentally overwriting
them if at some point in the future you turn the managed make script mechanism back on.

Note: if your linker script includes additional files (as the managed linker scripts do), then you
will also need to include the relative path information in the include inside the top level script file.

For more details of writing your own linker scripts, please see the GNU Linker (Id) documentation:
Help -> Help Contents -> Tools (Compilers, Debugger, Utilities) -> GNU Linker

There is also a good introduction to linker scripts available in Building Bare-Metal ARM Systems
with GNU: Part 3 at:

https://www.embedded.com/design/mcus-processors-and-socs/4026080/Building-Bare-Metal-
ARM-Systems-with-GNU-Part-3

See also the section on to review editor assistance when
manually creating Linker Scripts.
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Additional information can be found our the MCUXpresso IDE Community pages specifically see
the blog articles:

LPC55xx Multicore Applications with MCUXpresso IDE, and also the article: Using LPC55S69
SDK Trustzone examples with MCUXpresso IDE v11.0.0

Introduction

Multicore MCUs can be designed in many ways, however within MCUXpresso IDE there is an
underlying expectation that one core (the Primary) will control the execution (or at least the
startup) of code running on other (Secondary) core(s).

Multicore application projects as described below consists of two (or more) linked projects — one
project containing the Primary core’s code and the other project(s) containing the Secondary
core’s code. The ‘Primary’ project contains a link to the ‘Secondary’ project which will cause the
output image from the ‘Secondary’ to be included into the ‘Primary’ image when the Primary
project is built. Building the Primary project will trigger the Secondary project to be built first.

After a power-on or Reset, the Primary core boots and is then responsible for booting the
Secondary core. However, this relationship only applies to the booting process; after boot, an
application may treat either of the cores as Primary or Secondary.

For this concept to work, the memory configurations of these related projects must
be carefully managed to avoid unintended overlap or contention. One way this can
be achieved is by linking the Secondary application to execute entirely from a RAM
location unused by the Primary. Our automatic linkerscript generation will then locate the
Secondary’s code within the Primary’s generated image, this code will be relocated to the
correct RAM location by the Primary projects initialisation code at run time.

In practice, the Primary project's memory configuration will be the same as for a single core
project, where as the Secondary project’'s memory configuration will be set to use a ‘spare’ or
dedicated Secondary RAM region. In addition, a shared region may be used for communication
between the CPUs.

Note: MCUs supporting dedicated Flash regions for each core can also be supported by this
scheme, in such cases the Secondary project would simply be linked to the Secondary core’s
Flash location.

To complete the story ... the Primary project is debugged first, which will lead to the combined
image being programmed into Flash and the Primary code executed. The Primary core’s
initialisation code will (in addition to other things) copy the Secondary core’s code into RAM
(if appropriate) and then stop on Main. When the Secondary project is debugged, the launch
configuration will automatically be set to ‘Attach’ by the IDE since there is no need for this code
to be programmed/downloaded by the debugger. When the Primary application is resumed, it
will release the Secondary core and both projects can be debugged as required.

Important Note: Multicore MCUs may offer significant flexibility in how they can be used. The
mechanism described above (as used in example projects) is not necessarily the only way (or
even the best way) for a user’'s multicore projects to be configured. However, it has been chosen
as the simplest and safest way to demonstrate the concepts and issues involved.

MCUXpresso IDE allows for the easy creation of “linked” projects that support the targeting of
Multicore MCUs.

The rest of this chapter will describe the use of the LPC5411x multicore MCU, however the

concepts discussed will be the same (or similar) for other multicore MCUs such as the LPC43xx
and LPC5410x.
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18.2 Creating a Primary / Secondary project Pair (using an SDK)

The example described below is based around the LPC5411x multicore MCU using the

LPCXpresso54114 SDK.

Note: Be sure to have installed the LPCXpresso54114 SDK into MCUXpresso IDE if you wish

to follow this example.

18.2.1 Creating the MO Secondary project

As discussed above, the Primary project’s configuration will need to reference the Secondary
project, therefore the Secondary project should be created first.

Launch the New Project Wizard and select the LPCXpresso54114 SDK board. Entering 54114
into the boards filter will reduce the number of boards to help selection, then click Next.

B soK Wizard

(D) Creating project for device: LPCS41 141256 with no baard.

. Board and/or Device selection page

B ottt

MCUs from installed SOKs. Please click  Please select an available board for your project
above or visit maupresse nxp.cam o
obtain additional SDKs.

NP LPC541121256
w LPCS411x

LPCS41141256

[ Supported boards for device: LPC541141256

= Preinstalled MOUs
MCUs from preinstalled LPC and
generic Cortex-M part suppern
Target ~
LPCT102
LPC112x
LPC11dxx
LPC11E6x
LPC11E
LPC1 T
LPC 1 ey
LPCT T
LPC T Tl

w

Selected Device: LPC54114J256 with no board.

Target Core: multicore device with cones: cortex-m0plus cortex-m4
Description: Low Power 32-bit Microcontroller based on ARM Cortex-hd

Figure 18.1. New Project Wizard SDK MultiCore MO

o x
MO =
» P~
!‘32 .I.J: 1
-
:
SDKs for selected MOU
MName DK Verzion Manifest V.. Lecation
i SDK_ 2. _| PCrpresso54114 2,82 (376.202( 3.60 t <Commaon=\SDK_2.8.2 | PCXpres:
: . &

From the next wizard page, select the cmOplus Core, and see that the MOSLAVE is selected
in the core options. Also note that the Project will automatically be given the suffix MOSLAVE.
Drivers, utilities etc. can be selected at this stage for the Secondary project if required.
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B 508 wizard

. Configure the project

Propect name; LPCS41141236 Progect

B Use defsult bocation

Device Packages
(®) LPCSa1 1412958064
(D LPCSE114)256UK43

Cares
emiphus Flole:| MOSLAVE

Components

Add or remave SDK software components

Dirivers
e o filter

Narme

14 ade

B i chock

E| &4 common
O] 4 ctines
143 dma

] & dmic

[« drnic_dma
& drmic_tervad
145 flashiap

FA & flescomm

ChnxplowarkspaceLPCSE1 140238

Project

Board

() Default board files
() Empty board files

Operating Systems | Drivers . CBSIS Drivers| Utilities | Middlewsre | Board Companents | Abstraction Laytr' SofmartCnmwntnté_

Description

ADC Drnver

Cleck Driver
COMMON Driver
CTirmer Dineer
DA Driver

DNIC Diriver
DMSC DM Drnver
DAIC HWVAD Driver
FLASHIAP Driver
FLEXCOMM Driver

¥, The source from the SDK will be copied into the workspace. B you want to use linked files, please ungip the “SDK_2.x_LPCHpresso54114' SDK.

A Project name suffic

Froject Type
(® C Projest {_} Cr» Project
(D) C Saatic Library () C++ Static Library

—  Components sebection summany BB
| type to filter
Mamie Description Ve  Info
MxlBE O Drivers
S Operating Systems
= Software Componer
Version Info = 2 Utilities
250
220
224
203
241
230
130
230
205
0.2 Lt
< Back Fanish Cancel

Project Dptions
SDK Debug Console (8) Sernihost () UART
EA emsis-Cere

B Impart ather files

Figure 18.2. New Project Wizard SDK MO Secondary

Next, the MO Secondary memory configuration needs to be set.

Note: MCUXpresso IDE’s managed linker script mechanism will default to link code to the first
Flash region in this view (if one exists) and use the first RAM region for data, heap and stack..

To force our project to link to a private area of RAM, we must ensure that the Flash region is
removed and the chosen RAM bank is at the top of the list of memory regions. Note here that
the SDK we are using has presented the RAM regions in a non sequential order. In this example
we will configure the memory so that the MO Secondary project links to the RAM region starting
at address 0x20010000 (the first region).

MCUXpresso IDE User Guide -

All information provided in this document is subject to legal disclaimers

© 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022

233



NXP Semiconductors MCUXpresso IDE User Guide

B soK wizard o X
Ts-i{ =
Y a -
. Advanced project settings
= C/C++ Library Settings
Set library type {and hosting variant)  pedih {semihost-nf) w
] Rediib: Use floating point version of printf
[[] Redfit: Wse character rather than string based printf
[ Redirect SDK "PRINTF" to C library "printf™ Redire ank to TV
4 Inchude semihast HardFault handler ] Redirect printf/scanf to UART
= MECU € Compiler
Language standard | Compiler default bod
= MCU Linker
[ Link application to RAM
= Memory Confguration
Memaory details
Default LinkServer Flash Drives | | Browse..
Type Hame Alias Location Size Driver
I Flash PROGRAM FLASH Flash 0 D 405000 LPT541 b 56K ch
RAM SRam RAM l (0 20010000 I Coe 10000
RAM SRAMD RAM2 020000000 O 10000
RAM SRAMX RANM3 T 4000000 D BO00
Rt SRAM2 RAKA O 20020000 CooBOOD
Add Flash | | Add RAM Splt dour Import..  Merge..| | Export. Geneisie
. - — . -

Figure 18.3. New Project Wizard SDK MO Secondary Memory
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From this wizard, select the PROGRAM_FLASH and click Delete to remove the region. Ensure
that the top RAM region has the base address (location) 0x20010000, then click Finish to
complete the creation of the Secondary project.

Tip
@ Memory regions can be reordered by selecting a region and using the up/down
arrows to move the selected region.

Creating the M4 Primary project

To create the Primary project, launch the New Project Wizard and again select the
LPCXpresso54114 SDK board and click Next. This time, select the cm4 Core, and click the
MASTER check box, this configures the wizard to create a Multicore project. Note that the
Project will automatically be given the suffix MASTER.

Drivers, utilities etc. can be selected at this stage for the Primary project if required.
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B8 ok wizard

1, The spurce from the SDK will be copied into the workspace. If you want to use linked files, please unzip the “SDK_2.x_LPCXpresso34114' SDK.

- Configure the project

Project name: LPCS41141256 Project Project name suﬂix

Use defsult location

CAhnxpiworkspace\LPC341 140256 _Project
Device Packages Board Project Type
(®) LPC3411412568064 (!__, Default bom‘!files @ C Project OIC++ Project
(I LPCSL1141256UKAS ) Empty board files

() C Statie Library () C++ Static Library

Cores

cmd v Role: Master v

Project Options

SDK Debug Conscle
A CMsIs-Core

Flimpaort other files

Components. = Components selection summary i + =

@ Semihost () UART

Add or remeve SDK seftware compenents

Operating Systemns Drivers _CMSIS Drivers | Utilities | Middleware | Board Components | Abstraction Layer  Software Components

Drivers 4 H x|l B E
!_t_:. pe to filter
Marne Description Version info ~
[ 4 ade ADC Driver 25.0
= & clock Clock Driver 220
& comman COMMON Driver 224
145 ctirmer CTimer Driver 203
[ dma DMA Driver 241
4 dmic DMIC Driver 230
[ 45 dmic_dma DMIC DMA Driver 23.0
[0 45 dmic_hwvad DMIC HWWAD Driver 23.0
[ dgs flashiap FLASHIAP Driver 205
A & flexearmm FLEXCOMM Drivet 0.2
@ < Back

type to filter

MName
£ Drivers
& Operating Systermns
S Software Companer
= Unilities

Description Ve,  Info

Finish Cancel

Figure 18.4. New Project Wizard SDK M4 Primary

Next, the M4 Primary project’'s memory configuration needs to be set. Typically we might leave
the memory setting unaltered, however the SDK we are using presents the RAM regions in a
non sequential way. In this example we wish to select the RAM region at 0x20000000 for the
Primary projects data and the Flash at 0x0 for the Primary projects code (and also a copy of the

Secondary projects code)

Note: MCUXpresso IDEs managed linker script mechanism will default to link code to the first
Flash region in this view (if one exists) and use the first RAM region for data, heap and stack.
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13 son Wizasd o x

€3 Plesse select a shave project to fink for multicore projects! x | .l I

. Advanced project settings

» G+ s Librany Settings
Sek library type (and hosting vanent] | pediik (semihest-nf) w

] Redlit: Use flaating peint verion of prntf P
(] Readlib: Use character rather than string bazed prirtf He U= g point

= Relinect SOK “PRINTF to € liksary *printi” [0 Reeiresct peintfy scamf te TR
&1 Include semihost HardFault handler ) Reedirect printfiscant to UART

= Hardware settings

Set Floating Point type | £p.4-5P (Hard ABI) -
= MCU C Compiles

Language standard | Compiler default
= MCU Linker

] Link apglication to RAM

= Memory Configuration

Memiory details
Default LirkServer Flash Driver | | Browse
Type Hame Alias Location Size: Driver i
Hish PROGRAM FLASH Flash o] 040000 LPCHE11x 236K, of
RAzA SRAMIT Rt 20010000 O 10000
RAM SRAMD RAMZ D 20000000 D 10000
RAM SRAMX Rz 000000 [ 8000
RAM SRAMZ2 Rk 20020000 CxBODD
Add Flash | Add RAM Spiit | | loin | Delete Import_. | | Merge | | Export... | Generate

= Multicore slave projects settings
Optionally sllow am exeting slave project to be associated with this praject

Slave project for MOSLAVE mlt Section w

& By default, the slave smages will be placed m the RAME block of the master projects memody map, The ilave memany setting in the madter propect should match how the Slave propect was built,

7 _m Mt Fireihi Cangel

Figure 18.5. New Project Wizard SDK M4 Primary Memory

To adjust the memory layout, select the second RAM region (at location 0x20000000) and click
the ‘Up’ arrow to move this to the top of the RAM regions. The highlighted regions as shown
above will are effectively swapped.

Once this has been done, click ‘OK'.

Next, click Browse to locate a Secondary project within the Workspace and select the previously
created Secondary project, then click ‘OK’.
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m Slave project selection for MOSLAVE = a |55

Select a slave project to link with the master project being created.

(5 LPC54114)256_Project_MOSLAVE|

@ [ oK ] I Cancel

Figure 18.6. New Project Wizard SDK M4 Primary / Secondary Selection

Note: ensure the Link Section name (default of RAM2 highlighted) selects a Primary memory
region that matches the linked address of the Secondary project. In this case RAM2 should
correspond to the address 0x2001000. If required, other memory regions can be selected here
but please note: the first Flash Region and the first RAM Region are not included in the drop
down list because it is assumed that these will be used for the Primary Project. If required, this

setting can be changed later from:
Project Properties -> C/C++ Build -> Settings -> Multicore

Where all of the memory regions are available for selection.

Below we can see the edited project settings for the Primary project.

~ Memory Configuration

Memory details

Default LinkServer Flash Driver Browse...

Type Name Alias Location size Driver .
Flash PROGRAM_FLASH Flash Qx0 0x40000 LPC5411x_256K.cfx v
RAM SRAMO RAM 0x20000000 0x10000 =
RAM SRAM1 RAM2 0x20010000 0x10000 =
RAM SRAMX RAM3 0x4000000 0x8000
RAM SRAM2 RAM4 0x20020000 0xB8000O

Add Flash Add RAM Split Join Delete

Import... Merge... Export...
~ Multicore slave projects settings
Optionally allow an existing slave project to be associated with this project.
Slave project for MOSLAVE [ LPC54114J256_Project MOSLAVE _r,] Browse... | Link Section RAM2 a

% By default, the slave images will be placed in the RAM2 block of the master project's memory map. The slave memory setting in the master project should match how the slave project was built.

Figure 18.7. New Project Wizard SDK M4 Primary Project

Finally click Finish to generate the Primary project.

Note: if the memory regions of these projects overlap, the linker will generate an error similar to:

MSLAVE execute address differs from address provided in source i mage
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To fix this issue, review (and edit) the memory settings of the related projects so that their
addresses do not overlap via Project Properties -> C/C++ Build -> MCU settings .

18.3 Creating a Primary / Secondary project Pair (using Preinstalled
Part Support)
The example described below is base around the LPC5411x multicore MCU.
Note: It is recommended to create and build LPC541xx multicore projects which are linked to
LPCOpen. Thus before you follow the below sequence, please ensure that you have imported

the chip and (optionally) the board library projects (for both the M4 and M0+) from an LPCOpen
package for the LPC5410x family or LPC5411x family (depending upon your target part).

18.3.1 Creating the MO Secondary project

As discussed above, the Primary projects configuration will need to reference the Secondary
project, therefore the Secondary project should be created first.

Launch the New Project Wizard and select the LPC54114-MO0 from the Preinstalled MCUs.

(30 sDK Wizard = =R

(1) Cresting project for device: LPC54114)256-M0 } N L \57

. Board and/or Device selection page

b SDK MCUs Available boards iaz Taz | 7

- Preinstalled MCUs Please select an available board for your project.
WCUs from preinctaned LPC and generic =
Cortex-M part support Supported boards for device: LPC5411x

NXP LPC54114)256- MO 2 ‘

LPC54114)256-M0

PCE0x

> LPCB2x

> LPCB4x

» LPCBNOx
LPChwx

 PMT 300 LPCXpresso54114
b PNT4io00 =

[om

Selected Device: LPC54114J256-M0 with no board. SDKs for selected MCU

Target Core: cortex-m0 MName SDK Version  Manifest Ve.. Location

Description: Dual Cortex-M4/Cortex-M0+ based microcentroller, with up to 256KB
Flash and 192KB RAM

®@ T

Figure 18.8. New Project Wizard Preinstalled MO

Next, select a MultiCore MO Secondary project type, below we have selected an LPCOpen —
C Project.
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X (= o ]
New project...
LPC5411x Multicore (M0+ slave) -> LPCOpen - C Project

. Wizard selection page.

Wizard
4 LPC54110
4 LPC5411x (MD+]
LPCOpen - C Project
LPCOpen - C Static Library Project
LPCOpen - C++ Project
LPCOpen - C++ Static Library Project
C Project
C Project (Semihosted)
C Static Library Project
C++ Project
C++ Static Library Project
4 LPC5411x Multicore (MO+ slave)
LPCOpen - C Project
LPCOpen - C++ Project
C Project
C Project (Semihosted)
C++ Project

(?:' < Back MNext > Finish Cancel

Figure 18.9. New Project Wizard Preinstalled MO C Project

Next, name the project, for example LPC54114 MO_Slave, then click next until the Memory
Configuration page is reached. From here we can see the MCU memory regions.

Note: MCUXpresso IDE’s managed linker script mechanism will default to link code to the first
Flash region in this view (if one exists) and use the first RAM region for data.

To force our project to link to a private area of RAM, simply delete the Flash and first RAM region
(RAMO_64) from this view (since these will be use for the M4 Primary project). To do this, just
select the regions and click Delete. Since there will no longer be any Flash region, the default
Flash driver can also be removed.
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New project...
Memory Configuration Editor

. Wizard properties page.

Allows external flash to be defined and appropriate flash driver allocated, or for layout of internal RAM to be reconfigured.

Default flash driver
Type Name Alias Location Size Driver
"’Hash MFlash256 Flash 0 040000 ) s
NRAM __ Rami0 64 RAM 0x20000000 0,10000 &
RAM  Ramil_64 RAM2 (20010000 010000
RAM  Ram2.32 RAM3  (x20020000  0x8000
RAM  RamX_32 RAM4 04000000 0x8000
Add Flash Joil [1mport..] [Merge...| |Export...| [ Generate...
©) ot | [ (e

Figure 18.10. New Project Wizard Preinstalled MO Memory

The memory setting should then look as below. In this case our Secondary projects code and
data will be linked to address 0x20010000 with the stack set to the top of this region.

= o e =]
New project...
Memoery Configuration Editor
. Wizard properties page.
Allows external flash to be defined and appropriate flash driver allocated, or for layout of internal RAM to be reconfigured.
Default flash driver | R
Type MName Alias Driver
RAM  Raml 64 RAM ; —
RAM  Ram2_32 RAM2 . 2
RAM  RamX_32 RAM3 04000000 0xB000
Add Flash | | Add RAM Split {Import..w IMerge...] [Etport...l [Ganerate...]
@ Next > ([ Finish )| Cancel

Figure 18.11. New Project Wizard Preinstalled MO Memory edited

Now click Next -> Finish to complete the MO Secondary projects creation.

18.3.2

Creating the M4 Primary project

To create the Primary, Launch the New Project Wizard again and this time select the LPC54114
(M4) part and click Next. Select the matching ‘MultiCore M4 Master -> LPCOpen -C Project’ and
click Next again. Now, name the new project, for example LPC54114 M4 _Master and click next
until the Multicore Project Setup page is reached.

Note: The wizard will present an identical memory configuration page, but on this occasion, no
editing is required since the default Flash and RAM setting are

From here, click browse to select the previously created Secondary project from the existing

Workspace
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® = ==
New project...
Multicore Project Setup

. Wizard properties page.

Multicore Slave Project selection

Select an existing slave project to be associated with this master project

Slave Project ~([Browse.. )

[X] Stave Project =N on (=]
Browse to the slave project associated with this master project
(5 LPC54114_MO_Slave '
P Do PeRpTEso
(% Ipe_board_lpcxpresso_54114_m0

(5 Ipe_chip_5411x
(5 Ipe_chip_5411%_mD

Figure 18.12. New Project Wizard Preinstalled M4 Select Secondary

Now click Next -> Finish to complete the M4 Primary projects creation.

18.4 Debugging MultiCore Projects

The debug story for MultiCore MCUs can vary with their implementation and also the chosen
debug solution.

Our MultiCore model as described above, assumes that the Primary project will both copy the
Secondary MCUs code and data (into RAM) but also release the Secondary core from reset.
Therefore the Primary project should be run (debugged) first and typically run to main(). Once
here, the instantiation of the Secondary core’s code will be complete but the Secondary core will
not have been released. On some MCUSs, a debug connection can be made to the Secondary
core before it has been released, but on others this will only be possible after they are released.

Note: Secondary projects debug launch configurations may require user modification before a
debug connection can be made. Please see the section

In our example LPC54114, the Secondary core’s debug connection can be made as soon as the
Primare core reaches main(). The debug window will then look similar to that below.

B2 2T bl EERR)S LI FH OG-
%5 Debug 2

4 . LPC54114J256 _Project_MASTER LinkServer Debug [C/C++ (NXP Semicenductors) MCU Application]
4 [ LPC54114)256_Project_MASTER. ax‘F[LPC54114J256 (cortex-md)]

-gdb (£ LLLAMLTURLT}
4 . LPC54114J256 Project MOSLAVE LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application]
4 {g LPC54114)256 Project MOSLAVE. a)dLnPC54114J156 (cortex-m0plus)]

o e e G S AT e

Q‘P@ Thread #1 1 (Stopped) (Running)
gl arm-none-eabi-gdb (LLLLAULIUALTT

Figure 18.13. MultiCore Debug

Note above: that the MultiCore debug controls have been highlighted, these controls differ from

the standard controls in that they operate on all cores being debugged. Via these, the system
to be stepped, run, paused, terminated etc.
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18.4.1

In addition, the M4 Primary core’s debug stack (blue) is shown stopped at main, while the
Secondary core’s stack (green) is waiting to be released by the Primary core; clicking between
these stacks will change the IDE’s debug scope from one core to the other. The currently selected
core will be the one used for displaying many of the debug related views, such as Registers

and Locals.

Controlling Deb

ug Views

It is also possible to create copies of many of the debug related views, and then lock each copy
to a particular core (as described below).

For example, to create two register views, one for the M4 and one for the MO+ ...First of all, use
the ‘Open New view’ button in the Registers view to create a second Registers view:

roject Ex Peripheral  ifii Registers 3 Symbol V =0 4l
' tE gt vVl
Mame Value Description :
| vAALPC54114J256 (cortex-m4) LPCE4114.20an Hew View
bE 0 0x00000000
BiEir 0x200000F8
. i 0x00000400 M |
| Mir3 0x00000001
e rd 0x00000160
i rs 0x00000001
i 6 0x40000000
W7 Ox2000FFFO
M8 0x00000000
| b 0x00000000

110

Figure 18.14. MultiCore Debug New View

Now pin the original view to the core currently selected in the Debug, using the ‘Pin to Debug

context’ button :

[ Project Ex 2, Periphera

LPC54114.256_Project MASTER.axf: Thread [1]

Mame

Value

¥ 54LPC54114J256 (cortex-md)

0x00000000
0x200000F8
0x00000400
0x00000001
0x00000160
0x00000001
0x40000000
Ox2000FFFO
0x00000000
0x00000000
0x00000000

Figure 18.15. MultiCore Debug Pin View

14! Registers 52 . Symbol Vi

= O | 4 Debug &
v@Lrcs:
h v iRLPC
" Pin to Debug Context

t B il v
Description

LPC54114J256_F =

s arm

v@lLrese

v ELPC

Ll

ol arm

[g LPCEAT"

MCUXpresso IDE User Guide -

Now select the other core in the Debug view, and go to the second Register view. Use this view's
‘Pin to Debug Context’ button to lock this second Registers view to the selected core:
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Project Exp Peripherals iili Registers 23

LPC54114J256_Project MASTER.axf: Thread [1]
Name Value
v 44 LPCE4114J266 (cortex-m4)

0x00000018
0x2000FFB8
0x20000010
0x0000000F
0x00000160
0x00000001
0x40000000

Nw2INNNCEEN

111l Registers <2> 3 i

LPC54114J256_Project_ MOSLAVE.axf: Thread [1]
Name Value
v 5ALPCE4114J256 (cortex-mo0...

fiti ] 0x00000017
it gl 0x20011EE4
w2 0x00714F42
itir3 Ox00714F42
itirg 0x20010110
it 0x00000001
e OxFFFFFFFF

itir7? Ox2001FFE8

Figure 18.16. MultiCore Debug Registers

SymbolVie = O % Debug &2
t © 9 v vELPC541140256 Project MASTER LinkServer C
¥ 2 LPCE4114J266_Project MASTER.axf [LPCE
Description v &% Thread #1 1 (Stopped) (Suspended : Sigr
LPCE4114J2566_F = main() at LPC54114J256_Project_MAS
s arm-none-eabi-gdb (7.12.1.20170417)
".LPCE:I‘I 14J256_Project_MOSLAVE LinkServer
¥ (2 LPC54114J256_Project_MOSLAVE.axf [LPC
v % Thread #1 1 (Stopped) (Suspended : Sigr
= main() at LPC54114J256_Project_MO¢
s arm-none-eabi-gdb (7.12.1.20170417)

B Cisf ¥= 0 | [gLPC54114J256_Project MASTER.c X | [€] LPCE

53 /* Start slave CPU. */

Description Z
L boot_multicore_slave(};

LPC54114J256_f

)

61 printf("Hello World from MASTER\n");

63 /* Force the counter to be placed in
64 volatile static int i = @ ;

65 /* Enter an infinite loop, just incr
66 while(1) {

67 | T 3

13 1

69 return @ ;

18.4.2 Secondary Project Debug

Typically, the Primary project will be debugged first in exactly the same way as a single CPU
project. However the secondary projects debug launch configuration may require special settings
in order to establish a debug connection to the secondary CPU.

MCUXpresso IDE will automatically configure the correct settings for secondary launch
configurations on all debug solutions. However, there might be situations when the Secondary
project’s debug settings may require modifications.

« Core Selection - within a MultiCore MCU there will be more than one CPU (sometimes referred
to as a device). The debug connection needs to be made to the appropriate internal CPU for
both the Primary and Secondary projects.

* LinkServer CMSIS-DAP Debug: this process is automatic and hidden from the user. The
selection details are stored within the project’s build configuration folder(s) and will take the

suffix .jtag or .swd

« PEmicro Debug: appropriate cores inside Primary and Secondary launch configurations
are automatically selected by the IDE.
« SEGGER Debug: appropriate cores inside Primary and Secondary launch configurations
are automatically selected by the IDE. However, there might be certain situations when
Secondary core should be manually selected. In this case, the IDE will display a warning

with regards to incapability of finding a matching core (based on project description).

e Attach mode for the Secondary CPU - as described above, the debug connection to the
secondary core(s) should be via an attach

e LinkServer CMSIS-DAP Debug: this option is set automatically when the LinkServer
debug launch configuration is created.

« PEmicro Debug: this option is set automatically when the PEmicro debug launch

configuration is created.

e SEGGER Debug: this option is set automatically when the J-Link debug launch

configuration is created.

e Managing the Debug Server - this is the low level interface between the debugger and target

* LinkServer CMSIS-DAP Debug: the LinkServer launch configuration is automatically
correctly configured when the debug connection is made.
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« PEmicro Debug: the PEmicro launch configuration is automatically correctly configured
when the debug connection is made.

« SEGGER Debug: the J-Link launch configuration is automatically correctly configured
when the debug connection is made.

18.4.3 Auto-debug secondary project(s) for multicore projects

When using LinkServer as a debug connection, secondary projects can be automatically
debugged once initiating debug on the primary project. This behavior is controlled by
a LinkServer-specific preference that can be accessed via Eclipse menu -> Window ->
Preferences -> MCUXpresso IDE -> Debug Options -> LinkServer Options -> Miscellaneous
-> "Enable auto-debug secondary project(s) for multicore projects". By default, the
preference is enabled in a fresh workspace, meaning that debug sessions for secondary projects
will be automatically started.

8 preferences ] X

I Miscellaneous v ow 8

» General ~

LinkServer Debug Miscellaneous Options

» CfC++
RedLink Server Connection Timeout (s) 10
Help -
» Install/Update SWV Packet Timeout 0
> Java Extended debug trace (DEBUG_TRACE)
Library Hover |:| . e o |
. Maven Stream all stub messages to Console

v MCUXpresso IDE
v Debug Options
J-Link Options
~ LinkServer Options
Advanced
DFU Options
Miscellaneous
PEMicro Options
Probe Discovery
Default Tool settings
Editor Awareness
Energy Measurement

[[]Show stub warnings as notes

|:| Show debug log when written to

Display asynchronous error messages

[]Disable Auto-select device on multicore target

| Enable auto-debug secondary project(s) for multicore projects

Auto-debug secondary project(s) delay for multicore projects (ms) | 1000
E]ﬂlways show JTAG selection dialog

[[] show progress messages in log

Show extended debug messages

Enable Non-Stop Mode

Enable Registers View Double-Precision registers group

General [Jinitialise LPC-Link as HID (Requires power-cycle)
MCU settings Ignore LPC-Link HID (Windows 8 only)
Paths and Directories LPC-Link boot delay (ms) | 250
ickstart Panel
E;JCI)C . T: 5 ane LPC-Link driver settle time (s) 30
SDK Handling Extended boot logging file Browse...
SWO Trace
User Interface Enablement 9 Restore Defaults Apply
Utilities

Apply and Close Cancel

Figure 18.17. Auto-debug secondary project enable option

Subsequent debug sessions started for secondary projects are delayed and the actual delay is
specified in another preference, as depicted below. If required, users can change the default
1000ms value.
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v MCUXpresso IDE
~ Debug Options

v

Figure 18.18. Auto-debug secondary project delay option

L SIUW SLUL WdllIgs db NuLes

[ show debug log when written to

J-Link Options Display asynchronous error messages
LinkServer Options [[] Disable Auto-select device on multicore target
Advanced Enable auto-debug secondary project(s) for multicore projects
DFU Options | Auto-debug secondary project(s) delay for multicore projects (ms) | 1000 |

Miscellaneous

O Always show JTAG selection dialog

18.5

18.5.1

18.5.2

MCUXpresso IDE User Guide -

In the case you don’t want to have this feature enabled (so if you want to start debug sessions
for each core independently), uncheck this option.

Similar to LinkServer, the option for auto-debug of secondary project(s) for multicore projects
becomes enabled by default for multicore debug purpose when using PEmicro and J-Link. For
configuring the enablement, go to the appropriate Preferences page:

e PEmicro: Window -> Preferences -> MCUXpresso IDE -> Debug Options -> PEMicro
Options -> "Enable auto-debug secondary project(s)".

¢ J-Link: Window -> Preferences -> MCUXpresso IDE -> Debug Options -> J-Link Options
->"Enable auto-debug secondary project(s)".

MultiCore Projects additional Information

Defines

A number of compiler defines are automatically created for LPC5410x projects to allow
conditional compilation of certain blocks of code depending upon whether a specific project is
configured to be a Secondary, a Primary or neither.

__MULTICORE_MASTER
« Defined automatically for a project that has been configured to be a Primary project
__ MULTICORE_MASTER_SLAVE_MOSLAVE

« Defined automatically for a project that has been configured to be a Primary project and has
had a Secondary project associated with it (hence indicating to the Primary project which CPU
type the Secondary project is for).

_ MULTICORE_MOSLAVE

¢ Appropriate one defined automatically for a project that has been configured to be a Secondary
project

__MULTICORE_NONE

« Defined automatically for a project which has not been configured as either a Secondary or
Primary project

Note: The multicore support within MCUXpresso IDE is highly flexible and provides
functionality beyond that required for the LPC5411x family. Thus the symbols
_ MULTICORE_MASTER_SLAVE_MA4SLAVE and _ MULTICORE_MA4SLAVE are also
provided for completeness.

Secondary Boot Code

boot_multicore_slave() is called by the Primary project code created directly by the New project
wizard to release the Secondary core from sleep.
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Note: The source files containing this function will be included in all LPC541xx projects, but
will be conditionally compiled so that it is included only when required. This has been done to
allow projects originally created, for example, as a Secondary project, to be reconfigured (via the
project properties — linker multicore tab) as a Primary project.

18.5.3 Reset Handler code

When configured as a Primary project, the LPC541xx startup file will be built with additional
(assembler) code at the beginning of the reset handler, ResetISR(), with the ‘standard ‘ reset
handler code moved to ResetISR2().

This additional code is required in order to allow correct booting of both the Primary and
Secondary cores. It is written in assembler in order to force it to be ‘Thumbl’ code, and hence
runnable by both cores.
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19. Appendix — Additional Hints and Tips

These additional hints and tips extend the information provided in the main body of this guide.

19.1 Part Support Handling from SDKs

MCUXpresso IDE needs specific device information provided by the SDK in order to properly:

¢ Create/import projects
« with part specific startup code
« Define memory layout
¢ Create debugging launch configuration
e Perform flash programming

This detailed part knowledge is known as Part Support.

19.1.1 SDK Version control

MCUXpresso IDE obtains new Part Support from installed SDKs. The IDE’s internal database
only uses SDKs with the highest version number (latest version is v2.9). For example, a user
may have installed two SDKs for a single part:

+ SDK_2.3.0_FRDM-K64F
+ SDK_2.0.0_FRDM-K64F

The IDE loads only the 2.3.0 version of that SDK, and also provides a warning in the SDK View
header:

) Installed SDKs £2 [ Properties [ Console |*| Problems [] Memary Q Instruction Trace ;;a SWO Trace Config B Power Measure

% Installed SDKs 'SDK 2.x FROM-KBAF' {'2.2.0') replaced by SDK version ('2.3.0').

To install an SDK, simply drag and drop an SDK (zip file/folder) into the ‘Installed SDKs' view.

Name SDK Version Manifest Version Location
o SDK_2.x_FRDM-KG4F 2.3.0 3.2.0 @_ {SDK_2.3.0_FRDM-KB4F.zip

In this situation, it is likely that the user no longer needs the older version of the SDK. Therefore
the IDE provides an option to delete this older SDK via clicking on the warning message, and
clicking the X'.

(j Installed SDKs £2 [ Properties [ Console [®] Problems [] Memory 5 Instruction Trace ;; SWO Trace Config BED Power Measureme

5 Installed SDKs ‘SN 2 v EROM-KRAR! (' 70! raniarad bu SNK warsinn 9 3 00

To install an SDK, simply dra *, 'SDK_2.x_FRDM-K&4F' ('2,2.0') replaced by SDK version l'2.3.

Name SDK Version Manifest Version Location

+ SDK_2.x_FRDM-KB4F 2.3.0 3.2.0 @‘ /SDK_2.3.0_FRDM-K64F.zip

Note: Once a new SDK for a part is installed, it will always replace any older installed SDK for
that part, even if the new SDK is deactivated (by unchecking the associated tick box). The effect
of deactivating an SDK is that part support and wizard will be removed from internal views. These
will be restored if the SDK is activated again.

19.1.2 SDK Manifest versioning

Along with SDK versioning, also the internal manifest in an SDK can have multiple versions.
MCUXpresso IDE loads the manifest associated to its internal version head info. Thus, assuming
an IDE with internal head version set to 3.3, we could have an SDK with the following manifests:
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¢ Manifest version 3.3
¢ Manifest version 3.2
Manifest version 3.1
¢ Manifest version 3.0

In such case, the IDE will load the manifest version 3.3.

After loading, the IDE validates the manifest against the schema version head, and if for any
reason this is not valid, it will try with the other schema versions. If the manifest 3.3 cannot be
validated, then it tries with manifest 3.2, validating it, and so on. The manifest version is shown
in the SDK View and any validation errors are shown in the Error Log.

In the case that the IDE loads an older manifest, or in the case the SDK contains a manifest 3.4
and the IDE manifest head is 3.3, the SDK image in the SDK view is decorated with a warning
and, by clicking on the SDK, a message appears in the SDK view header:

(7] Installed SDKs #2 [] Properties ) Console |*/ Problems [] Memory

I Installed SDKs A newer version of MCUXpresso IDE is recommende

To install an SDK, simply drag and drop an SDK (zip file/folder) into the ‘installe

Mame SDK Version Manifest
"ﬂ SDK_2.x_FRDM-KGAF 2.3.0 3.2.0

The full error will look like: "A newer version of the MCUXpresso IDE is recommended for use
with the selected SDK. Please update your MCUXpresso IDE in order to get full SDK features"

Note Even if not intended, newer SDKs may be released supporting features not understood by
the current version of the IDE. A message will be used to warn users that there is a mismatch
between the SDK and IDE capabilities.

Device versions

If the user installs more than one SDK containing the same device (i.e. a device with the same
identifier), the IDE loads the part support from the device with the highest version number,
regardless of which SDK it is located within. If two or more SDKs have the same device with
the same version number, then the order these are presented to the IDE by the host OS will
determine which SDK is used.

If an SDK in the Installed SDK view contains a device that is not installed (because it is supplied
by another SDK), its image (and the device in the SDK tree) will be decorated with an icon:

J Installed SDKs £3 E Properties E Console |'_ Problems [] Memaory 9 Instruction Trace ;:; SWO Trace Config @D Power Measurement X Symbol Viewe

@i
@ Installed SDKs
To install an SDK, simply drag and drop an SDK (zip file/folder) inte the 'Installed SDKs' view.
Name SDK Version Manifest Version Location
41 SDK_2.x_FRDM-KE4F-AGMO1 2.2.0 3.0.0 <) /SDK_2.0_FROM-KB4F-agm( > [l Boards
™ SDK_2.x_FRDM-K&4F [® <Default Location>/SDK_2.0.0_FRDM-KGAF.zip [ Q Devices
B

[ 3 ,_',', Compilers

¥ i3 Toolchains

P (£ Toolchain Se

F ik Components
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How do | switch between Debug and Release builds?

By default, MCUXpresso IDE projects will automatically have two build configurations, Debug
and Release. Typically a project will be developed using the Debug build variant, but switched
to Release late in the development cycle to benefit from more compilation optimisations.

Changing the build configuration of a single project

You can switch between Debug and Release build configurations by selecting the project you
want to change the build configuration for in the Project Explorer view, then using one of the
below methods:

¢ Select the menu item Project->Build Configuration->Set Active and select Release or
Debug as necessary

¢ Use the drop down arrow next to the ‘sundial’ (Manage configurations for the current project)
icon on the main toolbar (next to the ‘hammer’ icon) and select Release or Debug as
necessary. Alternatively, you can use the drop down next to the ‘hammer’ icon to change the
current configuration and then immediately trigger a build.

R Q@ - &~
1o10 v’l’\\Sl Debug (Debug build) i
2 Releasze (Release build)

&

¢ Right click in the Project Explorer view to display the context sensitive menu and select Build
Configurations->Set Active entry.

Changing the build configuration of multiple projects

Itis also possible to set the build configuration of multiple projects at once. This may be necessary
if you have a main application project linked with a library project, or you have linked projects for
a multicore MCU such as an LPC43xx or LPC541xx (one project for the master Cortex-M4 CPU
and another for a slave Cortex-M0/M0+ CPU).

To do this, you first of all you need to select the projects that you wish to change the build
configuration for in the Project Explorer view — by clicking to select the first project, then use

shift-click or control-click to select additional projects as appropriate. If you want to change all
projects, then you can simply use Ctrl-A to select all of them.

Note: it is important that when you select multiple projects, you should ensure that none of the
selected projects are opened out — in other words, when you selected the projects, you must not
have been able to see any of the files or the directory structure within them. If you do not do this,
then some methods for changing the build configuration will not be available.

Once the required projects are selected, you then need to simply change the build configuration
as you would do for a single project.

Editing Hints and Tips

The editor view within Eclipse, which sits under the MCUXpresso IDE, provides a large number
of powerful features for editing your source files.

Multiple views onto the same file

The Window -> Editor menu provides several ways of looking at the same file in parallel.

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022 249



NXP Semiconductors MCUXpresso IDE User Guide

19.3.2

19.3.3

19.3.4

19.3.5

MCUXpresso IDE User Guide -

¢ Clone : two editor views onto the same file

e Toggle Split Editor : splits the view onto the current file into two (either horizontally or
vertically)

Viewing two edited files at once
To see more than one file at the same time, simply click the file tabs that you have open in the
editor view, and then keep the mouse button held down and drag that file tab across to the right.

After you've moved to the side, or below, an outline should appear showing you where that tab
will be placed once you release the mouse button.

Source folding

Within the editor view, functions, structures etc. may be folded to show the structure and hide
the detalil.

Folding is controlled via, right click in the margin of the editor view to bring up the context sensitive
menu, then select Folding -> <option required>

When folding is enabled, you can then click on the + or - icon that now appear in the margin next
to each function, structure, etc, to expand or collapse it, or use the Folding -> Expand all and
Folding -> Collapse all options from the context sensitive menu

Various settings for Folding can also be controlled through:

Preferences -> C/C++ -> Editor -> Folding

Editor templates and Code completion

Within the editor, a number of related pieces of functionality allow you to enter code quickly and
easily.

First of all, templates are fragments of code that can be inserted in a semi-automatic manner to
ease the entering of repetitive code — such as blocks of code for C code structures such as for
loops, if-then-else statements and so on.

Secondly, the indexing of your source code that is done by default by the tools, allows for auto
completion of function and variable names. This is known as “content assist”.

¢ Ctrl-Space at any point will list available editor template, function names etc.
« Ctrl-Shift-Space will display function parameters
e Alt-/ for word completion (press multiple times to cycle through multiple options).

In addition, the predefined templates are user extensible via:

Preferences -> C/C++ -> Editor -> Templates

Brace matching
The editor can highlight corresponding open and closing braces in a couple of ways.

First of all, if you place the cursor immediately to the right of a brace (either an opening or closing
brace), then the editor will display a rectangle around the corresponding brace.

Secondly, if you double click immediately to the right of a brace, then the editor will automatically
highlight all of the text between this brace and the corresponding one.
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19.3.6 Syntax coloring
Syntax Coloring specifies how your source code is rendered in the editor view, with different
colors used for different elements of your source code. The settings used can be modified in:
Preferences -> C/C++ -> Editor -> Syntax Coloring
Note that general text editor settings such as the background color can be configured in:
Preferences -> General -> Text Editors
Fonts may be configured in:
Preferences -> General -> Appearance -> Colors and Fonts
19.3.7 Comment/uncomment block
The editor offers a number of ways of comment in or out one or more lines of text. These can
be accessed using the Source entry of the editor context-sensitive menu, or using the following
keyboard shortcuts...
¢ Select the line(s) to comment, then hit Ctrl-/ to comment out using // at the start of the line, or
uncomment if the line is currently commented out.
¢ Select the line(s) to comment, then hit Ctrl-Shift-/ to block comment out (placing /* at the start
and */ at the end).
e To remove a block comment, hit Ctrl-Shift-\.
19.3.8 Format code
The editor can format your code to match the coding standards in use ( Preferences -> C/C
++ -> Code Style). This can automatically deal with layout elements such as indentation and
where braces are placed. This can be carried out on the currently selected text using the Source-
>Format entry of the editor context-sensitive menu, or using the keyboard shortcuts Ctrl-Shift-F.
If no text is selected, then the format will take place on the whole of the current file.
19.3.9 Correct Indentation
As you enter code in the editor, it will attempt to automatically indent your code appropriately,
based on the code standards in use, and also the layout of the preceding text. However, in
some circumstances, for example after manually laying text out, you may end up with incorrect
indentation.
This can usually be corrected using the Source->Correct Indentation entry of the editor context-
sensitive menu, or using the keyboard shortcuts Ctrl-I.
Alternatively, use the “Format code” option which will fix other layout issues in addition to
indentation.
19.3.10 Insert spaces for tabs in editor
You can configure the IDE so that when editing a file, pressing the TAB key inserts spaces instead
of tab characters. To do this go to
Preferences -> General -> Editors -> Text Editors
and tick the “Insert spaces for tabs” box. If you tick “Show white-space characters” you can see
whether a tab character or space characters are being inserted when you press the TAB key
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Replacing tabs with spaces
To replace existing tabs with spaces throughout the file, open the Code Style preferences:

Preferences -> C/C++ -> Code Style

« Select a Code Style profile and then select Edit...
« Choose the Indentation tab

For the Tab policy, select Spaces only

Apply the changes.

« Note: If the Code Style has not been edited before, the Profile must be renamed before the
change can be applied.

¢ The new style will be applied when the source is next formatted using Source -> Format

Hardware Floating Point Support

Most ARM-based systems — including those based on Cortex-M0, MO+ and M3, have historically
not implemented any form of floating point in hardware. This means that any floating point
operations contained in your code will be converted into calls to library functions that then
implement the required operations in software.

However, many Cortex-M4 based MCUs do incorporate a single precision floating point hardware
unit. Note: that the optional Cortex-M4 floating point unit implements single precision operations
(C/C++float) only. Thus if your code makes use of double precision floating point (C/C++ double),
then any such floating point operations contained in your code will still be converted into calls to
library functions that then implement the required operations in software.

Similarly, Cortex-M7 based MCUs may incorporate a single precision or double precision floating
point hardware unit.

Floating Point Variants

When a hardware floating point unit is implemented, ARM define that it may be used in one of
two modes.

SoftABI

« Single precision floating point operations are implemented in hardware and hence provide a
large performance increase over code that uses traditional floating point library calls, but when
calls are made between functions any floating point parameters are passed in ARM (integer)
registers or on the stack.

« SoftABIl is the ‘most compatible’ as it allows code that is not built with hardware floating point
usage enabled to be linked with code that is built using software floating point library calls.

HardABI

« Single precision floating point operations are implemented in hardware, and floating point
registers are used when passing floating point parameters to functions.

HardABI will provide the highest absolute floating point performance, but is the ‘least compatible’

as it means that all of the code base for a project (including all library code) must be built for
HardABI.

Floating point use — Preinstalled MCUs

When targeting preinstalled MCUs, MCUXpresso IDE generally assumes that when Cortex-M4
hardware floating point is being used, then the SoftABI will be used. Thus generally this is the
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mode that example code (including for example LPCOpen chip and board libraries) are compiled
for. This is done as it ensures that components will tend to work out of the box with each other.

When you use a project wizard for a Cortex-M4 where a hardware floating point unit may be
implemented, there will be an option to enable the use of the hardware within the wizard’s options.
This will default to SoftABI — for compatibility reasons.

Selecting this option will make the appropriate changes to the compiler, assembler and linker
settings to cause SoftABI code to be generated. It will also typically enable code within the startup
code generated by the wizard that will turn the floating point unit on.

You can also select the use of HardABI in the wizards. Again this will cause appropriate tool
settings to be used. But if you use this, you must ensure that any library projects used by your
application project are also configured to use HardABI. If such projects already exist, then you can
manually modify the compiler/assembler/linker settings in Project Properties to select HardABI.

Warning : Creating a project that uses HardABI when linked library projects have not been
configured and built with this option will result in link time errors.

19.4.3 Floating point use — SDK installed MCUs
When targeting SDK installed MCUs, MCUXpresso IDE generally assumes that when hardware
floating point is available, then the HardABI will be used. This will generally work without problem
as generally projects for such MCUs contain all required code (with no use of library projects).
However, it is still possible to switch to using SoftABI using the “Advanced Properties settings”
page of the |New project" and “Import SDK examples” wizards.

19.4.4 Modifying floating point configuration for an existing project
If you wish to change the floating point ABI for an existing project (for example to change it from
using SoftABI to HardABI), then go to:
Quickstart -> Quick Settings -> Set Floating Point type
and choose the required option.
Alternatively, you can configure the settings manually by going to:
Project -> Properties -> C/C++ Build -> Settings -> Tool Settings
and changing the setting in ALL of the following entries:
¢ MCU C Compiler -> Architecture -> Floating point
¢ MCU Assembler -> Architecture & Headers -> Floating point
¢ MCU Linker -> Architecture -> Floating point
Note: For C++ projects, you will also need to modify the setting for the MCU C++ Compiler.
Warning: Remember to change the setting for all associated projects, otherwise linker errors
may result.

19.4.5 Do all Cortex-M4 MCUs provide floating point in hardware?
Not all Cortex-M4 based MCUs implement floating point in hardware, so please check the
documentation provided for your specific MCU to confirm.
In particular with some MCU families, some specific MCUs may not provide hardware floating
point, even though most of the members of the family do (for example the LPC407x_8x). Thus it
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is a good idea to double check the documentation, even if the project wizard in the MCUXpresso
IDE for the family that you are targeting suggests that hardware floating point is available.

Why do | get a hard fault when my code executes a floating point
operation?

If you are getting a hard fault when your application tries to execute a floating point operation,
then you are almost certainly not enabling the floating point unit. This is normally done in the
LPCOpen or SDK initialisation code, or else in the startup file that MCUXpresso IDE generates.
But if there are configuration issues with your project, then you can run into problems.

For more information, please see the Cortex-M4 Technical Reference Manual, available on the
ARM website.

LinkServer Scripts

The LinkServer debug server supports a Basic like programming language that can be used to
script low level target operations. Within a LinkServer debug connection, we provide two call
outs where scripts can be referenced (if required). The first call out is intended to assist with the
initial debug connection, via a Connect Script, and the second is to assist with the targets reset
via a Reset Script.

These scripts are specified within a LinkServer launch configuration file and will be preselected
if needed for projects performing standard connections to known debug targets.

Supplied Scripts

A set of scripts are supplied within the MCUXpresso IDE installation at:

<install dir>/ide/bin/Scripts

These scripts will be used to prepopulate LinkServer launch configuration files when needed.

The purpose of certain scripts will be described below:

¢ kinetismasserase.scp - invoked by the GUI Flash Programmer to Resurrect locked Kinetis
device

¢ kinetisunlock.scp - if for any reason the GUI Flash Programmer fails to resurrect a locked part
(as above), this script can be specified in place of the above and the recovery attempt repeated

« delayexample.scp - an example script showing how a delay can be performed

Note: Some chips also require a preconnect script that prepares the target MCU for the initial
debug connection. A set of preconnect scripts can be found within the MCUXpresso IDE
installation at:

<install dir>/ide/bin/Tool Scripts

User Scripts
Additional user generated scripts can be added directly to the product installation but more

typically they should be located within a project. The LinkServer launch configuration allows the
location of scripts to be either project relative, absolute or product local.

Debugging code from RAM

[This section is deprecated — please see
for details of the improved scheme]
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MCUs have well defined boot strategies from reset, typically they will first run some internal
manufacturer boot ROM code that performs some hardware setup and then control passes to
code in flash (i.e. the users Application).

On occasion it can be useful to run and debug code directly from RAM. Since an MCU will not
boot from RAM a scheme is needed to take control of the debuggers reset mechanism. This can
be achieved the use of a LinkServer reset script.

Within MCUXpresso IDE, certain pre-created scripts are located at:

{install dir}/bin/Scripts

Contained in this directory is a script called kinetisRamReset.scp (see below).

10 REM Kinetis K64F Internal RAM (@ 0x20000000) reset scri pt

20 REM Connect script is passed PC/SP fromthe vector table in the i mage by the debugger
30 REM For the sinple use case we pass themback to the debugger with the |l ocation of the reset|context
40 REM

50 REM Syntax here is that '~ commands a hex output, all integer variables are a%to z%
70 REM Find the probe index

80 p% = probefirstfound

90 REM Set the 'this' probe and core

100 sel ect probecore p% 0

110 REM NOTE!'! Vector table presuned RAM | ocation i s address 0x20000000

120 REM The script passes the SP (%) and PC (%) back to the debugger as the reset context
130 b% = peek32 this 0x20000000

140 a% = peek32 this 0x20000004

145 d% = 0x20000000

150 print "Vector table SP/PC is the reset context."

160 print "PC = "; ~a%
170 print "SP = "; ~b%
180 print "XPSR = "; ~c%
185 print "VIOR = "; ~d%
190 end

This reset script makes an assumption that the user intends to run code from RAM at 0x20000000
— this is the value of the SRAM_Upper RAM block on Kinetis parts.

Note: To build a project to link against RAM, you can simply delete any flash entries within the
projects memory configuration. If the MCUXpresso IDEs default linker settings are used then
project will link to the first RAM block in the list. For many Kinetis parts, this address will match the
expected address within the script. For some parts (for example KLxx) however, the first RAM
block may take a different value. This problem can be resolved by editing the script or modifying
the projects RAM addresses.

For users if LPC parts, the RAM addresses will be different but the principal remains the same.
Within the Scripts directory, you will find an RAM reset script for the LPC18LPC43 parts, this
script is identical to the one above apart from the assumed RAM address.

Finally, to use the script, simply edit the projects launch configuration for the ‘Reset Script’ entry,
browse to the appropriate ‘RAMReset.scp’ script.

Note: When executing code from RAM, the projects Vector table will also be located at the
start of the RAM block. Cortex M MCUs can locate their vector table using an internal register
called VTOR (the vector table offset register). Typically this register will be set automatically by
a projects startup or init code. However, if execution fails when an interrupt occurs, check that
this register is set the correct value.
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LinkServer Scripting Features

LinkServer scripts are written in a simple version of the BASIC programming language. In this
variant of BASIC, 26 variables are available (%a thru %z). On entry to the script some variable

have assigned values:

a%is the PC
b%is the SP
c%is the XPSR
d%is the VIOR

On exit from the script a% is loaded into the PC, b% is loaded into the SP and d% is loaded into
the VTOR, thus providing a way for the script to change the startup behavior of the application.

They offer functionality as shown below:

Generic BASIC like functions that only work inside scripts

GOTO ' Li neNunber*

IF "relation" THEN 'statenent’

REPEAT : Start of a repeat bl ock

UNTIL "relation' : End with condition of repeat block
BREAKREPEATTO ' Li neNunber' : Premature end of a repeat |oop
GOSUB ' Li neNunber

RETURN

TIME : Returns a 10ns increnenting count fromthe host

Generic BASIC like functions

PEEKS {[TH S|
PEEK16 {[ THI S|

[ [ <Probel ndex> <Cor el ndex>]} <Address>
[
PEEK32 {[ TH S]
[
[

[ <Probel ndex> <Cor el ndex>]} <Address>
[ <Probel ndex> <Cor el ndex>]} <Address>
POKE8 {[TH S]
POKE16 {[TH S]
POKE32 {[ TH S]
QPOKE8  {[ THI 9]
QPOKEL6 {[ THI S|
QPOKE32 {[THI'S] | [<Probel ndex> <Corel ndex>]} <Address> <Dat a>

QSTARTTRANSFERS {[ THI S] | [ <Probel ndex> <Corel ndex>]} <NunmReads>

MEMDUMP {[THI' S] | [<Probel ndex> <Corel ndex>]} <Byte Address> <Length>

MEMLOAD {[ THI S] | [<Probel ndex> <Corel ndex>]} <FileNanme> <Byte Address> <Length

[ <Probel ndex> <Cor el ndex>]} <Address> <Dat a>

[ <Probel ndex> <Cor el ndex>]} <Address> <Dat a>

[ <Probel ndex> <Cor el ndex>]} <Address> <Dat a>
| [<Probel ndex> <Corel ndex>]} <Address> <Data>
|

[ <Probel ndex> <Cor el ndex>]} <Address> <Dat a>

Limt> Loads binary file data to menory
MEMSAVE {[ THI S] | [<Probel ndex> <Corel ndex>]} <FileNane> <Byte Address> <Length>
Saves nenory to binary file
PRI NT "TEXT"[;[~] Vari able | Constant]: Print statenment. Prints quoted text
and/or value of an internal variable (a%b6- z%4, or constant integer
expression in decimal, or hexadecimal[~] format
TIME : Returns an increnenting centisecond count fromthe host
TIMEMS : Returns an increnenting millisecond count fromthe host
VWAI T <nsec> : Wit for the nunber of nilliseconds before proceding
LI ST: Lists a | oaded scri pt
NEW Erases a | oaded script from menory
RENUMBER <Del t a>: Renunber script lines with Delta increnent (default is 10)
LOAD <"FI LENAME">: Loads a script fromthe current, absolute, or relative directory
SAVE <"FI LENAME'>: Saves a script to the current, absolute, or relative directory

Probe related functions
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PROBELI ST : Enunerates and returns an indexed |ist of known probe types

PROBENUM : Returns the nunber of probes attached

PROBECPENBY! NDEX <Pr obel ndex> [<"FI LENAME">] : Opens the probe associated w th Probel ndex
FI LENAME i s text of <key = value> pairs used for internal configuration
PROBEOPENBYSERI AL <" Seri al Nunber"> : Opens the probe associated with Serial Nunber
PROBECLCOSEBY!I NDEX <Pr obel ndex> : Cl oses the probe associated with Probel ndex
PROBECLOSEBYSERI AL <" Seri al Nunber"> : C oses the probe associated with Serial Nunber
PROBEFI RSTFOUND : Returns the THI' S Probel ndex or index of the first probe in the
enunerated |ist

PROBETI ME <Probel ndex> : Returns el apsed tinme fromfirnware boot, if supported
PROBESTATUS [ <Pr obel ndex>]: Returns an indexed |ist summary of the status of the
probes connected to the system

PROBEVERS| ON <Pr obel ndex>: Returns version information about probe firmare

PROBEI SOPEN <Pr obel ndex>: Returns TRUE or FALSE

PROBEHASJTAG <Pr obel ndex>: Returns TRUE or FALSE

PROBEHASSWD <Pr obel ndex>: Returns TRUE or FALSE

PROBEHASSW <Pr obel ndex>: Returns TRUE or FALSE

PROBEHASETM <Pr obel ndex>: Returns TRUE or FALSE

Core/TAP related functions

CORECONFI G {[THI S] | [<Probelndex>]}: Queries the scan chain configuration

CORESCONFI GURED <Pr obel ndex>: Returns TRUE or FALSE

APLIMT {[TH S] | [<Probelndex>]}: <APIndex> Limt the AP Query (set once)

APLIST {[TH S] | [<Probelndex>]}: [<APLimt>]: Detailed list of APs
connected to the specified probe. APLimt restricts queries to AP index.

CORELI ST {[THI'S] | [<Probelndex>]}: [<APLinit>]: Detailed |ist of APs/Cores
connected to the specified probe. APLimt restricts queries to AP index.

COREREADI D {[THI S] | [<Probel ndex> <Corelndex>]}: Returns the DplD

DEBUGVAI LBOXREQ {[ THI S] | [ <Probel ndex> <API ndex>]} <Request>: Debug Mail box Request

Wire related functions

W RESWDCONNECT {[THI S] | [<Probel ndex>]}: Configures the wire for SW and

returns the Dpl D

W REJTAGCONNECT {[THI'S] | [<Probelndex>]}: Configures the wire for JTAG

W REDI SCONNECT {[THI S] | [<Probelndex>]}: Coses the wire connection (SWY JTAG

W REI SPRESET {[TH S] | [<Probelndex>]}: Resets an LPC part into the ISP

boot | oader

W REBOOTCONFI GSET {[THI S] | [<Probel ndex>]} <"DATA">: Stores boot configuration data
that will be automatically applied during subsequent reset commands.

DATA is a string with up to 4 characters describing how each | SP_CTRL[3..0] pin
shoul d be handled: '0" (= drive low), '"1' (= drive high), 'x' (= do not drive)

W REBOOTCONFI GGET {[THI S] | [<Probelndex>]}: Returns previously stored configuration data
W REBOOTCONFI GREAD {[ THI S] | [<Probel ndex>]}: Returns the current state of |SP_CTRL[3:0]
W REBOOTCONFI GAPPLY {[ THI S] | [<Probelndex>]} <1/0>: Immediately starts/stops driving
the |1 SP_CTRL pins based on previously stored boot configuration data

W RETI MEDRESET <Probel ndex> <ns>: Asserts (Low) reset for ns mlliseconds and

returns the end state of the wire

W REHOLDRESET <Probel ndex> <State> : Asserts/Rel eases (Low Hi gh) reset and

returns the end state of the wire

W RESETSPEED <Pr obel ndex> <Hz>: Requests a particular wire speed in Hz

W REGETSPEED <Probel ndex> : Returns the current wire speed

W RESETI DLECYCLES <Pr obel ndex> <Cycl es>: Sets the nunber of idle cycles between

debug transactions

W REGETI DLECYCLES <Probel ndex> : Returns the current nunber of debug idle cycles

W REI SCONNECTED <Pr obel ndex>: >: Returns TRUE or FALSE if W RESWDCONNECT or

pi ns
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W REJTAGCONNECT is conpl ete

W REGETPROTOCOL <Pr obel ndex>: Returns SWD or JTAG

SELECTPROBECORE <Pr obel ndex> <Corel ndex> : Sets the THI S paraneter Probe/Core
pair

TH S : Displays the current Probe, Core pair

Cortex-M related functions

CM NI TAPDP {[THI S] | [<Probel ndex> <Corelndex>]}: Initialize a CM core ready
for debug connections

CMUNI NI TAPDP {[ THI S] | [<Probel ndex> <Corelndex>]}: Unlnitialize a CM core
(de-assert debug and system power - up)

CMARI TEDP {[ THI S] | [<Probel ndex> <Corel ndex>]} <REG> <DATA>. Returns zero on
success

CWMARI TEAP {[ THI S] | [<Probel ndex> <Corel ndex>]} <REG> <DATA>: Returns zero on
success

CVREADDP {[ THI S] | [<Probel ndex> <Corel ndex>]} <REG>: Returns data

CVREADAP {[ THI S] | [<Probel ndex> <Corel ndex>]} <REG>: Returns data (handles
RDBUF on AP reads)

CMCLEARERRORS {[ THI' S] | [<Probel ndex> <Corel ndex>] }

CWVHALT {[THI S] | [<Probel ndex> <Corel ndex>]}

CVRUN {[THI S] | [<Probel ndex> <Corel ndex>] }

CMSTEP {[ THI S] | [<Probel ndex> <Corel ndex>]}

CVREGS {[THI S] | [ <Probel ndex> <Corel ndex>]}

CVDEBUGSTATUS {[THI S] | [ <Probel ndex> <Corel ndex>]}

CWMARI TEREG {[ THI S] | [ <Probel ndex> <Corel ndex>]} <RegNumber> <Val ue>

CVREADREG {[ THI S] | [<Probel ndex> <Corel ndex>]} <RegNumber >

CMMATCHLI ST {[THI S] | [<Probel ndex> <Cor el ndex>] }

CMMATCHSET {[THI S] | [<Probel ndex> <Corel ndex>]} <DWII ndex> <Address> [ <RW R| W]

CMMATCHCLEAR {[ THI S] | [<Probel ndex> <Corel ndex>]} <DWII ndex>

CMBREAKLI ST {[THI S] | [<Probel ndex> <Corelndex>]} : List the FPB breakpoints

CMBREAKSET {[THI S] | [<Probel ndex> <Corel ndex>]} <Address> : Set an FPB

CVMBREAKCLEAR {[THI S] | [<Probel ndex> <Corel ndex>]} [<Address>] : Clear an FPB

CVMBYSRESETREQ {[ THI S] | [<Probel ndex> <Corelndex>]} : Systemreset request

CWECTRESETREQ {[ THI S] | [<Probel ndex> <Corelndex>]} : Core reset request

CVRESETVECTORCATCHSET {[ THI S] | [<Probel ndex> <Corel ndex>]} : Enable reset
vector catch

CVRESETVECTORCATCHCLEAR {[ THI S] | [<Probel ndex> <Corelndex>]} : Disable reset
vector catch

Miscellanious

HELP : display hel p on LinkServer conmands
VERSION : returns the LinkServer version
CONNECTI ONS : display active connections

Scripts can be specified within a LinkServer launch configuration to be run before a connection
and/or before a reset.

19.6 RAM projects with LinkServer

MCUs have well defined boot strategies from reset, typically they will first run internal
manufacturer boot ROM code to perform some hardware setup and then pass control to code
in flash (i.e. the users Application).

Most examples and wizards create projects to run from MCU flash memory but on occasion it
can be useful to debug code directly from RAM. There are two stages to such a task:
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1. Modify a project to that it links to run from RAM
2. Modify the default reset mechanism to ensure that the RAM image is executed

To build a project to link against RAM, simply delete any flash entries within the projects memory
configuration. If the MCUXpresso IDEs default linker settings are used then the project will then
link against the first RAM block in the list (provided no Flash entry is present). Alternatively, from:

Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Manager Linker Script, you can
check the entry Link application to RAM.

Note: if the project has already been built to link to flash, then it should be cleaned before being
rebuilt.

Since an MCU will not automatically boot from RAM, a scheme is needed to take control of the
debuggers reset mechanism. This can be achieved via the use of a SOFT reset type. LinkServer
launch configurations can take an additional option, add the line --reset soft to override the default
reset type. Or preferably, set the reset type to 'SOFT' as shown below.

LinkServer Options

~ Debug Connection
Settings for the debug connection

Attach only Reset on Connect

Reset script I Workspace... File System...

Connect script | kinetisconnect.sep ﬂ Workspace... File System...
Default

BootROM stall
SYSRESETREQ
VECTRESET

Flash driver reset handling m Reset handling JW

Disconnect behavior cont ki Semihosting support e a

A soft reset is performed by setting the PC to the images resetISR() address, the stack pointer
to the top of the first RAM region and VTOR (Vector Table Offset Register) to the base address
of the first RAM region.

Note: Typically, MCU RAM sizes will be smaller that Flash sizes, therefore such a scheme may
not be suitable for larger images.

Advantages of developing with RAM projects

There are a number of advantages when debugging from RAM:

* Breakpoints in RAM do not require dedicated HW resources, essentially there is no limit of the
number of breakpoints that can be set.

« Flash programming step is not required, so the build and debug cycle will be faster.

« Development of secondary bootloaders is free from BootROM considerations

« No risk of accidently triggering Flash security features.

« No requirement to understand or have flash programming capability allowing code (including
flash drivers) can be developed.

« Any flash contents are preserved while debugging
¢ Unit development of large applications

Note: It should be remembered that since the MCU will not undergo a true hardware reset,
peripheral configurations will be inherited from one debug session to the next.
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The Console View

The Console View contains a number of different consoles providing textual information about the
operation of various parts of MCUXpresso IDE. It is located by default in the bottom right of the
Debug Perspective, in parallel with a number of other views — including the ‘Installed SDKs’ view.

The actual consoles available within the Console view will depend upon what operations are
currently taking place — in particular a number of consoles will only become available once a
debug session is started.

The currently displayed console will provide a local toolbar, with icons to do things like copying
the contents of the console or clearing its contents.

To see the list of currently available consoles, and, if required, change to a different one..

1. Switch to the Console View

2. Using the toolbar within the Console View click on the drop-down arrow next to the Display
Selected Console icon (which looks like a small monitor)

3. Select the require console from the drop down list

(1) Installed SDKs (=] Properties [*! Problems E Console &2 Terminal . Image Info 53 Debugger Console s
s AR EE 481
MKE4FN1 MOIXX"" Peninnd | inliaciine Mok PO IMVD O H -] L LASLL A tH 2. N AV ACAIA LM AN Panlaad ad

[MCuXpresso § ! RedlinkServer
2 FreeRTOS Task Aware Debugger Console version 11.0.0 (201904171217)

[l 3 CDT Global Build Console
[ 4 CDT Build Console [MKE4FN1MO0xxx12_Project]
5 MK64FN1MOxxx12_Project LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application] gdb traces
[ 6 MKE4FN1MOx00x12_Project Debug messages
[ 7 MK64FN1M0x0012_Project LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application] MK64FN 1MOxxx12_Project.axf

Console types
Consoles you will typically see include the following...
Build Console and Global Build Console

The Build Console (sometimes referred to as the Build Log) is used by the MCUXpresso IDE
build tools (compiler,linker, etc.) to display output generated when building your project. In fact
MCUXpresso IDE has two build consoles — one of which records the output from building the
current project, and the second a global build console which will record the output from building
all projects.

By default, the number of lines stored in the Build Console is limited to 500 lines. You can increase
this to any reasonable number as follows:

1. Select the Windows->Preferences menu option
2. Now choose C/C++ -> Build -> Console
3. Increase the "Limit Console out (humber of lines)" to a larger number, for instance 5000.

Note: This setting, like most within the MCUXpresso IDE is saved as part of your workspace.
Thus you will need to make this change each time you create a new workspace.
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Other options that can be set in Preferences include whether the console is cleared before a
build, whether it should be opened when a build starts, and whether to bring the console to the
top when building.

Once your build has completed, then if you have any build errors displayed in the console, clicking
on them will, by default, cause the appropriate source file to be opened at the appropriate place
for you to fix the error.

FreeRTOS Task Aware Debugger Console

This console displays status about the FreeRTOS TAD views. Persistence of the logs can
be controlled via the Preferences page. For more details, please see the MCUXpresso IDE
FreeRTOS Debug Guide.

Azure RTOS ThreadX Task Aware Debugger Console

This console displays status about the Azure RTOS ThreadX TAD views. Persistence of the logs
can be controlled via the Preferences page. For more details, please see the MCUXpresso IDE
Azure RTOS ThreadX Debug Guide.

Zephyr RTOS Task Aware Debugger Console

This console displays status about the Zephyr RTOS TAD views. Persistence of the logs can be
controlled via the Preferences page. For more details, please see the MCUXpresso IDE Zephyr
RTOS Debug Guide.

gdb traces and arm-none-eabi-gdb Consoles

These consoles give access to the GDB command line debugger, that sits underneath the
MCUXpresso IDE’s graphical debugging front end.

RedlinkServer/LinkServer Console

This console gives access to the server application that sits at the bottom of the debug stack
when using a debug probe connected via the MCUXpresso IDEs native “LinkServer” debugging
mechanism. LinkServer commands can be entered from this console.

Debug messages Console

The Debug Messages Console (sometimes referred to as the Debug Log) is used by the debug
driver to display additional information that may be helpful in understanding connection issues
when debugging your target MCU.

Semihosting Console

This console, generally displayed with .axf, allows semihosted output from the application running
on the MCU target to be displayed, and potentially for input to be sent down to the target.

SWO and Trace Console

This console displays all information related to CoreSight components creation and
configuration, starting with the base address of the ROM table that is being scanned
for the purpose of CoreSight identification. For more information please refer to
MCUXpresso_IDE_SWO_Trace.pdf documentation.

Copying the contents of a console
Occasionally, you may wish to copy out the contents of a console. For instance, the MCUXpresso

IDE support team may ask you to provide the details of your Build Console in a forum thread.
To do this:
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. Clean, then build your project.

. Select the appropriate Build Console as above:
. Select the contents (e.g. Ctrl-A)

. Copy to the clipboard (e.g. Ctrl-C).

. Paste from clipboard into forum thread (e.g. Ctrl-V). If there is a large amount of text in the
build console, it is advisable to paste it into a text file, which can be ZIPed if appropriate.

a b~ WDN PP

Note: some console will provide a button in their local toolbar to copy or save out their contents.

Relocating and duplicating the Console view

By default the Console View is positioned in parallel with a number of other views. This can
mean, if a console is being regularly updated with new output (for instance the view displaying
semihosted output from the application running on the target MCU), then by default this may
cause the console to keep jumping to the foreground — hence hiding other views that you are
using (for instance one of the SWO Trace views)

To avoid this you may wish to relocate the Console. To do this:

1. Click and hold down on the Console View

2. Continue to hold down, and drag the cursor to the location you want to Console view to be
displayed

3. Then release the mouse click, and the Console view will be placed at the required position

§ (g yhegles & AMILE_UPWER_S0D) I (v MGLE_(SFER_Bn
g ANl > ALE_|BRLI_NA Trimiddi durma_spp bbisle Debug (€7 s » 3008 macandycts

e Frapeie. | (D (agrote 11 (5 Pronbews [ Memary B0l ) WD Ty B0 Fawe
/ - o

titelt (as_mgp buien Detr i S oty WACL) b ot i il darme_ appe

Release the mouse ¢lick; and the

e ,  Configure Console view will be placed at the®
’ Click and hold down on s 5l rEquiredpasitipn o
the Console View Purtyemanis Ceumen (2 W0

Ciata Watch Bl \[ prebe
.....

resTuRt

(== [MEP Sérmmondudion) MU Appbcsian] bt dome iy

Continue to hold down, and drag -
* the cursor to the location you

= want to Console view to be
displayed

Another alternative is to spawn a duplicate instance of the Console view. This allows multiple
consoles to be visible at the same time. To do this use the Open Console button on the Console
view local toolbar

& =B R
mo_apps_bubpleaxf
"' — | Open Console

and then select "New Console View"
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R BRI FE B~r9~
' 1 C/C++ Build Console

B 2cvs

| 3 Mew Console View

| roe 4 FreeRTOS Task Aware Debugger Console

This will then display a second console view, which can be drag and dropped to a new location
within in the Perspective, as shown for the single Console view case described above.

(€] bubble.c 3 Welcome >, = H| & Console &2 = 0
if Angl ﬁNGLEUPF‘ERBOlF " |§wbﬂ- ﬁﬁldavﬁ'
i e yhagle > o s frdmkb4f_demo_apps_bubble Debug [C/C++ (NXP Semiconduc
snele = 1680 W= -26 y = -38 -
) E_yAngle 3 i 235 3 = 34 1
/* Update angles to turn off | xi gy ~ =
if (g xAngle < ANGLE LOWER_BOL T o
K= -38 y = -37
g xfngle = @; b _ -28 y = -48
- a N= -35 y = -41 o
_.}_ - L — FE ar - X
14 i | r 1 }
(@ Install... [T] Proper.. | B Console &2 |[*] Proble.. [J Memory @ Instruc.. FSWOT.. BEDPower.. = O
ZEEE v E-o-
frdmkbdf_dermo_apps_bubble Debug messages
e e e
Awaiting telnet connection on port 3336 ... =

GDB nonstop mode enabled

Opening flash driver FTFE_4K.cfx (already resident)
Writing 26688 bytes to address @x@9000808 in Flash
Erased/Wrote page ©-6 with 26688 bytes in 324msec
Closing flash driver FTFE_4K.cfx

Flash Write Done —
Flash Program Summary: 26688 bytes in 8.32 seconds (88.44 KB/sec)

Stopped: Breakpoint #1 o

Having opened a second console view, select which console you want displayed in it, and then
use the “Pin Console” button to ensure that it does not switch to one of the other consoles when
output is displayed.

Using Terminal View for UART communication with target

MCUXpresso IDE provides a Terminal View, which can be used to display UART (serial) input/
output between a host PC and the target MCU. In situations where a debug probe is built into the
target board, UART comms will often be possible via a VCOM connection over the same USB
cable as the debug connection. However, where this is not the case a serial_to_USB cable can
be used, alternatively, if the target MCU has built in USB then a VCOM port can implemented in
the application code running on the target MCU.

Using a Terminal View offers an alternative way of interacting with the target when compared to
semihosting output via debug channel (which is displayed in the Console View). There are pros
and cons to both approaches, but one distinct advantage to using the Terminal View for serial
output is that you can interact with the target MCU without a debug session being active!
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To use the Terminal View within MCUXpresso IDE, the first thing you will need to do is open it (as
it is not visible by default). To do this go to: Window -> Show View -> Other and select Terminal.

(=3 @ Show View

» = Git
> (= Help
» (= Java
» (= Java Browsing

> (= Make

> [>MCUXpresso Config Toals

» (= MCUXpresso IDE

* [~>MCUXpresso |DE FreeRTOS

» = MCUXpresso |IDE Power Measurement
» [=MCUXpresso |DE Trace

» (= PEmicro
A Terminal

b (= \alidatinn Wisar

Alternatively, just type “Terminal” into the “Quick Access” button in the top right of the IDE’s
window.

Next, ensuring that the serial connection between your PC and the target MCU is active first,
click on the “Open a Terminal” button in the Terminal View's toolbar:

& Terminal &3 = $# =0

Open a Terminal (“CGT)

Note: If using the LPC-Link2 built into many LPCXpresso boards, then you need to make sure the
probe has been booted before the serial connection will be available. You can do this manually
by using the “Boot Debug probe” button in the tool bar towards the top of the IDE window. Or
else you can pre-program the probe firmware into flash using LPCScrypt.

Now select the type of terminal required — a serial one :

® © Launch Terminal ‘
Choose terminal + Local Terminal ’
Setti SSH Terminal
il Serial Terminal
Encoding: | U Telnet Terminal

e APV e P IS

And then select the appropriate settings:
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Launch Terminal

<>

Choose terminal:  Serial Terminal
Settings
Serial port: jdev/cu.usbmodemDSATBQD2 ¥

Baudrate: 115200

<>

<>

Data size: 8

<>

Parity: None

<>

Stop bits: 1

Encoding: Default (ISO-8859-1)

<>

) Cancel OK

Note: that if you are receiving serial output via USB (for instance over a VCOM port from the
debug probe), then the default settings should normally be fine. The one setting you do need to
get correct is the Serial port to use. This will vary depending upon what devices are connected
within your PC, what OS you are running, and what the source for your serial port will be.

For instance if you are running on Windows, then the simplest way to identify the required serial
port is to open “Device Manager” (typically via the “Start Menu”), then expand the “Ports” tab.
This should allow you to identify the appropriate COM port needed.

After configuring the settings as required, click on the “OK” button. You should now see serial
output from the application running on the target MCU within the Terminal View:

® Terminal 2 = e ARERE Y Be-=

SHELL (build: Apr 20 2018)
Copyright (c) 2017 NXP Semiconductor
SHELL>> help

"help": Lists all the registered commands
"exit": Exit program

"led argl arg2":

Usage:
argl: 1121314... Led index
arg2: onloff Led status

SHELL>>

PUPO Y T P L Y

Note: the Terminal view only offers a simple terminal mechanism with a small number of
configuration options. If you require more control over the way the terminal behaves, you may
still need to use a standalone terminal application, such as PuUTTY, CoolTerm and Tera Term.
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Using and troubleshooting LPC-Link2

LPC-Link2 hardware

LPC-Link2 is a powerful, low cost debug probe design from NXP Semiconductors based on the
LPC43xx MCU. It has been implemented into a number of different systems, including:

¢ The standalone LPC-Link2 debug probe
e The debug probe built into the range of LPCXpresso V2/V3 boards.

For more details, see https://www.nxp.com/Ipcxpresso-boards

Softloaded vs Pre-programmed probe firmware

One thing that most LPC-Link2 implementation offer is the ability to either softload the debug
probe firmware (using USB DFU functionality) or to have the debug probe firmware pre-
programmed into flash.

Programming the firmware into flash has some advantages, including:

¢ Allows the use of the LPC-Link2 with toolchains that, unlike MCUXpresso IDE, do not support
softloading of the probe firmware.

« Better supports the use of LPC-Link2 as a small production run programmer

¢ Allows the LPC-Link2 to be used with SEGGER J-Link firmware as an alternative to the normal
CMSIS-DAP firmware. For more details please visit https://www.segger.com

¢ Avoids issues that the re-enumeration of the LPC-Link2 can sometimes trigger as the firmware
softloads (particularly where virtual machines are in use).

The recommended way to program the firmware into the flash of LPC-Link2 is NXP’s LPCScrypt
flash programming tool. For more details, see https://www.nxp.com/LPCSCRYPT

However, when used with MCUXpresso IDE, softloading the probe firmware is the recommended
method of using LPC-Link2 in most circumstances.

This ensures that the firmware version matching the MCUXpresso IDE version can automatically
be loaded when the first debug session is started (so normally the latest version). It also allows
different probe firmware variants to be softloaded, depending on current user requirements.

For this to work, you need to make sure that the probe hardware is configured to allow DFU
booting. To do this:

¢ For standalone LPC-Link2: remove the link from header JP1 (nearest USB)
e For LPCXpresso V2/V3: add a link to the header "DFU link"

LPC-Link2 firmware variants

As well as providing debug probe functionality, NXP's CMSIS-DAP firmware for LPC-Link2 by
default also includes bridge channels to provide:

¢ Support for SWO Trace capture from the MCUXpresso IDE

¢ Support for Power Measurement from the MCUXpresso IDE (certain LPCXpresso V3 boards
only)

¢ Support fora UART VCOM port connected to the target processor (LPCXpresso V2/V3 boards
only)

e Support for a LPCSIO bridge that provides communication to 12C and SPI slave devices
(LPCXpresso V3 boards only)
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However, two other variants of the CMSIS-DAP firmware are provided that remove some of these
bridge channels.

« “Non Bridged”: This version of firmware provides debug features only — removing the bridged
channels such as trace, power measurement and VCOM. By removing the requirement for
these channels, USB bandwidth is reduced, therefore this firmware may be preferable if
multiple debug probes are to be used concurrently. The non-bridged build will also provide an
increase in download and general debug performance.

¢ “VYCOM Only”: This version of firmware provides only debug and VCOM features. The removal
of the other bridges allows better VCOM performance (though generally the bridged firmware
provides more than good enough VCOM performance).

A particular workspace can be switched to softload a different firmware variant via: Preferences
-> MCUXpresso IDE -> Debug Options -> LinkServer Options -> LPC-Link2 boot type.

[ NN ) Preferences

LinkServer Options Sy v w

> General Ask to boot LPC-Link 2

»C/C++
| & HI:EIp Boot LPC-Link 2
* Install/Update LPC-Link 2 boot type v CMSIS-DAP (default) '
> Java . CMSIS-DAP (Non-bridged - Debug only)
» Library Hover Redlink server port (restart required) CMSIS-DAP (VCOM serial bridge only)

MCUXpresso Config Tools
¥MCUXpresso IDE
Debug Options (Advanced) CMSIS-DAP SWO server port 8989
Debug Options (Miscellaneous) Enable Registers View Double-Precision registers group
Debug Probe Discovery
Default Tool settings
» Editor Awareness

Redlink wirespeed in Hz (0 = default) 0

Block IDE requests to kill redlink server

FreeRTOS TAD Shutdown redlink server
General Kill redlink server on exit
| J-Link Options
| LinkServer Options . r .
LPC-Link Options Show timestamps in Redlink console
MCU settings Enable range stepping
Paths and Directories Pull ISP on reset (on LPC-Link 2)

PEMirro Ontions

Note: If a mix of bridged and unbridged debug probes is required, then it is recommended that
these probes are pre-programmed with the required debug firmware. This can easily be done
via LPCScrypt.

Manually booting LPC-Link2

The recommended way to use LPC-Link2 with the MCUXpresso IDE is to allow the GUI to boot
and softload a debug firmware image at the start of a debug session.

Normally, LPC-Link2 is booted automatically (when configured to operate in DFU mode)
however, under certain circumstances — such as when troubleshooting issues, or using the
LinkServer command line flash utility, you may need to boot it manually.

LPC-Link2 USB Details

The standard utilities to explore USB devices on MCUXpresso IDE supported host platforms are:

¢ Windows — Device Manager
* MCUXpressolDE also provides a listusb utility in:
* install_dir/ide/bin/Scripts
¢ Linux — terminal command: Isusb
¢ Mac OS X — terminal command: system_profiler SPUSBDataType
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Before boot, LPC-Link2 appears as a USB device with details:

Devi ce Vendor | D/ Product | D 0x1FC9/ 0x000C (NXP Semi conduct or s)

and will appear in Windows -> Devices and Printers, as below:

-

LPC

After boot, LPC-Link2 will by default appear as a USB device with details:

Devi ce Vendor| D/ Product | D: 0x1FC9/ 0x0090

and will appear in Windows -> Devices and Printers similar to below:

"

LPC-LINK2
CMSIS-DAP
V3.224

Note: Text details will vary depending on version number and which probe firmware variant is
booted.

Booting from the command line
MCUXpresso IDE provides a boot script for all supported platforms. To make use of this script

first of all connect the LPC-Link2 to your PC then enter the commands into a DOS command
prompt (or equivalent):

cd <install_dir>\ide\bin
boot _I i nk2

This will invoke the dfu-util utility to download the probe firmware into the RAM of the LPC-Link2's
LPC43xx MCU and then re-enumerate the probe.

Booting from the GUI
It is also possible to manually boot LPC-Link2 from the MCUXpresso IDE GUI, which may be a

more convenient solution than using the command line. To do this, first of all connect the LPC-
Link2 to your PC, then locate the red Boot icon on the Toolbar:

P A0~ Q

Boot Debug Probe

and then click OK in the dialog displayed :
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Debug probe selection B %
Select the debug probes to be booted
[¥] LinkServer
[ selectan | [ Deselectan |
@.,\' [ OK ] | Cancel |

LPC-Link2 windows drivers
The drivers for LPC-Link2 are installed as part of the main MCUXpresso IDE installation process.

Note: One thing to be aware of is that the first time you debug using a particular LPC-Link2 on
a particular PC, the drivers will need to be loaded. This first time can take a variable period of
time depending upon your PC and operating system version. This may mean that the first debug
attempt fails, as the IDE may time out waiting for the booted LPC-Link2 to appear. In such as
case, a second debug attempt should complete successfully. Otherwise, try booting the LPC-
Link2 manually and checking the drivers load correctly.

If you need to reinstall the drivers, then the installer can be found at:

C\nxp\<install _dir>\Drivers\|pc_driver_installer.exe

LPC-Link2 failing to enumerate

On some systems, after booting LPC-Link2 with CMSIS-DAP firmware, the booted debug probe
does not enumerate correctly and the MCUXpresso IDE (or other toolchain) is unable to see the
debug probe. This problem is normally caused by on old, obsolete, version of the VCOM driver
being found by Windows instead of the correct driver. To see if this is the cause of a problem
on your computer, find the version number of the LPC-Link2 VCOM driver. The obsolete driver
version is 1.0.0.0.

To find the version number of the LPC-Link2 VCOM driver

If you are using a soft-booted LPC-Link2 debug probe, start by booting your LPC-Link2, as
described in . If your LPC-Link2 debug probe is booting from
an image preprogrammed into the flash, you can skip this step.

Once your LPC-Link2 has booted, find the device in Device Manager and look at the driver
version number.

¢ Open the Windows Device Manager

¢ Expand the “Ports (COM and LPT)” section

¢ Right-click on “LPC-Linkll UCom Port”, and select Properties

¢ Click on the Driver tab of the Properties dialog
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File Action View Help
= @ E HE B EXC
A PetePC A
a4 £ o LPC-Linkll UCom Port (COM3) Properties x
i Audio inputs and outputs
@ Batteries General Por Settings Driver Detalls Events
fi| Biometric devices
) Bluetooth ~g LPCLnKI UCom Port (COM3)
® Cameras -
& Computer — .
o Disk diives Driver Provider: ~ NXP
[ Display adapters Driver Date: 211124
¥ Firmware Driver Verson:  2.0.0.0
i Humfan Irlter_face Hievices Digital Signer: NXP Semiconductors USA. Inc.
:i‘; Imaging devices
& Jungo Connectivity
E3 Keyboards View details about the installed driver files.
m Mice and other pointing devices
B Monitors Update Driver Update the driver for this device.
I N T 'y
— 2 Foll Back Driver If the device fails after updating the driver, roll
v R ?__0'15 (COM & LPT) zinkests back to the previously installed driver.
W LPC-Linkll UCom Port (COM3)
Disable Device Disable the device.
i Printers
[ Processors Uninstall Device Uninstall the device from the system (Advanced).
B Security devices
f Software components
B Software devices OK Cancel
il Snund viden and name controllers &

Note: that this image shows the current correct version of the driver (2.0.0.0).

Removing the obsolete 1.0.0.0 LPC-Linkll UCOM driver

To remove the obsolete driver, perform the following actions:

00 ~NO Ol WODN B

9.

. In Device Manager, right-click on the LPC-Linkll UCOM device and select Uninstall

. If there is an option to delete the driver software, make sure it is checked, and press OK

. Select the menu item Action->Scan for hardware changes

. In Windows Control Panel, select Add/Remove program or Uninstall a program option

. Find the LPC Driver Installer, right-click on choose Uninstall

. Let the uninstaller complete

. Switch back to the Device Manager and Scan for hardware changes again

. If the LPC-Linkll UCOM driver version is still present, Uninstall it again (steps 1 through 3) and

repeat until the LPC-Linkll UCOM driver no longer appears
Now run the Ipc_driver_installer.exe found in the MCUXpresso IDE “Drivers” directory

Note: A reboot is recommended after running the Ipc_driver_installer.exe installer.

Now manually reboot the probe again (if softloading) and check Windows — Devices and
Printers to see if the device now appears correctly as an LPC-Link2 CMSIS-DAP VX.XXX.

If this fails to correct the problem, there is one final thing to try:

Open a Command Prompt as the Administrative user and run the following commands

cd % enmp%
pnputil -e >devices.txt

not epad devi ces. t xt
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¢ Search devices.txt for an entry similar to this, and note down the Published name (oemXX.inf)

Publ i shed nane : oenB8. i nf

Driver package provider : NXP

Class : Ports (COM & LPT)

Driver date and version : 09/12/2013 1.0.0.0

Si gner nane : NXP Semi conductors USA. |nc

¢ Using the name notes above, run the following command (replacing XX with the number found
above)

pnputil -f -d oemXX inf

Troubleshooting LPC-Link2

If you have been able to use LPC-Link2 in a debug session but now see issues such as “No
compatible emulator available” or “Priority O connection to this core already taken” when trying
to perform a debug operation ...

¢ Ensure you have shut down any previous debug session

« You must close a debug session (press the Red ‘terminate’ button) before starting another
debug session

« ltis possible that the debug driver is still running in the background. Use the task manager or
equivalent to kill any tasks called:

« redlinkserv
¢ arm-none-eabi_gdb*
e crt_emu_*

MCUXpresso IDE provides an IDE button " to kill all low level debug executables.

A failure occurring while initiating a debug connection might also be caused by the GDB client
being unable to communicate with the GDB stub. In this case, the error usually indicates a
networking-related error, such as “Connection timed out”. Firewall and the launch configuration
should be checked. Note that the stub will need to be listening on a networking port in order
to communicate with the GDB client. For more details about the Debug Server Connection
parameters, see also section.

If your host has never worked with LPC-Link2, then the following may help to identify the problem:

¢ Try manually booting your LPC-Link2 as per Manually booting LPC-Link2, and ensure that the
drivers have installed correctly.

e Try a different USB cable!

e Try a different USB port. If your host has USB3 and USB2, then try a USB2 port

 there are known issues with motherboard USB3 firmware, ensure your host is using the
latest driver from the manufacturer. Note: this is not referencing the host OS driver but the
motherboard firmware of the USB port

« If using a USB hub, first try a direct connection to the host computer

« If using a USB hub, try using one with a separate power supply — rather than relying on the
supply over USB from your PC.

« Try completely removing and re-installing the host device driver. See also
above.

 If using Windows 8.1 or later, then sometimes the Windows USB power settings can cause
problems. For more details use your favourite search engine to search for “windows usb power
settings” or similar.

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022 271


Link2ManualBoot

NXP Semiconductors MCUXpresso IDE User Guide

19.10

19.10.1

19.10.2

MCUXpresso IDE User Guide -

Using and troubleshooting MCU-Link

MCU-Link hardware

MCU-Link is a new powerful and cost effective debug probe architecture that can be used
seamlessly with MCUXpresso IDE, and is also compatible with 3rd party IDEs that support
CMSIS-DAP protocol.

There are a range of debug solutions based on the MCU-Link architecture, which include
the standalone very low cost base model (MCU-Link probe), a fully featured MCU-Link Pro
probe and various implementations built into NXP evaluation boards. MCU-Link Pro includes
many additional features to facilitate embedded software development, like energy consumption
analysis and support of peripheral and host emulation via USB bridging functions. On-board
implementations support all the base model features and can optionally support additional
features available on MCU-Link Pro.

MCU-Link solutions are based on the powerful, low power LPC55S69 microcontroller and all
versions run the same firmware from NXP.

MCU-Link common features:

¢ CMSIS-DAP firmware to support all NXP Arm Cortex®-M based MCUs with SWD or JTAG
debug interfaces

« High speed USB host interface
* USB to target UART bridge (VCOM)
¢ SWO profiling and 1/O features

MCU-Link Pro additional features:

¢ SEGGER J-Link firmware option

« Circuitry to measure the target’'s supply voltage and current drawn
« Trigger-based measurement

¢ Analog signal trace input

« A second USB to target UART bridge (VCOM)

« USB SPI and 12C bridges for programming/provisioning and host-based application
development

« Option to power target system at up to 350mA (at 1.8V or 3.3V)
¢ On-board, user-programmable LPC804 for peripheral emulation
« Multiple status LEDs for diagnosis of issues

e Target reset button

For more details, please refer to the Getting Started guides available on the product web pages
on nxp.com;

¢ MCU-Link debug probe: https://www.nxp.com/pages/:MCU-LINK
¢ MCU-Link Pro debug probe: https://www.nxp.com/pages/:MCU-LINK-PRO

MCU-Link CMSIS-DAP firmware

MCU-Link debug probes are factory programmed with NXP's CMSIS-DAP protocol based
firmware, which also supports all other features supported in hardware.

Besides SWD/JTAG debug probe functionality, NXP’s CMSIS-DAP firmware for MCU-Link by
default also includes bridge channels to provide:

¢ Support for SWO Trace capture from the MCUXpresso IDE
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¢ Support for a UART VCOM port (UART interface to target)

Support for a second UART VCOM port [MCU-Link Pro]

Support for USB serial I/O (SPI, 12C, GPIO) bridge compatible with LIBUSBSIO [MCU-Link Pro]
Support for energy measurement from the MCUXpresso IDE [MCU-Link Pro]

MCU-Link probe type and firmware details are displayed in MCUXpresso IDE's Probes
Discovered dialog when the probe is attached:

Available attached probes

Name Serial number [ ID / Nickname Type Manufacturer IDE Debug Mode
MCU-LINK Pro (rOCF) CMSIS-DAP V2.249 12PDSKZHWMUQD LinkServer NXP Semiconductors Non-Stop
MCU-LINK on-board (rOC7) CMSIS-DAP V2.249 AAMO1QI2CPGRH LinkServer NXP Semiconductors Non-Stop

Probes Discovered will provide an indication if a newer firmware version is available. It is
recommended to update the MCU-Link firmware to the latest version using the provided firmware
update utility. Go to the Design Resources section of the board web page and navigate to
“Development software” from the SOFTWARE section. Installation packages for each host OS
will be shown. Download and run the installer for your host OS. A step-by-step installation guide
is provided at the board web page on nxp.com

CMSIS-DAP versions

Firmware versions V2.xxx implement an older version of CMSIS-DAP 1.1.0 and use USB HID
as interface to the host PC.

Firmware versions V3.xxx are based on the latest CMSIS-DAP version 2.1.0 and use WinUSB
as interface to the host PC and is therefore faster. Since the firmware implements Microsoft
descriptors to declare WCID (Windows Compatible ID), no additional WinUSB driver is required
on Windows.

Note

Firmware versions 3.xxx are supported in MCUXpresso IDE 11.7.0 or newer. If
using an older MCUXpresso IDE product, please install MCU-Link Firmware version
V2.263.

MCU-Link USB Details

The standard utilities to explore USB devices on MCUXpresso IDE supported host platforms are:

* Windows — Device Manager
« MCUXpressolDE also provides a listusb utility in:
* install_dir/ide/bin/Scripts
¢ Linux — terminal command: Isusb
¢ macOS - terminal command: system_profiler SPUSBDataType

In ISP mode (firmware update enabled), MCU-Link will appear as a USB device with details:

Devi ce Vendor | D/ Product | D 0x1FC9/ 0x0021

In normal use, MCU-Link will appear as a USB device with details:

Devi ce Vendor| D/ Product| D: Ox1FC9/ 0x0143

MCU-Link will appear in Windows Control Panel -> Hardware and Sound -> Devices and Printers
similar to below:
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—

MCU-LINK
on-board (fC7)
CMSIS-DAP
V2.249

Note: Text details will vary depending on firmware version and probe configuration.

MCU-Link host drivers

MCU-Link debug probes are supported on Windows 10, macOS and Ubuntu Linux platforms.
MCU-Link probes use standard OS drivers, however on Windows an inf driver is provided to
allow displaying friendly names in Device Manager for the MCU-Link VCom Port(s). The driver
for MCU-Link is installed as part of MCUXpresso IDE installation process as well as during the
installation of the firmware update utility. If you need to reinstall the driver, it can be found at:

MCUXpresso | DE: <install _dir>\Drivers\ MCU Li nk
MCU- LI NK_i nstal ler: <install _dir>\drivers

To install the driver, navigate to MCU-Link drivers and install the file by right-click —> Install:

¢ mcu-link-vcom.inf

MCU-Link JLink-compatible firmware

A custom version of J-Link firmware to make MCU-Link Pro compatible with SEGGER'’s popular
J-Link LITE is also available, but note that this firmware is limited to supporting debug (including
SWO) and VCOM features only.

Troubleshooting MCU-Link

If you have been able to use MCU-Link in a debug session but now see issues such as “No
compatible emulator available” or “Priority 0 connection to this core already taken” when trying
to perform a debug operation ...

¢ Ensure you have shut down any previous debug session

* You must close a debug session (press the Red ‘terminate’ button) before starting another
debug session

 ltis possible that the debug driver is still running in the background. Use the task manager or
equivalent to kill any tasks called:

* redlinkserv
e arm-none-eabi_gdb*
e crt_emu_*

Use MCUXpresso IDE button % to kill all low level debug executables.

A failure occurring while initiating a debug connection might also be caused by the GDB client
being unable to communicate with the GDB stub. In this case, the error usually indicates a
networking-related error, such as “Connection timed out”. Firewall and the launch configuration
should be checked. Note that the stub will need to be listening on a networking port in order
to communicate with the GDB client. For more details about the Debug Server Connection
parameters, see also section.

All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide

Rev. 11.6.0 — 19 December, 2022 274



NXP Semiconductors MCUXpresso IDE User Guide

19.11

19.11.1

MCUXpresso IDE User Guide -

If your host has never worked with MCU-Link, then the following may help to identify the problem:

Try updating the MCU-Link firmware and ensure that the drivers have installed correctly. See
above.

Make sure it is plugged into a high speed USB 2.0 port!
Try a different USB cable!
Try a different USB port. If your host has USB3 and USB2, then try a USB2 port

 there are known issues with motherboard USB3 firmware, ensure your host is using the
latest driver from the manufacturer. Note: this is not referencing the host OS driver but the
motherboard firmware of the USB port

If using a USB hub, first try a direct connection to the host computer

If using a USB hub, try using one with a separate power supply — rather than relying on the
supply over USB from your PC.

Try completely removing and re-installing the host device driver. See
above.

Creating bin, hex or S-Record files

When building a project, the MCUXpresso IDE tools create an ARM executable format (AXF) file
—which is actually standard ELF/DWARF file. This file can be programmed directly down to your
target using the MCUXpresso IDE debug functionality, but it may also be converted into a variety
of formats suitable for use in other external tools.

Simple conversion within the IDE

The simplest way to create a one-off binary or hex file is to open up the Debug (or Release)
folder in Project Explorer right click on the .axf file, and " Binary Utilities -> Create binary" (or
Create hex, S-Record).
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You can also change the underlying commands and options that are called by these menu entries
from the " Preferences -> MCUXpresso IDE -> Utilities" preference page.

From the command line

The above “Binary Utilities” option within the IDE GUI is simply invoking the command line
objcopy tool (arm-none-eabi-objcopy). Objcopy can convert into the following formats:

« srec (Motorola S record format)
¢ binary

ihex (Intel hex)

* tekhex

For example, to convert example.axf into binary format, use the following command:
arm-none-eabi-objcopy -O binary example.axf example.bin

If you ctrl-click on the project name on the right hand side of the bottom bar of the IDE, this will
launch a command prompt in the project directory with appropriate tool paths set up. You can
also use the Project Explorer right-click “Utilities->Open command prompt here” option to do this.
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All you need to do before running the objcopy command is change into the directory of the
required Build configuration.

Automatically converting the file during a build

Objcopy may be used to automatically convert an axf file during a build. To do this, create an
appropriate Post-build step

Binary files and checksums

When creating a binary file for most LPC MCUSs, you also need to ensure that you apply a
checksum to it — so that the LPC bootloader sees the image as being valid. Generally the linker
script will do this if the managed linker script mechanism is used. Otherwise the “checksum” utility
found in the \ide\bin subdirectory of your MCUXpresso IDE installation can be used.

Post-build (and Pre-build) steps

It is sometimes useful to be able to automatically post-process your linked application, typically
to run one or more of the GNU ‘binutils’ on the generated AXF file.

For example, any application project that you create using the Project wizard will have least one
such “post-build step” - typically to display the size of your application.

® Post-build steps

Notes:
- A comment character (#) disables ALL FOLLOWING COMMANDS.
= Enter one command per line.
- After editing, commands are concatenated with a ;' separator.

arm-none-eabi-size “${BuildArtifactFileName}"
# arm-none-eabi-objcopy -v -0 binary "${BuildArtifactFileName}" "${BuildArtifactFileBaseName}.bin"
# checksum -p ${TargetChip} -d "${BuildArtifactFileBaseName}.bin"

Note: Additional commands may also be listed (for example to create a binary and to run a
checksum command), but be commented out by use of a # character and hence not executed.
Any commands following a comment #command will be ignored.

Adding additional steps is very simple. In the below example we are going to carry out three
post-link steps:

« displaying the size of the application
* generate an interleaved C / assembiler listing
« create a hex version of the application image

To do this:

* Open the Project properties. There are a number of ways of doing this. For example, make
sure the Project is highlighted in the Project Explorer view then open the menu “Project ->
Properties”.

¢ In the left-hand list of the Properties window, open “C/C++ Build” and select “Settings”.
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¢ Select the “Build steps” tab
« In the “Post-build steps - Command” field, click 'Edit...'
e Paste in the lines below and click 'OK'

ar m none- eabi - si ze ${Buil dArtifactFil eNane};
ar m none- eabi - obj dunp -S ${Bui | dArtifactFil eName} > ${Buil dArtifactFileBaseNane}.|ss;
ar m none- eabi - obj copy -O i hex ${Buil dArtifactFil eNanme} ${Buil dArtifactFil eBaseNane}. hex;

¢ Click apply

Repeat for your other Build Configurations (Debug/Release)

Next time you do a build, this set of post-build steps will now run, displaying the application size
in the console, creating you an interleaved C/assembler listing file called .Iss and a hex file called
hex.

Note: Pre-build steps can be added to a project in exactly the same way if required.

Temporarily removing post-build steps

If you want to temporarily remove a step from your post-build process, rather than deleting it
completely — move that entry to the end of the line and pre-fix it with a “#” (hash) character. This
acts as a comment, causing the rest of the post-build steps to be ignored.

Save Info for Support

When reporting an issue, it is recommended to send to product team all necessary information
to easily reproduce the error you experience in the IDE working environment. For this reason, a
new option (" Help -> MCUXpresso IDE Save Info for Support") is introduced in Eclipse Help
menu that helps you to gather and pack all information related to workspace, logs and consoles:

Help
i Welcome
@ Help Contents
Bl MCUXpresso IDE User Guide
' Search
Show Contextual Help
Show Active Keybindings... Ctrl+Shift+L

Tips and Tricks...
Cheat Sheets...

P

Eclipse User Storage >
Check for Updates

Install New Software...

Eclipse Marketplace...

(R )

Additional resources >
MCUXpresso IDE installation details
MCUXpresso IDE Save Info for Support

MCUXpresso IDE support forum
About MCUXpresso IDE

Once wizard is open, various types of information can be individually selected (by default, all
categories are preselected):
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@ @ MCUXpresso IDE
MCUXpresso IDE Save Info for Support

The wizard exports necessary support information into an archive file.

Source Description

¥ General information Basic information of the current workspace

Installation details Details of the MCUXpresso IDE installation

Workspace files Listed workspace files

Installed SDKs Installed SDKs information (Name, SDK Version, Manifest Version and Location)
Jog Workspace log file

¥ Console View All of the entries in the Console View (debug and build related)

CDT Build Console [frdmk64f_hello_world]
Archive file: [Users{202004240826_Supportinfo.zip Browse
Notes:

@ cancel | (I

« Installation details — information about installation paths, tool version, OS and java versions,
IDE plugins versions.

* Workspace files — a list with all flenames and directory structure within the workspace.

* Installed SDKs — a list with all installed SDKs generic information: name, SDK and manifest
versions, location path.

e .log — can be one or more files and contain Eclipse logs generated in <workspace
dir>/.metadata directory.

¢ Console View — all consoles (Console eclipse views) content: build log, debug and flash
programming logs, standard input/output console, etc.

Note: No sensitive information like source code or file content (other than eclipse/build/debug
logs) is included!

Optionally, add details in the “Notes:” edit box, located on the bottom of the “Save Info for Support”
window, regarding any information you think it might be helpful: steps to reproduce, errors you
observe, expected results, etc. If used, the text content will be added to the final zip file.

After the selection is done and a proper zip filename and path are chosen, press ‘Finish’ button

to generate the archived support information. Use afterwards this zip as an attachment when
reporting the problem.
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20. Legal information

Information in this document is provided solely to enable system and software implementers to
use NXP products. There are no express or implied copyright licenses granted hereunder to
design or fabricate any integrated circuits or integrated circuits based on the information in this
document.

NXP makes no warranty, representation, or guarantee regarding the suitability of its products for
any particular purpose, nor does NXP assume any liability arising out of the application or use of
any product or circuit, and specifically disclaims any and all liability, including without limitation
consequential or incidental damages. “Typical” parameters that may be provided in NXP data
sheets and/or specifications can and do vary in different applications, and actual performance
may vary over time. All operating parameters, including “Typicals”, must be validated for
each customer application by customer’s technical experts. NXP does not convey any license
under its patent rights nor the rights of others. NXP sells products pursuant to standard terms
and conditions of sale, which can be found at the following address: https://www.nxp.com/
SalesTermsandCondition.

While NXP has implemented advanced security features, all products may be subject to
unidentified vulnerabilities. Customers are responsible for the design and operation of their
applications and products to reduce the effect of these vulnerabilities on customer’s applications
and products, and NXP accepts no liability for any vulnerability that is discovered. Customers
should implement appropriate design and operating safeguards to minimize the risks associated
with their applications and products.

NXP, the NXP logo, Freescale, the Freescale logo, Kinetis and Tower are trademarks of NXP
B.V.

Arm, Cortex, Thumb, TrustZone, Mbed, Keil, CoreSight are registered trademarks of Arm Limited
(or its subsidiaries) in the US and/or elsewhere. Microsoft, Azure ThreadX are trademarks of the
Microsoft group of companies. FreeRTOS™ and FreeRTOS.org™ are trade marks of Amazon
Web Services, Inc. SEGGER Embedded Studio is a trademark of SEGGER Microcontroller
GmbH. J-Link is a trademark of SEGGER MICROCONTROLLER GMBH & CO. KG IAR
trademark is owned by IAR Systems AB. Java and all Java-based trademarks are trademarks
of Oracle Corporation in the United States, other countries, or both. Linux is the registered
trademark of Linus Torvalds in the U.S. and other countries. UNIX is a registered trademark
of The Open Group in the United States and other countries. Eclipse, CDT are trademarks of
Eclipse Foundation, Inc.

© NXP B.V. 2016-2022. All rights reserved.
How To Reach Us:
Home Page: https://www.nxp.com

Web Support: https://www.nxp.com/support

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2022 NXP Semiconductors. All rights reserved.

User Guide Rev. 11.6.0 — 19 December, 2022 280



https://www.nxp.com/SalesTermsandConditions
https://www.nxp.com/SalesTermsandConditions
https://www.nxp.com
https://www.nxp.com/support

	MCUXpresso IDE User Guide
	Table of Contents
	1. Introduction to MCUXpresso IDE
	1.1  MCUXpresso IDE Overview of Features
	1.1.1  Summary of Features
	1.1.2  Supported Debug Probes
	1.1.3  Development Boards
	  LPCXpresso Boards for LPC
	  Freedom and Tower Boards for Kinetis
	  iMX RT Crossover Processor Boards



	2. New Features in MCUXpresso IDE version 11.6.0
	2.1  Feature Highlights from previous releases of MCUXpresso IDE

	3. IDE Overview
	3.1  Workspaces
	3.2  Welcome View
	3.3  Documentation and Help
	3.4  Perspectives and Views
	3.5  Major Components of the Develop Perspective
	3.5.1  Dark Theme

	3.6  The Quickstart Panel
	3.7  Project Explorer and New Projects
	3.8  Updating MCUXpresso IDE
	3.8.1  Locating IDE Components


	4. Part Support Overview (Preinstalled and via SDKs)
	4.1  Preinstalled Part Support
	4.1.1  Differences in Preinstalled and SDK Part Handling
	4.1.2  Viewing Preinstalled Part Support

	4.2  SDK Part Support
	4.2.1  Obtaining and Installing a Plugin SDK
	4.2.2  SDK Part Support via SDK Builder
	4.2.3  Obtaining and Installing an SDK via SDK Builder
	4.2.4  Installing SDKs by Importing a Remote SDK Git Repository
	4.2.5  Installing SDKs by Importing a Local Clone of an SDK Git Repository
	4.2.6  Installed SDKs Operations
	  Converting a Plugin SDK into a FileSystem SDK
	  Uninstalling (Deleting) an Installed SDK

	4.2.7  Installed SDKs Features
	4.2.8  Advanced Use: SDK Importing and Configuration
	4.2.9  Advanced Use: SDK Misc Options
	4.2.10  Important notes for SDK Users
	  Only SDKs created for MCUXpresso IDE can be used
	  SDK compatibility with earlier versions of MCUXpresso IDE
	  Shared Part Support Handling
	  Building a Fat SDK
	  Uninstallation Considerations
	  Sharing Projects


	4.3  Enhanced Project Sharing Features
	4.3.1  Project Drag and Drop
	4.3.2  Project Local SDK Part Support
	4.3.3  Project Local Support files
	4.3.4  Export Project to Local SDK Git Repository


	5. Creating New Projects using installed SDK Part Support
	5.1  New Project Wizard
	5.1.1  SDK New Project Wizard: Basic Project Creation and Settings
	5.1.2  SDK New Project Wizard: Advanced Project Settings

	5.2  Project Build
	5.2.1  Build Configurations


	6. Importing Example Projects (from installed SDKs)
	6.1  SDK Example Import Wizard
	6.1.1  SDK Example Import Wizard: Basic Selection
	6.1.2  SDK Example Import Wizard: Advanced options
	6.1.3  SDK Example Import Wizard: Import from XML fragment
	6.1.4  Importing Examples to non default locations


	7. SDK Project Component Management
	7.1  SDK Project Component Management example
	7.2  SDK Project Refresh

	8. Creating New Projects using Preinstalled Part Support
	8.1  New Project Wizard
	8.2  Creating a Project
	8.2.1  Selecting the Wizard Type
	8.2.2  Configuring the Project
	8.2.3  Wizard Options
	  LPCOpen Library Project Selection
	  CMSIS-CORE Selection
	  CMSIS DSP Library Selection
	  Peripheral Driver Selection
	  Enable use of Floating Point Hardware
	  Code Read Protect
	  Enable use of Romdivide Library
	  Disable Watchdog
	  LPC1102 ISP Pin
	  Memory Configuration Editor
	  Redlib Printf Options

	8.2.4  Project Created


	9. Importing Example Projects (from the file system)
	9.1  Code Bundles for LPC800 Family Devices
	9.2  LPCOpen Software Drivers and Examples
	9.3  Importing an Example Project
	9.3.1  Importing Examples for the LPCXpresso4337 Development Board

	9.4  Exporting Projects
	9.5  Building Projects
	9.5.1  Build Configurations


	10. Debug Solutions Overview
	10.1  Starting a Debug Session
	10.2  An Introduction to Launch Configuration Files
	10.3  LinkServer Debug Connections
	10.4  LinkServer Debug Operation
	10.4.1  LinkServer Debug Scripts

	10.5  LinkServer Troubleshooting
	10.5.1  Debug Log
	10.5.2  Flash Programming
	10.5.3  LinkServer executables

	10.6  PEmicro Debug Connections
	10.7  PEmicro Debug Operation
	10.7.1  PEmicro Differences from LinkServer Debug
	10.7.2  PEmicro Software Updates

	10.8  SEGGER Debug Connections
	10.8.1  SEGGER software installation
	  SEGGER software un-installation


	10.9  SEGGER Debug Operation
	10.9.1  SEGGER Differences from LinkServer Debug

	10.10  SEGGER Troubleshooting

	11. Debugging a Project
	11.1  Debugging Overview
	11.1.1  Debug Launch
	11.1.2  Debug Probe Selection Dialog (Probes Discovered)
	  Firmware version check on MCU-Link / MCU-Link Pro probes

	11.1.3  Controlling Execution

	11.2  Launch Configurations
	11.2.1  Editing a Launch Configuration (LinkServer)

	11.3  Common Debug Operations and Launch Configurations
	11.3.1  Debug Quickstart Shortcuts
	11.3.2  Connecting to a running Target (attach)
	  LinkServer
	  PEmicro
	  SEGGER JLink

	11.3.3  Controlling the initial Breakpoint (on main)
	  LinkServer
	  PEmicro
	  SEGGER JLink

	11.3.4  Debugging Pre-loaded binaries (Add Symbols)
	11.3.5  Disconnect Behaviour
	  LinkServer
	  PEmicro
	  SEGGER JLink

	11.3.6  Project Flash Programming

	11.4  Breakpoints
	11.4.1  Breakpoint Types
	11.4.2  Breakpoints Resources
	11.4.3  Skip All Breakpoints

	11.5  Watchpoints
	11.5.1  Using Watchpoints to monitor stack depth

	11.6  Registers
	11.6.1  Basic Register set (Core Registers)
	  CycleDelta
	  Vectpc


	11.7  Faults
	11.8  Peripherals
	11.8.1  Custom SVD File

	11.9  Offline Peripherals
	11.9.1  Loading Custom SVD File in Offline Peripherals view

	11.10  Global and Live Global Variables
	11.11  Live Global Variable Plotting
	11.11.1  Live Global Variable Graphing details

	11.12  Heap and Stack View
	11.13  Additional Debug Features
	11.13.1  Local Variables
	11.13.2  Disassembly view
	11.13.3  Memory view


	12. Configuring a Project
	12.1  Changes available via Quickstart Quick Settings
	12.2  Project Settings
	12.3  Changing the MCU (and associated SDK)
	12.4  Changing the MCU (SDK) package type

	13. MCUXpresso Config Tools
	13.1  Using the Config Tools
	13.1.1  Tool Perspectives
	13.1.2  Pins Tool
	13.1.3  Clocks Tool
	13.1.4  Peripherals Tool
	13.1.5  Device Configuration Tool
	13.1.6  TEE Tool
	13.1.7  Generate Code
	13.1.8  SDK Components


	14. The GUI Flash Tool
	14.1  The Advanced GUI Flash Tool
	14.1.1  Advanced GUI Flash Tool command Preview
	14.1.2  Advanced GUI Flash Tool logged Output
	14.1.3  Advanced GUI Flash Tool Programming an arbitrary Binary


	15. LinkServer Flash Support
	15.1  Default vs Per-Region Flash Drivers
	15.2  Advanced Flash Drivers
	15.2.1  LPC18xx / LPC43xx Internal Flash Drivers
	15.2.2  LPC SPIFI QSPI Flash Drivers
	  Flash devices supported by our LPC SPIFI Flash Drivers

	15.2.3  i.MX RT QSPI and Hyper Flash Drivers
	15.2.4  Flash Drivers using SFDP (LPC and iMX RT)
	  QSPI SFDP issues and Limitations
	  Flash programming log
	  QSPI Programming and Booting
	  FlexSPI Flash reset


	15.3  Kinetis Flash Drivers
	15.4  Configuring projects to span multiple Flash Devices
	15.5  The LinkServer GUI Flash Programmer
	15.6  The LinkServer Command Line Flash Programmer
	15.6.1  Command Line Programming
	  Programming an image into Flash
	  Programming Flash with SDK Part Support
	  Programming Flash taking MCUXpresso IDE project Memory edits into Account
	  Programming Flash for complex debug connections
	  Finding the correct parameters from MCUXpresso IDE
	  Dealing with Errors during Flash operations
	  Validating the Content of Flash
	  Erasing the Flash
	  Validating that Flash has been Erased
	  Examples



	16. C/C++ Library Support
	16.1  Overview of Redlib, Newlib and NewlibNano
	16.1.1  Redlib extensions to C90
	16.1.2  Newlib vs NewlibNano

	16.2  Library Variants
	16.3  Switching the selected C library
	16.3.1  Manually Switching

	16.4  What is Semihosting?
	16.4.1  Background to Semihosting
	16.4.2  Semihosting Implementation
	16.4.3  Semihosting Performance
	16.4.4  Important notes about using Semihosting
	16.4.5  Semihosted printf and Debugging
	16.4.6  Semihosting Specification

	16.5  Use of printf
	16.5.1  Redlib printf Variants
	  Character vs String output
	  Integer only vs full printf (including floating point)

	16.5.2  NewlibNano printf Variants
	16.5.3  Newlib printf variants
	16.5.4  Printf when using LPCOpen
	16.5.5  Printf when using SDK
	16.5.6  Retargeting printf/scanf
	  Redlib
	  Newlib / NewlibNano

	16.5.7  How to use ITM Printf
	  ITM Overview
	  ITM printf with SDK
	  ITM printf with LPCOpen


	16.6  itoa() and uitoa()
	16.6.1  Redlib
	  Example invocations
	  Standards compliance

	16.6.2  Newlib/NewlibNano

	16.7  Libraries and linker scripts

	17. Memory Configuration and Linker Scripts
	17.1  Introduction
	17.2  Managed Linker Script Overview
	17.3  How are Managed Linker Scripts Generated?
	17.4  Default Image Layout
	17.5  Examining the layout of the generated image
	17.5.1  Linker --print-memory-usage
	  Comparing Code Size

	17.5.2  arm-none-eabi-size
	17.5.3  Linker Map Files

	17.6  Image Information (Info)
	17.6.1  Memory Usage
	17.6.2  Memory Contents
	17.6.3  Call Graph
	17.6.4  Use of Filters

	17.7  Enhanced Syntax Highlighting
	17.8  Other Options affecting the Generated Image
	17.8.1  LPC MCUs – Code Read Protection
	  CRP : Preinstalled MCUs
	  CRP : MCUs installed by Importing an SDK

	17.8.2  Kinetis MCUs – Flash Config Blocks
	17.8.3  Placement of USB Data
	17.8.4  Plain Load Image
	17.8.5  Link Application to RAM

	17.9  Modifying the Generated Linker Script / Memory Layout
	17.10  Using the Memory Configuration Editor
	17.10.1  Editing a Memory Configuration
	17.10.2  Device specific vs Default Flash Drivers
	17.10.3  Restoring a Memory Configuration
	17.10.4  Copying Memory Configurations

	17.11  Global Data Placement
	17.12  Modifying heap/stack placement
	17.12.1  MCUXpresso style Heap and Stack
	17.12.2  LPCXpresso style Heap and Stack
	17.12.3  Reserving RAM for IAP Flash Programming
	17.12.4  Stack Checking
	17.12.5  Heap Checking
	17.12.6  Checking the Heap from your Application

	17.13  Placement of specific code/data Items
	17.13.1  Placing code and data into different Memory Regions
	17.13.2  Placing data into different RAM blocks using Macros
	17.13.3  Noinit Memory Sections
	  Making global variables Noinit

	17.13.4  Placing code/rodata into different FLASH Blocks
	17.13.5  Placing specific functions into RAM Blocks
	  Long branch veneers and Debugging

	17.13.6  Reducing Code Size when support for LPC CRP or Kinetis Flash Config Block is Enabled

	17.14  FreeMarker Linker Script Templates
	17.14.1  Basics
	17.14.2  Reference
	  Linker script template hierarchy
	  Linker script search paths
	  Linker script templates
	  Predefined variables (macros)
	  Extended variables
	  Outputting variables


	17.15  FreeMarker Linker Script Template Examples
	17.15.1  Relocating code from FLASH to RAM
	  Relocating particular objects into RAM
	  Relocating particular libraries into RAM
	  Relocating majority of an application into RAM

	17.15.2  Configuring projects to span multiple Flash Devices

	17.16  Disabling Managed Linker Scripts

	18. Multicore Projects
	18.1  Introduction
	18.2  Creating a Primary / Secondary project Pair (using an SDK)
	18.2.1  Creating the M0 Secondary project
	18.2.2  Creating the M4 Primary project

	18.3  Creating a Primary / Secondary project Pair (using Preinstalled Part Support)
	18.3.1  Creating the M0 Secondary project
	18.3.2  Creating the M4 Primary project

	18.4  Debugging MultiCore Projects
	18.4.1  Controlling Debug Views
	18.4.2  Secondary Project Debug
	18.4.3  Auto-debug secondary project(s) for multicore projects

	18.5  MultiCore Projects additional Information
	18.5.1  Defines
	18.5.2  Secondary Boot Code
	18.5.3  Reset Handler code


	19. Appendix – Additional Hints and Tips
	19.1  Part Support Handling from SDKs
	19.1.1  SDK Version control
	19.1.2  SDK Manifest versioning
	19.1.3  Device versions

	19.2  How do I switch between Debug and Release builds?
	19.2.1  Changing the build configuration of a single project
	19.2.2  Changing the build configuration of multiple projects

	19.3  Editing Hints and Tips
	19.3.1  Multiple views onto the same file
	19.3.2  Viewing two edited files at once
	19.3.3  Source folding
	19.3.4  Editor templates and Code completion
	19.3.5  Brace matching
	19.3.6  Syntax coloring
	19.3.7  Comment/uncomment block
	19.3.8  Format code
	19.3.9  Correct Indentation
	19.3.10  Insert spaces for tabs in editor
	19.3.11  Replacing tabs with spaces

	19.4  Hardware Floating Point Support
	19.4.1  Floating Point Variants
	19.4.2  Floating point use – Preinstalled MCUs
	19.4.3  Floating point use – SDK installed MCUs
	19.4.4  Modifying floating point configuration for an existing project
	19.4.5  Do all Cortex-M4 MCUs provide floating point in hardware?
	19.4.6  Why do I get a hard fault when my code executes a floating point operation?

	19.5  LinkServer Scripts
	19.5.1  Supplied Scripts
	19.5.2  User Scripts
	19.5.3  Debugging code from RAM
	19.5.4  LinkServer Scripting Features

	19.6  RAM projects with LinkServer
	19.6.1  Advantages of developing with RAM projects

	19.7  The Console View
	19.7.1  Console types
	  Build Console and Global Build Console
	  FreeRTOS Task Aware Debugger Console
	  Azure RTOS ThreadX Task Aware Debugger Console
	  Zephyr RTOS Task Aware Debugger Console
	  gdb traces and arm-none-eabi-gdb Consoles
	  RedlinkServer/LinkServer Console
	  Debug messages Console
	  Semihosting Console
	  SWO and Trace Console

	19.7.2  Copying the contents of a console
	19.7.3  Relocating and duplicating the Console view

	19.8  Using Terminal View for UART communication with target
	19.9  Using and troubleshooting LPC-Link2
	19.9.1  LPC-Link2 hardware
	19.9.2  Softloaded vs Pre-programmed probe firmware
	19.9.3  LPC-Link2 firmware variants
	19.9.4  Manually booting LPC-Link2
	  LPC-Link2 USB Details
	  Booting from the command line
	  Booting from the GUI

	19.9.5  LPC-Link2 windows drivers
	19.9.6  LPC-Link2 failing to enumerate
	  To find the version number of the LPC-Link2 VCOM driver
	  Removing the obsolete 1.0.0.0 LPC-LinkII UCOM driver

	19.9.7  Troubleshooting LPC-Link2

	19.10  Using and troubleshooting MCU-Link
	19.10.1  MCU-Link hardware
	19.10.2  MCU-Link CMSIS-DAP firmware
	  CMSIS-DAP versions
	  MCU-Link USB Details

	19.10.3  MCU-Link host drivers
	19.10.4  MCU-Link JLink-compatible firmware
	19.10.5  Troubleshooting MCU-Link

	19.11  Creating bin, hex or S-Record files
	19.11.1  Simple conversion within the IDE
	19.11.2  From the command line
	19.11.3  Automatically converting the file during a build
	19.11.4  Binary files and checksums

	19.12  Post-build (and Pre-build) steps
	19.12.1  Temporarily removing post-build steps

	19.13  Save Info for Support

	20. Legal information

